
HP ALM Performance Center
Software Version: 12.20

User and Administrator Guide

Document Release Date: December 2014
Software Release Date: December 2014



Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be
construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software,
Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notice
© Copyright 2002 - 2014 Hewlett-Packard Development Company, L.P.

Trademark Notices
Adobe™ is a trademark of Adobe Systems Incorporated.

Microsoft® andWindows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of TheOpenGroup.

This product includes an interface of the 'zlib' general purpose compression library, which is Copyright © 1995-2002 Jean-loupGailly andMark Adler.

Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go to: http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to: http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.

Support
Visit the HP Software Support Online web site at: http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed tomanage your
business. As a valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Download software patches
l Manage support contracts
l Look up HP support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

User and Administrator Guide

HP ALM Performance Center (12.20) Page 2 of 521
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Chapter 1: HP ALM Performance Center Introduction
This chapter includes:

HP ALM Performance Center Overview 17

How to Conduct a Performance Test 18
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HP ALM Performance Center Overview
HP ALM Performance Center is a global cross-enterprise performance testing tool which enables you
tomanagemultiple, concurrent performance testing projects across different geographic locations
without any need to travel between the locations. Performance Center administers all your internal
performance testing needs. With Performance Center, youmanage all aspects of large-scale
performance testing projects, including resource allocation and scheduling, from a centralized location
accessible through theWeb. Performance Center helps streamline the testing process, reduce
resource costs, and increase operating efficiency.

Performance Center generates load on yourWeb server or application using HP's virtual user (Vuser)
technology. Each Vuser follows a series of steps (for example, hyperlink steps, submit form steps, and
so on) that you define in a Vuser script. You design Vuser scripts to emulate typical user activity in your
application.

Vusers run on dedicated host machines. Each host machine runs many Vusers. When run
concurrently, the Vusers create the same load as tens of thousands of individual human users. While
Vusers run, Performance Center collects server response time data.

Performance Center analysis tools, which you access both during and after the performance test,
provide you with a clear and concise picture of your application's performance under load.

Performance Center helps you pinpoint performance bottlenecks. It also allows you to determine the
number of users your system can scale up to (this number is the "breaking point" after which your
application's performance starts to degrade). This information gives clues as to what can be done to
increase your application's load capacity.

In addition, the information provided by Performance Center helps you analyze how the load on your
system affects the service level agreements (SLAs) or other performance thresholds that are important
to your business.

Performance Center has the following system advantages:

l Performance Center's step-by-step process helps guide you through the performance testing
procedure.

l Performance Center enables remote testing by anybody, from anywhere, at any time, eliminating
the need to travel.

l Performance Center enables multiple concurrent tests, replacing serial testing with parallel testing.

l Performance Center enables remotemanagement from anywhere through aWeb server.

l Performance Center is a complete system for managing performance tests, scripts, and resources.
Furthermore, Performance Center centralizes the testing environment, with no duplication of testing
labs, keeping costs down andminimizing time.

l Performance Center enables you to take advantage of the power of theWeb for supporting services
such as remote consulting, online support, and so on.
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For details on how to conduct a performance test, see "How to Conduct a Performance Test" below.

How to Conduct a Performance Test
This task describes how to conduct a performance test on your application.

Note: To view amovie that demonstrates how to conduct a performance test, select Help >
Movies in the ALMmain window.

To learnmore about performance testing, see "HP ALM Performance Center Overview" on the
previous page.

1. Create and add test assets
For details, see "How toManage Testing Assets" on page 39.

2. Reserve a timeslot for performance testing
For details, see "How to Reserve Timeslots for Performance Testing" on page 91.

3. Design a performance test
For details, see "How to Design a Performance Test" on page 111.

4. Run, monitor, and view results of the performance test
For details, see "How toManage a Performance Test Run" on page 242.
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Chapter 2: My Performance Center
This chapter includes:

My Performance Center Overview 21

How to Start My Performance Center 21

My Performance Center User Interface 22
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My Performance Center Overview
My Performance Center provides an interface specifically designed for facilitating execution of day-to-
day performance testing activities. It enables you create and personalize views of performance testing
features. UsingMy Performance Center, you can create and edit tests, manage test assets, as well as
run and track test runs.

How to Start My Performance Center
This task describes how to launchMy Performance Center on your machine from yourWeb browser.

1. Choose one of the following:

From Performance Center:Open your web browser and type the Performance Center Server
URL
http://<PCS server name>/loadtest.

Note: If more than one Performance Center server is installed in your system together with a
load balancer, you should access My Performance Center by entering the load balancer's
URL. Alternatively, you can also enter the server's defined internal URL.

From ALM:Open yourWeb browser and type your ALM URL
http://<ALM server name/IP address>[<:port number>]/qcbin. The HP Application
Lifecycle Management Options window opens. Click My Performance Center.

Note: Contact your system administrator if you do not have the correct URL.

2. TheMy Performance Center Login window opens.

Note: If Performance Center was configured for external authentication, the Login Name
andPassword fields do not appear in this window. For more details on external
authentication, see theHP ALM External Authentication Configuration Guide.

3. In the Login Name box, type your user name.

4. In thePassword box, type the password assigned to you by your site administrator.

5. Select theAutomatically log in to my last domain and project on this machine check box if
you want Performance Center to automatically log in to the last project in which you were working.

6. Click theAuthenticate button. Performance Center verifies your user name and password and
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determines which domains and projects you can access. If you specified automatic login,
Performance Center opens.

7. If authentication fails, check that your user name and password are correct and try again.

8. In theDomain list, select a domain. By default, the last domain in which you were working is
displayed.

9. In theProject list, select a project. By default, the last project in which you were working is
displayed.

Note: The system administrator can control user access to Performance Center projects by
defining user groups that can enter them, and by determining the types of tasks each user
group performs according to permission levels. For more information, see theHP Application
Lifecycle Management Administrator Guide.

10. Click the Login button. Performance Center opens.

My Performance Center User Interface
This section includes:

My Performance CenterWindow 23

Start Page 24

Personalized Views 25

Download Applications Dialog Box 27

Testing Hosts Module 29
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My Performance Center Window

This section describes theMy Performance Center window.

To access See "How to Start My Performance Center" on page 21.

User interface elements are described below:

UI Elements Description

Domain Displays the selected domain name.

Project Displays the selected project name.

Notifications. Opens the Notifications dialog box enabling you to receive and
send notifications to other users.

l My Last Notifications. Enables you to view and send notifications.

l Notifications Management. Contains a list of the available notifications.

Community. Enables easy access to Performance Center RSS feeds, links to
relevant groups and forums, and the product's Web site.

Download Applications. Opens the Download Applications dialog box
enabling you to download standalone applications needed for working with
Performance Center. For more details, see "Download Applications Dialog Box"
on page 27.

Displays help for Performance Center. It also enables you to open additional
online HP Application Lifecycle Management and Performance Center
resources.

Hello <user
name>

Displays the current user name.

Logout Logs you out of your current project and returns you to the Performance Center
Login window.

Module
Navigation
Toolbar

Enables you to navigate to a selectedmodule. Includes the following options:
Start, Test Management, Runs & Analysis, Resources, Reports, and
Personalized Views.

Returns to the last site visitedmodule.

Start Displays the starting page in Performance Center. For user interface details,
see "Start Page" on the next page.
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UI Elements Description

Test
Management >
Test Plan

Displays the Test Plan tree . Enables you to create andmanage tests. For user
interface details, see "Test PlanModule" on page 116.

Test
Management >
Test Lab

Enables you to ran andmanage test sets. For user interface details, see "Test
LabModule" on page 249.

Runs &
Analysis > Runs

Enables you to view andmanage test runs. For user interface details, see "Test
LabModule" on page 249.

Runs &
Analysis >
Trending

Enables you to view performance trending information. For user interface
details, see "Performance TrendingModule" on page 312.

Runs &
Analysis > PAL

Enables you to view performance application lifecycle information. For user
interface details, see "PALModule" on page 344.

Resources >
Test Resources

This module enables create andmanagemonitor profiles and analysis
templates. For user interface details, see "Test Resources Module" on page 67.

Resources >
Testing Hosts

Enables you to view andmanage hosts. For user interface details, see "Testing
Hosts Module" on page 29.

Resources >
Timeslots

Enables you to view andmanage timeslots. For user interface details, see
"Timeslots Module" on page 92.

Resources >
Topologies

Displays details about topologies defined in the system. For user interface
details, see "Topologies Module" on page 57.

Reports Usage Reports. Provides you with an overall analysis of Performance Center.
The analysis includes site users, resource usage, concurrent resource usage
vs. license limitations, timeslot usage, resource usage by duration and runs,
VUDS usage, protocol usage, and cloud utilization and operations. For more
details on usage reports, see theHP ALM LabManagement Guide.

Personalized
Views

Enables you create a personalized group of views to suit your specific testing
needs. For user interface details, see "Personalized Views" on the next page.

Auto Refresh On/Off.When enabled, automatically refreshes the views every
5 seconds so that it displays themost up-to-date task information.

Start Page

This section describes the Start page inMy Performance Center. This page displays a dashboard of
test runs. You can view your runs or all runs. The page also displays a list of your last modified entities,
and the resources in use.

To
access

See "How to Start My Performance Center" on page 21. On theMy Performance Center
navigation bar, click Start.
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User interface elements are described below:

UI Elements Description

<Common UI elements> For user interface details, see "My Performance CenterWindow" on
page 23.

Runs pane Displays the test run activities.

My Runs. Displays your test run activities.

All Runs. Displays test run activities for all users of the project.

Running. Displays the currently running tests in the system.

Scheduled. Displays the tests that are scheduled to run.

Finished. Displays the completed test runs.

Last Modified Entities
pane

Enables you to keep track of changes to performance testing entities.

Resources Enables you to keep track of the performance testing resources in use.

Personalized Views

You create a personalized group of views to suit your specific testing needs.

To access On theMy Performance Center navigation bar, select Personalized Views.

User interface elements are described below:

UI Elements Description

Create New Opens the Create New Perspective dialog box, enabling you to create a
personalized view.

Displays the available views in the a pane.

Available Views
User interface elements are described below:

UI Elements
(A - Z)

Description

Analysis
Templates

Enables you to create anmaintain analysis templates. For more information, see
"Customizing Analysis Templates" on page 232.

User and Administrator Guide
Chapter 2: My Performance Center

HP ALM Performance Center (12.20) Page 25 of 521



UI Elements
(A - Z)

Description

Currently
Running
Tasks

Enables you to keep track of currently running tasks in the system.

Currently
Running
Tests

Enables you to keep track of currently running tests in the system.

Groups and
Forums

Enables easy access to relevant groups and forums.

Last
Modified
Entities

Enables you to keep track of changes to performance testing entities.

Manage
Production
Data Sets

Enables you to import andmonitor PAL data sets from the production system. For
more information about PAL data sets, see "PALModule" on page 344.

Monitor
Profiles

Enables you to create andmanage existingmonitor profiles. For more information
about monitor profiles, see "Monitor Profiles" on page 64.

PAL
Reports

Enables you tomanage PAL reports. It displays a list of available reports, and
enables you to create new reports, and to delete or duplicate existing reports. For
more information about PAL reports, see "PALModule" on page 344.

Performance
Center
Hosts

Enables you to view andmanage Performance Center hosts. For more information
about hosts, see theHP ALM LabManagement Guide.

Performance
Center RSS

Enables easy access to Performance Center RSS feeds.

Performance
Test Set

Enables you to view and edit selected tests within test sets. You can create, edit,
rename, and remove tests. You can also run tests directly from this view. For more
details on this view, see "Test LabModule" on page 249

Performance
Trending

Enables you to create trend reports in order to identify performance improvements
and regressions. For more information about trending, see "Trending" on page 304.

Reports Enables you to generate various usage reports. You can export generate reports to a
.pdf or an Excel file. For more information on usage reports, see theHP ALM Lab
Management Guide.

Test Plan
Tree

Enables you tomanage your test plan tree. For more details, see "Test PlanModule"
on page 116.
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UI Elements
(A - Z)

Description

Test Run
Results

Displays result information for a test run selected in the Test Runs view. For more
details on this view, see "Test LabModule" on page 249

Test Runs Enables you to view andmanage results for individual test runs. For more details on
this view, see "Test LabModule" on page 249.

Test Sets
Tree

Enables you tomanage your test sets tree.

Timeslots Enables you to view reserved timeslots for the project. For more information on
timeslots, see "Timeslots Module" on page 92.

Topologies
Tree

Enables you to create andmanage topologies. For more information on topologies,
see "Topologies" on page 48.

Topology
Preview

Displays a preview of the topology defined for a performance test. For more
information on topologies, see "Topologies" on page 48.

VuGen
Scripts

Enables you to view and upload VuGen scripts to ALM. For more information on
managing scripts, see "VuGen Script Management" on page 40.

Web Page Enables easy access to the product's Web site.

Download Applications Dialog Box

This dialog box enables you to download various standalone applications for use with Performance
Center.

To access
In the upper-right corner of theMy Performance Center window, click .

User interface elements are described below:

UI Elements Description

Standalone
VuGen

Enables you to create Vuser scripts for performance tests. Using VuGen, you
record business processes into test scripts and customize the scripts according to
defined user behavior.

Standalone
Analysis

Enables you to analyze performance test data offline from any computer on which
Analysis is installed. You use Analysis graphs and reports to organize and display
performance test results and summarize system performance.
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UI Elements Description

Snapshot
Viewer

Enables you to view snapshot on error pages captured fromWeb Vusers during
performance test runs. The snapshot is a graphical representation of theWeb page,
displayed at the point at which the error occurred during the performance test run.
This viewer displays snapshots from files with .SOE and .INF extensions. A
Snapshot On Error (.SOE) file is a GNU-Zipped file containing one or more
snapshots represented by .INF files.

Standalone
Load
Generator

Enables you to generate load by running virtual users (Vusers). The Controller
dictates themanner in which they start and stop running. There can be any number
of load generators for a given test.

Standalone
Monitor Over
Firewall

To enablemonitoring of your servers from outside the firewall, youmust install the
Monitor Over Firewall component on designatedmachines inside the firewall. You
first configure theMonitor Over Firewall agent to operate over a firewall. You then
select the servers you want to monitor, and define the specific measurements that
Performance Center collects for eachmonitored server.

Performance
Validation
SDK

Provides the tools to create a custom protocol for running performance tests on a
previously unsupported application. For more information, see theHP Performance
Validation SDK Developer's Guide.

PAL Data
Set Creator

Enables you to create PAL production data sets using data fromMicrosoft IIS W3C
Extended Log Format, Google Analytics, andWebtrends. For more details, see
"PALData Set CreatorWizard" on page 369.

Script
Development
Tools

Includes the following tools:

l Agent for Citrix Server. Installs an optional component on the server machine
which enhances VuGen's capabilities in identifying Citrix client objects.

l Agent for Microsoft Terminal Server. Used for extended RDP protocol
record-replay. This component runs on the server side, and is used to create and
run enhanced RDP scripts.

l MQ Tester. Installs a component on the VuGenmachine to generate scripts that
load IBMMQSeries.

l WinPcap. Allows capturing network traffic into a file and analyzing it afterwards.
It is used in the VuGenWeb Services protocol server side recording feature. For
more information about WinPcap, see http://www.winpcap.org.

Add-ins for
Visual
Studio IDE

Installs a component that enables you to create and run scripts written in your
standard development environment, in the application's native language. Download
the add-in that matches your version of Visual Studio, and run the add-in's
executable file.
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Testing Hosts Module

This module enables you to view andmanage hosts used for test execution.

To access On theMy Performance Center navigation bar, select Resources > Testing Hosts.

Important
information

You can provision hosts from the cloud for use in performance testing. For more
information, see theHP ALM LabManagement Guide.

Relevant
tasks

l "How to Design a Performance Test" on page 111

l HP ALM LabManagement Guide

See also l "My Performance CenterWindow" on page 23

l HP ALM LabManagement Guide

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<My Performance Center common UI
elements>

ForMy PC menus and buttons, see "My Performance
CenterWindow" on page 23.

Opens the Add Host Dialog box, enabling you to
create a testing host. For more information, see the
HP ALM LabManagement Guide.

Opens the Provision Cloud Hosts dialog box, enabling
you to provision hosts. You can choose how many
hosts to provision and where the hosts are
provisioned, and you can select all necessary host
configurations. For more information, see theHP ALM
LabManagement Guide.

Deletes the selected host.

Open the Check Host dialog box, enabling you to
check connectivity between the selected host and
other machines in the system.
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UI Elements Description

Enables you to remotely reboot host machines.

Note:

l You cannot reboot Controller and Load
generator hosts while they are in the
Running state. You can only reboot these
hosts when they are idle.

l You cannot reboot a UNIX load generator
host.

l Available only for hosts with Performance
purposes.

Opens the Data Processor Queue window, enabling
you to view the pending data processing requests.

Opens the Change Host Status dialog box, enabling
you to change the status of a selected host.

The possible statuses are:

l Operational.The host is working.

l Non-operational. The host is not working.

l Unavailable.The host is not available.

Resets the following on the selected host machine:

l Host license

l System user (IUSR_METRO)

l Communication Security passphrase

Note: You can reconfigure only one host at a
time.

Opens the provisioning report for the selected cloud
host. For more information, see theHP ALM Lab
Management Guide. This option is disabled if the
selected host is not a cloud host.
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UI Elements Description

<Cloud Hosts Summary Panel> Displays a summary of cloud hosts by status/host
state. Click on the number next to a status/host state
to filter the Hosts grid by that status/host state.

<Quick Views> Lists predefined filters for the testing hosts grid. The
following quick views are available:

l All Performance Testing Hosts.

l Cloud Load Generators.

l Local Performance Testing Hosts.

l Custom.

Add Filter Enables you to filter the information being displayed in
the testing hosts grid. Click the drop-down arrow to
apply a filter.

Source The testing host's source:

l Local. The host exists in your testing lab.

l Cloud. The host was provisioned from a cloud
provider.

Name/IP The name or IP address of the host.

Label The logical name of the cloud host as specified during
provisioning.

Available in: All Performance Testing Hosts and
Cloud LoadGenerators

Purpose The testing tools available on the host. For
example: Controller, Load generator, Data processor.

Note:

l If the host machine is located over a firewall,
or is a UNIX machine, it cannot function as a
Controller or Data processor.

l If you selectedWindows Standalone LG or
Unix Load Generator as the installation
option, Load Generator is automatically
selected as the purpose for the host and the
other options are disabled.
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UI Elements Description

Status The status of the host. The possible statuses are:

l Operational. The host machine is up and running.

l Non-operational. The host machine is down.

l Unavailable. There is no information available
about the status of the host.

State The current activity on the host.

Idle. Indicates that the host is not being used.

Installing. Indicates that a patch is being installed on
the host.

Rebooting. Indicates that the host is rebooting.

<Run states>. Indicates the host state during a
performance test run.

<Data processing states>. Indicates the state of the
host during a data processing task.

<Provisioning states>. Indicates the provisioning
status of a cloud host. Host State changes to idle
once the host is provisioned.

Location The name of the host location.

Attributes The system attributes of the host.

Example:Memory, strength, installed components.

Tip: You can customize the host attributes in Lab
Management. For details, refer to theHP
Application Lifecycle Management Administrator
Guide.

Priority A rank assigned to the host. The higher the priority
you give the host, themore likely the host will be
allocated to a test. There are a number of criteria to
consider when assigning priority. Themain
considerations are whether the host is a dedicated
machine or a shared resource, and the type of
hardware installed on themachine.

Not Available in: Custom view
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UI Elements Description

Privacy Type The privacy type of the host. You canmodify all hosts
in LabManagement, including private hosts. In ALM,
you can only create andmodify private hosts within
the project's pool.

Not Available in: Custom view

Active Timeslot ID The ID of the timeslot for which this host is reserved,
and which is now open.

Cloud Host Identifier A unique ID for the host assigned by the cloud
provider.

Available in: Cloud LoadGenerators

Cloud Request Id The cloud provider's ID for a single provision request.
A provision request includes all requested batches of
hosts. Each batch has its ownCloud Request Item
ID.

Tip: You can filter by Cloud Request ID to see all
hosts that were provisioned in a single provision
request.

Available in: Cloud LoadGenerators

Cloud Template The host template used to provision the host.
Changing a host template does not affect existing
hosts that were provisioned from the template.

Available in: Cloud LoadGenerators

Task Indicates the host status.

Available in:Custom view

MI Listener The IP address or name of theMI Listener that
enables data collection. Relevant only for hosts
located over a firewall.

Available in:Custom view

Cloud Account The name of the cloud account from which the host
was provisioned.

Available in:Custom view

Cloud Image Themachine image applied to the cloud host.

Available in:Custom view
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UI Elements Description

Cloud Instance Type The hardware specs of the cloud host.

Available in:Custom view

Cloud Region The region from which a cloud host was provisioned.

Available in:Custom view

Runtime State Indicates the host state during a performance test run.

Available in:Custom view

Active Timeslot ID The ID of the timeslot for which this host is reserved,
and which is now open.

Available in:Custom view

Description tab Describes the currently selected host.

Event Log tab Displays detailed information about the tasks
performed on the selected host, the action status, and
a description of any errors.

Installed PC Components tab Displays a list of the Performance Center
components installed on the host machine, including
versions and patches.

Installed Programs tab Displays a list of all of the programs installed on the
host machine. Details include the version, the
publisher of the software, and the date it was installed
in the host machine.

Processes tab Displays detailed information about the processes
and resource usage of the selected host. For more
details, see theHP ALM LabManagement Guide.

Services tab Displays the services running on the host machine.
For more details, see theHP ALM LabManagement
Guide.

Check Host Status tab Displays the status of each step of the host checks.
For more details, see theHP ALM LabManagement
Guide.
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Chapter 3: Testing Assets - Introduction
This chapter includes:

How toManage Testing Assets 39
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How to Manage Testing Assets
The following steps describe how to configure project settings and add testing assets.

Note: This task is part of a higher-level task. For details, see "How to Conduct a Performance
Test" on page 18.

Configure project settings
You can configure themonitors, runtime settings, timeout, general, and debug information options for
all your Performance Center projects. For details, refer to theHP ALM LabManagement Guide.

Create projects that contain virtualized services - optional
You can create projects that contain virtualized services and integrate these services into your VuGen
scripts. For details, see theHP Service Virtualization User Guide.

Upload VuGen scripts
After you create Vuser scripts using HP Virtual User Generator, youmust upload them to Performance
Center. For details, see "How to Upload VuGen Scripts" on page 42.

Design topologies of your applications under test
You can design topologies of your applications under test using the Topologies feature. For details, see
"How to Design Topologies" on page 49.

Create monitor profiles tomonitor your tests
Tomonitor server resources, youmust configure themonitor settings for a test. Thesemonitor settings
can then be saved as monitor profiles that can be used by any performance test in your project. For
details on creatingmonitor profiles, see "How to Create and ConfigureMonitor Profiles" on page 65.
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Chapter 4: VuGen Script Management
This chapter includes:

Vuser Scripts 41

Mapping VuGen Parameters to AUT Parameters 41

How to Upload VuGen Scripts 42

How to Convert NUnit, JUnit, or Selenium Tests to VuGen Scripts 43

VuGen Script Management User Interface 44
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Vuser Scripts
When you run a performance test, virtual users (Vusers) access your application concurrently in order
to put load on your server. The actual steps that the Vusers perform when accessing your application
are represented in a Vuser script. Each Vuser performs the actions recorded in one Vuser script.

You design Vuser scripts to emulate typical end-user activities on your application. For example, if you
are testing performance on aWeb site, the Vuser script emulates a real user accessing URLs, clicking
links, submitting forms, and so on. When you create a performance test, you distribute your Vuser
scripts among your Vusers.

For example, in the case of testing aWeb site, you can specify that a portion of the Vusers run a Vuser
script that emulates real users accessing your home page, a portion run a script that performs a search
query, and a portion emulate the completion of an order form.

You obtain Vuser scripts by recording them using HP's Virtual User Generator (VuGen) and uploading
them to Performance Center.

You can also obtain Vuser scripts by converting existing NUnit, JUnit, or Selenium tests and uploading
them to Performance Center.

In addition to testingWeb sites, Performance Center can be used to test performance of non-Web
environments. For example, you can test WAP, Real, or Oracle NCA applications. For details of
supported protocols, see theHP Virtual User Generator User Guide.

For details on how to upload VuGen scripts to Performance Center, see "How to Upload VuGen
Scripts" on the next page.

For details on how to convert NUnit, JUnit, or Selenium tests to VuGen scripts, see "How to Convert
NUnit, JUnit, or Selenium Tests to VuGen Scripts" on page 43.

Mapping VuGen Parameters to AUT Parameters
When setting VuGen parameters in a Vuser script, you can define AUT environment parameters. AUT
Environments allows users tomake test executionmore dynamic by parameterizing the environment
data used for testing. Instead of defining and running several different scripts that use the same logic
but need different AUT environment parameters, you can simply provide a specific AUT environment
configuration that ALM inserts into your script at run-time. ALM will then use the parameter values you
defined in the AUT environment configuration when deploying the environment and executing the test.

For more details on working with AUT environments, refer to theHP Application Lifecycle Management
User Guide.
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How to Upload VuGen Scripts
This task describes how to upload VuGen scripts to Performance Center.

Note: This task is part of a higher-level task. For details, see "How toManage Testing Assets" on
page 39.

This task includes the following steps:

l "Prerequisites" below

l "Upload the VuGen scripts to Performance Center" below

1. Prerequisites
Create scripts in VuGen. For details, see theHP Virtual User Generator User Guide.

Note: Service Virtualization:

n If your test requires the service to be running while you record your business process,
open HP Service Virtualization simultaneously and deploy the virtualized service. Record
the script as usual.

n Pointing calls to virtual services in the application under test covers twomajor scenarios:

o Application components that use the service are embedded in the code or in a
configuration file. In this case, update the code in the application under test or update
the configuration file to point to the new URL.

Examples:

A .NET Desktop application uses a web service, and the url is set using a
constant: stringURL = http://hp.com

A service or back end component uses the web service and the URL is configured
in the app.config file.

o The service is consumed by accessing UDDI or some other registry component
(Systinet) and the URL is retrieved at run-time. In this case, update the end point URL
in UDDI/Systinet.

2. Upload the VuGen scripts to Performance Center

a. Save the VuGen scripts locally. The scripts must be saved in ZIP format andmust include all
the files in the test scripts folder.
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b. On theMy Performance Center navigation bar, select Test Management > Test Plan.

c. Click theUpload VuGen Scripts button.

Select a destination folder, scripts to upload, and upload options.

For user interface details, see "Upload VuGen Scripts Dialog Box" on page 45.

For more details about uploading VuGen scripts from VuGen to ALM, see the section about saving
VuGen scripts to ALM in theHP Virtual User Generator User Guide.

How to Convert NUnit, JUnit, or Selenium Tests to VuGen
Scripts
This task describes how to convert NUnit, JUnit, or Selenium tests to VuGen Scripts.

1. Prerequisites

n Make sure to configure the load generator machine the same as themachine that is used to
record or prepare the script or test.

n NUnit tests: Before converting a NUnit test to a VuGen script, make sure that
nunit.framework.dll resides in the same directory as the NUnit test.

n NUnit tests: Make sure that the NUnit framework is installed on the load generator machine.

n Java scripts and JUnit tests:Verify that test dependencies are available on the load
generator machine with the same paths defined in the classpath Run-Time settings.

2. Convert test to a VuGen script

a. From a Performance Center host machine, select Start > All Programs > HP Software >
Performance Center Host > VuGen Script Convertor. The VuGen Script Convertor dialog
box opens. For user interface details, see "VuGen Script Convertor" on page 46.

b. Select the test and specify location for saving the converted script. Click Convert. The
converted script is saved in ZIP format.

3. Upload converted VuGen scripts to Performance Center

a. Save the converted VuGen scripts locally.

b. On theMy Performance Center navigation bar, select Test Management > Test Plan. Click

theUpload VuGen Scripts button.

For user interface details, see "Upload VuGen Scripts Dialog Box" on page 45.

User and Administrator Guide
Chapter 4: VuGen Script Management

HP ALM Performance Center (12.20) Page 43 of 521



VuGen Script Management User Interface
This section includes:

Upload VuGen Scripts Dialog Box 45

VuGen Script Convertor 46
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Upload VuGen Scripts Dialog Box

This dialog box enables you to upload VuGen scripts to ALM.

To access 1. In My Performance Center, on the navigation bar, select Test Management>
Test Plan.

2. Click theUpload VuGen Scripts button.

Important
information

l The Upload VuGen Scripts dialog box is intended for uploadingVuGen scripts
only. The VuGen scripts must be saved locally, must be in ZIP format, andmust
include all the files in the test scripts folder.

l You cannot uploadQuickTest (UFT GUI Tests) or Service Test tests using the
Upload VuGen Scripts dialog box. To uploadQuickTest (UFT GUI Tests) or
Service Test tests, see the relevant product's User Guide.

l If the name of the folder to which you are uploading VuGen scripts contains a
forward slash (/) you cannot upload the scripts using the Upload VuGen Scripts
dialog box. Either rename the folder so that it does not contain a forward slash (/)
or upload the scripts from VuGen.

Relevant
tasks

"How to Upload VuGen Scripts" on page 42

See also "Vuser Scripts" on page 41

User interface elements are described below:

UI Elements Description

Uploads the selected VuGen Scripts to the specified destination folder.

Select Folder The destination folder for the uploaded scripts.

Note: The folder namemust not contain a forward slash (/).

Select Scripts Enables you to select up to five scripts.

Note: The scripts must be saved locally, must be in ZIP format, andmust include
all the files in the test scripts folder.

If Script
Exists

Action to take if the script already exists in the destination folder.

l Auto Rename Script. Automatically gives the script a different name.

l Overwrite Existing Script. Overwrites the existing script.
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UI Elements Description

Upload
Method

Themethod to use for uploading the script:

l Upload All Files. Uploads all the files contained in the .zip file. With this
option the upload takes a long time.

l Upload runtime files only. Only the runtime files—that is the scripts, runtime
settings, parameters, and so on—are uploaded.

Versioning >
Keep checked
out

For version enabled projects, keeps the uploaded scripts checked out.

Version Control:When you upload a script, it is available only for your own use
until you check it in. After you check the script in, other users can access the
script as well.

Messages Enables you to enter messages and comments about the script upload.

VuGen Script Convertor

This dialog box enables you to transform NUnit, JUnit, or Selenium tests into VuGen scripts. You can
then upload the VuGen scripts to Performance Center.

To access Select Start > All Programs > HP Software > Performance Center Host >
VuGen Script Convertor.

Important
information

Java and and JUnit tests:Before running the converted VuGen scripts, make sure
to update the Runtime Settings > Java Environment Settings > Classpath of the
Vuser group, with the JUnit path and the dependent jars. For more details on runtime
settings, "How to Configure Runtime Settings" on page 467.

Relevant
tasks

l "How to Convert NUnit, JUnit, or Selenium Tests to VuGen Scripts" on page 43

l "How to Upload VuGen Scripts" on page 42

See also "Vuser Scripts" on page 41

User interface elements are described below:

UI Elements Description

System or Unit Tests file Enables you to browse to and select the test to be converted.

Output Directory Enables you to specify where to store the converted file.

Converts the test to a VuGen script.
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Topologies Overview
Performance Center can articulate the topology of your application under test (AUT) and use it as an
interface for defining performancemonitors by integrating with HP SiteScope.

Using topologies, you can:

l Manage an inventory of application under test (AUT) hosts which are grouped into AUT host pools,
similar to Performance Center hosts and host pools

l Visually understand the tested environment

l Configuremonitors using best practicemonitor templates

l Configuremonitors using templates from production environments

l Pinpoint runtime performance issues by highlighting a topology node's status based on the
SiteScopemonitor thresholds

The SiteScope user interface hosted in Performance Center enables leveraging SiteScope functionality
in a use-case oriented approach, without requiring additional monitor configuration on the Performance
Center side.

During runtime, the AUT schemawith comprehensive SiteScopemonitor data is displayed in different
monitor graphs in the Performance Center run screen andmeasurement names can be identified and
filtered.

For details on designing topologies, see "How to Design Topologies" below.

How to Design Topologies
This section describes how to design a topology that graphically displays the logical components that
make up your application under test (AUT) and the relationships between the components. This
provides a useful method for managing your inventory of AUT hosts and enables topology-oriented
monitoring and analysis.

Note:

l This task is part of a higher-level task. For details, see "How toManage Testing Assets" on
page 39.

l Ensure that SiteScope is installed and configured to integrate with ALM Performance Center.
For details, see the section about installing SiteScope in theHP ALM Performance Center
Installation Guide.
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l After you have designed a topology you can select it for a performance test when you design
the test.

Tip: For a use-case scenario related to this task, see "How to Design Topologies - Use-Case
Scenario" on page 52.

To learnmore about topologies, see "Topologies Overview" on the previous page.

This task includes the following steps:

l "Create an empty topology" below

l "Design the topology" below

l "Add the AUT hosts" on the next page

l "Configure the component properties" on the next page

l "Configuremonitors on the components" on the next page

l "Results" on the next page

1. Create an empty topology
a. On theMy Performance Center navigation bar, select Resources > Topologies.

b. To create a topology folder, click theNew Folder button, and enter the folder name.

c. Click theNew Topology button and enter the topology details. To add SiteScope
monitors to the topology, specify the SiteScope server details.

2. Design the topology

Note: The Topology Designer window opens automatically when you create a new topology.
If the Topology Designer window did not open, select a topology and click Design Topology.

In the Topology Designer window:

a. From the palette on the left, select relevant nodes representing the components in your AUT
and drag them onto the Topology canvas.

b. To connect two components, click one component (ensure that it is not selected) and drag the
cursor to the other component.
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3. Add the AUT hosts
Define themachines that host the relevant components of the AUT.

On the Topology Designer window, click AUT Hosts. Click Add New AUT Host to define the
machines hosting your AUT.

Tip: If you have an Excel file listing your AUT hosts, you can import the list of AUT hosts into
ALM. For details, refer to theHP ALM LabManagement Guide.

You can view the list of AUT hosts in the AUT Hosts tab on the left.

4. Configure the component properties
Select a component and, in theProperties pane in the top right corner of the Topology Designer,
enter the relevant properties for that component. For successful integration with SiteScope,
ensure that you select the relevant AUT host, and that all of the relevant properties are accurate.

Tip:When you click a property, a description is displayed in the lower area of the Properties
pane.

Repeat this procedure for each of the relevant components.

5. Configure monitors on the components
You can configure groups of monitors for the components on AUT hosts. Ensure that the AUT
host details are accurate for each relevant component.

n To deploy relevant monitors on specific components on your canvas, select the components,
right-click the selection, and select Deploy Monitor Templates. Monitor groups are created in
SiteScope for each selected component, and each group is automatically configured with
relevant system-definedmonitors.

n To configuremonitors for a component manually in SiteScope, right-click the component and
select Configure Monitors. For more details about configuringmonitors in SiteScope, see the
HP SiteScope User Guide.

Note: The AUT host defined in a component's properties is passed to SiteScope as a
remote host and is inserted as the default monitored server for all monitors created for this
component.

6. Results
After you save the topology, you can select the designed topology for your performance test. For
details, see "Performance Test Designer > Topology " on page 62.
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During a test run, you can view the SiteScopemonitor activity on the relevant components in your
AUT. For details, see "Performance Test Run Page" on page 261.

How to Design Topologies - Use-Case Scenario
This use-case scenario describes how to design a topology that graphically displays the logical
components that make up your application under test (AUT) and the relationships between the
components.

Note: For a task related to this use-case scenario, see "How to Design Topologies" on page 49.

This scenario includes the following steps:

l "Background" below

l "Create the topology and design the outline" below

l "Add the AUT hosts" on page 54

l "Define the component properties" on page 55

l "Deploy themonitor templates" on page 55

l "Results" on page 56

1. Background
John is a performance engineer working with HPWeb Tours. He would like to design a
performance test for the application.

As a first step, he would like tomodel the application in ALM Performance Center so that he can
keep track of the topology of his application under test. Using this model, he can benefit from the
monitoring and online view features that the topology feature offers.

2. Create the topology and design the outline
a. On the Performance Center navigation bar, John selects Resources > Topologies to open

the Topology module, and clicks theNew Topology button to create a new topology. He
calls the topologyWebTours, and enters the details of the SiteScope server with which the
application will interact for monitoring purposes.
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When John clicks OK, the Topology Designer window opens, displaying the Topology canvas
which, at this stage, is empty.

b. John's Web Tours application comprises the following components: A Web server, an
application server, and a database server. The user accesses the application through a client
workstation.

In the Topology Designer window, from the palette in the left, John drags the nodes
representing these components onto the Topology canvas, and changes their captions to
names that are relevant to the components they represent.

John drags the following nodes:

Palette Category Component New Caption

WebServers Microsoft IIS Web Server

Application Microsoft ASP Server Application Server

Database Microsoft SQL Server Database Server

Miscellaneous Workstation Client

Miscellaneous User User
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c. John connects the application server to theWeb server by clicking the application server
(ensuring that it is not selected) and dragging the cursor over to theWeb server.

Similarly, he connects the application server to the database server, the client workstation to
theWeb server, and the user to the client.

3. Add the AUT hosts
The AUT hosts are the physical machines that host the relevant components of the application
under test.

On the Topology Designer window, John clicks AUT Hosts. He then clicks Add New AUT Host

, and enters the name and details of themachine that hosts the database server:

John then adds the AUT host that hosts both the application andWeb servers.
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Tip:

n Alternatively, if John had an Excel file listing the AUT hosts in his system, he could have
imported the list of AUT hosts to ALM. For details, refer to theHP ALM LabManagement
Guide.

n John can view the list of AUT hosts in theAUT Hosts tab by clickingAUT Hosts next to
the Palette tab.

4. Define the component properties
For successful integration with SiteScope, John needs to ensure that the properties for each
component are defined correctly.

John selects each component and, in theProperties pane in the top right corner of the Topology
Designer window, he provides the relevant properties. The properties differ from one type of
component to another.

Tip: A description for each property is displayed in the lower area of the Properties pane, and
helps John to understand what information to provide for each property.

For example, for the database server, John selectsmachine33 from theAUT Host drop-down
list, and accepts the default values for all of the other properties. Then he provides the relevant
details for the application andWeb servers.

5. Deploy the monitor templates
John selects the three servers and clicks Deploy Monitor Templates. Performance Center
creates amonitor group in SiteScope for each of the selected components, and deploys the
relevant system-definedmonitor templates for each component. Because the AUT Host
Templates property is enabled, the templates for the actual AUT host are deployed as well.
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Tip: If John wants to view ormodify thesemonitors, he can do so by clickingConfigure
Monitors on the toolbar, which opens HP SiteScope and displays themonitor trees that were
created for each component.

6. Results
John saves the topology and closes the Topology Designer window. He selects this topology
when designing the performance test for theWeb Tours application. When he runs the test, he can
view the SiteScopemonitor activity on the relevant components in the application in the
Performance Test Run page.

Topologies User Interface
This section includes:

Topologies Module 57

Add / Update Topology Dialog Box 58

Topology DesignerWindow 58

Add / Update AUT Host Dialog Box 60

Deploy PAL Templates from Production Dialog Box 61

Performance Test Designer > Topology 62
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Topologies Module

This module enables you to create andmanage topologies.

To access On theMy Performance Center navigation bar, select Resources >Topologies.

Important
information

After you have designed a topology for your performance test, youmust associate it
with your test. For details about associating a topology with a test, see "Performance
Test Designer > Topology " on page 62.

Relevant
tasks

"How to Design Topologies" on page 49

See also "Topologies Overview" on page 49

"My Performance CenterWindow" on page 23

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

New Topology Folder. Enables you to create a topology folder.

New Topology. Opens the Add Topology dialog box, enabling you to create a new
topology. For details, see "Add / Update Topology Dialog Box " on the next page.

Delete. Enables you to delete the selected topologies.

Refresh All. Refreshes the page so that it displays themost up-to-date information.

Design
Topology

Opens the Topology Designer window, enabling you to design topologies. For
details, see "Topology DesignerWindow" on the next page.

Edit Details Opens the Update Topology dialog box, enabling you to update the topology details.
For details, see "Add / Update Topology Dialog Box " on the next page.

<Topologies
tree>

Located on the left side of the window, organizes and displays your topologies
hierarchically.
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Add / Update Topology Dialog Box

To
access

l To add a topology: On theMy Performance Center navigation bar, select
Resources > Topologies. Click theNew Topology button.

l To edit topology details: On theMy Performance Center navigation bar, select
Resources > Topologies. Select a topology and click Edit Details.

Relevant
tasks

"How to Design Topologies" on page 49

See also "Topologies Overview" on page 49

User interface elements are described below:

UI Elements Description

Topology Name The name of the topology.

SiteScope
Server

The name of the SiteScope server.

SiteScope Port The port defined for SiteScope during installation of
SiteScope.

Default value:

l Non-SSL: 8080

l SSL: 8443

SiteScope SSL Indicates whether SiteScope uses SSL.

Enable
Monitors

Always enables SiteScopemonitors, or enables them
automatically duringmonitor configuration and performance
test runs.

Description The description of the topology.

Topology Designer Window

To access On the navigation bar, select Resources >Topologies. Select a topology, and click
Design Topology.

Important
information

After you have designed a topology for your performance test, youmust select it for
your test. For more details, see "Performance Test Designer > Topology " on page 62.
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Relevant
tasks

"How to Design Topologies" on page 49

See also "Topologies Overview" on page 49

User interface elements are described below:

UI
Elements

Description

Save Topology. Enables you to save your topology.

Cut/Paste selected items. Enables you to cut and paste the selected topology from
one topology folder to another.

Copy selected items. Enables you to copy items selected on the canvas.

Delete selected items. Enables you to delete items selected on the canvas.

Undo/Redo. Enables you to undo or redo the previous action.

Zoom in/Zoom out. Enables you to zoom in and out of the canvas.

Actual size. Restores the whole topology design to its normal size. This button is
enabled when the Zoom In and ZoomOut buttons are in use.

Fit whole screen. Enables you to fit the entire topology design to the current screen
size.

Configure Monitors. Opens the ConfigureMonitors dialog box, enabling you to
manually configure SiteScopemonitors on the selected node. For details about
creating SiteScopemonitors, see theHP SiteScope User Guide.

Note:When configuringmonitors for these components in SiteScope, the value
forMonitor Run Settings > Frequency should be changed to amore suitable
value, such as 5 - 15 seconds.

Deploy Monitor Templates. Opens the Deploy Monitor Templates Status dialog box,
enabling you to configure SiteScopemonitors on the selected node automatically by
deploying a templatemonitor set.

Deploy PAL Templates from Production. Opens the Deploy PAL Templates from
Production dialog box, enabling you to import PAL templates from a production data set
to the selected node. For more details, see "Deploy PAL Templates from Production
Dialog Box" on page 61.

Export Topology. Enables you to export the whole area of the topology, or only the
visible region of the topology to an image file.
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UI
Elements

Description

Palette
tab

Enables you to select components to add to the canvas.

The palette includes various types of server categories, as well as aMiscellaneous
category. This category includes nodes that are not necessarily AUT-specific but that
complete the topology design, such as a user or a client workstation.

AUT
Hosts tab

Enables you tomanage all AUT hosts defined in the AUT host pool. Includes the
following options:

l Add New AUT Host. Opens the Add AUT Host dialog box, enabling you to
add a new AUT host. For more details, see "Add / Update AUT Host Dialog Box"
below.

Tip: If you have a list of AUT hosts set up in an Excel file, you can import this list
instead of adding the hosts one by one. For details, refer to theHP ALM Lab
Management Guide.

l Update AUT Host. Opens the Update AUT Host dialog box, enabling you to
modify AUT host details. For more details, see "Add / Update AUT Host Dialog
Box" below.

l Delete AUT Host. Deletes selected AUT host.

Topology
canvas

Provides a canvas where you can lay out the topology by dragging components/server
nodes and linking them to each other.

Properties Enables you to define properties for the node selected on the canvas.

The lower section of the Properties pane displays a description of the selected
property.

Navigator Enables you to drag the topology's structure to a new position on the canvas.

Add / Update AUT Host Dialog Box

This dialog box enables you to create a new AUT host.

To access l To add an AUT Host: On theMy Performance Center navigation bar, select
Resources > Topologies. Click Design Topology. Click AUT Hosts. Click

Add New AUT Host .

l To edit topology details: On theMy Performance Center navigation bar,
select Resources > Topologies. Click Design Topology. Click AUT Hosts.
Select an AUT host and click Update AUT Host .
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Important
information

When creating an AUT host in ALM, the AUT host is automatically added to the AUT
Pool of the project.

Tip: You can import a list of AUT hosts from an Excel file. For details, refer to theHP
ALM LabManagement Guide.

See also l "Topologies Overview" on page 49

l HP ALM LabManagement Guide.

User interface elements are described below:

UI Elements Description

Machine
Name/IP

The name or IP of the AUT host machine.

Logical Name The logical name given to the AUT host.

Platform The base operating system of the AUT host machine: Window or UNIX.

Protocols The network protocol used for communication with the AUT host (for monitoring
purposes).

Default value:NetBIOS, WMI,SSH.

User The user name for logging in to the AUT host machine.

Password The password for logging in to the AUT host machine.

Deploy PAL Templates from Production Dialog Box

This dialog box enables you to import PAL templates from a production data set to a selected topology
node.

To
access

On the navigation bar, select Resources >Topologies. Select a topology, and click

Design Topology. Click theDeploy PAL Templates from Production button.

Relevant
tasks

"How to Design Topologies" on page 49

"How toWork with PAL" on page 339

See also "Topologies Overview" on page 49

"PALOverview" on page 337

User interface elements are described below:

UI Elements Description

Name The name of the selected node.
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UI Elements Description

AUT Host The name of the AUT Host associated with the selected node.

Select a production
data set

Click the down arrow to select a data set file. The data set file is stored
as a .zip file.

Templates Lists the available templates. Select a relevant template.

Settings Defines the parameters of a selected template.

Performance Test Designer > Topology

This view enables you to select a topology for a performance test.

To access 1. On theMy Performance Center navigation bar, select Test Management >
Test Plan.

2. Select a performance test in the test plan tree and select Edit Test.

3. In the Performance Test Designer window, click Topology.

Important
information

You design topologies in the Topologies module. After you have designed
topologies, you can select one of them for a performance test.

Relevant
tasks

l "How to Design a Performance Test" on page 111

l "How to Design Topologies" on page 49

See also "Topologies Overview" on page 49

User interface elements are described below:

UI Elements Description

Opens the Topologies tree in the right pane, enabling you to select a
topology for the test.

Enables you to remove the selected topology.

Zoom in. Enables you to zoom into the displayed topology.

Zoom out. Enables you to zoom out of the displayed topology.

Fit to panel. Enables you to fit the topology to the size of the Topology
pane.

User and Administrator Guide
Chapter 5: Topologies

HP ALM Performance Center (12.20) Page 62 of 521



UI Elements Description

Topologies tree Opens when you click Select Topology, enabling you to select a topology
for the test.

Expand the Topologies tree, select a topology, and click to move it to
the Topology pane on the left.

To refresh the tree, click .

Topology pane Displays the selected topology.

Saves the topology to the selected test and opens the Run Test dialog
box. For more details, see "Run Test Dialog Box" on page 270.

Save the topology to the selected test.
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Chapter 6: Monitor Profiles
This chapter includes:

Monitor Profiles Overview 65

How to Create and ConfigureMonitor Profiles 65

Monitor Profiles User Interface 66
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Monitor Profiles Overview
Youmonitor performance test execution using the Performance Center onlinemonitors. Tomonitor
server resources, youmust configure themonitor settings for a performance test. You select the type
of monitors to run, the servers whose resources you want to monitor, and add themeasurements to
monitor for each server. Thesemonitor settings can then be saved as amonitor profile that can be used
by any performance test in your project.

For details about creatingmonitor profiles, see "How to Create and ConfigureMonitor Profiles" below.

How to Create and Configure Monitor Profiles
This task describes how to create and configure amonitor profile.

Note: This task is part of a higher-level task. For details, see "How toManage Testing Assets" on
page 39.

To learnmore about monitor profiles, see "Monitor Profiles Overview" above.

This task includes the following steps:

l "Prerequisites" below

l "How to Create and ConfigureMonitor Profiles" above

l "Create amonitor profile" on the next page

1. Prerequisites
To use the followingmonitors, youmust first install or configuremonitoring components on the
server machine. For task details about configuring themonitoring components, see the specific
monitoring sections listed below.

n Citrix. For task details, see "How to Set up the Citrix Monitoring Environment" on page 445.

n J2EE & .NET. For task details, see "How to Enable and Configure J2EE/.NET Diagnostics"
on page 205.

n Network Delay. For task details, see "How to Set Up the Network Monitoring Environment" on
page 408.

n Oracle. For task details, see "How to Set Up theOracle Monitoring Environment" on page 421.

n UNIX. For task details, see "How to Set up the UNIX Monitoring Environment" on page 400.
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2. Create a monitor profile
a. On theMy Performance Center navigation bar, select Resources > Test Resources.

b. Click New Monitor Profile . The Create New Monitor Profile dialog box, enabling you to
add a new monitor profile.

c. In theMonitor Profile page, click theAdd Monitor button . In the Add New Monitor page
that opens, select themonitor that you want to run.

d. In the Edit Monitor dialog box, enter the required information and select the counters that you
want to monitor. The Edit Monitor page varies depending on whichmonitor type you select:

o For user interface details forWindows Resources, UNIX, Apache, MS IIS, MS ASP,
Citrix, SQL, or Oracle, see "Edit Monitor Dialog Box" on page 71.

o For SNMP monitor user interface details, see "Edit Monitor (SNMP) Dialog Box " on
page 73.

o For SiteScopemonitor user interface details, see "Edit Monitor (SiteScope) Dialog Box" on
page 74.

o For Network Delay Timemonitor user interface details, see "Edit Monitor (Network Delay
Time) Dialog Box" on page 75.

Monitor Profiles User Interface
This section includes:

Test Resources Module 67

Monitor Profile Page 69

Add New Monitors Page 69

Edit Monitor Dialog Box 71

Edit Monitor (SNMP) Dialog Box 73

Edit Monitor (SiteScope) Dialog Box 74

Edit Monitor (Network Delay Time) Dialog Box 75

Performance Test Designer > Monitors 77
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Test Resources Module

This module enables create andmanagemonitor profiles and analysis templates.

To access On theMy Performance Center navigation bar, select Resources > Test
Resources.

Relevant
tasks

l "How to Create and ConfigureMonitor Profiles" on page 65

l "How to Customize Analysis Templates" on page 233

See also l "Monitor Profiles Overview" on page 65

l "Analysis Templates Overview"

l "My Performance CenterWindow" on page 23

Test Resources Tree

User interface elements are described below:

UI
Elements

Description

New Folder. Enables you to create a new resource folder.

New Monitor Profile. Opens the Create New Monitor Profile dialog box, enabling you
to add a new monitor profile.

New Monitor Over Firewall. Opens the Create New Monitor Over Firewall dialog box,
enabling you to create amonitor-over-firewall agent.

New Analysis Template. Opens the Create New Analysis Template dialog box,
enabling you to create a new analysis template in Performance Center. For more details,
see

Delete. Deletes selected resource.

Refresh All. Refreshes the tree so that it displays themost up-to-date information.

Monitor Profile Pane

This pane enables you to view andmanage a selectedmonitor profile.
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User interface elements are described below:

UI
Elements

Description

Add Monitor. Opens the Add New Monitor dialog box, enabling you to select amonitor.

Edit Monitor. Opens the Edit Monitor dialog box, enabling you to add andmanage a
monitor type for the selectedmonitor profile. For more details, see "Edit Monitor Dialog
Box" on page 71.

Delete Selected Item. Deletes the selectedmonitor profile from theMonitor Profile grid.

Refresh Monitor List. Refreshes themonitor list so that it displays themost up-to-date
information.

Monitor The name of themonitor.

Server The server whose resources are beingmonitored.

Counters The counters that are beingmonitored.

Analysis Templates Pane

This pane enables you to create, view, upload and download analysis templates.

User interface elements are described below:

UI
Elements

Description

Upload New Analysis Template Content. Opens the Upload Analysis Template
dialog box, enabling you to upload analysis templates to Performance Center. For more
details, see "Upload Analysis Template Dialog Box" on page 235.

Download Analysis Template Content. Downloads the selected analysis template
zip file to your machine.

Refresh Content. Refreshes the pane so that it displays themost up-to-date
information.

Name The name for the analysis template.

Uploaded
By

The user who uploaded the analysis template zip file.

Template
File

The name of the analysis template zip file.

Uploaded
Date

The date the analysis template zip file was uploaded .
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Monitor Profile Page

This page enables you to add and edit monitors that are part of a monitor profile.

To access Use one of the following:

l In the Test Resources module, select amonitor profile in the test resource tree.

l In the Performance Test Designer, click theMonitors tab, and then click View
Selected.

Relevant
tasks

l "How to Create and ConfigureMonitor Profiles" on page 65.

l "How toManage a Performance Test Run" on page 242.

User interface elements are described below:

UI
Elements

Description

Add Monitor. Opens the Add New Monitor dialog box, enabling you to select which
monitors to run in themonitor profile.

Edit Monitor. Opens theMonitor Profile page, enabling you to add andmanage a
monitor type for the selectedmonitor profile. For more details, see "Edit Monitor Dialog
Box" on page 71.

Delete Selected Item. Deletes the selectedmonitor profile from themonitor profile.

Refresh Monitor List. Refreshes themonitor list so that it displays themost up-to-date
information.

Counters The counters that are beingmonitored.

Monitor The name of themonitor.

Server The server whose resources are beingmonitored.

Add New Monitors Page

This page enables you to select themonitor type to add to amonitor profile.
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To
access

Use one of the following:

l In the Test Resources module, select amonitor profile in the test resource tree and
click theAdd Monitor button .

l In the Run-TimeMonitors dialog box, click theAdd Monitor button . For more
information, see "Monitor Profile Content Dialog Box" on page 276.

Relevant
tasks

l "How to Create and ConfigureMonitor Profiles" on page 65

l "How toManage a Performance Test Run" on page 242

User interface elements are described below:

UI Elements Description

l Windows
Resources

l Unix
Resources

l Apache

l MS IIS

l MS Active
Server
Pages

l Citrix
Server

l SQL
Server

l Oracle

l TUXEDO

l PeopleSof
t (Tuxedo)

l SAPGUI

Enables you to select the specific counters for this monitor type. For more
information, see "Edit Monitor Dialog Box" on the next page.

SNMP Opens the Edit Monitors Page, which enables you to select the specific counters
that you want to monitor for this monitor type. For more information, see "Edit
Monitor (SNMP) Dialog Box " on page 73.
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UI Elements Description

SiteScope Opens the Edit Monitors Page, which enables you to select the specific counters
that you want to monitor for this monitor type. For more information, see "Edit
Monitor (SiteScope) Dialog Box" on page 74.

Network
Delay Time

Opens the Edit Monitors Page, which enables you to select the specific counters
that you want to monitor for this monitor type. For more information, see "Edit
Monitor (Network Delay Time) Dialog Box" on page 75.

Edit Monitor Dialog Box

This dialog box enables you to define the server whose resources you want to monitor, and to select
the counters to monitor.

To access 1. On theMy Performance Center navigation bar, select Resources > Test
Resources.

2. Select amonitor profile in the test resource tree.

3. In theMonitor Profile page, select one of the following: Windows Resources,
UNIX Resources, Apache, MS IIS, MS ASP, Citrix, SQL, Oracle.

4. Click Edit Monitor .

Important
information

This dialog box contains information relevant for the followingmonitor types:
Windows Resources, UNIX Resources, Apache, MS IIS, MS Active Server Pages,
Citrix, SQL, Oracle

Relevant
tasks

"How to Create and ConfigureMonitor Profiles" on page 65

User interface elements are described below:

UI Elements Description

Server The name or IP address of the server whose resources you want to monitor.

User Name Themonitored server's user name, if relevant.

Password Themonitored server's password, if relevant.
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UI Elements Description

URL (Apache only) The Server statistics information URL. To verify the statistics information
URL, try to view it through the browser using the following format:
http://<server_name/IP address>:<port_number>/server-
status?auto For example: http://stimpy:80/server-status?auto.

Format: Enter the server statistics information URL, without the server
name.

Default value:/server-status?auto

Note: The default port number and URL can vary from one server to
another. Consult yourWeb server administrator.

Available for:Apache

Port The port number of the Apache server.

Note: Tomonitor an Apache server through a firewall, use theWeb
server port (by default, port 80).

Available for:Apache

Client The SAPGUI client.

Available for: SAPGUI

SAP Server The SAP Server.

Available for:SAPGUI

Click to display a list of available counters.

Available Counters A list of available counters for the selectedmonitor.

Selected Counters A list of selected counters for themonitor.
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Edit Monitor (SNMP) Dialog Box

This dialog box enables you to define the SNMP server whose resources you want to monitor, and to
select the counters to monitor.

To access 1. On theMy Performance Center navigation bar, select Resources > Test
Resources.

2. Select amonitor profile in the test resource tree.

3. In theMonitor Profile page, select SNMP.

4. Click Edit Monitor .

Relevant
tasks

"How to Create and ConfigureMonitor Profiles" on page 65

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Server Enter the name or IP address of the server to monitor.

Note: Performance Center connects to default SNMP port 161. To use
a different port number, specify themachine name in the following
format:

<server name>:<port number>

Concatenate SNMP
Levels

For SNMP object nodes with ten or more levels, select to display the sub-
levels as a single string, separated by periods (.).

Click to display a list of available counters.

<choose counters
area>

Displays a list of available counters.

Default:Displays all nodes of the SNMP objects in a tree-level hierarchy.
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Edit Monitor (SiteScope) Dialog Box

This dialog box enables you to define the SiteScope server whose resources you want to monitor, and
to select the counters to monitor.

To access 1. On theMy Performance Center navigation bar, select Resources > Test
Resources.

2. Select amonitor profile in the test resource tree.

3. In theMonitor Profile page, select SiteScope.

4. Click Edit Monitor .

Relevant
tasks

"How to Create and ConfigureMonitor Profiles" on page 65

User interface elements are described below:

UI Elements Description

Server The SiteScope server name.

Port The SiteScope port.

Default: 8888

Use HTTPS Specify if you are using a secure HTTP connection.

Use Account Select when SiteScope is working in securemode, which requires
authentication. Enter the SiteScope account name, user name and
password in the corresponding fields.

User Name WhenUse Account is selected, enter the relevant user name.

Password WhenUse Account is selected, enter the relevant password.

Click to display a list of available counters.
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Edit Monitor (Network Delay Time) Dialog Box

This dialog box enables you to define the Network Delay Time server whose resources you want to
monitor, and to select the counters to monitor.

To access 1. On theMy Performance Center navigation bar, select Resources > Test
Resources.

2. Select amonitor profile in the test resource tree.

3. In theMonitor Profile page, select Network Delay Time.

4. Click Edit Monitor .

Relevant
tasks

"How to Create and ConfigureMonitor Profiles" on page 65

User interface elements are described below:

UI Elements Description

Source Machine The name of the sourcemachine from which you want the network path
monitoring to begin.

Note: To run the Network Delay Monitor when there are firewalls
between the Performance Center Host machine and the source
machine, type the server name or IP address of the sourcemachine
according to the format:

<MI Listener machine>:<sourcemachine local key>

Where source machine local key is the unique key that you chose when
configuring the Performance Center agent on the sourcemachine.

Example

12.12.12.3:vds

For more information about working with firewalls in Performance Center,
see the section about firewalls in theHP ALM Performance Center
Installation Guide.

Platform The platform on which themachine runs.
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UI Elements Description

Destination Machine The name of themachine at the final destination of the path you want to
monitor.

Note: If the destinationmachine is localhost, type the local machine's
name and not localhost.

Monitor Settings l Send Request Using X protocol. Select the relevant protocol. It is
recommended that you keep the default protocol. InWindows, the
default is TCP, and in UNIX, the default is UDP.

l Send request to port X. Enter the port number being used by the
network path.

l Enable display of network nodes by DNS names. Select to view the
DNS name of each node along the network path, in addition to its IP
address. Note that selecting this option decreases the speed of the
Network monitor.

Monitor Frequency Send next packet X milliseconds after receipt of previous packet.
Select the number of milliseconds themonitor should wait between
receiving a packet and sending out the next packet. If you have a long,
steady load test, you can increase the interval by several seconds.

Default: 3000milliseconds

Monitoring Packet
Retries

l Wait Xseconds for packet to return before retrying. Select the
maximum number of seconds that themonitor should wait for a packet
to return before it retries to send the packet.

Default: 3 seconds. If your network is very large and loaded (an internet
connection with a low capacity), increase the value by several seconds.
If you have a small network (such as a LAN), decrease the value.

l Number of retries. Select the number of times the Network monitor
should try resending a packet to a node if the packet is not initially
returned.

Default: 0

Uses the default values.
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Performance Test Designer > Monitors

This view enables you to select monitor profiles andmonitor-over-firewall agents to use in your
performance test.

To access 1. On theMy Performance Center navigation bar, select Test
Management > Test Plan.

2. Select a performance test in the test plan tree and select Edit Test.

3. In the Performance Test Designer window, click Monitors.

Important
information

Youmust havemonitor profiles defined before you can select them for the
test.

Relevant tasks l "How to Design a Performance Test" on page 111

l "How to Create and ConfigureMonitor Profiles" on page 65

See also "Monitor Profiles Overview" on page 65

User interface elements are described below:

UI Elements Description

Opens theMonitor Profiles tree in the right pane, enabling you to select a
monitor profile for the test.

Opens theMonitors Over Firewall tree in the right pane, enabling you to
select amonitor-over-firewall agent for the test.

Opens a window that displays all of themeasurements of the selected
monitor profile.

Removes the selectedmonitor profile or monitor-over-firewall agent from
the test.

Associated Monitors
grid

Displays themonitors andmonitor-over-firewall agents selected for the
test.

Monitor Profile Tree /
Monitor Over Firewall
Tree

Enables you to select amonitor profile or monitor-over-firewall agent for
the test.

Expand the Resources tree, select amonitor profile or monitor-over-

firewall agent, and click to move it to the AssociatedMonitors grid
on the left.
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Performance Testing Timeslots Overview
When running tests, or performingmaintenance on host machines (administrators only), the resources
needed for these tasks must be available, andmust fall within the project and license limits.
Performance Center's timeslots feature enables you to reserve resources in advance to ensure that the
required resources are available when you are ready to perform these tasks. Performance Center itself
also reserves resources needed for data processing tasks.

This section includes:

Types of Timeslot Reservations 82

Automatic Timeslots 83

Extending Timeslot Reservations 84

Understanding Timeslot Failure 85

Host Allocation 85

Example of Allocating and Reshuffling Hosts 86
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Types of Timeslot Reservations

Timeslots can be reserved for immediate use or they can be reserved in advance for future use. This
section describes these two types of timeslot reservations.

Immediate Timeslot Reservations
Scheduling an immediate timeslot reserves resources for a task at hand.

l Administration: If you want to perform administrative tasks on particular hosts, such as installing
patches, when you start the task—and provided that the hosts are currently available—
Performance Center automatically reserves the requested hosts in amaintenance timeslot so that
the hosts cannot be used for any other purpose for the duration of your task.

l Performance Testing:When you start running a performance test, before the test starts to run, you
specify the time and resources you need for the test. Performance Center checks if the required
hosts and Vusers are currently available for that amount of time, and that the license and project
limits are not exceeded, in which case, you can reserve the hosts and Vusers for that timeslot. If
the hosts and Vusers are not available, or license/project limits have been exceeded, you cannot
run the test at that time and need to try again at a later time.

l Data Processing:Whenworking with Performance Center projects, tasks such as test result
analysis, SLA status publication, and trending are performed on a data processor host.
Performance Center estimates how long a data processor host is needed for the task at hand. As
soon as a data processor becomes available for this task, an immediate timeslot reservation is
automatically made.

Advance Timeslot Reservations
If you know which testing resources you need for running a test, or you know the hosts on which you
need to perform maintenance, you can reserve the resources for your test in advance for a specified
amount of time.

When reserving resources for a testing timeslot, there are two types of timeslot reservations:

l Performance Test. Enables you to reserve the resources needed for running a single instance of a
performance test.

l Build Verification Suite. Enables you to reserve the resources needed for running several
functional test sets together with a single instance of a performance test with the purpose of
checking the overall status of your build. The tests in the test set are executed consecutively,
followed by the single performance test. This type of timeslot reservation enables you to integrate
your system with HP Continuous Delivery Automation (CDA) for provisioning, deployment, and so
on. For more information, see theHP Application Lifecycle Management User Guide.

When reserving a testing timeslot, you can request either specific hosts or automatch hosts. That is,
you can specify the exact hosts which will run your test or test set, and if those hosts are available,
Performance Center reserves them for you. Alternatively, you can request automatch hosts, which
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allows Performance Center to allocate any available host with properties that match your selected
criteria.

When you add a test instance to a test set, Performance Center automatically allocates automatch
hosts to the test instance based on the test type. You can change the allocation as part of the timeslot
reservation.

For performance test timeslots, youmust select at least one Controller and one load generator. For
more details, see the "LoadGenerator Distribution Overview" on page 161.

A timeslot can be reserved successfully only if all of the requested resources are available.

Tip: All users in your project can use the timeslot that you have reserved.

It is important to note that many conditions and changes in the system can affect host allocation, and
can cause a shuffling around of the hosts. For more details about host allocation and examples of
resource shuffling, see "Host Allocation" on page 85.

Automatic Timeslots

Some tests might require a lot of time andmany resources. The Timeslot feature enables you to
reserve these resources when resources aremore readily available, and/or when youmight not be
available to run the test manually. This allows for maximum resource usage because your resources
can then be used around the clock.

Example

Suppose a project has a total of eight hosts for allocation and the employees assigned to the
project work a standard 09:00-17:00 day. The hours between 09:00 and 17:00 are peak hours for
host usage, during which time all the hosts are usually reserved for testing, data processing, and
maintenance tasks. Because of this, theremay be periods during the day that employees cannot
perform tasks because there are no available hosts. In contrast, the non-standard work hours pass
with very little host resource usage.

To extend host resource usage, employees might come in early or stay late to run tests, but this only
extends the peak usage by one or two hours at the beginning and end of the day.

Reserving timeslots during non-standard work hours and setting the tests to run during these timeslots
allows for maximum resource usage.

Best Practices for Reserving Automatic Timeslots

This section describes some best practices to follow when reserving an automatic timeslot:

l Where possible, run the test manually first to get an indication as to how long it takes for the test to
run. This information can assist you when selecting the timeslot duration.

l The following suggestions apply to running automatic Performance tests:

User and Administrator Guide
Chapter 7: Timeslots

HP ALM Performance Center (12.20) Page 83 of 521



Note:When a performance test is added to a Build Verification Suite timeslot, the performance
test runs only after all included functional tests have completed running.

n Always ensure that the Scheduler is set to stop as soon as all the Vusers have stopped running.
This allows more time for post-run actions during the duration of the timeslot. For details on
setting test options, refer to the "Test Options Dialog Box" on page 146.

n If you want to analyze the test results straight after the run, take into account that the analysis
process can take a long time, so be sure to reserve enough time for this operation.

n If you want to perform auto-collate and analyze operations at the end of the run, you should take
the time required for these operations into account when reserving the timeslot.

Note: To prevent loss of run data, it is recommended, whenever possible, to collate the
results immediately after the run finishes. If your timeslot ends before result collation is
completed, collation continues as it does not require reserved resources.

n 15minutes before the end of a timeslot, Performance Center automatically stops the test run.
Fiveminutes before the end of the timeslot, even if all the Vusers have not yet finished running,
Performance Center aborts the run. To ensure that the test ends properly as designed, make
sure that you reservemore time than defined in the test schedule.

Extending Timeslot Reservations

Theremay be times when you do not allocate enough time for a test set to finish. For example, when
running a test set for the first time, youmay be unsure how long the tests will take to complete. You can
extend timeslots to allow your tests to finish running.

To extend a timeslot, all necessary testing resources must be available during the extension time. If
any of the testing resources are reserved for a different timeslot immediately following yours, you
cannot extend the timeslot and tests stop without completing properly.

A performance test is extendedmanually while the test is running. If you see that a performance test
will reach the end of its timeslot before it completes, you can enter a number of minutes to extend the
timeslot. For more information, see the "Timeslot Duration Dialog Box" on page 274.

Note: If the Vusers are in the process of stopping gradually, the system will prolong the timeslot
automatically for 15minutes, provided the resources are still available.
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Understanding Timeslot Failure

Timeslots can be reserved successfully only when all the requested resources are available for the
requested duration of time.

Many factors render a timeslot invalid. Such factors include:

l Changes to the ALM licenses (This does not affect maintenance timeslots)

l Resources become unavailable

l A test linked to a timeslot becomes invalid

In some cases, such as where there is a conflict between hosts, the system can perform a reshuffle of
hosts to try to rectify the situation and revalidate the timeslot. For more information, see "Host
Allocation" below. Other factors, such as test invalidation, can be correctedmanually.

Tip: You can configure the system to alert you by email when a timeslot becomes invalid. The
alert provides details about the cause of the failure. For details on configuring timeslot alerts, refer
to theHP ALM LabManagement Guide.

Host Allocation

When reserving a timeslot, the system calculates the availability of all the requested hosts and, in the
case of a Performance Test timeslot, Vusers. A timeslot can be reserved successfully only if all of the
requested hosts can be allocated, and in the case of a Performance Test timeslot, if all the requested
Vusers are available.

Note: Performance Testing. Youmust request at least one Controller and one LoadGenerator. If
you have linked a test to the timeslot, the hosts and Vusers defined in the test are automatically
requested for the timeslot.

Hosts are allocated as follows:

l A specific host defined in the Testing Host grid can be allocated for testing as long as it is available
and operational. A specific host can be allocated for maintenance even if it is non-operational.

Note: You canmake specific hosts available only to specific users. For details, see theHP
ALM LabManagement Guide.

l AnAutomatch host is matched up with a specific host that has the requested properties. A host is
allocated after the following criteria have been checked:

n LabManagement and PC create a list of all the hosts in the host pool of the project that are
operational and available, and that match the requested properties of the automatch host.
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n From this list of candidate hosts, the system allocates the host that best fits the requested
properties, taking into account the host priority, the number of pools the host belongs to, the
purposes assigned to the host, and the host's attributes. The hosts are then allocated in such a
way that other hosts with similar but also additional properties may still be available for allocation
to other test executions.

Note: You can block hosts from being included in the automatch selection. For details, see the
HP ALM LabManagement Guide.

It is important to note that many conditions and changes in the system can occur that can affect host
allocation. At such times, the system attempts to optimize the overall resource usage by reshuffling the
hosts that are available among the timeslots.

It is not always possible to shuffle the hosts appropriately. When this happens, a timeslot might
become partially allocated, and thus invalid. As soon as the requested host becomes available again
or another host can be allocated instead, the timeslot becomes valid again.

Example

l If an allocated host becomes non-operational, then the system will try to find another host to replace
the non-operational host.

l In a version-enabled project, if a test is linked to an automatic timeslot and is checked out, modified,
and checked in again before the timeslot starts, the timeslot recalculates the availability of the
updated resources.

To view an example of how hosts are allocated, and how they are reshuffled when necessary, see
"Example of Allocating and Reshuffling Hosts" below.

Example of Allocating and Reshuffling Hosts

There aremany factors that can affect the allocation of hosts among timeslots. Consider the following
scenarios which illustrate how hosts are allocated among performance timeslots and how changes in
the available testing hosts can affect the host allocation. You will see that LabManagement attempts
to optimize the overall resource usage by reshuffling the hosts that are available among the timeslots.

Assume the following hosts belong to the host pool of the project:

Host Properties

Host1 Controller

Host2 Controller + LoadGenerator

Host3 LoadGenerator with the following property:

l Priority = 1_Lowest
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Host Properties

Host4 LoadGenerator with the following properties:

l Citrix. The host can run scripts based on Citrix protocols.

l Priority = 9_Highest

At 07:00 am, John reserves the following timeslot:

Timeslot Reserved at Reserved for Requested Resources, Properties

TS1 07:00 08:00am - 10:00am 1Controller, Any

1 LoadGenerator, Any

John submits the request. The system allocates Host1 as the Controller, leaving Host2 available to
serve as either load generator or Controller in other timeslots. Additionally, the system allocates Host4
as the load generator, since it has higher priority than both Host2 and Host3. The following hosts are
allocated successfully:

Requested Hosts Allocated Hosts

1 Controller, Any Host1

1 LoadGenerator, Any Host4
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At 07:30 am, Sue submits the following timeslot reservation:

Timeslot Reserved at Reserved for Requested Resources, Properties

TS2 07:30 09:00am - 11:00am

Autostart

1 Controller, Any

1 LoadGenerator, Citrix

Because Host4 is the only Citrix load generator, the system checks if it can allocate a different load
generator to John's timeslot so that Host4 can be allocated to Sue's timeslot instead.

The necessary hosts are available, so the following reshuffle occurs:

l Host3 is allocated to John; Host4 is allocated to Sue

l John's Controller, Host1 remains allocated to John; Host2, also a Controller, (not yet allocated), is
allocated to Sue

Sue successfully submits the request. The new host allocation looks as follows:

Timeslot Requested Hosts Allocated Hosts

TS1 1Controller, Any

1 LoadGenerator, Any

Host1

Host3 (replaced Host4)
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Timeslot Requested Hosts Allocated Hosts

TS2 1Controller, Any

1 LoadGenerator, Citrix

Host2

Host4

Note: Host allocation works on a "first-come, first-served" basis. Since John reserved Host4 first,
if there had been no other host to allocate to his timeslot, Host4 would have remained allocated to
John, and Sue would not have been able to reserve her timeslot successfully.

At 07:45am, Peter reserves the following timeslot:

Timeslot Reserved at Reserved for Requested Resources, Properties

TS3 07:45 10:00am - 12:00pm 1Controller, Host2

1 LoadGenerator, Any
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Peter is specifically requesting Host2 for his Controller, and any load generator. The system checks if
the requested hosts can be allocated, taking into consideration requests and timing of the other
timeslots:

l To allocate Host2 to Peter's timeslot, it must be available by 10:00.

l Sue is willing to have any Controller.

l John's timeslot will end at 10:00 and free resources.

The following reshuffle occurs so that all the timeslots can be accommodated:

l Sue's timeslot gives up Host2, and is allocated Host1 instead; Host4 (Citrix) remains allocated to
Sue's timeslot

l Host2 is allocated to John's timeslot; Host3 remains allocated to John's timeslot

l Host2 and Host3 can then be allocated to Peter's timeslot because John's timeslot will be finished
by 10:00 when Peter's starts.

Peter successfully submits his request. The new host allocation looks as follows:

Timeslot Requested Hosts Allocated Hosts

TS1 1Controller, Any

1 LoadGenerator, Any

Host2

Host3

TS2 1 Controller, Any

1 LoadGenerator, Citrix

Host1

Host4

TS3 1 Controller, Host2

1 LoadGenerator, Any

Host2

Host3
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Note: If John and Peter's timeslots had overlapped, Host2 would not have been available for part
of Peter's timeslot. In this case, the reshuffle would not have been possible and Peter would not
have been able to reserve his timeslot successfully.

Now let's say at 07:55 Host2 becomes non-operational. As a result, TS1 takes back Host1, and starts
at 08:00. It follows from the information above, that TS2 and TS3 both become invalid as their
resources have become partially allocated.

Then, at 09:05, Host2 becomes operational again. It is allocated to TS2, and TS2 starts, though five
minutes late, but still during the specified retries period. (For details about configuring retries, refer to
theHP ALM LabManagement Guide.)

At 11:00, TS3 remains invalid (partially allocated) and is unable to start because Host2 is still being
used by TS2.

How to Reserve Timeslots for Performance Testing
This section describes how to reserve timeslots.

Note: This task is part of a higher-level task. For details, see "How to Conduct a Performance
Test" on page 18.

To learnmore about topologies, see "Performance Testing Timeslots Overview" on page 81.
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1. Prerequisites
n Ensure that there is a host pool defined and allocated to the project. For information about

managing host pools in LabManagement, see theHP ALM LabManagement Guide.

n If you want to run a particular test during the timeslot, ensure that an instance of that test is
included in a test set.

n Make sure that at least one of the hosts in the host pool can be designated as a Controller, and
that Host, Vuser, and Concurrent Run limits are defined in the project settings.

2. Create a timeslot
a. On theMy Performance Center navigation bar, select Resources > Timeslots.

b. On the Timeslots module, click Create Timeslot .

c. Enter the details of the timeslot and select resources. For user interface details, see " Add
New Timeslot / Edit Timeslot Dialog Box" on page 98.

3. Verify availability of requested resources
Do one of the following:

n (Recommended) Click Calculate Availability. The system checks the availability of the
requested resources. The results of this calculation are displayed in the Timeslot Status tab
and graphically on the resource availability timeline.

If the timeslot cannot be reserved, consider the reasons displayed in the Timeslot Status tab
when reselecting your resources. If the timeslot can be reserved, you can click Submit to save
the timeslot.

n Click Submit. The system calculates the availability of the requested resources during the
selected timeslot. If all of the resources are available, the Add New Timeslot dialog box closes
and the timeslot is reserved and displayed in the Timeslots page. If the timeslot cannot be
reserved, the reasons are displayed in the Timeslot Status tab.

Timeslots Module
This module enables you to reserve timeslots for running Performance tests. Themodule contains the
following views: Calendar View, Grid View.

To access On theMy Performance Center navigation bar, select Resources > Timeslots.

Relevant tasks l "How to Reserve Timeslots for Performance Testing" on the previous page

l HP ALM LabManagement Guide
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See also l "Performance Testing Timeslots Overview" on page 81

l HP Application Lifecycle Management User Guide.

Calendar View

This view enables you to view the timeslots in a calendar view.The Calendar view is time-oriented. It
allows you to view your timeslots scheduled for the same day, and to get a visual indication of
overlapping timeslots.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements
(A-Z)

Description

Create Timeslot. Opens the Add New Timeslot dialog box, enabling you to
reserve timeslots for running performance tests. For more details, see " Add New
Timeslot / Edit Timeslot Dialog Box" on page 98.

Edit Timeslot. Opens the Edit Timeslot dialog box, enabling you to edit a selected
timeslot for running performance tests. For more details, see " Add New Timeslot /
Edit Timeslot Dialog Box" on page 98.

Delete Timeslot. Deletes the selected timeslot.

Abort Timeslot. Aborts the selected timeslot.

Enables you to view timeslots in a flat, non-hierarchical view. Each line in the grid
displays a separate timeslot. This view is useful for filtering the timeslots and for
viewing the details of multiple timeslots simultaneously.

Displays the current day only on the calendar.

Displays the date selected in the date selector.

Displays the 5-day work week around the date selected in the date selector.

Displays the full week around the date selected in the date selector.

<Date
navigator>

Enables you to select the day/week to display in themain calendar grid.

My Timeslots
for Today

Displays open and future timeslots that you reserved for the current day in the
current project.
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UI Elements
(A-Z)

Description

<Calendar> Displays the reserved timeslots in your projects in calendar form.

The timeslots in the calendar view are color-coded as follows:

l Performance timeslots

l Maintenance timeslots

l Data processing timeslots (Performance Center projects only)

l Build Verification Suite timeslots

l Read only timeslots, reserved in other projects
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UI Elements
(A-Z)

Description

Summary tab Displays a summary of the timeslot selected in the calendar.

l AUT env. configuration. The set of environment parameters allocated to the
timeslot, orNot Connected indication.

l Build Verification Suite. The name of the build verification suite associated
with the timeslot, orNot Connected indication. Available for:Build
Verification Suite timeslots only.

l Created by. The user who created the timeslot.

l Description. Displays a description of the timeslot.

l Duration. The duration of the timeslot (in minutes).

l End time. The end time of the timeslot.

l Hosts. The number of hosts requested for the timeslot.

l Last modified by. The user who last modified the timeslot.

l Maintenance state. The state of themaintenance timeslot. Available for:
Maintenance timeslots only.

l Name. The name of the timeslot.

l Performance Test. The name of the performance test linked to the timeslot.

l Post-run action. The post-run action specified for the linked performance test.

l Priority modified. The date and time that the priority of the timeslot was
modified.

l Processing state. The state of the data processing timeslot. Available for:
Data processing timeslots only.

l Project. The project in which the timeslot was created.

l Realized environment name. After linking to CDA, the name of the actual
environment for the timeslot. Available for:Build Verification Suite timeslots
only.

l Start. How the timeslot is started:

n Manually. The timeslot reservation reserves testing resources only.

n Automatically. The linked tests or test sets automatically start running at
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UI Elements
(A-Z)

Description

the start of the timeslot, without any manual intervention.

l Timeslot ID. The timeslot ID.

l Topology action. Topological deployment, provisioning and deprovisioning
actions defined for the timeslot. Available for:Build Verification Suite
timeslots only.

l Validity. The validity of the timeslot:

n Valid. The timeslot is valid.

n Failed. The timeslot failed (Because resources unexpectedly became
unavailable; Because of a change in license definitions; Because of
changes in project settings; In the case of a testing timeslot, due to changes
such as the validity of a test, a test set, an AUT environment configuration,
or a build verification suite.

l Vusers. The number of Vusers requested for the timeslot.

Host
Allocation tab

Displays the allocation of hosts for the selected timeslot. For future timeslots, the
host allocation is a temporary allocation.

l Requested. Displays the requested hosts, including the requested properties.

l Actual. Displays the specific hosts allocated for the timeslot. May display the
following in place of specific host names:

n Not Allocated. Requested host(s) could not be allocated.

n Allocated (Deleted). The allocated host was deleted after the timeslot start
time.

n From another pool. The host belongs to a host pool in another project to
which you do not have access.

Note: If an allocated host becomes unavailable, the system attempts to
replace the allocated host with another host with similar properties. If no host
is available, the timeslot becomes partially allocated and is rendered invalid.

Grid View

Enables you to view timeslots in a flat, non-hierarchical view. Each line in the grid displays a separate
timeslot. This view is useful for filtering the timeslots and for viewing the details of multiple timeslots
simultaneously.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Enables you to view the timeslots in a calendar view.The Calendar view is
time-oriented. It allows you to view your timeslots scheduled for the same
day, and to get a visual indication of overlapping timeslots.

Opens the Add New Timeslot dialog box, enabling you to reserve timeslots
for running performance tests. For more details, see " Add New Timeslot /
Edit Timeslot Dialog Box" on the next page.

Opens the Edit Timeslot dialog box, enabling you to edit a selected timeslot
for running performance tests. For more details, see " Add New Timeslot /
Edit Timeslot Dialog Box" on the next page.

Aborts the selected timeslot.

Deletes the selected timeslot.

Add Filter Enables you to filter the information being displayed in the timeslots grid.
Click the drop-down arrow to apply a filter.

ID A unique numeric ID for the timeslot, assigned automatically by ALM. This
is a read-only field.

Valid indicates whether the timeslot is valid .

Created By The user who reserved the timeslot.

Start Time The date and time that the timeslot is due to start or started.

Duration The duration of the timeslot.

Hosts The number of hosts (including Controller) requested for the timeslot.

Vusers The number of Vusers reserved for the timeslot.

Test The name of the test.

Run A unique numeric ID for the run, assigned automatically by ALM. This is a
read-only field.

End Time The date and time that the timeslot ends.

Event Log Displays a log of events related to the currently selected timeslot. For
details, refer to theHP ALM LabManagement Guide.
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UI Elements Description

Host Allocation tab Displays the allocation of hosts for the selected timeslot. For future
timeslots, the host allocation is a temporary allocation.

l Requested. Displays the requested hosts, including the requested
properties.

l Actual. Displays the specific hosts allocated for the timeslot. May
display the following in place of specific host names:

n Not Allocated. Requested host(s) could not be allocated.

n Allocated (Deleted). The allocated host was deleted after the
timeslot start time.

n From another pool. The host belongs to a host pool in another
project to which you do not have access.

Note: If an allocated host becomes unavailable, the system attempts to
replace the allocated host with another host with similar properties. If no
host is available, the timeslot becomes partially allocated and is
rendered invalid.

Add New Timeslot / Edit Timeslot Dialog Box
This dialog box enables you to reserve andmanage timeslots for running performance tests.

To access 1. On theMy Performance Center navigation bar, select Resources > Timeslots.

2. To add a new timeslot, click New Timeslot . To edit a timeslot, select the

timeslot and click .

Relevant
tasks

"How to Reserve Timeslots for Performance Testing" on page 91

See also "Performance Testing Timeslots Overview" on page 81
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Start Choose themethod for executing linked tests or test sets:

l Manually. The timeslot reservation reserves testing resources
only. Youmanually execute the linked test or test sets.

l Automatically. The linked tests or test sets automatically start
running at the start of the timeslot, without any manual
intervention. Setting the test to start automatically enables
autostart for the timeslot.

Note: To set autostart retry settings, refer to "Timeslot
Settings Page" inHP ALM LabManagement Guide.

Version Control: The last checked-in version of a test always runs,
even if you have the test checked out at the start of the timeslot. In
version-enabled projects, if a test scheduled to autostart contains
scripts that are checked out, the autostart fails.

Name A descriptive name for the timeslot.

Test instance Enables you to link a performance test instance to the timeslot.

By default, there is no linked test, and the selection is empty.

You do not have to link a test to the timeslot. However, linking a test
gives you the option of running the test automatically without your
manual intervention.

Note: If youmake changes to the linked test (in the Performance
Test Designer), the timeslot is updated automatically, and you do
not need to relink the test manually. Bear in mind that changing a
linked test might affect the validity of the timeslot.

Version Control:You cannot link a test that is checked out.
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UI Elements Description

<Select a test set> Enables you to link a test set to the timeslot.

By default, there is no linked test set, and the selection is empty.

You do not have to link a test set to the timeslot. However, linking a
test set gives you the option of running the test set automatically
without your manual intervention.

Note: If youmake changes to the linked test set, the timeslot is
updated automatically, and you do not need to relink the test set
manually. Bear in mind that changing a linked test set might
affect the validity of the timeslot.

Vusers Displays the number of Vusers that are defined in the linked test.

Note: The sum of all Vusers reserved for the requested timeslot
and other timeslots must not exceed the limits specified in the
project settings (Lab Settings > Project Settings), andmust not
exceed the number of Vusers specified in the license.

Available:Only when a performance test has been linked to the
timeslot.

VUDs Displays the number of VUDs that are defined in the linked test.

Note: The sum of all VUDs reserved for the requested timeslot
and other timeslots must not exceed the limits specified in the
project settings (Lab Settings > Project Settings), andmust not
exceed the number of VUDs specified in the license.

For more information about VUDs, refer to theHP ALM Lab
Management Guide.

Available:Only when a performance test has been linked to the
timeslot.

Duration The duration of the timeslot, in hours andminutes.

Note: A timeslot can be reserved for aminimum of 15minutes
andmaximum of 480 hours (20 days).

Start Time The date and time (in hours andminutes) that the timeslot starts.

End Time The date and time (in hours andminutes) that the timeslot ends.
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UI Elements Description

Opens the Add Automatch LoadGenerators dialog box, enabling you
to select automatch load generators with specific properties for the
timeslot.

Note: Performance Test timeslots must include at least one load
generator (automatch or specific).

Opens the Add Specific LoadGenerator dialog box, enabling you to
select specific load generators for the timeslot.

Note: Performance Test timeslots must include at least one load
generator (automatch or specific).

Enables you to edit the selected request.

l Selecting an automatch load generator opens the Add Automatch
LoadGenerators dialog box.

l Selecting a specific load generator opens the Add Specific Load
Generator dialog box.

l Selecting a controller opens the Select Controller dialog box.

Removes selected load generators.

Note: You can change the selected Controller, but you cannot
delete it.
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UI Elements Description

Post Run Enables you to define the action to be taken when the performance
test run is complete:

l Collate.When the run has finished, the run results are collected
from all the load generators.

Note: To prevent loss of or inaccessibility to run data, select
this option so that the results are collected immediately upon
completion of the test run.

l Collate and Analyze.When the run has finished, the run results
are collected and analyzed. Data analysis requires some time,
depending on the size of the results file. If there is no timeslot
available to include the data analysis, then select theCollate
option instead, and run late Analysis when a data processor
becomes available. You run late Analysis from the Results tab.

l None. Frees themachines immediately after the performance test
ends. When the run has finished, the run results are left on the load
generators. You can analyze the results at a later stage from the
Results tab.

AUT Env. Configuration Enables you to select an AUT environment configuration for the
timeslot.

By default, there is no configuration selected, and the selection
appears as none.

To link an AUT Environment Configuration, click the [none] link. A
window displaying the AUT Environments tree opens. Navigate to the
AUT environment configuration to add and click OK.

For more information regarding AUT Environments, see theHP
Application Lifecycle Management User Guide.
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UI Elements Description

Deployment When your system is integrated with HP Continuous Delivery
Automation (CDA), these options enable you to select deployment
actions for the application under test. For more information on the
integration between AUT environment configuration and CDA, see the
HP Application Lifecycle Management User Guide.

The following options are available:

l Provision and deploy. Allocates machines on which to deploy
the application under test, and prepares the required image so that
the application can be installed. That is, the operating system,
database server and all required software are installed based on
CDA parameters. Following provisioning, the application under
test itself is installed.

l Redeploy. Deploys and runs the application under test
environment onmachines that have already been provisioned.

l Use deployed environment. Uses an existing installation to run
the test.

When you select an option, the environment name appears in blue.
Click the name to change the selection.

Note:

l When deciding which option to select, bear in mind that the
provisioning and deployment actions can be very time
consuming. For routine testing, it is advisable to select Use
Deployed.

l You can arrange for an environment to be deployed and
available for your run. Schedule a build verification suite or
test set to run for the entire day, and select the environment
you want to use.

Calculates the availability of the requested resources for the selected
timeslot. The results are displayed graphically on the resource
availability chart, and amessage is displayed in the Timeslot Status
tab.

Timeslot Status tab Displays the status of the timeslot reservation.

For details about timeslot failure, see theHP Application Lifecycle
Management User Guide.

Pool and Project tab Displays pool details and project limits related to the timeslot.
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Add Automatch Load Generator Dialog Box
This dialog box enables you to reserve and define properties for automatch load generators.

To access To add an automatch load generator:

1. On theMy Performance Center navigation bar, select Resources >
Timeslots.

2. Click New Timeslot .

3. Click .

To edit an automatch load generator:

1. On theMy Performance Center navigation bar, select Resources >
Timeslots.

2. Click .

3. In the Edit Timeslot dialog box, select the automatch load generator and click

.

Relevant
tasks

"How to Reserve Timeslots for Performance Testing" on page 91

See also "Performance Testing Timeslots Overview" on page 81

User interface elements are described below:

UI
Elements Description

Reserve x
Load
Generators

The number of automatch load generators to reserve for the timeslot.

Location Select a load generator location for the reserved load generators.
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UI
Elements Description

Host
Attributes

Select attributes for the selected load generators.

Tip: The list of attributes can be customized. For details, see "LoadGenerator
Distribution Overview" on page 161.

Example:

Youwant a Vuser group to use a load generator that is located in London and has
medium strength andmemory. Under Location, select London, and in theHost
Attributes list, select Host memory: Medium andHost strength: Medium. At
runtime, the system tries to assign a specific load generator with these properties
to the Vuser group.

Add Specific Load Generator Dialog Box
This dialog box enables you to add specific load generators for a selected timeslot.

To access To add a specific generator:

1. On theMy Performance Center navigation bar, select Resources >
Timeslots.

2. Click New Timeslot .

3. Click .

To edit a specific load generator:

1. On theMy Performance Center navigation bar, select Resources >
Timeslots.

2. Click .

3. In the Edit Timeslot dialog box, select the specific load generator and click

.

Relevant
tasks

"How to Reserve Timeslots for Performance Testing" on page 91

See also "Performance Testing Timeslots Overview" on page 81
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User interface elements are described below:

UI
Elements Description

ID The load generator ID.

Name/IP The name or IP address of the load generator.

Pupose The purpose of the load generator, that is, Controller, Load Generator, Data
Processor, or a combination of these.

Location The location of the load generator.

Status The current state of the load generator: Operational, Non- Operational, or
Unavailable.

Installation The installation type of the host. The following types are available:

Unix Load Generator. Indicates that this Unix host is used as a LoadGenerator for
performance tests.

Windows Host. Indicates that this Windows host can be used for performance
purposes (Controller, LoadGenerator, or Data Processor).

Windows Standalone LG. Indicates that this Windows host is used as a standalone
LoadGenerator for performance tests.

Attributes The attributes for the load generator.

Select Controller Dialog Box
This dialog box enables you to select a controller for a selected timeslot.

To access 1. On theMy Performance Center navigation bar, select Resources > Timeslots.

2. Click New Timeslot .

3. Select a controller and click .

Important
information

If you select a Controller host that has multiple purposes (Controller+Load
Generator+Data Processor), it is recommended to dedicate the host for Controller
functionality, and not to select it for other functionality as well, to avoid performance
issues during runtime.

Relevant
tasks

"How to Reserve Timeslots for Performance Testing" on page 91

See also "Performance Testing Timeslots Overview" on page 81
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User interface elements are described below:

UI Elements Description

Select a
Controller for
the timeslot

l Automatch. Enables the system to allocate an available Controller for the
timeslot.

l Specific. Enables you to select a specific controller for the timeslot.

<Controller
grid>

Lists all the specific controller hosts.

Note:Enabled when Specific is selected.

ID The controller ID.

Name/IP The name or IP address of the controller.

Pupose The purpose of the controller host, that is, Controller, Load Generator, Data
Processor, or a combination of these.

Location The location of the controller.

Reserve as C +
LG

Allows the selected host to serve both as a controller and as a load generator.

Note: This option is not recommended. The Controller host should be
dedicated for Controller functionality, and it is recommended not to run
Vusers on this host.

Note:Enabled when Specific is selected.
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Performance Test Design Overview
When you design a performance test you create the test, define a workload for the test and, if desired,
associate a topology andmonitor profiles which provide a diagram of the application under test.

You can also enable a diagnostics module to collect diagnostics data during the test run.

Service Virtualization: Your test can run simulated, virtualized services instead of actual services, for
example, if the actual services involve additional costs or if the services are inaccessible at the time
you run the performance test.

Performance Test Design Best Practices

Before you start with designing a performance test, it is recommended to:

l Create scripts for your test in the relevant application (VuGen scripts, QuickTest tests, Service
Test tests), and upload them to ALM. For details, see the relevant User Guide.

l Design topologies of your application under test. For details, see "Topologies" on page 48.

l Configure themonitor machines or monitor-over-firewall agents that you want to use tomonitor the
test run, and definemonitor profiles for thesemonitors. For details, see "Monitor Profiles" on
page 64.

l To enable diagnostic modules to collect diagnostics data from the test run, youmust set up the
relevant diagnostics components (server/mediators). For details, refer to theHP ALM Lab
Management Guide.

l To use simulated services during your test run instead of loading actual services, create your
virtualized services in HP Service Virtualization Designer. For details on creating projects that
contain virtualized services, see theHP Service Virtualization User Guide.

How to Design a Performance Test
This task describes how to design a performance test.

Note: This task is part of a higher-level task. For details, see "How to Conduct a Performance
Test" on page 18.

To learnmore about performance test design, see "Performance Test Design Overview" above.
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This task includes the following steps:

l "Prerequisites" below

l "Create a new performance test" below

l "Design a workload for the test" on the next page

l "Integrate virtualized services - Optional" on the next page

l "Select a topology for the test - Optional" on the next page

l "Select monitor profiles to monitor the test - Optional" on the next page

l "Enable and configure diagnostics - Optional" on page 114

l "Define service level agreements for the test - Optional" on page 114

l "Results" on page 114

1. Prerequisites
n Make sure the relevant scripts/tests have been uploaded/saved to Performance Center. You

can use VuGen scripts for performance testing, as well as QuickTest (UFT GUI Tests) and
Service Test tests.

o VuGen scripts: For details on uploading VuGen scripts, see "Upload VuGen Scripts Dialog
Box" on page 45.

o QuickTest tests: For details on saving QuickTest tests (UFT GUI Tests), see theHP Unified
Functional Testing User Guide.

o Service Test tests: For details on saving Service Test tests (API Tests), see theHP Service
Test User Guide or the information about API testing in theHP Unified Functional Testing
User Guide.

n Under Lab Resources, select Testing Hosts andmake sure that there is at least one
Controller, one load generator, and one data processor in the host pool of your project. If not,
contact your administrator to add them.

n For optional pre-design best practices, see "Performance Test Design Best Practices" on the
previous page.

2. Create a new performance test

a. On theMy Performance Center navigation bar, select Test Management > Test Plan.

b. In the Test Plan Tree, select theSubject root folder, click New Folder . Type folder name
and click OK.
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c. Select the folder from the tree.

d. Click New Test . Fill in the fields in the Create New Performance Test dialog box. For
more details, see "Test PlanModule" on page 116.

Tip: To simplify the process of creating, designing, and running performance tests, you can
use Test Express Designer. This tool guides you through each step, including selecting
scripts for a test, scheduling how many Vusers to run in each script and for how long to run
them, and selecting a post-run action. During test run, you can view the performance test
initialization steps performed by Performance Center and the status for each step. If each
step is completed successfully, the performance test continues running and the Performance
Test Run page opens. For user interface details, see "Test Express Designer" on page 253.

3. Design a workload for the test
Designing a workload involves creating Vuser groups, distributing Vusers among the Vuser
groups, assigning hosts to the Vuser groups, and defining a run schedule for the test. For task
details, see "How to Define a Performance Test Workload" on page 128.

Note: Non-English national characters are not supported in group names.

4. Integrate virtualized services - Optional
Configure and integrate virtualized services into the performance test. For task details, see "How
to Add Virtualized Services to Performance Tests" on page 152.

You can start adding projects that contain virtualization services to your performance test from the
Performance Test Designer at any point in the design process, but we recommend adding projects
after you have added relevant scripts to the test.

5. Select a topology for the test - Optional

Note: Before you can select a topology for a test, youmust design the topology. To design
topologies, see "How to Design Topologies" on page 49.

In the Performance Center Designer's Topology tab, click Select Topology and select a
topology for the test. For user interface details, see "Performance Test Designer > Topology " on
page 62.

6. Select monitor profiles tomonitor the test - Optional

Note: Before you can select monitors for a test, youmust configuremonitor machines and
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createmonitor profiles. For details, see "How to Create and ConfigureMonitor Profiles" on
page 65.

Similarly, youmust definemonitor-over-firewall agents in the system before you can select
them tomonitor a test.

In the Performance Center Designer's Monitors tab, click Add Monitor Profile orAdd Monitor
OFW. The respective tree opens on the right. Select amonitor, and drag and drop it into the left
pane.

For user interface details, see "Performance Test Designer > Monitors " on page 77.

7. Enable and configure diagnostics - Optional
Enable and configure diagnostic modules to collect diagnostics data from the test run.

n For ERP/CRM diagnostics, see "How to Enable and Configure ERP/CRMDiagnostics" on
page 205.

n For J2EE/.NET diagnostics, see "How to Enable and Configure J2EE/.NET Diagnostics" on
page 205.

8. Define service level agreements for the test - Optional
Define service level agreements tomeasure performancemetrics against performance goals. For
details, see "How to Define Service Level Agreements" on page 190.

9. Results
When you save the test, it goes through a validation process. The test is valid only if it contains no
errors. The result of the validation is stated at the bottom of the Test Designer window.

Click the link to open the Test Validation Results dialog box and view the details of the validation
results. For user interface details, see "Test Validation Results Dialog Box" on page 125.

Note: If youmake changes to the test, and the test is linked to a timeslot, the timeslot is
updated with these changes automatically.
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Performance Test Design User Interface
This section includes:

Test PlanModule 116

Performance Test Designer > Summary View / Preview Tab 117

Performance Test Designer > Test Runs Trend View / Test Runs Trend Tab 121

Performance Test DesignerWindow 122

Create New Performance Test Dialog Box 124

Test Validation Results Dialog Box 125
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Test Plan Module

This module enables you to create andmanage Performance Center tests in the test plan tree.

To access On theMy Performance Center navigation bar, select Test Management > Test
Plan.

Relevant
tasks

"How to Design a Performance Test" on page 111

See also "Performance Test Design Overview" on page 111

User interface elements are described below:

UI Elements Description

<My Performance
Center common
UI elements>

ForMy PC menus and buttons, see "My Performance CenterWindow" on
page 23.

New Folder.Opens the Create New Test Folder dialog box, enabling you to
add a test subject under a selected folder.

Syntax exceptions:A folder name cannot include the following characters: \ ^
*

New Test. Opens the Create New Performance Test dialog box, enabling you
to add a test under a selected folder. For more details, see "Create New
Performance Test Dialog Box" on page 124.

Upload Script. Opens the Upload VuGen Scripts dialog box, enabling you to
upload VuGen scripts to Performance Center. For more details, see "Upload
VuGen Scripts Dialog Box" on page 45.

Delete. Deletes the selected test or folder in the test plan tree.

When deleting a folder, the selected folder is deleted and all related tests are
moved to the Unattached folder. You cannot delete the root Subject folder.

When deleting a test, the selected test is deleted permanently. In addition, all
test runs associated with the deleted test are deleted from the project and
removed from any associated test sets.

Note:Deleting a performance test that is linked to a timeslot will affect the
timeslot.

Refresh. Refreshes the test plan tree so that it displays themost upto- date
information.

Copy/Paste Right-click a folder/test to copy it within the same tree.
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Preview Tab
This tab displays test details and enables you to edit and run your test. For more details, see
"Performance Test Designer > Summary View / Preview Tab " below.

Test Runs Tab
This tab enables you tomanage results and related actions for test runs. For more details, see "Test
LabModule" on page 249.

Test Runs Trend Tab
This tab enables you tomonitor the test runs of a selected test over time. For more details, see
"Performance Test Designer > Test Runs Trend View / Test Runs Trend Tab " on page 121.

Performance Test Designer > Summary View / Preview Tab

This view displays a detailed summary of a selected performance test.

Summary View
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Preview Tab

To access Summary View:

1. On theMy Performance Center navigation bar, select Test Management > Test
Plan.

2. Select a performance test in the test plan tree and click Edit Test.

3. In the Performance Test Designer window, click Summary.

Preview tab:

1. On theMy Performance Center navigation bar, select Test Management > Test
Plan.

2. Click a performance test in the test plan tree.

See also l "Performance Test DesignerWindow" on page 122

l "Test PlanModule" on page 116

User interface elements are described below:

UI Elements Description

Opens the Performance Test Designer window where you design performance
tests. For details, see "Performance Test DesignerWindow" on page 122.

Available in:Preview tab
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UI Elements Description

l If the selected test is assigned to a single test set, then the Run Test dialog box
opens. For more details, see "Run Test Dialog Box" on page 270.

l If the selected test is assigned tomore than one test set, or if the selected test
is not assigned to a test set, then the Assign and Select Test Set dialog box
opens. Select a test set and click Run. The Run Test dialog box opens. For
more details, see "Run Test Dialog Box" on page 270.

Available in:Preview tab

General Details Pane
This pane displays general summary information about the test.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Settings
column icons> l Indicates that there is an error in the test design.

l Indicates that the test is valid and can run.

l Indicates whether:

n A topology is selected for the test

n Monitors are selected for the test

n Diagnostics are enabled for the test

n IP Spoofing is enabled for the test

Test name The name of the test.

Validation Indicates whether the test is valid.

If the test is not valid or there are notifications about the test, theDetails column
displays a link to the Test Validation Results dialog box which lists errors and
messages related to the test. For details, see "Test Validation Results Dialog
Box" on page 125.

Workload Type The workload type selected for the test.

Total Vusers The number of Vusers defined in the test.
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UI Elements Description

Topology Indicates whether a topology is associated with the test, and if so, displays the
relevant details.

Diagnostics Indicates whether diagnostics are enabled for the test, and if so, displays the
relevant details.

Monitors Indicates whether monitor profiles are defined for the test, and if so, displays the
relevant details.

IP Spoofer Indicates whether IP spoofing is enabled for the test. For details, see "Test
Options Dialog Box" on page 146.

Services
Virtualization

Indicates whether service virtualization is on or off.

Controller/Load
Generator

Displays the number of hosts selected for the test, and their properties.

Assign To Opens the Assign and Select dialog box, enabling you assign the selected test to
a test set, and then run it from the Run Test dialog box. For details on the Run
Test dialog box, see "Run Test Dialog Box" on page 270.

Groups Pane
This pane displays details about the Vuser groups defined in the test.

User interface elements are described below:

UI Elements Description

Group Name The name of the Vuser group.

Script Name The name of the Vuser script associated with the Vuser group.

Script Type The Vuser script type.

Vusers #/% The number/percentage of Vusers distributed to the Vuser group.
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Service Level Agreement Pane
This pane displays service level agreements (SLAs) that are defined for the test.

Important information l You create, modify, and delete SLAs in the Summary tab.

l In the Test Design tab you can only view a list of defined
SLAs.

l In the Preview tab you can only view a list of defined SLAs.

Relevant tasks "How to Define Service Level Agreements" on page 190

See also "Service Level Agreements Overview" on page 189

For user interface details, see "Service Level Agreement Pane" on page 195.

Performance Test Designer > Test Runs Trend View / Test Runs
Trend Tab

Displays a trend graph whichmonitors the test runs of a selected test over time.

To access Test Runs Trend View:

1. On theMy Performance Center navigation bar, select Test Management > Test
Plan.

2. Select a performance test in the test plan tree and click Edit Test.

3. In the Performance Test Designer window, click Test Runs Trend.

Test Runs Trend tab:

1. On theMy Performance Center navigation bar, select Test Management > Test
Plan.

2. Click a performance test in the test plan tree.
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See also l "Performance Test DesignerWindow" below

l "Test PlanModule" on page 116

User interface elements are described below:

UI Elements Description

Measurement
Value

The value of themeasurement being trended.

Run The number of test runs.

Filter By Run
Dates

Select the desired trended time frame for the graph.

Select
Measurement
Types

Select the desiredmeasurement types:

l Average Hits Per Second.Measures the average number of hits per second
within the trended time range.

l Average Throughput Per Second. The amount of throughput per second
within the trended time range.

l Total Passed Transactions. The total number of passed transactions run
within the trended time range.

l Total Failed Transactions. The total number of failed transactions run within
the trended time range.

l Total Errors. The total number of errors within the trended time range.

l Maximum Vusers. Themaximum number of running Vusers during a test run
within the trended time range.

Enable
Automatic
Scaling

Automatically scales themeasurements by calculating the best ratio for displaying
the graph. The scaling factor is specified next to eachmeasurement.

Performance Test Designer Window

This window enables you to define a performance test. Defining a performance test includes selecting
scripts for the test, scheduling how many Vusers to run in each script and for how long to run them,
choosing topologies andmonitor profiles for the test, and enabling collection of diagnostics data for the
test run.

Version Control: If your project is version-enabled:
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l To edit a test, youmust check it out.

l When you check out a test, only you can edit the test.

l If the test is checked out by another user, you cannot check the test out as well. You can view
the last checked in version in read-only mode.

To access 1. On theMy Performance Center navigation bar, select Test Management >
Test Plan.

2. Select a performance test in the test plan tree and click Edit Test.

Relevant
tasks

"How to Design a Performance Test" on page 111

See also l "Enabling and Configuring ERP/CRM and J2EE/.NET Diagnostics " on
page 204

l "Monitor Profiles" on page 64

l "Topologies" on page 48

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Summary Displays a summary of the test. For details, see "Performance Test Designer
> Summary View / Preview Tab " on page 117.

Groups &
Workload

Enables you to design a workload for the test. For details, see "Performance
Test Designer > Groups & Workload" on page 134.
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UI Elements Description

Monitors Enables you to select monitors to monitor the test. For details, see
"Performance Test Designer > Monitors " on page 77.

Topology Enables you to associate a topology with the test. For details, see
"Performance Test Designer > Topology " on page 62.

Diagnostics Enables you to select a diagnostics module to collect diagnostics data from
the test. For details, see "Performance Test Designer > Diagnostics" on
page 207.

Test Runs Trend Enables you tomonitor the test runs of a selected test over time. For details,
see "Performance Test Designer > Test Runs Trend View / Test Runs Trend
Tab " on page 121.

<Validation
message>

When you save the test, this message displays the test validation result. If
there are errors or messages, a link to the test validation results is displayed.

For details, see "Test Validation Results Dialog Box" on the next page.

Opens the Test Options dialog box, enabling you to set general Scheduler and
testing options. For details, see "Test Options Dialog Box" on page 146.

Create New Performance Test Dialog Box

This dialog box enables you to create a performance test.

To
access

Use one of the following options:

l On theMy Performance Center navigation bar, select Test Management > Test
Plan. In the test tree, click New Test.

l On theMy Performance Center navigation bar, select Test Management > Test
Lab. In the test tree, click Create New Test.

Relevant
tasks

"How to Design a Performance Test" on page 111

See also "Performance Test Design Overview" on page 111
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User interface elements are described below:

UI Elements Description

Test name The name of the performance test.

Test Plan folder The folder in the test plan tree in which the test resides.

Available in: Test Labmodule

Assign to Test Set The test set in which the test resides.

Test Validation Results Dialog Box

This dialog box displays the validation results of your performance test.

To access 1. On theMy Performance Center navigation bar, select Test Management > Test
Plan. Select a performance test in the test plan tree and click Edit Test.

2. Use one of the following:

n Click the validation link at the bottom of the Performance Test Designer
window.

n In theSummary view, click the validation link.

Note: The validation link appears only if the test is invalid or there are
messages about the test. If the test is valid and there are nomessages, no
validation link is displayed.

Important
information

A performance test that is not valid cannot run.

Relevant
tasks

"How to Design a Performance Test" on page 111

See also "Performance Test Designer > Summary View / Preview Tab " on page 117

User interface elements are described below:

UI Elements Description

Level The type of message:

Error or
Warning.

Details Describes the error or warning.
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Performance Test Workload Overview
When you create a performance test you need to define a workload for the test. Defining a workload
involves selecting a type of workload for the test, creating Vuser groups that emulate groups of users
running on the application, and configuring how they should behave during the test.

You select a workload depending on the type of schedule and schedule runmode you want to use to run
your test, and depending on how you want to distribute the Vusers among the Vuser groups in your test.

For details on defining a workload for your performance test, see "How to Define a Performance Test
Workload" on the next page.

This section also includes "Rendezvous Points" below.

Rendezvous Points

During a test run, you can instruct multiple Vusers to perform tasks simultaneously by using
rendezvous points. A rendezvous point creates intense user load on the server, enabling you to
measure server performance under load.

Suppose you want to measure the performance of an application when 10 Vusers perform a given task
simultaneously. Tomake sure that multiple Vusers act simultaneously, you create a rendezvous
point in the Vuser script. When Vusers arrive at a rendezvous point, they are held there by the
Controller. The Controller releases the Vusers from the rendezvous either when the required number of
Vusers arrives, or when a specified amount of time has passed.

For example, to test an online bank, you could create a test that contains two rendezvous points. The
first rendezvous ensures that one thousand Vusers simultaneously deposit cash. The second
rendezvous ensures that another thousand Vusers simultaneously withdraw cash. Tomeasure how the
server performs when only 500 Vusers deposit cash, you can set the release policy so that the Vusers
are released when 500 Vusers arrive at the rendezvous.

You can configure rendezvous policies when defining the test workload. For task details, see "How to
Define a Performance Test Workload" on the next page.

You canmanually release Vusers waiting at a rendezvous point during a run. For task details, see
"How toManage a Performance Test Run" on page 242.
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How to Define a Performance Test Workload
This task describes how to define a performance test workload.

Note: This task is part of a higher-level task. For details, see "How to Design a Performance Test"
on page 111.

To learnmore about performance testing, see "Performance Test WorkloadOverview" on the previous
page.

This task includes the following steps:

l "Prerequisite" below

l "Select a workload" below

l "Select a Controller" below

l "Create Vuser groups and distribute Vusers to the groups" on the next page

l "Distribute load generators among the Vuser groups " on the next page

l "Define a schedule for the performance test" on the next page

l "Configure test settings - Optional" on the next page

l "Define topology, monitoring, and diagnostics options" on page 131

1. Prerequisite
Create a performance test. For details, see "How to Design a Performance Test" on page 111.

2. Select a workload
a. On theMy Performance Center navigation bar, select Test Management > Test Plan. Select

a performance test in the test plan tree and click Edit Test.

b. In the Performance Test Designer window, click Groups & Workload.

c. Click theSelect Workload Type button adjacent to theWorkload type box, and select a
type of workload for the test. The type of workload you choose determines the type of
schedule by which the test will run, and how the Vusers will be distributed at runtime. For user
interface details about theWorkload Types dialog box, see "Workload Types Dialog Box" on
page 141.

3. Select a Controller
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Click theSelect Controller button adjacent to theController box, and select a host to act as the
Controller for the test. For user interface details about the Select Controller dialog box, see "Select
Controller Dialog Box" on page 142.

4. Create Vuser groups and distribute Vusers to the groups
a. In the Groups pane, select scripts from the Scripts Tree pane on the right to run in the test. If

the Scripts Tree pane is not open, click theSelect Scripts button.

Tip: You can select complete folders of scripts, or select multiple scripts while holding
down the CTRL key on your keyboard.

b. (Optional) For each selected script, a Vuser group is created in the Groups grid and is given,
by default, the same name as the selected script. You can change the group name if desired.

c. Distribute Vusers among the Vuser groups according to the Vuser distributionmethod you
selected in the workload type. For details, see "How to Distribute Vusers Among Vuser
Groups" on page 131.

Note: Non-English national characters are not supported in group names.

5. Distribute load generators among the Vuser groups
Select amethod by which to distribute the load generators among the Vuser groups, and specify
which load generators to distribute to which groups.

For details, see "How to Distribute LoadGenerators Among Vuser Groups" on page 162.

6. Define a schedule for the performance test
Schedule how the Vuser groups are to run in the test. For details, see "How to Define a Schedule
for the Performance Test" on page 177.

7. Configure test settings - Optional
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You can configure the following optional settings for your test:

Optional Test
Setting Description

Command line
arguments

Sending command line arguments enables you to configure test settings
without the need tomanually define them in the UI.

In the Groups pane, click theEdit Command Line button. For
details, seeEdit Command Line in the "Performance Test Designer >
Groups & Workload" on page 134.

Rendezvous
Points

When you add Vuser groups to the test, their associated scripts are
scanned for rendezvous points.

To view andmanage the rendezvous points, click theView Rendezvous

button. For user interface details, see "Rendezvous Dialog Box" on
page 144.

Runtime Settings
Configuration

You can configure the runtime settings of uploaded Vuser scripts.
Runtime settings are applied to Vusers when the script runs.

To open the Runtime Settings dialog box, in the Groups pane toolbar,

click theEdit Runtime Settings button. For more details, see
"How to Configure Runtime Settings" on page 467.

Runtime Settings
Duplication

You can copy runtime settings from one script in the test to other scripts
of the same script type. In the Groups pane toolbar, click theDuplicate

Runtime Settings button.

For details, seeDuplicate Runtime Settings in the "Performance Test
Designer > Groups & Workload" on page 134.

Network
Virtualization

Network Virtualization enables you to emulate probable network effects
over your network, thereby creating amore realistic performance test.

To open the Network Virtualization Settings dialog box, in the Groups
pane toolbar, select Advanced > Newtwork Virtualization Settings.
For user interface details, see "Network Virtualization Settings Dialog
Box" on page 300.
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Optional Test
Setting Description

Services
Virtualization

Instead of loading actual services, Service Virtualization enables you to
use simulated services in your test run.

To open HP Services Virtualization dialog box, in the Groups pane
toolbar, select Advanced > Services Virtualization. For user interface
details, see "HP Service Virtualization Dialog Box" on page 154.

PAL Reports Enables you open a PAL production report. To open the Select PAL
Report dialog box, select Advanced > Open PAL Report. For more
details on PAL, see "How toWork with PAL" on page 339.

Analysis Template Enables you to select a customized template for the analysis report of
your performance test. To open the Analysis Template Options dialog
box, select Advanced > Analysis Template Options. For user
interface details, see "Analysis Template Options Dialog Box" on
page 236.

Terminal Services When usingmanual load generator distribution, you can open terminal
services sessions on the load generators, enabling you to runmultiple
GUI Vusers simultaneously on the same application. For details, see
"Terminal Services Dialog Box" on page 224.

8. Define topology, monitoring, and diagnostics options
For task details, see "How to Design a Performance Test" on page 111.

How to Distribute Vusers Among Vuser Groups
This task describes how to distribute Vusers in a performance test among the Vuser groups. You
distribute Vusers according to the Vuser distributionmethod you selected for the workload.

You can distribute the Vusers by number, by percentage (manually), or by percentage using the relative
distributionmethod.

Note:

l In workloads with group schedules, you can distribute Vusers by number only.

l This task is part of a higher-level task. For details, see "How to Define a Performance Test
Workload" on page 128.
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This task describes how to:

l "Distribute Vusers by number" below

l "Distribute Vusers by percentage" below

l "Distribute Vusers by percentage using relative distribution" below

Distribute Vusers by number

Note: This procedure assumes that you selectedBy numberwhen you selected the workload for
the test. For user interface details, see "Workload Types Dialog Box" on page 141.

l Basic schedule: In the Performance Test Designer window, in the Groups grid, select a group, and
in theVusers column, enter the number of Vusers to allocate to that group.

l Real-world schedule: You define the number of Vusers when you define the test schedule. For
details, see "How to Define a Schedule for the Performance Test" on page 177.

For both runmodes, the total number of the Vusers assigned to all the Vuser Groups is displayed in the
Groups pane toolbar.

Distribute Vusers by percentage

Note: This procedure assumes that you selectedBy percentagewhen you selected the workload
for the test. For user interface details, see "Workload Types Dialog Box" on page 141.

1. In the Performance Test Designer window, in the Groups grid, in theVusers-100% column for
each group, enter the percentage of the total number of Vusers to allocate to the group.

Note: The total of all the groups' percentages must be exactly 100% for the test to be valid.

2. Allocate a total number of Vusers to run in the test:

n Basic mode: In the Groups pane, enter the number of Vusers in the Total Vusers box.

n Real-world mode:You define the number of Vusers when you define the test schedule. For
details, see "How to Define a Schedule for the Performance Test" on page 177.

Distribute Vusers by percentage using relative distribution

In the Performance Test Designer window, in the Groups grid, click theRelative Distribution
button to define a ratio by which to distribute the Vusers from each group. For user interface details, see
Relative Distribution in the "Performance Test Designer > Groups & Workload" on page 134.
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Defining Performance Test Workloads User Interface
This section includes:

Performance Test Designer > Groups & Workload 134

Workload Types Dialog Box 141

Select Controller Dialog Box 142

Relative Distribution Dialog Box 143

Rendezvous Dialog Box 144

Test Options Dialog Box 146
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Performance Test Designer > Groups & Workload

This view enables you to define a workload for the test. You select a Controller for the test, scripts to
run in the test, and load generators on which to run the Vusers. You also define a run schedule for the
test.

To access 1. On theMy Performance Center navigation bar, select Test Management >
Test Plan.

2. Select a performance test in the test plan tree and click Edit Test.

3. In the Performance Test Designer window, click Groups & Workload.

Relevant
tasks

"How to Define a Performance Test Workload" on page 128

See also See "Groups Pane" on the next page for details about:

l View Script dialog box

l Edit Command dialog box

l Relative Distribution dialog box

l Duplicate Runtime Settings dialog box

l Duplicate Scheduler Settings dialog box

l Analysis Template Options dialog box
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Workload Tab Common Area
User interface elements are described below:

UI
Elements

Description

Workload
Type Displays the workload type for the test. Click to open theWorkload Types dialog

box and select a type of workload for the test.

For details, see "Workload Types Dialog Box" on page 141.

Controller Displays the Controller selected for the test. Click to open the Select Controller
dialog box and select a Controller for the test.

For details, see "Select Controller Dialog Box" on page 142.

Groups Pane
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Select Scripts. Opens the Scripts Tree pane, enabling you to select scripts to
run in your test. For details, see "Scripts Tree pane" on page 140.

View Script. Opens the script selected in the Groups grid in a read-only
window.

Versioning:

l As long as a script is checked in, the same version is displayed for all users.

l If you have checked out the script, the script displayed is your own private
copy of the script. If youmake changes to the script, other users will not be
able to see your changes until you check the script back in. Similarly, if other
users check in changes to this script, you will not be able to see them as
long as you have the script checked out.

l If another user checks out the script, you will still see the latest checked-in
version.
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UI Elements Description

Edit Runtime Settings. Opens the Runtime Settings dialog box for the
selected script, enabling you to configure its runtime settings.

To use the default settings, click Use Defaults. Vuser scripts have individual
runtime setting defaults for VuGen and the Controller, to support the debugging
environment of VuGen and the performance testing environment of the
Controller.

For more information, see "Runtime Settings Configuration" on page 464.

Edit Command Line. Opens the Command Line dialog box, enabling you to
pass arguments to instruct the Controller how to behave. By passing arguments
in the command line, you configure test settings without the need tomanually
define them in the user interface.

l Command line. Type the name and value of the parameter you want to
send using the format, <Parameter_Name> <value>.

Note: For information about the command line parsing functions, or for
details about including arguments on a command line, see theHP
LoadRunner Online Function Reference, provided with HP Virtual User
Generator.

l <Command line options>. Select whether to:

n Apply the command line to the current script only

n Apply the command line to all the scripts in the test

n Add the command line to all the scripts in the test

Note: You cannot pass arguments to Service Test tests.

Delete Group. Deletes the selected Vuser group.

Relative Distribution. Opens the Relative Distribution dialog box, enabling you
to provide a ratio by which Performance Center calculates the percentage of
Vusers to distribute to each Vuser group. For details, see "Relative Distribution
Dialog Box" on page 143.

Note: Enabled in percentagemode only.
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UI Elements Description

View Rendezvous. Opens the Rendezvous dialog box, enabling you to enable
or disable rendezvous points, and set policies for how to treat Vusers when they
arrive at a rendezvous point. For details, see "Rendezvous Dialog Box" on
page 144.

Duplicate Runtime Settings. Opens the Duplicate Runtime Settings dialog
box, enabling you to select a source script, and copy its runtime settings to one
or more scripts of the same type.

Note: The source and destination scripts must be of the same script type.

Duplicate Scheduler Settings. Opens the Duplicate Scheduler Settings dialog
box, enabling you to select a source Vuser group, and copy its schedule
settings to one or more Vuser group in the test.

For details, see the instructions on how to copy group schedules in "How to
Define a Schedule for the Performance Test" on page 177.

Available for:Schedules by group only.

Total Vusers Displays the total number of Vusers distributed to all of the Vuser groups
participating in the test. For details, see "How to Distribute Vusers Among
Vuser Groups" on page 131.

LG Distribution Enables you to select amethod for assigning load generators to the Vuser
groups in the test.

l Assign all to each group. All of the automatch load generators are
distributed to all of the participating Vuser groups.

l Assign manually. Load generators are distributedmanually.

For details, see "LoadGenerator Distribution Overview" on page 161.

LG Displays the number of automatch load generators selected for the test.

Note: Available only if Assign all to each group is selected in the LG
Distribution box.

Automatch Load Generator Properties. Opens the Automatch Load
Generator Properties dialog box, enabling you to specify properties for
automatch load generators. For details, see "Automatch LoadGenerators
Properties Dialog Box" on page 171.
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UI Elements Description

Assign Load Generators to Multiple Groups. Opens the Assign Load
Generators to Multiple Groups dialog box, enabling you to assign one or more
load generators—automatch or specific—tomultiple Vuser groups at once. You
can also use this dialog box to remove one or more load generators from
multiple Vuser groups at once. For details, see "Assign LoadGenerators to
Multiple Groups Dialog Box" on page 165.

Available for: TheAssign manually load generator distributionmethod. See
"LGDistribution" on the previous page.

Advanced >
Network
Virtualization
Settings

Opens the Network Virtualization Settings dialog box, enabling you to emulate
probable Network Virtualization effects over your network, thereby creating a
more realistic performance test.

For details, see "Network Virtualization Settings Dialog Box" on page 300.

Advanced >
Services
Virtualization

Opens the Configure Service Virtualization dialog box, enabling you to integrate
virtualized services into your performance test. For user interface details, see
"HP Service Virtualization Dialog Box" on page 154.

For details on creating projects that contain virtualized services, see theHP
Service Virtualization User Guide.

For task details on using virtualized services in performance tests, see "How to
Add Virtualized Services to Performance Tests" on page 152.

Advanced >
Open PAL
Report

Opens the Select PALReport dialog box, enabling you to select a PAL
production report. For more details on PAL, see "How toWork with PAL" on
page 339.

Advanced >
Analysis
Template
Options

Opens the Analysis Template Options dialog box, enabling you to select a
customized template for the analysis report of your performance test.

For task details on using customized analysis templates, see "How to
Customize Analysis Templates" on page 233.

<grid filters> Located under each column name. Displays the filter that is currently applied to
a column. If the filter box is empty, no filter is currently applied to the column.

Type directly into the box and press ENTER to apply the filter.
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UI Elements Description

Groups grid Displays the Vuser groups participating in the test.

l Vusers. (By Numbermode) The number of Vusers distributed to the Vuser
group.

Default: 10 Vusers

l Group Name. The name of the Vuser group.

l Script Name. The name of the Vuser script associated with the Vuser
group. When the group is selected, the script name turns into a link. To
select a different script, click the script name and select a script.

l Load Generators. The load generators assigned to the Vuser group.

l Script Type. The Vuser script type.

l Tag. A tag for the Vuser group. Tagging enables categorization and easy
identification of Vuser groups.

Examples:

n If you have finished configuring runtime and Scheduler settings for
the group, you could tag the group Done. For a group that is not yet
done, you could tag TODO.

n Groups running against the Defects or Requirements modules, could
be tagged DEF or REQ.
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UI Elements Description

Scripts Tree
pane Opens on the right when you click . Lists all the VuGen

scripts, UFT GUI tests, and UFT API tests that have been uploaded to the
project.

Note: HP Unified Functional Testing (UFT) comprises the product formerly
known as HP QuickTest Professional and the product known as HP
Service Test.

l Functionality provided by QuickTest is now known as GUI testing in
UFT.

l Functionality provided by Service Test is also known as API testing in
UFT.

Drag and drop one or more scripts from the tree into the Groups pane or select

the scripts and click .

Tip: You can select whole folders of scripts, or select multiple scripts while
holding down the CTRL key on your keyboard.

To keep the Scripts Tree open, click theDock button .

Global Scheduler Pane
TheGlobal Scheduler pane enables you to define a run schedule for your test. For details, see "Global
Scheduler Pane" on page 182.
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Workload Types Dialog Box

This dialog box enables you to select a type of workload for the performance test. The type of workload
you choose determines the type of schedule by which the test will run, and how the Vusers will be
distributed at runtime.

To access 1. In the Performance Test Designer window, click Groups &
Workload.

2. Next to theWorkload type box, click Select Workload Type

.

Important information If you change the workload, Scheduler settings are lost.

Relevant tasks "How to Define a Performance Test Workload" on page 128

See also l "Performance Test WorkloadOverview" on page 127

l "Scheduling Performance Tests Overview" on page 175
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User interface elements are described below:

UI Elements Description

Basic schedule, by test. Select this workload type to configure all the Vuser
groups to run together on the same test schedule, in the basic runmode.

Vusers can be distributed:

l By number. The Vusers are distributed by number.

l By percentage. The Vusers are distributed by percentage.

Basic schedule by group. Select this workload type to configure each Vuser
group to run on its own test schedule, in the basic runmode.

In group schedules, Vusers are always distributed by number.

Real-world schedule, by test. Select this workload type to configure all the Vuser
groups to run together on the same test schedule, in the real-world runmode.

Vusers can be distributed:

l By number. The Vusers are distributed by number.

l By percentage. The Vusers are distributed by percentage.

Real-world schedule, by group. Select this workload type to configure each
Vuser group to run on its own test schedule, in the real-world runmode.

In group schedules, Vusers are always distributed by number.

Select Controller Dialog Box

This dialog box enables you to select a Controller for the performance test.

To access 1. In the Performance Test Designer window, click Groups & Workload.

2. Next to theController box, click .

Important
information

l You select only one Controller for a performance test.

l Due to possible heavy load on the Controller and load generator hosts during a
performance test, if you select a C+LG host for Controller functionality, it is best
practice not to assign it as a load generator as well.

Relevant
tasks

"How to Define a Performance Test Workload" on page 128

See also "Performance Test WorkloadOverview" on page 127
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User interface elements are described below:

UI
Elements

Description

Automatch:
Dedicated
Controller

At runtime, an available Controller host in the host pool of the project is allocated for
the test run, and is dedicated for Controller functionality. Because it is a dedicated
Controller, it cannot be allocated as a load generator as well.

For details about host allocation, see "Host Allocation" on page 85.

Specific Select this option if you want a specific Controller host. The grid lists the specific
Controller hosts available in the project's host pool.

Note: If a host is marked with a red asterisk (*), it is already assigned to a Vuser
group as a load generator. Due to possible heavy load on the Controller and load
generator hosts during a performance test, if a host is assigned to a Vuser group,
it is best practice not to select it as a Controller as well.

Relative Distribution Dialog Box

This dialog box enables you to provide a ratio by which Performance Center calculates the percentage
of Vusers to distribute to each Vuser group.

To access In theGroups & Workload view, click Relative Disribution .

Important information Enabled in percentagemode only.

Relevant tasks l "How to Distribute Vusers Among Vuser Groups" on page 131

l "How to Define a Performance Test Workload" on page 128.

See also "Performance Test Designer > Groups & Workload" on page 134
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Ratio The part of total number of Vusers to distribute to the corresponding Vuser group.

Example:

To distribute 200 Vusers among the groups at a ratio of 1:1:3, type 1 for group1, 1
for group2, and 3 for group3.

20% of the Vusers are assigned to group1, 20% to group2, and 60% to group3. That
is, 40 Vusers are assigned to group1, 40 Vusers to group2, and 120 Vusers to
group3.

Group
Name

The name of the Vuser group.

Rendezvous Dialog Box

This dialog box enables you to enable/disable rendezvous points defined in the Vuser scripts and to set
rendezvous policies that determine how the Controller handles Vusers at a rendezvous point.

To access l During the test design phase: In theGroups & Workload view, click View

Rendezvous .

l During the test run:On the Performance Test Run page, click Rendezvous
.

Important
information

Rendezvous points are inserted in the Vuser script when creating the script in VuGen.
For information, see theHP Virtual User Generator User Guide.

Rendezvous points causemultiple Vusers to perform tasks at exactly the same time,
thereby creating intense user load on the server. Enabling rendezvous points enables
you to check your system's response under specific load.

For each rendezvous point, you can set Policy attributes. During the test run, you can
manipulate the Vuser behavior at the rendezvous points.
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Relevant
tasks

l "How to Define a Performance Test Workload" on page 128.

l "How toManage a Performance Test Run" on page 242

See also "Rendezvous Points" on page 127

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Select all. Selects all the rendezvous points in the grid.

Select none. Clears all the selected rendezvous points in the grid.

Switch between selected/non selected. Inverts the current selection of
rendezvous points.

That is, the non-selected rendezvous points are selected, and the selected
rendezvous points are cleared.

Enables/Disables the selected rendezvous point. Enabling or disabling a
rendezvous point influences the level of server load.

Releases the Vusers at the selected rendezvous points.

Available from:Performance Test Run page only

<Rendezvous
grid>

Displays the details about the rendezvous points in the scripts:

l Name. The name of the rendezvous point as given in the VuGen script.

l Status. The status of the rendezvous point: Enabled orDisabled.

l Contained in Scripts. The names of the scripts in which the rendezvous point
was defined.

You select a rendezvous point by clicking it.
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UI Elements Description

Policy Enables you to determine how the Controller handles Vusers at a rendezvous point.
You set the following policy attributes for each rendezvous:

l Release when. Sets how many Vusers are released from a rendezvous point at
a time.

n X% of all Vusers arrive at the rendezvous. Releases the Vusers only
when the specified percentage of all Vusers have arrived at the rendezvous
point.

Note: This option interferes with the scheduling of the test. If you select
this option, your test will not run as scheduled.

n X% of all running Vusers arrive at the rendezvous. Releases the
Vusers only when the specified percentage of all Vusers running in the test
have arrived at the rendezvous point.

n X Vusers arrive at the rendezvous. Releases the Vusers only when the
specified number of Vusers have arrived at the rendezvous point.

l Timeout between Vusers. The timeout value (in seconds). After each Vuser
arrives at the rendezvous point, the Controller waits up to themaximum timeout
period specified for the next Vuser to arrive. If the next Vuser does not arrive
within the timeout period, the Controller releases all the waiting Vusers from the
rendezvous. Each time a new Vuser arrives, the timer is reset to zero. You set a
timeout for each rendezvous point.

Test Options Dialog Box

This dialog box enables you to set general Scheduler and testing options.

To access 1. In the Performance Test Designer window, click Groups & Workload.

2. In the lower-right area of the Performance Test Designer window, click

.

Important
information

This is accessible only when theGroups & Workload view is displayed.

Relevant tasks l "How to Define a Schedule for the Performance Test" on page 177

l "How to Enable IP Spoofing in ALM" on page 227

See also "Performance Test WorkloadOverview" on page 127
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User interface elements are described below:

UI Elements Description

Enable
Scheduler

Enables the Scheduler so that you can run the test according to a user-defined
schedule. To define a schedule, this optionmust be selected.

l Stop test when Scheduler ends and Vusers are inactive. Automatically
stops the test when the test schedule has stopped and all the Vusers are in any
of the following inactive states: Down, Pass, Fail, Error, orStop.

l Start the Scheduler after a delay of HH:MM:SS. Enables you to specify
when, after the Run Test command has been issued, the Scheduler should start
running the schedule. If this option is not selected, the schedule starts to run as
soon as the test starts running.

l Wait for all groups to initialize. Instructs the Scheduler to wait until all the
Vusers in all the Vuser groups have finished initializing before starting to run any
of the groups.

Note: If you select this option, if any of the Vuser groups' Initialize action is
Initialize each Vuser just before it runs, the Scheduler automatically
changes this setting to Initialize all Vusers simultaneously.

l Pause Scheduler at test start. Pauses the Scheduler at the start of a test run,
enabling youmake changes to the test design just before the test is about to run.
You can then restart the Scheduler manually.

Enable IP
Spoofer

After you definemultiple IP addresses, and before you run the test, select this option
to enable IP spoofing.

Note: Youmust enable IP spoofing before running a test.

For details about multiple IP addressing, see "Multiple IP Addresses" on page 226.

Set
maximum
number of
concurrent
Vusers

Themaximum number of concurrent Vusers allowed for this test.
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Integrating Virtualized Services Overview
As part of your performance test, youmay want to test applications that depend on other services
which are a part of your business scenario. Instead of loading actual services, you can use simulated
services in your test run. The virtualized services are a simulation of actual services.

To facilitate performance testing business processes that contain services that are not available,
Performance Center integrates with HP Service Virtualization.

Using simulated services in your test is helpful if using actual services involves an additional cost or
requires the service of an application that is under development or inaccessible at the time when you
run your performance test.

Example

Your business process might include a service that is in development or incurs a cost, such as
processing a credit card through a third-party vendor. By using a virtual service, you can replace
actual services with simulated services that mirror both the datamodel and the performance
model.

For details on creating projects that contain virtualized services, see theHP Service Virtualization User
Guide.
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The workflow below explains how HP Service Virtualization integrates with Performance Center
processes:

For task details, see "How to Add Virtualized Services to Performance Tests" on page 152.

This section includes: 

l "Service VirtualizationMonitoring" on the next page

l "Service Virtualization Locking" on page 152
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Service Virtualization Monitoring

The HP Service Virtualizationmonitors enable you to analyze the status and performance of the
simulated services during the performance test run. For example, youmay integrate a payment
process service containing the following operations into your script:

Type Example Name Example Description

Service CreditServ Process online credit card payments

Operation CreditServ.PurchaseRequest Cardholder requests product/service

Operation CreditServ.AuthorizationRequest Merchant request authorization for payment

Operation CreditServ.AuthorizationApproval Credit card company authorizes or denies payment

The onlinemonitors measure the overall behavior of the service and each operation. The flowchart
illustrates using a service and operations for credit card payment.

In addition to the Run-Timemonitor graphs available in Performance Center, the following graph(s) are
useful for working with and analyzing service virtualization integration.

You can view the following Run-Timemonitor graphs during a test run:

l "Operations Graph" on page 386

l "Services Graph" on page 387
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Service Virtualization Locking

When your performance test contains virtualized services, those services are automatically locked and
cannot be used by other users while the test is running. Virtualized services may be locked by you or
other users for editing, simulation, deployment.

l If your test includes a service that has been locked by another user, start run will fail and an error
message will appear in the ALM Test Runs module's event log for the specific run.

l If your test is running and you update the test to include a service that has been locked by another
user, the test will continuing running, however an error message will appear in the Online Screen's
Messages tab as an error. There will also be an error notification in the Summary.

How to Add Virtualized Services to Performance Tests
The task describes how to configure virtual services to run when designing a performance test.

This task includes the following steps: 

l "Prerequisites " below

l "Configure service virtualization" below

l "Add projects and services" on the next page

l "Select the services to simulate" on the next page

l "Check service deployment" on the next page

l "Enter credentials for monitoring the SV server" on the next page

1. Prerequisites
n Create your virtualized services in HP Service Virtualization Designer. For details on creating

projects that contain virtualized services, see theHP Service Virtualization User Guide.

n In VuGen, create or record a script. Upload the script either from VuGen or from within
Performance Center. For details on uploading VuGen scripts to Performance Center, see "How
to Upload VuGen Scripts" on page 42.

2. Configure service virtualization
Open Performance Test Designer. In theGroups & Workload view, select Advanced > Service
Virtualization. The HP Service Virtualization dialog box opens.

This dialog box enables you to add projects, remove projects, and check the deployment of
services. For user interface details, see "HP Service Virtualization Dialog Box" on page 154.
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3. Add projects and services
To add projects and their corresponding services, click Add Project and search and select for the
relevant project containing the simulated services you want to run with your performance test. For
user interface details, see "Add Project Dialog Box" on page 156.

4. Select the services to simulate

Expand a project. Check theSimulate checkbox of each virtualized service you want to run,
and provide the relevant datamodel and performancemodel information.

5. Check service deployment
Click theCheck Deployment button to determine if the services are deployed correctly on the
SV server specified in the URL. Under Messages, click More Details. The Deployment Check
Results dialog box opens. For user interface details, see "Deployment Check Results Dialog Box"
on page 157.

indicates that the service is deployed on the specified server.

indicates that the service is not deployed on the specified server.

Note: The virtualized servicemust be deployed on the simulation server to be able to
configure the service and run it as part of your performance test in Performance Center.

6. Enter credentials formonitoring the SV server
Click theServer Credentials button to enter the credentials for monitoring the SV server in the
Server Credentials dialog box. For user interface details, see "Server Credentials Dialog Box" on
page 158.

Integrating Virtualized Services User Interface
This section includes:

HP Service Virtualization Dialog Box 154

Add Project Dialog Box 156

Deployment Check Results Dialog Box 157

Server Credentials Dialog Box 158
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HP Service Virtualization Dialog Box

This dialog box provides integration with HP Service Virtualization designer. This integration allows you
to test services with virtualized services instead of real-time services.

To access Open Performance Test Designer. In theGroups & Workload view, select
Advanced > Service Virtualization.

Important
information

If youmake changes to the services virtualization configuration during run time, both
the original andmodified configurations are saved in thewlrun.log file on the Load
Testing Server (LTS)machine.

For developers: Pointing calls to virtual services in the application under test cover
twomajor scenarios:

1. Application components that use the service are embedded in the code or in a
configuration file. In this case, you will need to update the code in the application
under test or update the configuration file to point to the new URL.

Examples

.NET Desktop application uses a web service, and the url is set using a
constant: stringURL = http://hp.com

Service or back end component uses the web service and the URL is
configured in the app.config file.

2. Service is consumed by accessing UDDI or some other registry component
(Systinet) and the URL is retrieved at run-time. In this case, you will need to
update the end point URL in UDDI/Systinet.

Relevant
tasks

"How to Add Virtualized Services to Performance Tests" on page 152

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Element Description

Add Project Opens the Add Project dialog box, allowing you to specify or browse for a HP Service
Virtualization project. Project files have a .zip or .vproj extension. For user interface
details, see "Add Project Dialog Box" on page 156.
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Delete
Project

Removes the selected project and its services from the list.

Note: Performance tests that are currently running the virtualized services in the
deleted project keep running the virtualized services; Deleting the project
unlocks the corresponding services so others can edit them.

Check
Deployment

Checks if the virtual service was deployed (started) on the virtualization server
specified inServer URL. For user interface details, see "Deployment Check Results
Dialog Box" on page 157.

Server
Credentials

Opens the Server Credentials dialog box, which enables you to configure SV server
credentials used for monitoring the SV servers and virtual services deployed on
them. Credentials include server login and password. For user interface details, see
"Server Credentials Dialog Box" on page 158.

Project
Name

The name of the HP Service Virtualization project containing the virtual service.

Simulation
Server

The address of the SV server on which the selected service is deployed.

Formats:

http:<server>:6080/management - for standalone SV servers

http:<server>:7080/management - for embedded SV servers (available only if
the SV Designer is open)

Deployed An indicator showing the deployment status of the project:

l . Click theCheck Deployment button to check the status.

l . Successfully deployed.

l . Unsuccessfully deployed.
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<virtualized
services>

A list of the virtualized services showing the following information:

l Simulate. When checked, includes the virtual service when executing the
performance test. When cleared, the service switches to pass-throughmode by
the test.

l Service Name. The name of the virtual service to use during performance test
execution.

l Data Model. The datamodel to associate with the virtual service.

l Performance Model. The performancemodel to associate with the virtual
service.

l Deployed. An indicator showing the deployment status of the virtual service:

n . Click theDeploy Check button to check the status.

n . Successfully deployed.

n . Unsuccessfully deployed.

Messages Displays messages about the virtual services, such as:

Last Deployment Check. Date on which the last deployment check occurred.

More details. Opens the Deployment Check Results dialog box, enabling you to
determine if the services are deployed correctly on the SV server specified in the
URL. For user interface details, see "Deployment Check Results Dialog Box" on the
next page.

Add Project Dialog Box

This dialog box enables you to add projects that contain virtualized services to your performance test.

To access In the Services Virtualization dialog box, click Add Project.

Relevant tasks "How to Add Virtualized Services to Performance Tests" on page 152

See also l "Integrating Virtualized Services Overview" on page 149

l "HP Service Virtualization Dialog Box" on page 154

User interface elements are described below:

UI Element Description
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Select Project
File

Name of the project file. Project files have a .zip or a .vproj extension.

Select Enables you to browse for, and select, a project.

Note: If the project file is password protected, enter password in the
Password Required dialog box.

Remove Removes a selected a project file.

Messages Displays messages about the project file, such as error messages.

Deployment Check Results Dialog Box

This dialog box enables you to check if the projects and their virtualized services are deployed on the
server at the specified URL address.

To access In the HP Services Virtualization dialog box, click Check Deployment. Under
Messages, click More details.

Important
information

The deployment check verifies that a service with the same ID exists on the
specified server.

Relevant tasks "How to Add Virtualized Services to Performance Tests" on page 152

See also l "Integrating Virtualized Services Overview" on page 149

l "HP Service Virtualization Dialog Box" on page 154

User interface elements are described below:

UI Element Description

Deployed Indicates whether the virtualization service is deployed correctly on the specified
server.

l Status is unknown. Click Deploy Check to check the status.

l Successfully deployed.

l Unsuccessfully deployed.

Project
Name

Displays the name of the project containing the virtualization service.

Service
name

Displays the name of the virtualization service.
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Check
details

Displays the results of the check.

Server Credentials Dialog Box

This dialog box enables you to configure login information for the SV server.

To access In the HP Services Virtualization dialog box, click theServer Credentials button .

Important
information

This dialog box only lists the servers that are defined in the HP Services
Virtualization dialog box's Simulation Server column.

Relevant
tasks

"How to Add Virtualized Services to Performance Tests" on page 152

See also l "Integrating Virtualized Services Overview" on page 149

l "HP Service Virtualization Dialog Box" on page 154

User interface elements are described below:

UI
Element Description

Server Url Displays the URL for the server.

User Displays the user name for the server. To edit, click the URL to display theUser and
Password text boxes.

Example

Password Displays the password for the server. To edit, click the server URL to display theUser
andPassword text boxes.
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Load Generator Distribution Overview
Load generators are Performance Center hosts on which Vusers run during a test run.

This section includes:

l "LoadGenerator Types" below

l "LoadGenerator DistributionMethods" below

l "LoadGenerator Attribute Customization" on the next page

Load Generator Types
There are two types of load generators:

Type Description

Specific
load
generator

An actual load generator. For example, machine host1, located in London.

Automatch
load
generator

A load generator placeholder, for example LG1. When you assign an automatch load
generator to a Vuser group, you are not assigning a specific load generator to the
group, but rather a placeholder for a load generator with specific properties. At runtime,
specific load generators in the host pool of the project that have the same properties as
the automatch load generators, are allocated in place of the automatch load
generators.

Load Generator Distribution Methods
When you design a performance test, you specify how to distribute load generators among the Vuser
groups participating in the test. You can automatically assign all load generators to each Vuser group,
or you canmanually select which load generators to assign to which group.

Use the followingmethods to distribute load generators:

Method Description

Automatic
load
generator
distribution

When you select the automatic load generator distributionmethod, during the test
design phase all of the automatch load generators in the test are distributed to all
of the participating Vuser groups.

At runtime, specific load generators in the project's host pool that have the same
properties as the automatch load generators, are allocated in place of the automatch
load generators.
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Method Description

Manual
Load
Generator
Distribution

Using themanual distributionmethod, you can assign specific load generators to
Vuser groups.

If you are not particular about which load generators should be used for the test, you
can assign automatch load generators to the groups. At the initialization stage of the
test run, the automatch load generators are automatically replaced with specific load
generators from the project's host pool that match the automatch load generators'
properties.

Manual distribution enables you to distribute your load generators among Vuser
groups, without overloading any one load generator.

Load Generator Attribute Customization
You can customize load generator attributes. For details about how to customize host attributes, see
theHP Application Lifecycle Management Administrator Guide.

When customizing load generator attributes, consider the following:

l Create attributes that represent properties about your hosts that will help tell one host apart from
another host when using them for performance testing.

l Because you can select multiple attributes for your host, you can define an unlimited number of host
attributes. They do not need to be related.

l Host attributes can refer to anything. For example, Host Memory - High, Spanish environment,
Very slow machine.

How to Distribute Load Generators Among Vuser Groups
This task describes how to distribute load generators automatically andmanually among Vuser groups
participating in the performance test.

Note: This task is part of a higher-level task. For details, see "How to Define a Performance Test
Workload" on page 128.

To learnmore about load generator distribution, see "LoadGenerator Distribution Overview" on the
previous page.

This task includes the following steps:

l "Prerequisites" on the next page

l "Select a load generator distributionmethod" on the next page
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l "Specify the load generators to use in the test" below

l "Select properties for the automatch load generators - optional" below

1. Prerequisites
Add Vuser groups to participate in the test. For details, see "How to Define a Performance Test
Workload" on page 128 on "How to Define a Performance Test Workload" on page 128.

2. Select a load generator distributionmethod
In the Performance Test Designer window, click Groups & Workload. On theGroups pane
toolbar, in the LG Distribution box, select one of the following options:

n Assign all to each group. Assigns all the load generators automatically to each Vuser group.

n Assign manually. Enables you to assign load generators manually to the Vuser groups.

3. Specify the load generators to use in the test
n If you selectedAssign all to each group above, the LG box is displayed to the right of the LG

Distribution box.

Type the number of load generators to use in the test and press ENTER. The automatch load
generators are distributed to each of the Vuser groups and are displayed in the Load
Generators column.

n If you selectedAssign manually above:

o To select the same load generators for multiple groups at once, click theAssign Load

Generators to Multiple Groups button. In the dialog box that opens, select
automatch and/or specific load generators to multiple groups

Similarly, you can remove load generators that have been assigned to the groups.

For user interface details, see "Assign LoadGenerators to Multiple Groups Dialog Box" on
page 165.

o To select load generators for a specific group only, you can use the link that appears in the
Load Generators column of a selected group. Click the link and select automatch and/or
specific load generators to assign to the group.

For user interface details, see "Select LoadGenerators Dialog Box " on page 168.

4. Select properties for the automatch load generators - optional
You can select properties for the automatch load generators that are assigned to Vuser groups in
your test. Properties include a location and other attributes. At runtime, each automatch load
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generator is matched up with an available specific load generator (in the host pool of the project)
with the same properties.

To select properties for automatch load generators, click theConfigure Automatch Load

Generator Properties button, select one or more automatch load generators, and enter a
location and/or attributes.

For user interface details, see "Automatch LoadGenerators Properties Dialog Box" on page 171.

Note: If no properties are specified, the automatch load generator is matched up with any load
generator in the project's host pool.

Load Generators User Interface
This section includes:

Assign LoadGenerators to Multiple Groups Dialog Box 165

Select LoadGenerators Dialog Box 168

Automatch LoadGenerators Properties Dialog Box 171
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Assign Load Generators to Multiple Groups Dialog Box

This dialog box enables you to assign one or more load generators—automatch or specific—tomultiple
Vuser groups at once. You can also use this dialog box to remove one or more load generators from
multiple Vuser groups at once.

To access 1. In the Performance Test Designer window, click Groups & Workload.

2. From the LG Distribution drop-down list, select Assign manually.

3. Click Assign Load Generators to Multiple Groups .

Important
information

This dialog box is available only when using themanual load generator
distributionmethod.

Relevant tasks l "How to Define a Performance Test Workload" on page 128

l "How to Distribute LoadGenerators Among Vuser Groups" on page 162

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Enables you to addmore automatch load generators for the test. Enter the
number of load generators in the adjacent box and click Add LGs.

Assigns the selected load generators to the selected Vuser groups.

Removes the selected load generators from the selected Vuser groups.
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UI Elements Description

Automatch tab Enables you to select automatch load generators to assign to Vuser groups
in the test, or to remove assigned automatch load generators from the Vuser
groups.

l Name. The name of the automatch load generator. By default, these are
named LG1, LG2, and so on.

l Properties. The properties by which the automatch load generator is
matched up with a specific load generator in the host pool of the project at
runtime.

Any is displayed by default. This means that the automatch load
generator can bematched up with any load generator in the project's host
pool at runtime.

To specify properties for an automatch load generator, click the
corresponding link in this column to open the Automatch LoadGenerator
Properties dialog box. For details, see "Automatch LoadGenerators
Properties Dialog Box" on page 171.

Tip: To select all the load generators in the list, select the check box in
the check box column heading.
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UI Elements Description

Specific tab Enables you to select load generators from the project's host pool to assign
to the Vuser groups in the test, or to remove them from the Vuser groups.

l <filter>. Enables you to filter the information being displayed in grid.

l Name. The name of the load generator.

l State. The state of the load generator: Operational; Non-operational;
Unavailable

Note: Assigned load generators must be operational during runtime.

l Location. The location of the load generator.

l Purpose. The purpose of the load generator. Controller, Load
Generator, Data Processor, or a combination of these.

n Only the hosts in the pool with at least a Load Generator
purpose are displayed.

n QuickTest tests (UFT GUI Tests) cannot run on a load generator
that has been selected as the Controller of the performance test.

n If a load generator is marked with an asterisk (*), this indicates
that the load generator host has been selected as the Controller.
It is recommended not to use a Controller host as a load generator
as well.

Tip: To select all the load generators in the list, select the check box in
the check box column heading.

<Select Load
Generators pane>

Enables you to select load generators to assign to the Vuser groups in the
test, or to remove them from the Vuser groups.

l Click theAutomatch tab to select automatch load generators.

l Click theSpecific tab to select specific load generators.
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UI Elements Description

Select Groups pane Enables you to select the Vuser groups to which the selected load
generators are to be assigned, or from which they are to be removed.

l Name. The name of the Vuser group.

l Assigned Load Generators. The load generators currently assigned to
the Vuser group.

Tip: To select all the Vuser groups, select the check box in the check
box column heading.

Select Load Generators Dialog Box

This dialog box enables you to assign one or more load generators—automatch or specific—to a Vuser
group.

To access 1. In the Performance Test Designer window, click Groups & Workload.

2. From the LG Distribution drop-down list, select Assign manually.

3. Select a Vuser group in the Groups pane and click the link in the Load
Generators column.

Important
information

This dialog box is available only when using themanual load generator
distributionmethod.

Relevant tasks l "How to Define a Performance Test Workload" on page 128

l "How to Distribute LoadGenerators Among Vuser Groups" on page 162

l "How to Create a Terminal Session" on page 219

See also "LoadGenerator Distribution Overview" on page 161

User interface elements are described below:

UI Elements Description

Enables you to addmore automatch load generators for the test. Enter the
number of load generators in the adjacent box and click Add LGs.

Available from:Automatch tab only
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UI Elements Description

Terminal Services. Enables you to configure terminal services sessions on
the selected load generator. For details, see "Configuring Terminal
Sessions" on page 218.

Available: For load generators

Automatch tab Enables you to select automatch load generators to assign to the selected
Vuser group.

l Name. The name of the automatch load generator. By default, these are
named LG1, LG2, and so on.

l Properties. The properties by which the automatch load generator is
matched up with a specific load generator at runtime.

Any is displayed by default. This means that the automatch load
generator can bematched up with any load generator at runtime. To
specify properties for a particular automatch load generator, click the
correspondingAny link in the Properties column to open the Automatch
LoadGenerator Properties dialog box. For details, see "Automatch Load
Generators Properties Dialog Box" on page 171.

l Virtual Locations. The name of the virtual location. Click theSelect
virtual location link to open the Select Virtual Location dialog box.

Tip: To select all the load generators in the list, select the check box in
the check box column heading.
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UI Elements Description

Specific tab Enables you to assign load generators from the host pool of the project to the
selected Vuser group.

l <filter>. Enables you to filter the information being displayed in grid.

l Name. The name of the load generator.

l State. The state of the load generator: Operational, Non-operational,
Unavailable.

Note: Assigned load generators must be operational during runtime.

l Location. The location of the load generator.

l Virtual Locations. The name of the virtual location. Click theSelect
virtual location link to open the Select Virtual Location dialog box.

l Purpose. The purpose of the load generator, that is, Controller, Load
Generator, Data Processor, or a combination of these.

n Only the hosts in the pool with at least a Load Generator
purpose are displayed.

n You can runQuickTest tests (UFT GUI Tests) only on load
generators that are not also assigned as the Controller for the
performance test.

n If a load generator is marked with an asterisk (*), this indicates
that the load generator host has been selected as the Controller.
It is recommended not to use a Controller host as a load generator
as well.

Tip: To select all the load generators in the list, select the check box in
the check box column heading.
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Automatch Load Generators Properties Dialog Box

This dialog box enables you to define properties for an automatch load generator. Properties include a
location, and other host attributes. At runtime, a specific load generator in the host pool of the project
matching these properties is assigned to the Vuser group.

To access 1. On theMy Performance Center navigation bar, select Test Management >
Test Plan.

2. Select a performance test in the test plan tree and click Edit Test.

3. In the Performance Test Designer window, click Groups & Workload.

4. On theGroups pane tool bar, click Configure Automatch Load Generators

Properties .

Relevant
tasks

l "How to Distribute LoadGenerators Among Vuser Groups" on page 162

l "How to Create a Terminal Session" on page 219

User interface elements are described below:

UI Elements Description

Enables you to add additional automatch load generators for the test.

Available:When theAssign Manually load generator distributionmethod is
selected.

Enables you to configure terminal services sessions on the selected load
generator. For details, see "Configuring Terminal Sessions" on page 218.

Available:When theAssign Manually load generator distributionmethod is
selected.

Load Generators
pane

Lists the available automatch load generators.

Location Select a load generator location for the selected load generators.
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UI Elements Description

Host Attributes Select attributes for the selected load generators.

Tip: The list of attributes can be customized. For details, see "Load
Generator Distribution Overview" on page 161.

Example:

Youwant a Vuser group to use a load generator that is located in London
and has medium strength andmemory. Under Location, select
London, and in theHost Attributes list, select Host memory:
Medium andHost strength: Medium. At runtime, the system tries to
assign a specific load generator with these properties to the Vuser
group.

Virtual Location Select a load generator virtual location for the selected load generators.

Available:Whenworking with HP Network Virtualization and using the
Assign All to Each Group load generator distributionmethod.

For more details on working with HP Network Virtualization, see "How to
Integrate Network Virtualization into a Performance Test" on page 292.
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Scheduling Performance Tests Overview
You use the Scheduler to create a schedule that distributes load in a performance test in a controlled
manner.

Using the Scheduler, you can:

l Set the time at which the test should begin running, and specify how long the Scheduler should wait
after the Run Test command is issued, and before running Vusers.

l Stipulate:

n How to initialize the Vusers in the test

n How many Vusers to start/stop within a given time period

n How often to start running the Vusers—simultaneously or gradually

For details, see "Global Scheduler Actions" on page 184.

l Limit the run duration of the Vusers or Vuser groups within the test by specifying the amount of time
the Vusers or Vuser groups should be in the running state.

l Set a test to run according to the runtime settings defined for the enabled Vuser groups, or set the
Vuser groups to run over and over again until the schedule settings instruct them to stop running.

To define a performance test schedule, see "How to Define a Schedule for the Performance Test" on
page 177.

This section also includes:

l "Types of Test Schedules " below

l "Schedule RunModes" on the next page

Types of Test Schedules
When you design a performance test, you can define a schedule according to which the participating
Vuser groups should run in the test.

You can schedule all the groups to run together on one schedule, or you can define a separate schedule
for each Vuser group.

Scheduling By Test

When you schedule by test, all the Vuser groups participate in the test run simultaneously. That is, the
schedule is applied to all the Vuser groups concurrently, and each action is applied proportionally to all
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the Vusers groups.

For example, take a test that includes three participating Vuser groups as follows:

Group Name Number of Vusers

Group1 10

Group2 20

Group3 30

Total 60

When scheduling by test, if the scheduler instructs 30 Vusers to start running when it starts the test
run, a proportional number of Vusers starts running from each group as follows:

Group Name Number of Vusers

Group1 5

Group2 10

Group3 15

Total 30

Note: The same principle applies when the test is in percentagemode.

Scheduling By Vuser Group

Note: For tests in Vuser group (number) mode only.

When you schedule by Vuser group, each Vuser group participating in the test runs on its own
separate schedule. That is, for each Vuser group, you can specify when to start running the Vuser
group, how many Vusers in the group to start and stop running within specified time intervals, and how
long the group should continue running.

Group schedules can run separately, or all at the same time.

Schedule RunModes
You can schedule a test to run according to the run-time settings defined for the Vuser groups, or you
can let the groups run over and over again until the test schedule instructs them to stop running.
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You can schedule a test to run in one of the following runmodes:

l Real-world run mode. The test runs according to a user-defined group of actions that simulate a
real-world schedule of events. Vuser groups run according to the iterations defined in their run-time
settings, but you can define how many Vusers to run at a time, how long Vusers should continue to
run, and how many Vusers to stop running at a time.

l Basic run mode. All enabled Vuser groups run together on one schedule, each according to its
own run-time settings. You can schedule how many Vusers to start running at a time, and how long
they should run before stopping.

The following table illustrates how the given schedule types run in real-world versus basic runmode:

Schedule
by Run Mode - Real World Run Mode - Basic

Test All participating Vuser groups run
together on one schedule. The test runs
according to a user-defined group of
actions that emulates a true-to-life
schedule of events. You can schedule
Vusers to start and stop running
numerous times during the test, and
specify how long to keep them in their
running or stopped state.

All participating Vuser groups run together
on one schedule, each according to its own
run-time settings. You schedule when to
start running all the Vusers, specify how
long they should run, and then specify how
to stop running all the Vusers.

Group

(Not
applicable
when the
test is in
Percentage
mode)

Each participating Vuser group runs
according to its own defined schedule
that emulates a true-to-life schedule of
events for that Vuser group. You can
schedule Vusers in the groups to start
and stop running numerous times during
the test, and specify how long to keep
them in their running or stopped state.

Each participating Vuser group runs
according to its own schedule, each
according to its own run-time settings. For
each Vuser group, you schedule when to
start running the Vuser group, how to start
running all the Vusers in the group, specify
how long the Vusers should run, and then
specify how to stop running all the Vusers
in the group.

How to Define a Schedule for the Performance Test
This task describes how to define a schedule for a performance test.

Note: This task is part of a higher-level task. For details, see "How to Define a Performance Test
Workload" on page 128.

This task includes the following steps:
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l "Prerequisites" below

l "Define a set of scheduler actions" below

l "Group schedules only: Copy a Vuser group's scheduler settings to other groups - optional" below

l "Schedule a start time for the test - optional" on the next page

1. Prerequisites
n OpenPerformance Test Designer > Groups & Workload, under theGroups section, make

sure the test contains scripts.

n The Scheduler must be enabled. Click theOptions button located at the bottom of the Groups
& Workload view. In the Test Options dialog box, ensure that Enable Scheduler is selected.
For user interface details, see "Test Options Dialog Box" on page 146.

2. Define a set of scheduler actions
TheGlobal Schedule grid displays the default scheduler actions that correspond to the workload
type selected in theWorkload type box.

In real-world schedules, you can addmore scheduler actions, and edit or delete existing actions.

In basic schedules, you can edit the existing scheduler actions.

n For details about the scheduler actions, see "Global Scheduler Actions" on page 184.

n For details about how to add actions (real-world schedules only), see "How to Add Actions to a
Test Schedule" on the next page.

n For details about how to edit actions, see "How to Edit Scheduler Actions" on page 181.

3. Group schedules only: Copy a Vuser group's scheduler settings to other groups -
optional
When scheduling by Vuser group, you can copy a Vuser group's scheduler settings to other
Vuser groups.

Note:

n Scheduler settings copied include the scheduler runmode (basic or real-world) and the set
of defined scheduler actions.

n This option is disabled for global schedules.
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a. On theGroups grid toolbar, click theDuplicate Scheduler Settings button.

b. Select the source group whose settings you want to copy, and select one or more target
groups.

c. Click Apply. The source group's scheduler settings are copied to the target groups.

4. Schedule a start time for the test - optional
Click theOptions button located at the bottom of the Groups & Workload view. Select Start the
Scheduler after a Delay of, and enter the amount of time after which to start running the test.

How to Add Actions to a Test Schedule
This task describes how to add actions to a real-world test schedule.

Note: You can add actions to a real-world schedule only.

This task includes the following steps:

l "Add an action to the schedule from theGlobal Scheduler grid" below

l "Add an action by splitting one action into two actions" on the next page

Add an action to the schedule from the Global Scheduler grid

Note: A new action is always added after the action selected in the Global scheduler grid.

1. In the Global scheduler grid, select an action after which to insert the new action, and click the
New scheduler action button's down arrow.

2. Select the type of action to add.

Note: You can add aStart Vusers, Stop Vusers, orDuration action. For details about each
type of action, see "Global Scheduler Actions" on page 184.

3. In theProperties column, specify the action's properties.

n If you are adding a Start Vusers or Stop Vusers action, enter the number of Vusers to start/stop
running, and select how to start/stop running the Vusers: simultaneously or gradually.

If you selected gradually, enter the number of Vusers to start/stop at a time, and a time interval.
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n If you are adding a Duration action, select how long to run the action.

Click Apply change to save the action settings.

4. When you have finished adding actions to the schedule, click Save at the bottom of theWorkload
tab.

Note: If you navigate away from the Performance Test Designer window without clicking
Save, changes applied to the schedule are not saved.

Add an action by splitting one action into two actions
You can addStart Vusers, Duration, andStop Vusers actions from theGlobal Scheduler grid or from
the graph by splitting an action into two halves of the original action.

To split an action in two:

1. Select the action in the grid, or the line in the graph that represents the action that you want to split.

Tip: Selecting the action in the Global Scheduler grid highlights the corresponding line in the
graph.

2. Click theSplit selected action button . The selected action/line splits in two. In the Global
scheduler grid, the original action splits into two equivalent actions, each representing half of the
original action.

Example

n Splitting a Duration action of 5 minutes results in two Duration actions of 2.5 minutes each.

n Splitting a Start Vusers action that starts 20 Vusers results in two Start Vusers actions,
each starting 10 Vusers.

3. (Optional) Edit each of the actions. For details, see "How to Edit Scheduler Actions" on the next
page.
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How to Edit Scheduler Actions
This task describes how to edit scheduler actions. You can edit all types of actions. For details about
each action type, see "Global Scheduler Actions" on page 184.

To edit a scheduler action:

1. In the Actions grid, select the action that you want to edit. TheProperties column becomes
editable.

2. Modify the action settings and click Apply change .

3. When you have finished editing the actions, click Save.

Note: If you navigate away from the Performance Test Designer window without clicking
Save, changes applied to the schedule are not saved.

Scheduling Performance Tests User Interface
This section includes:

Global Scheduler Pane 182

Global Scheduler Actions 184
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Global Scheduler Pane

This pane enables you to define a schedule for running your performance test.

To access In the Performance Test Designer window, click Groups & Workload.

Important
information

If scripts in your test contain rendezvous points, the test will not run as scheduled
because the rendezvous points interfere with the schedule. For details, see
"Rendezvous Points" on page 127.

Relevant
tasks

"How to Define a Schedule for the Performance Test" on page 177

See also l "Scheduling Performance Tests Overview" on page 175

l "Global Scheduler Actions" on page 184

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

New scheduler action. Enables you to add an action to the test schedule. The
new action is added after the action selected in the grid.

You can add Start Vuser, Duration, and Stop Vuser actions only. For details, see
"Global Scheduler Actions" on page 184.

Available from:Real-world schedule only

Delete selected action. Deletes the selected action.

Split selected action. Splits the selected action into two identical halves of the
original action.

Apply change. Enables you to apply modifications made to the actions in the
schedule graph.
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UI Elements Description

Hide/Show Legend. Hides/Shows the graph legend.

Note for group schedules only:When the legend is showing, the group selected
in the grid's title bar is read-only in the legend.

To view/hide one or more of the other Vuser groups, select/clear the check boxes
next to the Vuser groups respectively.

Scheduled
Vusers

Displays a total of the Vusers scheduled to run in the test.

Note:

l When the test is in numbermode and you are defining a basic schedule,
the number of scheduled Vusers is updated when youmodify the number
of Vusers in the Vuser groups. You can change the number of Vusers in a
selected group:

n In the Groups grid:Select the group and change the number of Vusers

n In the Global Scheduler grid:Select the group in the grid's title bar and
change the number of Vusers in theStart Vusers action.

l In real-world schedules, the total number of Vusers is the sum of all the
Vusers defined in the Start Vusers actions.

<Global
Scheduler
grid>

Lists the scheduled actions. Initially the grid displays default actions that
correspond to the schedule type you selected for your workload. For details, see
"Workload Types Dialog Box" on page 141.

For all schedules, some of the actions can bemodified.

In real-world schedules, you can also add and delete actions, enabling you to
simulate amore true-to-life schedule by which to run your test.

<Schedule
graph>

Provides a graphical representation of the actions listed in the Global Scheduler
grid.

In real-world schedules, you can add new actions from the graph by splitting an
action into two identical halves.

<Title bar> Displays the type of schedule and the number of scheduled Vusers, depending in
the type of workload is selected for the test:

l Global Schedule. Displayed when the schedule is a schedule by test.

l Group Schedule for <group>. Displayed for group schedules. Displays the
name of the group whose schedule is displayed in the Global Scheduler grid.

Messages Displays alert messages.
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Global Scheduler Actions

A performance test schedule contains a sequence of actions that instruct the test when to start running
a Vuser group, how to initialize Vusers, when to start and stop running Vusers, and how long to run an
action.

The following sections describe the available scheduler actions.

l "Start Group" below

l "Initialize " on the next page

l "Start Vusers" on the next page

l "Duration" on page 186

l "Stop Vusers" on page 187

Start Group
The Start Group action defines when to start running a Vuser group. By default, theStart Group action
appears as the first action in the Global Scheduler grid when you select a workload of type: by group.

Options Description

Start
immediately

The Scheduler starts running the selected Vuser group as soon as the test starts
running.

Resulting action: Start immediately after the test begins.

Start with
delay

After the test starts running, the Scheduler waits the specified time (in hours,
minutes, and seconds) before it starts running the selected Vuser group.

Resulting action: Start (HH:MM:SS) after the test begins.

Start when
group

The Scheduler starts running the selected Vuser group immediately after the Vuser
group specified in this option has finished running.

Resulting action: Start when group <group name> finishes.

Note:

l TheStart Group action is available for group schedules only.

l TheStart Group action is always followed by the Initialize action.

l TheStart Group action cannot be deleted.
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Initialize
The Initialize action instructs the Scheduler to prepare the Vusers so that they are in theReady state
and can run. By default, the Initialize action appears in the Global Scheduler grid for all types of
schedules.

Options Description

Initialize all
Vusers
simultaneously

The Scheduler initializes all the Vusers in the test or selected Vuser group
together, and waits the specified amount of time before running them.

Resulting action:
Initialize all Vusers simultaneously
Wait for <00:00:00> (HH:MM:SS) after initialization

Initialize
gradually

The Scheduler initializes the specified number of Vusers gradually, according to
the specified time interval (in hours, minutes, and seconds), and waits the
specified amount of time before running them.

Resulting action:
Initialize <X> Vusers every (HH:MM:SS)
Wait for (HH:MM:SS) after initialization.

Initialize each
Vuser just
before it runs

The Scheduler initializes each Vuser in the test or selected Vuser group just
before it starts running.

Resulting action: Initialize each Vuser just before it runs.

Note: This option is not available for Group schedules whenWait for all groups
to initialize is selected. See "Wait for all groups to initialize" on "Test
Options Dialog Box" on page 146.

Note: The Initialize action cannot be deleted.

Start Vusers
The Start Vusers action instructs the Scheduler to start running the Vusers.

Options Description

Start All
Vusers:
Simultaneously

The Scheduler runs all the Vusers in the test simultaneously.

Start X Vusers:
gradually
Y Vusers: every
<hh:mm:ss>
(HH:MM:SS)

The Scheduler runs the specified number of Vusers (X) gradually. That is, the
Scheduler runs Y Vusers, and waits the specified time (in hours, minutes, and
seconds) before running another Y Vusers.

Resulting action: Start X Vusers: Y Vusers every <hh:mm:ss> (HH:MM:SS)
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Note:

l The Scheduler starts running Vusers only when they have reached theReady state.

l In a basic schedule, the Scheduler always runs all the Vusers, whether simultaneously or
gradually. In a real-world schedule, you can select how many Vusers to start running at a time.

l While a test is running, you can add Vuser groups/scripts to the test and enable them. When
starting the Vusers gradually, if you add a Vuser group after all the Vusers in the test have
started running, the new group will start running immediately.

Duration
The Duration action instructs the Scheduler to continue running the test in the current state, for the
specified amount of time.

Options Description

Run until
complete

The test runs until all the Vusers have finished running.

Resulting action: Run until completion

Run for The test runs in its current state for the specified amount of time (in days, hours,
minutes, and seconds) before continuing with the next action.

Default: 5 minutes

Maximum definable duration period: 99.23:59:59 dd.HH:MM:SS.

Resulting action: Run for <dd.hh:mm:ss> (dd.HH:MM:SS)

Run
indefinitely

The test runs indefinitely.

Resulting action: Run indefinitely

Available for:Basic schedule only

Note:

l In a real-world schedule, if a Duration action is not followed by another action, the test
continues to run indefinitely.

l In a real-world schedule, to avoid unexpected behavior during the test run, add a Duration
action between consecutive Start Vusers and Stop Vusers actions.

l In a basic schedule, aRun forDuration action is always followed by a Stop Vuser action.
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Stop Vusers
The Stop Vusers action instructs the Scheduler to stop the running Vusers.

Options Description

Stop All
Vusers:
Simultaneously

The Scheduler stops all the running Vusers at once.

Stop All/X
Vuser:
gradually

The Scheduler stops the specified number of Vusers (All orX) gradually. That is,
the Scheduler stops Y Vusers, and waits the specified time (in hours, minutes,
and seconds) before stopping another Y Vusers.

Resulting action: Stop <X> Vuser: <Y> Vusers every <hh:mm:ss>
(HH:MM:SS)

Note:

l A basic schedule that has aRun forDuration action, is always followed by a Stop Vuser
action that stops all the Vusers, simultaneously or gradually.

l In a real-world schedule, to avoid unexpected behavior during the test run, add a Duration
action between consecutive Start Vusers and Stop Vusers actions.

l In a real-world schedule, if no action is specified after aRun forDuration action, the Vusers
continue to run indefinitely—that is, the schedule continues to run indefinitely.

l When scheduling by group, if Group A is scheduled to run indefinitely, andGroup B is
scheduled to run after Group A, thenGroup A must be stoppedmanually before Group B can
start running.
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Service Level Agreements Overview
Service level agreements (SLAs) are specific goals that you define for your performance test. After a
test run, HP LoadRunner Analysis compares these goals against performance related data that was
gathered and stored during the course of the run, and determines whether the SLA passed or failed.

Depending on themeasurements that you are evaluating for your goal, ALM determines the SLA status
in one of the following ways:

SLA Type Description

SLA status
determined at
time intervals
over a timeline

Analysis displays SLA statuses at set time intervals over a timeline within the
test run. At each time interval in the timeline—for example, every 10 seconds—
Analysis checks to see if themeasurement's performance deviated from the
threshold defined in the SLA.

Measurements that can be evaluated in this way:

l Average Transaction Response Time

l Errors per Second

SLA status
determined
over the whole
run

Analysis displays a single SLA status for the whole test run.

Measurements that can be evaluated in this way:

l Transaction Response Time - Percentile

l Total Hits per run

l Average Hits (hits/second) per run

l Total Throughput (bytes) per run

l Average Throughput (bytes/second) per run

Note:

l You can define and edit SLAs in ALM or in HP LoadRunner Analysis.

l For details about viewing post-run SLA statuses in ALM Performance Center, see "SLA
Report" on page 285.

l For details about viewing post-run SLA statuses in Analysis reports, see theHP LoadRunner
Analysis User Guide.
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Tracking Period

When you define service level agreements (SLAs) for measurements that are evaluated over a
timeline, Analysis determines SLA statuses at specified time intervals within that timeline. The
frequency of the time intervals is called the tracking period.

An internally-calculated tracking period is defined by default. You can change this tracking period by
defining a value which Analysis plugs into a built-in algorithm to calculate the tracking period. For
details, see "Tracking Period Dialog Box" on page 203.

How to Define Service Level Agreements
This task describes how to define service level agreements (SLAs).

You can define service level agreements (SLAs) whichmeasure performance test goals over time
intervals during a test run, or over a whole performance test run. To learnmore, see "Service Level
Agreements Overview" on the previous page and theHP LoadRunner Analysis User Guide.

Note: This task is part of a higher-level task. For details, see "How to Design a Performance Test"
on page 111.

Tip: For a use-case scenario related to this task, see "How to Define Service Level Agreements -
Use-Case Scenario" on the next page.

This task includes the following steps:

l "Prerequisites" below

l "Run through the SLA wizard" on the next page

l "Define a tracking period - optional" on the next page

l "Results" on the next page

1. Prerequisites
Create a performance test. For details, see "How to Design a Performance Test" on page 111.

Note: To define Average Transaction Response Time or Transaction Response Time
Percentile SLAs, your performance test must include a script that contains at least one
transaction.
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2. Run through the SLA wizard
In the Performance Test Designer, click Summary. In theService Level Agreement pane, click
New to open the Service Level Agreement wizard. For user interface details, see "Service Level
Agreement Wizard" on page 196.

a. Select ameasurement for the SLA.

b. If you are defining an SLA for Transaction Response Time (Average/ Percentile), select the
transactions to include in your goal.

c. (Optional)When evaluating SLA statuses over a timeline, select a load criterion to take into
account and define appropriate load value ranges for the load criterion.

d. Set thresholds for themeasurements.

o If the values of Transaction Response Time (Average/Percentile) orErrors per
Second exceed the defined thresholds, Analysis will produce a Failed SLA status.

o If the values of Total Hits, Average Hits per Second, Total Throughput, orAverage
Throughput are lower than the defined threshold, Analysis will produce a Failed SLA
status.

3. Define a tracking period - optional
Formeasurements whose SLA statuses are determined over time intervals, you need to define the
frequency of the time intervals, known as the tracking period. For details, see "Tracking Period"
on the previous page.

For user interface details, see "Tracking Period Dialog Box" on page 203.

4. Results
During post test run analysis, HP LoadRunner Analysis compares the data collected from the test
run against the settings defined in the SLAs, and determines SLA statuses which are included in
the default Summary Report and the SLA Report.

See also theHP LoadRunner Analysis User Guide.

How to Define Service Level Agreements - Use-Case
Scenario
This use-case scenario describes how to define a service level agreement (SLA) for Average
Transaction Response Time.

Note: For a task related to this scenario, see "How to Define Service Level Agreements" on the
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previous page.

This use-case scenario includes the following steps:

l "Background" below

l "Start the SLA wizard" below

l "Select themeasurement for the SLA" below

l "Select the transactions to evaluate in your goal" below

l "Select a load criterion and define appropriate ranges of load - optional" below

l "Set thresholds" on the next page

l "Define a tracking period - optional" on the next page

l "Results" on page 194

1. Background
The administrator of HP Web Tours would like to know when the average transaction response
time for booking a flight and searching for a flight exceeds a certain value. Assume that your
performance test includes a script that includes the following transactions: book_flight and
search_flight.

2. Start the SLA wizard
In the Service Level Agreement pane, click New to start the Service Level Agreement wizard.
Click Next.

3. Select the measurement for the SLA
On theMeasurement page, select Transaction Response Time, and from the drop-down list,
select Average.

4. Select the transactions to evaluate in your goal
On the Transactions page, select the transactions to be evaluated: book_flight and search_
flight.

5. Select a load criterion and define appropriate ranges of load - optional
On the Load criteria page, select the load criterion to take into account when evaluating the
average transaction response time.
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In this case, to see the effect that various quantities of Vusers running on the system has on the
average transaction response time of each transaction, in the Load Criterion box, select
Running Vusers.

Then set the value ranges for the running Vusers:

Consider less than 20 Vusers to be a light load, 20 – 50 Vusers an average load, and 50 Vusers or
more a heavy load. Enter these values in the Load Values boxes.

Note:

n You can set up to three in-between ranges.

n Valid load value ranges are consecutive—there are no gaps in the range—and span all
values from zero to infinity.

6. Set thresholds
On the Thresholds page, you define the acceptable average transaction response times for the
transactions, taking into account the defined load criterion.

In this case, define the same threshold values for both transactions as follows: for a light load, a
reasonable average response time can be up to 5 seconds, for an average load, up to 10 seconds,
and for a heavy load, up to 15 seconds.

Tip: To define the same thresholds for all the transactions, enter the values in the Apply to
all transactions boxes above the table, and click theApply to all button.

7. Define a tracking period - optional
When SLA statuses for ameasurement are determined at time intervals over a timeline, the
frequency of the time intervals is determined by the tracking period.

This step is optional because an internally-calculated tracking period of at least 5 seconds is
defined by default. You can change the tracking period in the Tracking Period dialog box:

a. In the Service Level Agreement pane, click the Tracking Period button.

b. Select Tracking period of at least X seconds, and select a tracking period. The time
intervals are calculated by Analysis according to a built-in algorithm and as a function of the
value you enter here.

Example:

If you select a tracking period of 10, and the aggregation granularity for the performance
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test (defined in Analysis) is 6, then the tracking period is set to the nearest multiple of 6
that is greater than or equal to 10, that is, Tracking Period = 12.

For details, see "Tracking Period" on page 190.

For user interface details, see "Tracking Period Dialog Box" on page 203.

8. Results
When analyzing your test run, Analysis applies your SLA settings to the default Summary Report
and the report is updated to include all the relevant SLA information.

For example, it displays the worst performing transactions in terms of defined SLAs, how specific
transactions performed over set time intervals, and overall SLA statuses.

For more information, see theHP LoadRunner Analysis User Guide.

Service Level Agreement User Interface
This section includes:

Service Level Agreement Pane 195

Service Level Agreement Wizard 196

Tracking Period Dialog Box 203
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Service Level Agreement Pane

This pane lists all the service level agreements (SLAs) defined for the performance test.

To access In the Performance Test Designer window, click Summary.

Relevant Tasks l "How to Design a Performance Test" on page 111

l "How to Define Service Level Agreements" on page 190

See also "Service Level Agreements Overview" on page 189

User interface elements are described below:

UI Elements Description

Starts the Service Level Agreement wizard where you can define new goals
for the performance test.

Opens the Service Level Agreement wizard where you canmodify the goals
defined in the SLA.

Deletes the selected SLA.

Opens the SLA Details dialog box which displays a summary of the details
of the selected SLA.

Opens the Tracking Period dialog box where you can adjust the tracking
period for measurements that are evaluated per time interval over a timeline.

For conceptual information, see "Tracking Period" on page 190.

For user interface details, see "Tracking Period Dialog Box" on page 203.

Service Level
Agreement list

Lists the SLAs defined for the performance test.
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Service Level Agreement Wizard

This wizard enables you to define service level agreements (SLAs). SLAs enable you to define
performance targets or goals for your performance test. During a test run, ALMmeasures performance
and collects data. This data is compared against thresholds defined in the SLAs.

To access To view a list of defined SLAs:

On theMy Performance Center navigation bar, select Test Management > Test
Plan. Select a test in the tree. The Service Level Agreement pane lists the defined
SLAs

To define SLAs:

1. Select a test in the tree, and click Edit Test.

2. In the Performance Test Designer window, click Summary.

3. In the Service Level Agreement pane, click .

Important
information

You can define SLAs in the Performance Test Designer only.

Relevant
tasks

"How to Define Service Level Agreements" on page 190

Wizard
map

This wizard contains:

Introduction > "Measurement Page" on the next page > "Transactions Page" on
page 198 > "Load Criteria Page" on page 199 > "Thresholds Page " on page 200 >
"Summary Page" on page 202

See also "Service Level Agreements Overview" on page 189

User interface elements are described below:

UI Elements Description

Skip this
page next
time

When this option is selected, the SLA wizard starts on theMeasurements page.
For details, see "Measurement Page" on the next page.

To view the Introduction page again, on theMeasurement page click Back and
clear theSkip this page next time option.
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Measurement Page

This wizard page enables you to select ameasurement for the SLA. Somemeasurements are
measured at time intervals over a timeline, and others aremeasured over the whole test run.

Important
information

General information about this wizard is available here: "Service Level Agreement
Wizard" on the previous page.

Wizard
map

The "Service Level Agreement Wizard" on the previous page contains:

Introduction > "Measurement Page" above > "Transactions Page" on the next page >
"Load Criteria Page" on page 199 > "Thresholds Page " on page 200 > "Summary
Page" on page 202

See also "Service Level Agreements Overview" on page 189

User interface elements are described below:

UI Elements Description

Transaction
Response
Time

l Percentile.Measures the percentage of transactions whose transaction
response time falls below a specific threshold. The SLA is measured over the
whole run.

l Average.Measures whether the average transaction response time of the
transactions over a specified time interval exceeds the defined threshold.

Note: Transaction Response Time SLAs can be defined only when at least
one of the scripts participating in the test includes a transaction.

Errors per
Second

Measures whether the errors per second over a specified time interval exceed the
defined threshold.

Total Hits Measures whether the total number of hits over the whole test run reach the defined
threshold.

Average Hits
per Second

Measures whether the average hits per seconds over the whole test run reach the
defined threshold.

Total
Throughput

Measures whether the total throughput over the whole test run reaches the defined
threshold.

Average
Throughput

Measures whether the average throughput over the whole test run reaches the
defined threshold.
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Transactions Page

This wizard page enables you to include transactions critical to your test in the evaluation.

Important
information

l General information about this wizard is available here: "Service Level Agreement
Wizard" on page 196.

l The Transaction page is displayed only when at least one of the scripts
participating in the test includes a transaction.

Wizard
map

The "Service Level Agreement Wizard" on page 196 contains:

Introduction > "Measurement Page" on the previous page > "Transactions Page"
above > "Load Criteria Page" on the next page > "Thresholds Page " on page 200 >
"Summary Page" on page 202

See also "Service Level Agreements Overview" on page 189

User interface elements are described below:

UI Elements Description

Available Transactions Lists the transactions in the scripts participating in the test.

Tomove a script to theSelected Transaction list, double-click it.

Note: Youmust select at least one transaction for evaluation.

Selected Transactions Lists the transactions in the scripts that have been selected for the SLA.

To remove a script from this list, double-click it.

Note: At least one transactionmust be listed.

User and Administrator Guide
Chapter 13: Service Level Agreements

HP ALM Performance Center (12.20) Page 198 of 521



Load Criteria Page

This wizard page enables you to select a load criterion for your goal and define appropriate load value
ranges. For example, you can define the SLA to show the behavior of errors per second when there are
less than 5 running Vusers, when there are between 5 and 10 running Vusers, and when there are 10 or
more running Vusers.

Important
information

l General information about this wizard is available here: "Service Level Agreement
Wizard" on page 196.

l This page is available only when defining theAverage Transaction Response
Time orErrors per Second SLAs.

l In the next wizard step (Thresholds page), you will set different thresholds for
each of these load value ranges.

Wizard
map

The "Service Level Agreement Wizard" on page 196 contains:

Introduction > "Measurement Page" on page 197 > "Transactions Page" on the
previous page > Load Criteria Page >"Thresholds Page " on the next page >
"Summary Page" on page 202

See also "Service Level Agreements Overview" on page 189

User interface elements are described below:

UI Elements Description

Measurement Themeasurement selected for the SLA.

Load
Criterion

The load criterion to consider when evaluating the goal.

l None. Does not consider any load criterion.

l Running Vusers. Considers the impact of the running Vusers.

l Throughput. Considers the impact of throughput.

l Hits per Second. Considers the impact of the hits per second.

For Average Transaction Response Time, you can also select:

l Transactions per second. Considers the impact of the transactions per
second.

l Transactions per second (passed). Considers the impact of the transactions
per second that passed the evaluation.
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UI Elements Description

Load Values Values of load to consider when evaluating the goal.

Value ranges must be consecutive, spanning all values from zero to infinity.

l Less than. The lower range is always from 0 up to, but not including, the value
entered here.

Example:

If you enter 5, the lower range is between 0 and 5, but does not include 5.

l Between. The in-between ranges include the lower value of the range, but not
the upper value.

Example:

If you enter 5 and 10, the range is from 5 and up to, but not including, 10.

Note: You can set up to three in-between ranges.

l Greater than. The upper range is from the value entered here, and higher.

Example:

If you enter 10, the upper range is from 10 and up.

Thresholds Page

This wizard page enables you to define thresholds for the selectedmeasurement.

Important
information

General information about this wizard is available here: "Service Level Agreement
Wizard" on page 196.

Wizard
map

The "Service Level Agreement Wizard" on page 196 contains:

Introduction > "Measurement Page" on page 197 > "Transactions Page" on page 198
> "Load Criteria Page" on the previous page > "Thresholds Page " above > "Summary
Page" on page 202

See also "Service Level Agreements Overview" on page 189
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Measurement Themeasurement selected for the SLA.

Percentile Percentage of transactions tomeasure against the configured threshold.

Available for the following measurement: Transaction Response Time
Percentile

Apply to all
transactions

Enables you to define a threshold or a set of thresholds for all of the listed

transactions. Click to apply the thresholds to all of the listed
transactions simultaneously.

Note: Threshold values for the transactions do not have to be the
same. You can assign different values for each transaction.

Available for the following measurement:Average Transaction
Response Time

Provide a threshold
value for all
transactions

Enables you to define one threshold for all of the listed transactions. Click

to apply the value to all of the listed transactions
simultaneously.

Note: The threshold values for the transactions do not have to be the
same. You can assign different values for each transaction.

Available for the following measurements: Transaction Response
Time Percentile
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UI Elements Description

Threshold/<Threshold
table>

Theminimum/maximum threshold value for the selectedmeasurement.

l Transaction Response Time Percentile: If the resulting value over
the whole run exceeds the defined threshold values, the SLA produces
a Failed status.

l Average Transaction Response Time andErrors per Second: If
the resulting value over the specified time interval exceeds the
threshold values, the SLA produces a Failed status for that time
interval.

l Average/Total Throughput andAverage Hits per Second/Total
Hits: If the resulting value over the whole run is lower than the
threshold value, the SLA produces a Failed status.

Note:

l Transaction Response Time Percentile andAverage
Transaction Response Time:Whenmore than one transaction
is selected, all of the transactions are listed in a table enabling you
to define thresholds for each transaction separately.

l Average Transaction Response Time andErrors per Second:
When a load criterion is selected, the table displays the load value
ranges, enabling you to define thresholds per range of load values.
For details, see "Load Criteria Page" on page 199.

Summary Page

This wizard page displays a summary of the SLA you defined and enables you to definemore SLAs.

Important
information

General information about this wizard is available here: "Service Level Agreement
Wizard" on page 196.

Wizard
map

The "Service Level Agreement Wizard" on page 196 contains:

Introduction > "Measurement Page" on page 197 > "Transactions Page" on page 198
> "Load Criteria Page" on page 199 > "Thresholds Page " on page 200 > "Summary
Page" above

See also "Service Level Agreements Overview" on page 189

User and Administrator Guide
Chapter 13: Service Level Agreements

HP ALM Performance Center (12.20) Page 202 of 521



User interface elements are described below:

UI Elements Description

Define another service
level agreement

Enables you to define another SLA while still in the SLA wizard.

If this option is selected, clicking Finish takes you directly to the page
where you can select ameasurement for another SLA.

Tracking Period Dialog Box

This dialog box enables you to set a tracking period for service level agreements.

To access 1. In the Performance Test Designer, click theSummary tab.

2. In theService Level Agreement pane, click the Tracking Period button.

Important
information

Formeasurements evaluated over a timeline, Analysis determines SLA statuses at
specified time intervals within that timeline. These time intervals are known as the
tracking period.

Relevant
tasks

"How to Define Service Level Agreements" on page 190

See also "Service Level Agreements Overview" on page 189

User interface elements are described below:

UI Elements Description

Internally
calculated
tracking
period

Analysis automatically sets a tracking period over which SLA statuses are
determined.

Minimum tracking period: 5 seconds

Tracking
period of at
least <xx>
seconds

Analysis sets the tracking period as close as possible to the value specified here.

Minimum tracking period: 5 seconds

Example:

Assume that you select a tracking period of X=10, and assume that the
aggregation granularity for the performance test is 6. The tracking period is set
to the nearest multiple of 6 that is greater than or equal to 10. That is, Tracking
Period = 12.

For this option, Analysis uses the following formula:

Tracking Period = Max(5 seconds, m(Aggregation Granularity))

wherem is a multiple of the performance test's aggregation granularity such thatm
(Aggregation Granularity) is greater than or equal to X.
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Chapter 14: Enabling and Configuring ERP/CRM and
J2EE/.NET Diagnostics
This chapter includes:

How to Enable and Configure ERP/CRMDiagnostics 205

How to Enable and Configure J2EE/.NET Diagnostics 205

How to View Diagnostics Results 206

Diagnostics User Interface 206
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How to Enable and Configure ERP/CRM Diagnostics
This task describes how to configure the ERP/CRMDiagnostics modules to communicate with the
Mediator, and how to define the servers that you want to monitor in order to generate diagnostics data.

To learnmore about ERP/CRM diagnostics, refer to theHP ALM LabManagement Guide.

Note: This task is part of a higher-level task. For details, see "How to Design a Performance Test"
on page 111.

1. Prerequisites
n Make sure that the ERP/CRMMediator is installed and configured. If this is not the case,

consult the administrator for help.

n Make sure that the performance test is not already running.

2. Manually define transactions in the Vuser script
To ensure that valid diagnostics data are generated, manually define the transactions in the Vuser
script rather than using automatic transactions. Make sure to disable the following options in the
Run-Time Settings' General > Miscellaneous node: Define each action as a transaction and
Define each step as a transaction.

3. Enable the diagnostics module
On theMy Performance Center navigation bar, select Test Management > Test Plan. Select a
performance test in the test plan tree and click Edit Test . Click Diagnostics.

For user interface details, see "Performance Test Designer > Diagnostics" on page 207.

How to Enable and Configure J2EE/.NET Diagnostics
This step describes how to capture J2EE/.NET diagnostics metrics in a performance test, and how to
select the probes that are included in the test.

To learnmore about J2EE/.NET diagnostics, refer to theHP ALM LabManagement Guide.

Note: This task is part of a higher-level task. For details, see "How to Design a Performance Test"
on page 111.
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Enable J2EE/.NET diagnostics from the Diagnostics Tab
On theMy Performance Center navigation bar, select Test Management > Test Plan. Select a
performance test in the test plan tree and click Edit Test . Click Diagnostics.

For user interface details, see "Performance Test Designer > Diagnostics" on the next page.

How to View Diagnostics Results
You view results for ERP/CRM as well as J2EE/.NET diagnostics in HP LoadRunner Analysis.

1. Open Analysis
a. Navigate to <HP Performance Center Host directory> Applications > Analysis.

b. Open the desired results file from the following location:

<LTS installation>\orchidtmp\Results\<Domain Name+Project Name>\Run_<Run
number>\res<Run number>\res<Run number>.lrr

2. View results in the Analysis diagnostics graphs
You can use the Analysis diagnostics graphs and reports to view the performance data and drill
down to pinpoint problem areas in any layer of the application.

For information about specific diagnostics graphs, see theHP LoadRunner Analysis User Guide.

Diagnostics User Interface
This section includes:

Performance Test Designer > Diagnostics 207

J2EE/.NET Configuration Dialog Box 208

Oracle 11i Configuration Dialog Box 209

Oracle 11i Server Configuration Dialog Box 210

SAP Configuration Dialog Box 211

Siebel Configuration Dialog Box 212

Siebel DB Configuration Dialog Box 213

Siebel DB Server Configuration Dialog Box 214

Siebel Server Configuration Dialog Box 215
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Performance Test Designer > Diagnostics

This view enables you to enable and define the ERP/CRM and J2EE/.NET diagnostics modules for a
performance test.

To access 1. On theMy Performance Center navigation bar, select Test Management > Test
Plan.

2. Select a performance test in the test plan tree and click Edit Test.

3. In the Performance Test Designer window, click Diagnostics.

Important
information

l The contents of the tab are disabled while the performance test is running. You
must enable and configure the diagnostics modules before running the test.

l The settings that you configure are per performance test. All scripts in the
performance test run under the same diagnostics configuration.

Relevant
tasks

l "How to Enable and Configure ERP/CRMDiagnostics" on page 205

l "How to Enable and Configure J2EE/.NET Diagnostics" on page 205

User interface elements are described below:

UI Elements Description

Enable the
following
Diagnostics for
X% of all
relevant Vusers
in the test

Specify the percentage of Vusers for which you want to collect diagnostics
data. This value determines how many of the transactions on the application
server are reported to the Controller. Reducing this percentage will reduce the
overhead on the application server forWeb Page, Oracle 11i, and J2EE & .NET
Diagnostics.

Example: If you enter a sampling value of 25% and run 12 Vusers in
group1, 8 Vusers in group2, and 1 Vuser in group3, diagnostics data will
be collected for 3 Vusers in group1, 2 Vusers in group2, and 1 Vuser in
group3.

Note: Theminimum percentage of Vuser sampling allowed is 1%, or 1
Vuser per group, whichever is more.

Themaximum percentage allowed is the lowest of theMax. Vuser Sampling
values of all the selected diagnostics types.

Configure Click the button to configure each diagnostics type.

Max Vuser
Sampling

Themaximum percentage of the amount of Vusers specified in theEnable the
following Diagnostics for X% ... that can be collected.
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J2EE/.NET Configuration Dialog Box

This dialog box enables you to set up the J2EE/.NET diagnostics module.

To access 1. On theMy Performance Center navigation bar, select Test Management
> Test Plan.

2. Select a performance test in the test plan tree and click Edit Test.

3. In the Performance Test Designer window, click Diagnostics.

4. Select Enable the following diagnostics for X% of all relevant
Vusers in the test.

5. Select Enable by J2EE/.NET Application Diagnostics, then click the
Configure button .

Important
information

The dialog box is read only while the performance test is running.

Relevant tasks "How to Enable and Configure J2EE/.NET Diagnostics" on page 205

See also J2EE & .NET Diagnostics Graphs in theHP LoadRunner Analysis User
Guide.

User interface elements are described below:

UI Elements Description

Monitor server
requests

Select to capture a percentage of server requests which occur outside the
context of any Vuser transaction. For more information, seeHP ALM Lab
Management Guide.

Note:

l The server requests will be captured at the same percentage that
was selected for the percentage of Vusers in the Diagnostics
Distribution dialog box.

l Enabling this option imposes an additional overhead on the probe.
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UI Elements Description

Select Probes Table l . Selects a probe for monitoring. At least one probemust be
selected.

l Name. The name of the probe.

l Group. The probe group.

l Host Name. The host the probe is running on (or the application server
on which the probe is installed).

l Status. The probe's status. Either Available or Not Available.

Note: If you upgraded your Diagnostics installation, probes from
existing performance tests may appear with a red status. Clear any
probes that appear in red.

There is a firewall
between the Mediator
and the Controller.
Use the MI Listener
for collating results.

Select if the Diagnostics server (or a Diagnostics server in Mediator mode
in a distributed environment) is located behind a firewall.

Note: If there is a firewall between the Controller and the Diagnostics
Server involved in a load test, youmust configure the Controller and
the Diagnostics Server to use theMI Listener to enable the transfer of
the offline analysis file. For more information, refer to theHP
Diagnostics Installation and Configuration Guide.

Troubleshoot
diagnostics for
J2EE/.NET
connectivity

Click to open the HP Diagnostics System Health Monitor to enable you to
investigate any connectivity issues between the Diagnostics
components.

Oracle 11i Configuration Dialog Box

This dialog box enables you to set up the Oracle 11i Diagnostics module to communicate with the
Mediator.

To access 1. On theMy Performance Center navigation bar, select Test Management >
Test Plan.

2. Select Test Design > Edit Test > Diagnostics.

3. Select Enable the following diagnostics for X% of all relevant Vusers in
the test.

4. Select Enable by Oracle 11i Diagnostics, then click the Configure button .
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Relevant
tasks

"How to Enable and Configure ERP/CRMDiagnostics" on page 205

See also l "Oracle 11i Server Configuration Dialog Box" below

l Oracle 11i Diagnostics Graphs in theHP LoadRunner Analysis User Guide

User interface elements are described below:

UI Elements Description

Opens theOracle 11i Server Configuration dialog box where you can addOracle
11i servers and enter server information. For more information, see "Oracle 11i
Server Configuration Dialog Box" below.

Tests the connections between theOracle 11i Diagnostics module and the
Mediator.

Note: This does not check the connections to the Oracle servers.

Enables you to edit the server details.

Name The name of theMediator used to collect and process the Oracle 11i diagnostics
data. Only oneMediator is supported for each diagnostics module.

Servers Table l Server. The name of the Oracle server.

l Platform. The platform of the Oracle server.

l Log Directory. The directory where the Oracle trace files (*.trc) are written.

Oracle 11i Server Configuration Dialog Box

This dialog box enables you to addOracle 11i servers and to add server information.

To access In the Oracle 11i Configuration dialog box, click Add Server.

Relevant tasks "How to Enable and Configure ERP/CRMDiagnostics" on page 205

See also "Oracle 11i Configuration Dialog Box" on the previous page

User interface elements are described below:

UI Elements Description

Domain TheOracle server domain.
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UI Elements Description

Log Directory A location where the Oracle application saves the trace files. The trace
files can be saved in a shared directory on the Oracle server or in a
separate folder.

Password/Passphrase The user password or passphrase.

Platform TheOracle server platform.

Private Key File The name of the file where the Private Key is stored. This can be found on
theMediator. If you specify the file name only (without a path), the
configuration automatically looks for the file in theMediator's <Mediator
Root>\bin directory.

Server The name of the Oracle server.

Use Secure Shell Select if you are working with a Secure Shell connection.

User Name The user name of the server where trace files are stored.

Note: ForWindows platforms, the user should have administrator
privileges.

SAP Configuration Dialog Box

This dialog box enables you to add SAP servers and to add server information.

To access 1. On theMy Performance Center navigation bar, select Test Management > Test
Plan, then select the desired test.

2. Select Test Design > Edit Test > Diagnostics.

3. Select Enable the following diagnostics for X% of all relevant Vusers in the
test.

4. Select Enable by SAP Diagnostics, then click theConfigure button .

Relevant
tasks

"How to Enable and Configure ERP/CRMDiagnostics" on page 205

See also SAP Diagnostics Graphs in theHP LoadRunner Analysis User Guide

User and Administrator Guide
Chapter 14: Enabling and Configuring ERP/CRM and J2EE/.NET Diagnostics

HP ALM Performance Center (12.20) Page 211 of 521



User interface elements are described below:

UI
Elements

Description

Validates the connection to the SAP server.

When you click Validate, the Controller produces a report of all the servers that are
available for diagnostics through the Server Host.

Client
Number

The client number of the selected user.

Name The name of theMediator used to collect and process the SAP diagnostics data.
Only oneMediator is supported for each diagnostics module.

Note: If you are using aMediator that is over a firewall, enter the local machine
key of theMediator instead of theMediator machine name.

Server Host
Name

The name of the SAP server.

System
Router
string

Optional. Enter the system router string of the SAP server.

System
number

The system number of the SAP server.

User Name The user's unique name for logging onto the SAP server.

User
Password

The user's password for logging onto the SAP server.

Siebel Configuration Dialog Box

This dialog box enables you to set up the Siebel Diagnostics module to communicate with the
Mediator.

To access 1. On theMy Performance Center navigation bar, select Test Management > Test
Plan, then select the desired test.

2. Select Test Design > Edit Test > Diagnostics.

3. Select Enable the following diagnostics for X% of all relevant Vusers in the
test.

4. Select Enable by Siebel Application Diagnostics, then click theConfigure button
.
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Relevant
tasks

"How to Enable and Configure ERP/CRMDiagnostics" on page 205

See also l "Siebel DB Server Configuration Dialog Box" on the next page

l Siebel Diagnostics Graphs in theHP LoadRunner Analysis User Guide

l Siebel DB Diagnostics Graphs in theHP LoadRunner Analysis User Guide

User interface elements are described below:

UI Elements Description

Opens the Siebel Server Configuration dialog box where you can add Siebel
servers and enter server information. For more information, see "Siebel Server
Configuration Dialog Box" on page 215.

Tests the connections between the Siebel Diagnostics module and theMediator.

Note: This does not check the connections to the Siebel servers.

Enables you to edit the server details.

Name The name of theMediator used to collect and process the Siebel diagnostics
data. Only oneMediator is supported for each diagnostics module.

Servers Table l Server Name. The name of the Siebel server.

l Platform. The platform of the Siebel server.

l Log Directory. The Siebel server directory where Siebel log files (*.SARM)
are written.

Siebel DB Configuration Dialog Box

This dialog box enables you to add Siebel DB servers and to add server information.

To access 1. On theMy Performance Center navigation bar, select Test Management > Test
Plan, then select the desired test.

2. Select Test Design > Edit Test > Diagnostics.

3. Select Enable the following diagnostics for X% of all relevant Vusers in the
test.

4. Select Enable by Siebel Application Diagnostics, then click theConfigure button
.
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Relevant
tasks

"How to Enable and Configure ERP/CRMDiagnostics" on page 205

See also l "Siebel DB Server Configuration Dialog Box" below

l Siebel DB Diagnostics Graphs in theHP LoadRunner Analysis User Guide

User interface elements are described below:

UI Elements Description

Opens the Siebel DB Server Configuration dialog box where you can add Siebel
DB servers and enter server information. For more information, see "Siebel DB
Server Configuration Dialog Box" below.

Tests the connections between the Siebel DB Diagnostics module and the
Mediator.

Note: This does not check the connections to the Siebel servers.

Enables you to edit the server details.

Name The name of theMediator used to collect and process the Siebel diagnostics
data. Only oneMediator is supported for each diagnostics module.

Servers Table l Server Name. The name of the Siebel server.

l Platform. The platform of the Siebel server.

l Log Directory. The Siebel server directory where Siebel log files (*.SARM)
are written.

Siebel DB Server Configuration Dialog Box

This dialog box enables you to add Siebel DB servers and add server information.

To access In the Siebel DB Configuration dialog box, click Add Server.

Relevant tasks "How to Enable and Configure ERP/CRMDiagnostics" on page 205

See also "Siebel DB Configuration Dialog Box" on the previous page

User interface elements are described below:

UI Elements (A-Z) Description

Domain The Siebel server domain.
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UI Elements (A-Z) Description

Log Directory A location where the Siebel application saves the trace files. The trace
files can be saved in a shared directory on the Siebel server or in a
separate folder.

Password/Passphrase The user password or passphrase.

Platform The Siebel server platform.

Private Key File The name of the file where the Private Key is stored. This can be found on
theMediator. If you specify the file name only (without a path), the
configuration automatically looks for the file in theMediator's <Mediator
Root>\bin directory.

Server Name The name of the Siebel server.

Use Secure Shell Select if you are working with a Secure Shell connection.

User Name The user name of the server where trace files are stored.

Note: ForWindows platforms, the user should have administrator
privileges.

Siebel Server Configuration Dialog Box

This dialog box enables you to add Siebel servers and enter server information.

To access In the Siebel Configuration dialog box, click Add Server.

Relevant tasks "How to Enable and Configure ERP/CRMDiagnostics" on page 205

See also "Siebel Configuration Dialog Box" on page 212

User interface elements are described below:

UI Elements Description

Domain The Siebel server domain.

Log Directory A location where the Siebel application saves the trace files. The trace
files can be saved in a shared directory on the Siebel server or in a
separate folder.

Password/Passphrase The user password or passphrase.

Platform The Siebel server platform.
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UI Elements Description

Private Key File The name of the file where the Private Key is stored. This can be found on
theMediator. If you specify the file name only (without a path), the
configuration automatically looks for the file in theMediator's <Mediator
Root>\bin directory.

Server ID The Siebel server ID.

Server Name The name of the Siebel server.

Server Type The Siebel server type.

Use Secure Shell Select if you are working with a Secure Shell connection.

User Name The user name of the server where trace files are stored.

Note: ForWindows platforms, the user should have administrator
privileges.
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Terminal Sessions Overview
Using Performance Center's terminal sessions, you can runmultiple load generators simultaneously in
your performance test on a terminal server. Performance Center allows you to create a new terminal
session, or connect to an existing session.

Using terminal sessions enables you to overcome the limitation of being able to run only a single GUI
Vuser on aWindows-based load generator. GUI Vusers, which operate graphical user interface (GUI)
applications, are defined in a GUI Vuser script. You create GUI Vuser scripts using HP's QuickTest
Professional (HP Unified Functional Testing). By opening a terminal server session for eachGUI
Vuser, you can runmultiple GUI Vusers on the same application.

You select the number of terminals to be used in your performance test (provided that you have
sufficient terminal sessions running), and themaximum number of Vusers that can be run per terminal.
Themaximum number of Vusers depends on the Vuser type used in the script. For GUI Vusers, the
maximum is one Vuser for each terminal session. Performance Center then evenly distributes the
number of Vusers among the client sessions.

For details on how to create or connect to a terminal session, see "How to Create a Terminal Session"
below.

How to Create a Terminal Session
This task describes how to create a new terminal session.

To learn about terminal sessions, see "Terminal Sessions Overview" above.

Note:

l You can enable terminal sessions when configuring performance tests with manual load
generator distribution only.

l The Terminal Services Manager does not support terminal sessions connected over a firewall.
To configure terminal sessions over a firewall, see "How to Configure a Terminal Session over
a Firewall" on page 222.

1. Prerequisites
n Ensure that a load generator host is installed on the terminal server machine.

Note: You cannot use terminal sessions on Linux load generators.

n Ensure that the Remote Desktop Connection client software is installed on the Controller
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machine.

2. Configure the Performance Center agent on the load generatormachine
a. Select Start > All Programs > HP Performance Center Host > Advanced Settings >

Performance Center Agent Configuration. The Agent Configuration dialog box opens.

b. Select Enable Terminal Services and click OK.

c. When prompted to restart the agent, click OK.

3. Check the Terminal Services logon settings
Ensure that the correct terminal services settings are selected for the Remote Desktop
Connection client.

To configure the correct Terminal Server logon settings:

a. On the load generator machine, select Start > Programs > Administrative Tools >
Terminal Services Configuration. The Terminal Services Configuration dialog box opens.
Right-click RDP-TCP, and select Properties to open the RDP-TCP Properties dialog box.

b. Click the Logon Settings tab.

c. Make sure that Use client-provided logon settings is selected and that Always prompt for
password is not selected.

4. Add the load generator to the system
Use the New Host dialog box to add the load generator the system. For user interface details, refer
to theHP ALM LabManagement Guide.

5. Configure the terminal session
You configure the terminal session from the Terminal Services dialog box. For user interface
details, see "Terminal Services Dialog Box" on page 224.

How to Connect to a Terminal Session
This task describes how to connect to an existing terminal session.

To learn about terminal sessions, see "Terminal Sessions Overview" on the previous page.
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Note:

l You can enable terminal sessions when configuring performance tests with manual load
generator distribution only.

l The Terminal Services Manager does not support terminal sessions over a firewall. To
configure terminal sessions over a firewall, see "How to Configure a Terminal Session over a
Firewall" on the next page.

1. Prerequisites
n Ensure that a load generator host is installed on the terminal server machine.

Note: You cannot use terminal sessions on Linux load generators.

n Ensure that the Remote Desktop Connection client software is installed on the Controller
machine.

2. Run the Performance Center agent as a process
a. On the load generator machine, run <Performance Center Host installation>\launch_

service\bin\Magentconfig.exe. The Agent Runtime Settings dialog box opens.

b. SelectManual log in to this machine.

Note: Youmust run the Performance Center agent as a process for each terminal
session that you are running.

3. Configure the Performance Center agent on the load generator
a. Select Start > All Programs > Performance Center Host > Advanced Settings >

Performance Center Agent Configuration. The Agent Configuration dialog box opens.

b. Select Enable Terminal Services and click OK.

c. When prompted to restart the agent, click OK.

4. Add the load generator to the system
Use the New Host dialog box to add the load generator to the system. For user interface details,
refer to theHP ALM LabManagement Guide.

5. Launch a terminal session from the Controller
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Note: Youmust open a terminal session for each terminal that you want to run Vusers on
during the performance test.

a. Select Start > All Programs > Accessories > Communication > Remote Desktop
Connection, or select Start > Run and run themstsc command. The Remote Desktop
Connection dialog box opens.

b. Click Options.

c. In theGeneral tab, enter the name or IP address of a terminal server, or select a terminal
server from the list of available servers.

d. Enter you user name, password, and domain name (if required) for login onto the terminal
server.

e. Click Connect to open a Terminal Client window.

6. Configure the terminal session
You configure the terminal session from the Terminal Services dialog box. For user interface
details, see "Terminal Services Dialog Box" on page 224.

How to Configure a Terminal Session over a Firewall
This task describes how to configure a terminal session on a load generator that is located over a
firewall.

1. Open the load generator machine console.

2. If the Performance Center Agent is not running as a process, run <load generator host
installation>\launch_service\bin\magentproc.exe.

3. Configure the Performance Center Agent on the console:

a. Select Enable Firewall Agent, click Settings. In the Local Machine Key field, enter a
virtual load generator name, for example, machine_ofw.

b. Select Enable Terminal Services, and click OK.

4. Create one or more terminal sessions on the load generator consolemachine.

Consider the following:

n For each terminal session, run the agent configuration as above. For each session, specify a
different Local Machine Key name, for example, machine_ofw_1, machine _ofw_2, etc.

n If you stop the agent on a terminal session, youmust reconfigure the settings for that particular
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session before restarting the agent.

n When selecting the load generator for the scenario in the Controller, select the local machine
key for each individual virtual load generator used.

Terminal Sessions User Interface
This section includes:

Terminal Services Dialog Box 224

Performance Center Agent Runtime Settings Dialog Box 225
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Terminal Services Dialog Box

This dialog box enables you to configure terminal sessions.

To access Use one of the following:

l In theSelect Load Generators dialog box, select a load generator and click the

Terminal Services button . For more information, see "Select Load
Generators Dialog Box " on page 168.

l In the Automatch LoadGenerators Properties dialog box, select a load generator
then click Terminal Services. For more information, see "Automatch Load
Generators Properties Dialog Box" on page 171.

l During Runtime, on the Performance Test Run page, click the Load Generators

button. Then click Terminal Sessions Settings.

Important
information

During runtime, you can set or change terminal services settings only when the load
generator is non-operational.

Relevant
tasks

"How to Create a Terminal Session" on page 219

User interface elements are described below:

UI Elements Description

Enable Terminal
Services

Applies the settings to the load generator running on the terminal
server.

Number of Terminal
Services to open on
Load Generator

Enter the number of terminals in your performance test.

Note: Youmust open a terminal session for each terminal on
which you want to run Vusers during the performance test.

Maximum number of
Vusers to run in a
Terminal Service

Enter themaximum number of Vusers that you want to run in a terminal
session.

Note: Themaximum number of Vusers depends on the Vuser
type used in the script. For GUI Vusers, themaximum is one
Vuser for each terminal session.

Create new Terminal
Services sessions

Enables the Controller to launch terminal sessions automatically using
the Remote Desktop Connection.
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UI Elements Description

Connect to existing
Terminal Services
session

Enables a connection to an existing terminal session.

Performance Center Agent Runtime Settings Dialog Box

This dialog box enables you to run the Performance Center Agent as a service, or as a process.

User interface elements are described below:

UI Elements Description

Allow virtual users to run on
this machine without user
login

Select to run the Performance Center Agent as a service. You
must enter your user credentials.

Note: This is the default selection.

Manual log in to this machine Select to run the Performance Center Agent as a process. This
enables you to runmultiple GUI Vusers on the same load
generator.
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Multiple IP Addresses Overview
Application servers and network devices use IP addresses to identify clients. The application server
often caches information about clients coming from the samemachine. Network routers try to cache
source and destination information to optimize throughput. If many users have the same IP address,
both the server and the routers try to optimize. Since Vusers on the same load generator have the same
IP address, server and router optimizations do not reflect real-world situations.

TheMultiple IP Addresses feature enables Vusers running on a single load generator to be identified by
many IP addresses. The server and router recognize the Vusers as coming from different load
generators and as a result, the testing environment is more realistic.

This feature can be implemented onWindows and Linux platforms with the following protocols:

DNS, IMAP, Oracle NCA, OracleWeb Applications 11i, POP3, RTE, SAP-Web, Siebel-Web, SMTP,
Web (HTTP/HTML), Web Services, andWindows Sockets.

How to Enable IP Spoofing in ALM
The following steps describe how to add IP addresses to a load generator to enable IP Spoofing.

This task includes the following steps:

l "Createmultiple IP addresses on the load generator." below

l "Update the server's routing table with the new addresses." below.

l "Enable theMultiple IP Addresses feature from Performance Center" on the next page

1. Create multiple IP addresses on the load generator.
n Windows:Run the IP Wizard to createmultiple IP addresses. For details on running the IP

Wizard, see "IP Wizard" on page 229.

The new IP addresses are added to the load generator once and are used for all performance
tests. After running the wizard, restart the load generator machine.

n Linux:Manually configure the new IP addresses for Linux load generators. For details, see
"How to ConfigureMultiple IP Addresses on Linux" on page 229.

2. Update the server's routing table with the new addresses.
Once the client machine has new IP addresses, the server needs the addresses in its routing
table, so that it can recognize the route back to the client. If the server and client share the same
netmask, IP class, and network, the server's routing table does not require modification.
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Note: If there is a router between the client and server machines, the server needs to
recognize the path via the router. Make sure to add the following to the server routing table:

n A route from theWeb server to the router,

n Routes from the router to all of the IP addresses on the load generator.

Update theWeb server routing table as follows:

a. Edit the batch file that appears in the IP Wizard Summary page. An example .bat file is shown
below.

b. For each occurrence of [CLIENT_IP], insert your IP address instead.

c. Run the batch file on the server machine.

3. Enable the Multiple IP Addresses feature from Performance Center
After you definemultiple IP addresses, you set an option to tell the Controller to use this feature.

a. On theMy Performance Center navigation bar, select Test Management > Test Plan. Select
a performance test in the test plan tree and click Edit Test. In the Performance Test Designer
window, click Groups & Workload and click theOptions button at the bottom of the
window. Select Enable IP Spoofer.

Note: Youmust select this option before running a performance test.

b. Specify how the Controller should allocate the IP addresses: per process or per thread. For
details, see the Controller's general run option settings described inHP ALM Lab
Management Guide.
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How to Configure Multiple IP Addresses on Linux
The following section describe how tomanually configuremultiple IP addresses on the Linux load
generator.

1. To definemultiple IP addresses for a single Ethernet card, you need IP Aliasing compiled into the
kernel. To do this, use the ifconfig command: /sbin/ifconfig eth0:0 x.x.x.x netmask 255.255.x.x
up

2. Substitute the new IP address for x.x.x.x, and insert the correct information for subnet mask.
Place this command in the rc.local file so that it executes upon boot.

IP Wizard
This wizard enables you to create and save new IP addresses onWindows machines.

To access Use one of the following:

l Start > Program Files > Performance Center Host > Tools > IP Wizard

l From the Performance Center Host's \bin directory, run ipwizard.exe.

Important
information

l The IP wizard resides on each load generator.

l The new addresses can be a range of addresses defined by the Internet
Assignment Numbers Authority. They are for internal use only, and cannot
connect to the Internet. This range of addresses is the default used by the IP
Wizard.

l The IP Wizard only works onmachines with a fixed IP, not onmachines with a
DHCP.

l Before any of the changes made can take effect, youmust restart themachine
after you run the wizard, and theWeb server's routing table may need to be
updated.

Relevant
tasks

"How to Enable IP Spoofing in ALM" on page 227
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IP WizardWelcome - Step 1 of 3
User interface elements are described below:

UI Elements Description

Create new settings Enables you to define new IP settings on the load generator.

Load previous settings from file Enables you to use an existing file with IP address settings.

Restore Original Settings Restores original settings.

IP Wizard - Step 2 of 3 - Optional
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Web Server
Address box>

If you havemore than one network card, enables you to choose the card to use for
IP addresses.

This step enables the IP Wizard to check the server's routing table to see if it
requires updating after new IP addresses are added to the load generator.

For details, see "How to Enable IP Spoofing in ALM" on page 227.

IP Wizard - Step 3 of 3 - Optional
User interface elements are described below:

UI Elements Description

Opens the Add dialog box, enabling you to add a new IP address.

l Private Address Spaces. The class that represents the correct submask for
themachine's IP addresses.

l From IP. Adds IP addresses starting with this number.

l Submask. IP addresses include two components, a netid and hostid. The
submask determines where the netid portion of the address stops and where the
hostid begins.

l Number to add. The number of IP addresses to add.

l Verify that new IP addresses are not already in use. Instructs the IP Wizard
to check the new addresses. The IP Wizard adds only the addresses that are not
already in use.
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UI Elements Description

Removes a selected IP Address.

IP Address The IP addresses on the load generator machine.

Subnet Mask The submasks of the IP addresses on the load generator machine.

Number of
IPs added

The number of IP addresses added to the load generator machine.

IP Wizard - Summary
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Summary area> Displays a summary of the operations performed by the IP Wizard.

Take note of the location of the batch file (.bat). This is used to update the
routing table if necessary. See "How to Enable IP Spoofing in ALM" on
page 227.

Reboot now to
update routing
tables

If you updated the routing table, rebooting initializes theWindows device
drivers with the new addresses.
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Analysis Templates Overview
You can customize your analysis reports using templates. In HP LoadRunner Analysis, you create the
customized templates. You then import the templates to ALM and access the specific template you
want for each test in Performance Center.

How to Customize Analysis Templates
This task describes how to customize analysis templates.

You can customize analysis templates to display your performance test run reports in a format that is
suitable to your needs. To learnmore, see "Analysis Templates Overview" above and theHP
LoadRunner Analysis User Guide.

Note: This task is part of a higher-level task. For details, see "How to Design a Performance Test"
on page 111.

This task includes the following steps:

l "Create a customized analysis template" below

l "Create a zip file with the customized analysis template" below

l "Upload the file to My Performance Center" below

l "Apply the customized analysis template to the report of your performance test" below

1. Create a customized analysis template
In LoadRunner, create a customized analysis template. For user interface details, see theHP
LoadRunner Analysis User Guide.

2. Create a zip file with the customized analysis template
After creating a local copy of the customized analysis template, zip the folder containing the
customized analysis template. Make sure the folder contains a .tem file.

3. Upload the file to My Performance Center
Upload the customized analysis template zip file to the Test Resources module.

For more information, see "Upload Analysis Template Dialog Box" on page 235.

4. Apply the customized analysis template to the report of your performance test

User and Administrator Guide
Chapter 17: Customizing Analysis Templates

HP ALM Performance Center (12.20) Page 233 of 521



Apply the customized analysis template to the analysis report of your performance test.

For more information, see "Analysis Template Options Dialog Box" on page 236.

Note:

l During the test run, the analysis template is logically bound to the run entity by its ID.

l Editing a test after it has run and changing to another analysis template only impacts future
runs. Prior runs still use the previous analysis template.

l If the customized analysis template is not found, the default analysis template is used.

Analysis Template User Interface
This section includes:

Create New Analysis Template Dialog Box 235

Upload Analysis Template Dialog Box 235

Analysis Template Options Dialog Box 236
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Create New Analysis Template Dialog Box

This dialog box enables you to create a new analysis template..

To access 1. On theMy Performance Center navigation bar, select Resources > Test
Resources.

2. Click theNew Analysis Template button.

Relevant
tasks

"How to Customize Analysis Templates" on page 233

See also "Test Resources Module" on page 67

User interface elements are described below:

UI Elements Description

Name The name of the new analysis template.

Analysis Template
Folder

The folder of the new analysis template.

Note: The folder namemust not contain a forward slash (/).

Description Enables you to enter a description of the new analysis template.

Messages Enables you to enter messages and comments about the new analysis
template.

Upload Analysis Template Dialog Box

This dialog box enables you to upload analysis template files to ALM.

To access 1. On theMy Performance Center navigation bar, select Resources > Test
Resources.

2. Select an existing, or create a new, Analysis Template resource.

3. Click theUpload Analysis Template Content button.

Important
information

The template file must be saved locally, must be in ZIP format, andmust
include at least one .tem file.

Relevant tasks "How to Customize Analysis Templates" on page 233

See also "Test Resources Module" on page 67

User interface elements are described below:
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UI Elements Description

Uploads the selected analysis template zip file to the specified Analysis Template
resource.

Select The analysis template zip file.

Clear Clears the selected analysis template zip file.

Messages Enables you to enter messages and comments about the analysis template upload.

Analysis Template Options Dialog Box

This dialog box enables you to apply an analysis template to a selected performance test run report.

To access 1. On theMy Performance Center navigation bar, select Test Management >
Test Plan.

2. Select a performance test in the test plan tree and click Edit Test.

3. In the Performance Test Designer window, click Groups & Workload.

4. From the Advancedmenu, select Analysis Template Options.

Relevant
tasks

"How to Define a Performance Test Workload" on page 128

"How to Customize Analysis Templates" on page 233

See also "Performance Test Designer > Groups & Workload" on page 134

"Test Resources Module" on page 67

User interface elements are described below:

UI Elements Description

Use default Analysis
Template

Selecting this option uses the default analysis template for the selected
performance test report.

Use Analysis Template
resource

Select this option to select a customized analysis template for the
selected performance test report.
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Running Performance Tests Overview
After planning, designing and scheduling your performance test, you run it to create load on your
application and to test its performance.

This section includes:

l "Performance Test Execution Flow" below

l "Monitoring Performance Test Execution" below

l "Analyzing Performance Test Results" on the next page

Performance Test Execution Flow
The following table explains the various stages of the test run flow.

Run
stage Description

Start
of run

At the start of the run, the Controller checks the test configuration information, invokes the
applications that were selected to run with the test, and then distributes each Vuser script to
its designated load generator. When the Vusers are ready, they start running their scripts.

During
run

During the run, you can see a synopsis of the test and can also drill down to see which
Vuser actions are causing the application problems.

Service Virtualization:During the run, specified virtualized services run instead of the
actual services. You can update services during the test run.

The online graphs display performance data collected by themonitors. You use this
information to isolate potential problem areas in your system.

End of
run

The test run ends when all the Vusers have completed their scripts, when the duration runs
out, or when you terminate it.

Monitoring Performance Test Execution
Onlinemonitors enable you tomonitor performance test execution. During a test run, you can view
graphs that display information about the load that Vusers generate on yourWeb server and other
applications. ALM Performance Center displays this data in real-time during test execution.

At the conclusion of the performance test, you can use HP LoadRunner Analysis to view a summary
and graphs of the data collected from thesemonitors during the test run. For detailed information on the
available graphs, see theHP LoadRunner Analysis User Guide.

For a list of supportedmonitor types, see "Monitor Types" on page 380.
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Analyzing Performance Test Results
HP LoadRunner Analysis lets you analyze performance test data off-line, from any computer on which
Analysis is installed. You use Analysis to generate various graph views, merge graphs, drill down
within graphs, change zoom level and granularity, and so forth.

Analysis integrates with ALM Performance Center to let you analyze data collected during a
performance test run. You can download raw results and sessions for analysis on a local machine.
After analyzing the data, you can upload the analysis data (HTML and Rich reports) to Performance
Center to share the results with other users.

For Analysis to access an ALM project, your version of Analysis must be properly configured, and be
connected to ALM Performance Center.

For information about how to work with ALM Performance Center from within Analysis, see theHP
LoadRunner Analysis User Guide.

For details about running performance tests, see "How toManage a Performance Test Run" below.

How to Manage a Performance Test Run
This task describes the workflow for running a performance test, and the available options for managing
the test run.

Version Control: If your project is version-enabled: If you have checked out your test or related
scripts, the checked-out versions are used. If another user has checked out the test or scripts and
you want to run the test or script, the last checked-in version is used.

To learnmore about running performance tests, see "Running Performance Tests Overview" on the
previous page.

This task includes the following steps:

l "Prerequisite" on the next page

l "Begin test execution" on the next page

l "Manage Vusers during the test run - Optional" on the next page

l "Manage virtualized services during the test run - Optional" on the next page

l "Manage runtimemonitors, monitor over firewall machines, and load generators during the test run "
on page 244

l "Manually stop the test run and collate run results - Optional" on page 244

l "View test results andmanage result files" on page 244
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l "Analyze test run results" on the next page

l "View performance improvements and regressions" on the next page

1. Prerequisite

Make sure that the performance test you want to run is valid. For more information, see "How to
Design a Performance Test" on page 111.

Tip: To simplify the process of creating, designing, and running performance tests, you can
use Test Express Designer. This tool guides you through each step, including selecting
scripts for a test, scheduling how many Vusers to run in each script and for how long to run
them, and selecting a post-run action. During test run, you can view the performance test
initialization steps performed by Performance Center and the status for each step. If each
step is completed successfully, the performance test continues running and the Performance
Test Run page opens. For user interface details, see "Test Express Designer" on page 253.

2. Begin test execution
a. On theMy Performance Center navigation bar, select Test Management > Test Lab. In the

Test Labmodule, create a test set that includes an instance of the performance test you want
to run. For user interface details, see the "Test LabModule" on page 249.

b. In the Performance Test Set pane, select a performance test and click RunTest. The Run
Test dialog box opens, enabling you to reserve a timeslot for the test run. For user interface
details, see "Run Test Dialog Box" on page 270.

c. Select an available timeslot and click Run. The Initializing Run page opens. The Initializing
Run page displays the performance test initialization steps performed by ALM Performance
Center, and the status for each step. If each step is completed successfully, the performance
test starts running and the Performance Test Run page opens.

o For Initializing Run page user interface details, see "Initializing Run Page" on page 259.

o For Performance Test Run page user interface details, see "Performance Test Run Page"
on page 261.

3. Manage Vusers during the test run - Optional
You can override the defined schedules andmanually control the behavior of Vusers during a
performance test run.

For task details, see "How toManage Vusers During a Test Run" on page 245.

4. Manage virtualized services during the test run - Optional
You can stop, start, update, and load virtualized services during your performance test run.
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For task details, see "How toManage Virtualized Services During a Test Run" on page 246.

5. Manage runtimemonitors, monitor over firewall machines, and load generators during
the test run
You can perform actions related to the status andmanagement of runtimemonitors, monitor over
firewall machines, and load generators during a performance test run.

For task details, see "How toManageMonitoring and LoadGenerator Information During a Test
Run" on page 247.

6. Manually stop the test run and collate run results - Optional
You canmanually stop a test run, for example, if you want to delay data collection and analysis
until a more convenient time.

n To stop the test run gradually. On the Performance Test Run page, click theStop Run

button . The Stop Run dialog box opens, which prompts you to select a post-run collation
option. Select an option, then click Stop. All Vusers in the test move to theGradual Exiting
state. For user interface details, see "Stop Run Dialog Box" on page 275.

n To stop the test run immediately. After clicking theStop button in the Stop Run dialog box,

theStop Run button on the Performance Test Run page changes toStop Now . Click the
button to stop all Vusers immediately.

7. View test results andmanage result files
You view andmanage result files generated by the test run in the Test Labmodule's Test Runs
view. For user interface details, see "Test LabModule" on page 249.

8. Analyze test run results
You use HP LoadRunner Analysis to analyze test run data off-line, from any computer on which
Analysis is installed. For information on how to access your ALM Project from Analysis, see the
HP LoadRunner Analysis User Guide.

If there are SLAs defined for the performance test, you can calculate SLA results, and view these
results in the Analysis Summary report and SLA report which can be accessed from the Test
Run's Result tab. For user interface details, see "Test LabModule" on page 249.

9. View performance improvements and regressions
You can use the Trend Reports feature to view improvements or regressions in performance
across several test runs. For more information, see "Trending" on page 304.
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How to Manage Vusers During a Test Run
The following steps describe runtime options for managing the behavior of Vusers during a performance
test run.

Note: This task is part of a higher level task. For more information, see "How toManage a
Performance Test Run" on page 242.

This task includes the following steps:

l "View details of individual Vusers" below

l "Run Vusers" below

l "Add/Edit Vuser groups" below

l "View Vuser scripts" on the next page

l "Manually release Vusers from aRendezvous" on the next page

1. View details of individual Vusers
You can view status details of individual Vusers, and run/stop a single Vuser currently in the
down/run state, irrespective of its defined schedules.

On the Performance Test Run page, click theVusers Details button . The Vusers dialog box
opens, enabling you to run or stop individual Vusers. For user interface details, see "Vusers Dialog
Box" on page 280.

2. Run Vusers
You can initialize, run, or stop any number of Vusers irrespective of their defined schedules. In
addition, you can add new Vusers to the performance test.

On the Performance Test Run page, click theRun Vusers button . The Run Vusers dialog
box opens, enabling you to run additional Vusers. For user interface details, see "Run Vusers
Dialog Box" on page 281.

3. Add/Edit Vuser groups
You can add Vuser groups, or you canmodify existing groups during the test run.
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To open the Add/Edit Vuser Group dialog box:

n To add a group. On the Performance Test Run page, click theDesign Groups and

Scheduler button . Then select Add Groups. The Add/Edit Vuser Group dialog box
opens, enabling you to add a Vuser group.

n To edit a group. On the Performance Test Run page, on the Groups pane, place themouse
cursor over the name of the group you want to edit. Click the down arrow that appears adjacent
to the name, and select Edit Group. The Edit Group dialog box opens, enabling you to edit the
group's details.

For user interface details, see "AddGroup Dialog Box" on page 283.

4. View Vuser scripts
On the Performance Test Run page, on the Groups pane, place themouse cursor over a group
name. Click the down arrow that appears adjacent to the name, and select View Script. The View
Script dialog box opens up, enabling you to view the code for each action in the script.

5. Manually release Vusers from a Rendezvous
You canmanually release Vusers from a rendezvous before the Controller releases them.

On the Performance Test Run page, click the View Rendezvous button . The Rendezvous
Policy dialog box opens. For user interface details, see "Rendezvous Dialog Box" on page 144.

How to Manage Virtualized Services During a Test Run
The following task describes runtime options for managing the behavior of virtualized services during a
performance test run.

Note: This task is part of a higher level task. For more information, see "How toManage a
Performance Test Run" on page 242.

1. Open Performance Test Run Page. In theGroups & Workload view, select Advanced >

Services Virtualization to open the Service Simulation dialog box.

2. In theService Simulation dialog box, click theSimulate checkbox of the service you want to
stop, start, or update (for example, change its datamodel).

3. Click Add Project to load the additional project containing the virutalized services to run with your
performance test.
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Tip: You can also click Remove Project to remove the project.

How to Manage Monitoring and Load Generator
Information During a Test Run
The following steps describe runtime options for managingmonitor profile, monitor-over-firewall, and
load generator information during a performance test run.

Note: This task is part of a higher level task. For more information, see "How toManage a
Performance Test Run" on page 242.

This task includes the following steps:

l "Manage RuntimeMonitors" below

l "Edit Monitor Over Firewall Information" below

l "Manage LoadGenerators" below

Manage Runtime Monitors
You can add, edit, or remove currently runningmonitors during a performance test run.

On the Performance Test Run page, click theMonitors button , and select Runtime
Monitors. TheMonitor Profile content dialog box opens. For user interface details, see "Monitor Profile
Content Dialog Box" on page 276.

Edit Monitor Over Firewall Information
You can change the status of amonitor over firewall machine during a performance test run.

On the Performance Test Run page, click theMonitors button , and selectMonitors Over
Firewall. TheMonitors Over Firewall dialog box opens. For user interface details, see "Monitor Over
Firewall Dialog Box" on page 279.

Manage Load Generators
You can perform the following actions with load generators during a performance test run: View status
andmachine utilization, connect and disconnect load generators, add load generators to the test, and
configure terminal sessions.

On the Performance Test Run page, click the Load Generators button . The LoadGenerators
dialog box opens. For user interface details, see "LoadGenerators Dialog Box" on page 277.
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Performance Test Execution User Interface
This section includes:

Test LabModule 249

Test Express Designer 253

Initializing Run Page 259

Performance Test Run Page 261

Run Test Dialog Box 270

Timeslot Duration Dialog Box 274

Stop Run Dialog Box 275

Performance Test Schedule Dialog Box 276

Monitor Profile Content Dialog Box 276

LoadGenerators Dialog Box 277

Add LoadGenerators Dialog Box 278

Monitor Over Firewall Dialog Box 279

Vusers Dialog Box 280

Run Vusers Dialog Box 281

AddGroup Dialog Box 283

View Script Dialog Box 284

SLA Report 285

Calculate Service Level Agreement Dialog Box 286
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Test Lab Module

This module enables you to create andmanage test sets.

To access On theMy Performance Center navigation bar, select Test Management > Test
Lab.

Relevant
tasks

"How toManage a Performance Test Run" on page 242

See also "My Performance CenterWindow" on page 23

User interface elements are described below:

UI Elements Description

<My Performance Center common
UI elements>

ForMy PC menus and buttons, see "My Performance
CenterWindow" on page 23.

Filter By Test Set Enables you to filter by a selected test set.

Test Enables you to filter by a selected test.

Opens the Create New Test Set dialog box, enabling you to
create test sets.

Performance Test Set view Enables you to design tests, assign tests to test sets, and
run tests.

Test Runs view Enables you tomanage results and related actions for test
runs.

Performance Test Set View
This pane enables you to design tests, create test sets, assign tests to test sets, and run tests.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<My Performance
Center common UI
elements>

ForMy PC menus and buttons, see "My Performance CenterWindow" on
page 23.

Opens the Test Express view, which enables you to design and run the
performance test. For more details, see "Test Express Designer" on
page 253.
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UI Elements Description

Opens the Run dialog box, which enables you to run the performance test.
For more details, see "Run Test Dialog Box" on page 270.

Opens the Create New Performance Test dialog box, enabling you to define
a performance test. For more details, see "Create New Performance Test
Dialog Box" on page 124.

Opens the Performance Center Test Designer window, enabling you to
define a performance test. Defining a performance test includes selecting
scripts for the test, scheduling how many Vusers to run in each script and for
how long, choosing topologies andmonitor profiles for the test, and enabling
collection of diagnostics data for the test run. For more details, see
"Performance Test DesignerWindow" on page 122.

Opens the Assign Test to Test Set dialog box, enabling you to add a test
instance of a selected test to a specified test set.

Enables you to rename the test.

Enables you to remove the test.

ID The ID number of the test.

VS The version status of the test.

Test Name The name of the test.

Status The run status of the test.

Responsible The user responsible for the test.

Last Modified The date on which the test was last modified.

Version The version number of the test.

Checkout By The user responsible for checking out the test.

Test Runs View
This pane enables you tomanage results and related actions for test runs.
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User interface elements are described below:

UI Elements Description

Result Management
> Collate

Collates results of test runs that have not yet been collated.

Note:

l If a test is running on the Controller that will perform the collating,
ALMPerformance Center issues an alert. Click OK to proceed with
collating the results, orCancel to defer the action until later.

l Should the Collate Results process encounter an error, the Collate
Errors dialog box appears, displaying details of the error. To
analyze the partially collated results, select Analyze partially
collated results. Note that analyzing partially collated results is an
irreversible operation.

Result Management
> Analyze

Analyzes results for the selected test run. ALM Performance Center
generates analysis data and deletes the temporary results from the load
generators and the Controller.

Note: Only enabled when the test run state is Before Creating
Analysis Data.

Result Management
> Recover Results

Enables you to recover and collate the results of a failed test run.

Note:

l Only enabled when the test run is in the failed state.

l Enables you to collate results only up to the point where the test
failed.

Opens an HTML version of the Analysis Summary report, which analyzes
the data collected during the performance test run. The report provides
general information about the performance test, lists statistics about the
test run, and provides links to graphs containing test run data.

For more details regarding the summary report, see theHP LoadRunner
Analysis User Guide.
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UI Elements Description

Opens the SLA Report for the selected test run. For details, see "SLA
Report" on page 285.

Note: This feature is available only if SLAs were defined during the
performance test design phase. Foremore information about SLAs,
see "Service Level Agreements" on page 188.

Opens the Calculate SLA dialog box. For details, see "Calculate Service
Level Agreement Dialog Box" on page 286.

Note: This feature is available only if SLAs were defined during the
performance test design phase. For more information about SLAs, see
"Service Level Agreements" on page 188.

Enables you to rename a selected test run name.

Deletes selected test run.

Opens the Timeslot Hosts dialog box, which displays the requested and
actual hosts.

Opens the Export PAL Data dialog box.

Add Filter Enables you to filter the information being displayed in the Test Runs grid.
Click the drop-down arrow to apply a filter.

Last Modified Enables you to filter the information being displayed in the Test Runs grid
by the last modified date. Click the drop-down arrow to apply a filter.

Run ID The test run ID.

Run Name The name of test run.

Test The name of the test.

State Displays the current state of the selected test runs.

SLA Status . Indicates a failed SLA status.

. Indicates a passed SLA status.

. Indicates that there is no data about the SLA status.
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UI Elements Description

Exec Date The date and time of the test run.

Duration The time, in minutes, that the test took to run.

Tester The name of the user running the test.

Timeslot The ID of the test run timeslot.

Results tab Displays result information for the selected test run.

l . Enables you to download a selected result file.

l ID. The result file ID.

l Type. The type of result file.

l Name. The name of the result file.

l Modified by. The user who last modified the result file.

l Last Modified. The date the result file was last modified.

Event Log tab Displays a list of events generated for the selected test run.

l ID. The event ID.

l Type. An indication of the event's severity. Frommost to least severe:
error, warning, or info.

l Time. The date and time the event was logged.

l Event. The name of the event.

l Description. A description of the event.

l Responsible. The user, or automated system process responsible for
the event.

Test Express Designer

This window simplifies the process of creating, designing, and running performance tests. It guides you
through each step, including selecting scripts for a test, scheduling how many Vusers to run in each
script and for how long to run them, and selecting a post-run action. During test run, you can view the
performance test initialization steps performed by Performance Center and the status for each step. If
each step is completed successfully, the performance test continues running and the Performance
Test Run page opens.
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To access 1. On theMy Performance Center navigation bar, select Test Management > Test
Lab.

2. Click .

Important
Information

You can refine and adjust your performance test using the Performance Test
Designer window. For more details, see "Performance Test DesignerWindow" on
page 122.

Relevant
tasks

l "How to Design a Performance Test" on page 111

l "How toManage a Performance Test Run" on page 242

See also l "Performance Test Design - Introduction" on page 110

l "Performance Test Execution Introduction" on page 240

l "Performance Test Run Page" on page 261

Step 1 Scripts Pane
This pane enables you to select VuGen scripts to run in the performance test.

User interface elements are described below:

UI Elements Description

Adds the selected VuGen script to the Step 2 - Design pane.

Tip: You can also add a script by dragging it from the tree to the Groups table
in the Design pane.

Refreshes the resources tree.

<resources
tree>

Displays the available VuGen scripts.

Step 2 - Design
This pane enables you to define a performance test. Defining a performance test includes setting a test
run duration, and selecting load generators on which to run the Vuser groups.

User interface elements are described below:
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UI
Elements

Description

Test
Name

The name of the test.

Test
Folder

The test plan folder name.

Groups Name. The name of the Vuser group.

Script. The name of the Vuser script.

Vusers. The number of Vusers assigned to the group.

Load Generators. The load generator on which the group is running. Click the down
arrow to select a load generator.

Command Line. Opens the Script Command Line dialog box, enabling you to type the
name and value of the parameter you want to send using the format, <Parameter_
Name> <value>. For information about the command line parsing functions, or for
details about including arguments on a command line, see theHP LoadRunner Online
Function Reference, provided with HP Virtual User Generator.

Start/End
Vusers

You can start all Vusers simultaneously or start a specific number of Vusers gradually.

l To start all Vusers simultaneously:Move the slider all the way to right.

l To start a specific number of Vusers gradually:Move the slider to the
appropriate predefined settings. The Scheduler will run X Vusers and then wait the
predefined time before running another X Vusers.

Duration The duration of the test run in hours andminutes.

Note: This indicates the test run duration once the gradual initialization and
stopping of all Vusers is done.

Scheduler
Preview

Displays a preview graph by Vuser groups. For more details, click the Scheduler
Preview tooltip icon .

Step 3 - Run
This pane enables you to run the performance test and determine the action to be taken when the test
run is complete.

User interface elements are described below:
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UI
Elements

Description

Post-Run
Actions

Indicates the action to be taken when the test run is complete.

l Do not collate results. Frees themachines immediately after the performance test
ends. When the run has finished, the run results are left on the load generators. You
can analyze the results at a later stage from the Results.

l Collate results.When the run has finished, the run results are collected from all the
load generators. This is recommended because collation of results takes only a few
minutes, and can prevent loss of or inaccessibility to results in case any of your
load generators becomes unavailable.

l Collate and analyze results.When the run has finished, the run results are
collected and analyzed. Data analysis requires some time, depending on the size of
the results file. If there is no timeslot available to include the data analysis, select
the Collate option instead, and run late Analysis when a data processor becomes
available. You run late Analysis from the Results tab. For user interface details, see
"Test LabModule" on page 249.

Test
Validation

Displays the validation results of your performance test

l Level. The type of message: Error orWarning.

l Details. Describes the error or warning.

Save and
Run

Saves and runs the performance test.

The Process Details page opens, displaying the performance test initialization steps
performed by Performance Center and the status for each step. For user interface
details, see "Process Details Page" below.

If each step is completed successfully, the performance test starts running and the
Performance Test Run page opens. For user interface details, see "Performance Test
Run Page" on page 261.

Save Saves the performance test.

Process Details Page
This page displays the performance test initialization steps performed by Performance Center and the
status for each step.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

<progress
chart>

Displays test initialization steps progress in percentage.
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UI
Elements

Description

Step Name Displays the following steps:

l RegisterRun. Performance Center initializes the run process.

l ValidateScripts. Performance Center checks that the selected scripts' Run Logic
runtime settings are in sync with the scripts' state.

l GetReservationData. Performance Center checks the required resource
information from the selected timeslot.

l CheckDiskSpace. Performance Center checks that there is enough disk space
on the Controller.

l LaunchController. Performance Center initializes the Controller so that other
testing entities, such as load generators and scripts can connect to it. If there is a
problem launching the Controller, Performance Center automatically attempts to
find an alternative Controller. This attempt appears as an additional initialization
step. If no alternative Controller is available, the step fails.

l ConnectToLGs. Performance Center checks that the required load generators
are valid and connects them to the Controller. If this step fails, Performance
Center attempts to find alternative load generators automatically. If this step still
fails, check the test definitions and select different load generators for the test.

l DownloadScripts. Performance Center downloads the required Vuser scripts.

l StartControllerServices. Performance Center initializes the Controller's
configuration settings in preparation to run the performance test.

l MapVirtualHosts. Performance Center maps virtual hosts to actual hosts.

l LoadLTOMToController. Performance Center creates the performance test and
adds the Vuser scripts to the Controller.

l StartRun. Performance Center starts the performance test run.

Description A detailed description of the current status of the step.

Status Displays whether the step passed or failed.

System
Messages

Displays error messages generated when a step fails. These error messages can
also be viewed from the Event Log. For details about the event log, refer to theHP
ALM LabManagement Guide.
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Initializing Run Page

The Initializing Run page displays the performance test initialization steps performed by ALM
Performance Center and the status for each step.

To access In the Run Performance Center dialog box, click Run. For details, see "Run Test
Dialog Box" on page 270.

Relevant
tasks

"How toManage a Performance Test Run" on page 242

User interface elements are described below:

UI
Elements

Description

Test Name The name of the test.

<Run Date
and Time>

The date and time of the test run.

By The user responsible for running the test.

Timeslot
Name

The name of the test run timeslot.

Duration The time that the test takes to run.

Vusers The number of Vusers reserved for the timeslot.

Machines The number of hosts requested for this test.

<Progress
Chart>

Displays test initialization steps progress in percentage.
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UI
Elements

Description

Step Name Displays the step name. For explanations about the action ALMPerformance Center
performs for each step, see Initialization Steps below.

Description A detailed description of the current status of the step.

Status Displays whether the step passed or failed.

System
Messages

Displays error messages generated when a step fails. These error messages can
also be viewed from the Event Log. For details about the event log, refer to theHP
ALM LabManagement Guide.

Initialization Steps

The Initialization steps are described below:

Step Description

RegisterRun Performance Center initializes the run process.

ValidateScripts Performance Center checks that the selected scripts' Run Logic runtime
settings are in sync with the scripts' state.

GetReservationData Performance Center checks the required resource information from the
selected timeslot.

CheckDiskSpace Performance Center checks that there is enough disk space on the
Controller.

LaunchController Performance Center initializes the Controller so that other testing entities,
such as load generators and scripts can connect to it.

If there is a problem launching the Controller, Performance Center
automatically attempts to find an alternative Controller. This attempt appears
as an additional initialization step.

If no alternative Controller is available, the step fails.

DownloadScripts Performance Center downloads the required Vuser scripts.
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Performance Test Run Page

The Performance Test Run page displays a detailed overview of the running performance test, and
enables you to perform all runtime test run actions.

To
access

The Performance Test Run page opens as a tab inMy Performance Center automatically
when a performance test starts, or when you join a running test fromMy Performance
Center.

Relevant
tasks

"How toManage a Performance Test Run" on page 242

Performance Test Details Pane - Toolbar Buttons
The Performance Test Details pane displays details on the running test.

To access The pane is located in the upper area of the Performance Test Details page.

User interface elements are described below:

UI Elements Description

Displays the Performance Test Run page Details paneGroups view. For
more information, see "Performance Test Details Pane - Groups View"
on page 263.

Displays the Performance Test Run page Details pane Transactions
view. For more information, see "Performance Test Details Pane -
Transactions View" on page 264.
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UI Elements Description

Displays the Performance Test Run page Details paneMessages view.
For more information, see "Performance Test Details Pane - Messages
View" on page 265.

Vusers Details. Displays specific details for each Vuser in the
performance test, and enables you to run or stop individual Vusers
irrespective of their defined schedules. For user interface details, see
"Vusers Dialog Box" on page 280.

Run Vusers. Enables you to run additional Vusers during the course of a
performance test. That is, you can run Vusers that are not included in the
test's original defined schedule. For user interface details, see "Run
Vusers Dialog Box" on page 281.

Stop Run/Stop Run Now. Enables you to stop a running performance
test.

l Stop Run. Stops the test gradually by moving all running Vusers to
the Gradual Exiting state. For user interface details, see "Stop Run
Dialog Box" on page 275.

l Stop Run Now. Enabled only after you click theStop Run button.
Enables you to stop the Vusers immediately.

Design Groups and Scheduler. Click the arrow adjacent to the button
for the following options:

l Add Group. Enables you to add a Vuser group to a running
performance test, or to edit Vuser group settings during a test run. For
user interface details, see "AddGroup Dialog Box" on page 283.

l Edit Scheduler. Enables you to edit the scheduler during a test run.
For user interface details, see "Performance Test Schedule Dialog
Box" on page 276.

Monitors. Click the arrow adjacent to the button for the following
options:

l Runtime Monitors. Displays a list of monitors which are currently
running during a performance test, and enables you to add, edit, and
removemonitors during the run. For user interface details, see
"Monitor Profile Content Dialog Box" on page 276.

l Monitor Over Firewall. Enables you to change the status of a
monitor over firewall machine. For user interface details, see "Monitor
Over Firewall Dialog Box" on page 279.
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UI Elements Description

View Rendezvous. Enables you to enable/disable rendezvous points
defined in the Vuser scripts and to set rendezvous policies that
determine how the Controller handles Vusers at a rendezvous point. For
user interface details, see "Rendezvous Dialog Box" on page 144.

Load Generators. Enables you tomanage the load generator in the
performance test. For user interface details, see "LoadGenerators
Dialog Box" on page 277.

Timeslot Duration. Enables you to extend or shorten the duration of the
performance test. For user interface details, see "Timeslot Duration
Dialog Box" on page 274.

Filter Items. Enables you to filter the information being displayed.

Refresh Frequency. Enables you set the refresh frequency of the page.

Service Virtualization. Opens the Configure Service Virtualization
Dialog Box. For user interface details, see see "HP Service Virtualization
Dialog Box" on page 154.

Add to PAL. Opens the Select PALReport dialog box, enabling you to
add the test run data to a selected PAL report. The test run data is
displayed in the Data Sources Tab. For more details, see "Data Sources
Tab" on page 352.

Performance Test Details Pane - Groups View
TheGroups view of the Details pane displays the statuses of the Vusers in the performance test.

To access In the Performance Test Run page, in the Details pane, click Groups.

Note: Displayed by default.

User interface elements are described below:

UI Elements
(A - Z)

Description

Down The number of Vusers that are down.

Error The number of Vusers for which a problem occurred.
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UI Elements
(A - Z)

Description

Exiting
(displayed as
Exit)

The number of Vusers that have finished running, or have been stopped, and are
exiting now.

Failed The number of Vusers that have finished running. The script failed.

Gradual
Exiting
(displayed as
G. Exit)

The number of Vusers that are finishing their current iteration before exiting.

Init The number of Vusers that are being initialized on the host machine.

Name The Vuser group name.

Passed The number of Vusers that have finished running. The script passed.

Paused The number of Vusers that have been paused.

Pending The number of Vusers that are ready to be initialized and are waiting for an available
load generator, or are transferring files to the load generator. The Vusers run when
the conditions set in their scheduling attributes aremet.

Ready The number of Vusers that have already performed the init section of the script and
are ready to run.

Rendezvous The number of Vusers that have arrived at the rendezvous and are waiting to be
released.

Running The number of Vusers that are running. The Vuser script is being executed on a host
machine.

Stopped The number of Vusers that have been stoppedmanually.

Performance Test Details Pane - Transactions View
The Transactions view of the Details pane displays how many transactions have been executed
successfully or unsuccessfully.

To access In the Performance Test Run page, in the Details pane, click Transactions.

User interface elements are described below:

UI Elements Description

Failed The number of times the transaction failed.
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UI Elements Description

Name The transaction name.

Pass The number of times the transaction passed.

Stopped The number of times the transaction stopped.

Success Rate % The transactions success rate percentage.

TPS The number of times per second the transaction has run.

Performance Test Details Pane - Messages View
TheMessages view of the Details pane displays error, warning, debug, and output messages that are
sent to the Controller by the Vusers and load generators during a test run.

To access In the Performance Test Run page, in the Details pane, click Messages.

Important
information

To view details of specific messages, click the number for themessage type to
open theOutput Details dialog box.

User interface elements are described below:

UI
Elements

Description

Script
Name

The name of the script that generated themessage.

Total
Debug

Sent only if the debugging feature is enabled in the Controller. To enable the feature,
select Tools > Performance Center Controller Options > Debug Information.

Total
Errors

The total number of error messages received. Error messages usually indicate that the
script failed.

Total
Messages

The total number of messages received.

Total
Output

The total number of output messages received from the Vuser script.

Total
Warnings

The total number of warningmessages received. Warningmessages indicate that the
Vuser encountered a problem, but the test continued to run.

Summary Pane
The Summary pane displays a synopsis of the running performance test.

To access Displayed in the upper left corner of the Performance Test Run page.
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User interface elements are described below:

UI Elements Description

Controller The Controller being used in the test.

Elapsed Time The amount of time since the test began running.

Errors The number of Vuser errors that occurred during the test run.

Failed
Transactions

The number of completed, unsuccessful transactions performed during the test
run.

Hits per Sec How many hits (HTTP requests) there have been to theWeb server by Vusers
during each second of the test run.

Passed
Transactions

The number of completed, successful transactions performed during the test run.

Run ID The run ID.

Running
Vusers

The number of Vusers currently running in the test.

Scheduler State The current state of the scheduler.

State The current run state.

Test The name of the test.

User The name of the user who is running the test.

Services
Virtualization

Whether services virtualization is on or off.

Online Graphs Pane
The onlinemonitor graphs are used to display performancemeasurements for those resources being
monitored in a performance test.

To access Displayed in the lower section of the Performance Test Run page.

User interface elements are described below:

UI
Elements

Description

# Graphs. Enables you to select the number of graphs being displayed.
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UI
Elements

Description

Graph Configuration. Opens theGraph Configuration dialog box which enables you to
configure the graphs display. The following options are available:

l Granularity. The interval of the test displayed in the graph.

l Time Display. The time displayed on the x-axis.

n Relative to Load Test start. Displays the amount of time that has elapsed since
the beginning of the test (in hours, minutes, and seconds).

n Controller clock. Displays the time on the Controller clock.

n None. No clock or time is displayed.

l Scale. Select the desired scale:

n Automatic. Eachmeasurement in the graph is displayed in the scale that best
suits it.

n None. Eachmeasurement's true values are displayed in the graph.

l Line Style. Select the desired line style:

n With markers. Lines in the graph aremarked with dots.

n Without markers. Lines in the graph are smooth.

l Apply to all visible graphs. Applies the changes to all displayed graphs.

Duplicate Graph. Enables you to duplicate a graph.

Rename Graph. Enables you to rename a graph.

User and Administrator Guide
Chapter 18: Performance Test Execution Introduction

HP ALM Performance Center (12.20) Page 267 of 521



UI
Elements

Description

Diagnostics Transaction Breakdown. Opens HP Diagnostics, displaying the
Transactions view, which displays performancemetrics and drilldown options for the
relevant transaction. For more information about interpreting data in the Diagnostics
Transactions view, see the section that describes the transaction views in theHP
Diagnostics User Guide.

Note:

l Only enabled if your system is configured to work with HP Diagnostics.

l To ensure that you can view Diagnostics data during a performance test run, in
the Java Settings' Java Control Panel, click theNetwork Settings button and
select Direct Connection.

<graph
legend>

Displays details about graph. The following information is displayed.

l V. Selects themeasurement to be displayed on the graph.

l B. Displays themeasurement in bold.

l <color>. Enables you to select in which color themeasurement appears in the
graph.

l Name. Themeasurement name.

l Scale. The graph scale.

l Max. Themeasurement's maximum value.

l Min. Themeasurement's minimum value.

l Avg. Themeasurement's average value.

l Std. Themeasurement's standard deviation.

l Last. Themeasurement's last value.

Graphs Displays a tree which lists all the configured onlinemonitors graphs.

Graph Selection Tab
This tab displays a tree which lists all the configured onlinemonitors graphs, and enables you to select
which graphs to display in the Online Graphs pane.

To access Click theGraphs tab, on the right of the Online Graphs pane.
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User interface elements are described below:

UI Elements Description

<Online
graphs tree>

Displays a list of the configured onlinemonitors. Select amonitor to display its
graph in the Online Graphs pane.

Topology Tab
This tab displays the topology selected for the performance test, enabling you to track the SiteScope
monitor status on each component of your AUT.

To access Click the Topology tab, on the right of the Online Graphs pane.

Important
information

l To ensure that SiteScopemonitoring data can be displayed for the topology,
ensure that the relevant SiteScope server is up and running and that connectivity
has been established.

l After the test run, a snapshot of the topology is included among the run result files.
For details, see "Test LabModule" on page 249.

See also "Topologies Overview" on page 49

User interface elements are described below:

UI
Elements

Description

Zoom in/out. Enables you to zoom in and out of the topology tab.

Fit to panel. Enables you to fit the entire topology design to the current pane size.

Edit monitor. Opens HP SiteScope, enabling you to edit themonitors defined on the
component selected in the Topology tab.

Note: During a test run, you can only edit monitors that were defined on the
components when designing the topology. You cannot add new monitors during
the test run.
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UI
Elements

Description

<Topology
display
area>

Displays the topology selected for the test.

If monitors are defined on a component in the topology, the following icons may
appear:

l . Indicates that all of themonitors on the component are working successfully.

l . Indicates that there is an error with at least one of themonitors on the
component.

l . Indicates that at least one of themonitors on the component is not working or
not receiving data.

l . Indicates a warning on at least one of themonitors on the component.

Run Test Dialog Box

This dialog box enables you to run performance tests.
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To
access

Use one of the following:

l On theMy Performance Center navigation bar, select Test Management > Test
Plan. Click a performance test in the test plan tree. In the Preview, click Run Test.

l On theMy Performance Center navigation bar, select Test Management > Test
Lab. In the Performance Test Set pane, select a performance test and click Run
Test.

Relevant
tasks

l "How toManage a Performance Test Run" on page 242

l "How toWork with PAL" on page 339

New Timeslot Tab

Enables you to create a new timeslot. If the current resources are insufficient for the selected test, you
will be unable to reserve a timeslot to run the test.

User interface elements are described below:

UI Element Description

Duration The amount of time, in hours andminutes, that you need the resources reserved.

Requested
Resources

The resources being requested for this test.

VUDs Requests VUDs Vusers for the test rather than regular Vusers. For details about
VUDs, refer to theHP ALM LabManagement Guide.

Post Run
Action

The action to be taken when the test run is complete.

l Do not collate results. Frees themachines immediately after the performance
test ends. When the run has finished, the run results are left on the load
generators. You can analyze the results at a later stage from the Results.

l Collate results.When the run has finished, the run results are collected from
all the load generators. This is recommended because collation of results takes
only a few minutes, and can prevent loss of or inaccessibility to results in case
any of your load generators becomes unavailable.

l Collate and analyze results. When the run has finished, the run results are
collected and analyzed. Data analysis requires some time, depending on the
size of the results file. If there is no timeslot available to include the data
analysis, select the Collate option instead, and run late Analysis when a data
processor becomes available. You run late Analysis from the Results tab. For
user interface details, see "Test LabModule" on page 249.

AUT Env.
Configuration

You can only use a deployed environment. For details, refer to theHP Application
Lifecycle Management User Guide.
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UI Element Description

Calculate
Availability

Calculates the availability of the resources required for running the test and checks
whether a new timeslot can be created.

Availability
results

Displays the results of the availability verification. If your timeslot cannot be
reserved, the reason will be displayed.

Run Uses the hosts reserved by the selected timeslot and runs the test. The
Performance Center Dashboard opens displaying the Performance Test Run page.
For details, see "Performance Test Run Page" on page 261.

Reserved Tab

Enables you to run a test in a reservedmanual timeslot that has been assigned to your test or has not
been assigned to any test. If there are no timeslots available, you will be unable to schedule your test.

User interface elements are described below:

UI Element Description

ID The ID of the run created in the context of the timeslot.

Created By The user who reserved the timeslot.

Start Time The date and time that the timeslot is due to start or started.

Duration The duration of the timeslot.

Vusers The number of Vusers reserved for the timeslot.

Hosts The number of hosts (including Controller) requested for the timeslot.

User and Administrator Guide
Chapter 18: Performance Test Execution Introduction

HP ALM Performance Center (12.20) Page 272 of 521



UI Element Description

Remark Indicates a timeslot remark. Includes the following values:

l New. Indicates a new timeslot that can be created especially for this run.

l Recommended. Displayed when the test you are about to run is linked (without
Autostart) to the timeslot. When the timeslot was reserved, all the resources
needed for this test were reserved. It is therefore recommended to use this
timeslot rather than creating a new one.

l Update Required. Indicates that the timeslot can offer some of the resources
needed for the test but you need to update the timeslot to include all the other
required resources too. The resource requiring the update is marked with an
asterisk (*).

Note: Even if you reserved a timeslot in the Timeslots module, it may not
appear in the grid. Some possible reasons include:

l The timeslot is not open yet.

l The timeslot is running (it was configured to start automatically instead of
manually).

l The timeslot does not have the required resources, and due to concurrent
timeslots, it cannot be updated with more resources.

l The timeslot was not configured with a duration long enough to run the
selected test entity, and it cannot be prolonged.

l The timeslot was linked to another test by mistake.

Name The name of the timeslot.

Duration The amount of time, in hours andminutes, that you need the resources reserved.

Requested
Resources

The resources being requested for this test.

VUDs Requests VUDs Vusers for the test rather than regular Vusers. For details about
VUDs, refer to theHP ALM LabManagement Guide.
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UI Element Description

Post Run
Action

The action to be taken when the test run is complete.

l Do not collate results. Frees themachines immediately after the performance
test ends. When the run has finished, the run results are left on the load
generators. You can analyze the results at a later stage from the Results.

l Collate results.When the run has finished, the run results are collected from
all the load generators. This is recommended because collation of results takes
only a few minutes, and can prevent loss of or inaccessibility to results in case
any of your load generators becomes unavailable.

l Collate and analyze results. When the run has finished, the run results are
collected and analyzed. Data analysis requires some time, depending on the
size of the results file. If there is no timeslot available to include the data
analysis, select the Collate option instead, and run late Analysis when a data
processor becomes available. You run late Analysis from the Results tab. For
user interface details, see "Test LabModule" on page 249.

AUT Env.
Configuration

You can only use a deployed environment. For details, refer to theHP Application
Lifecycle Management User Guide.

Timeslot Duration Dialog Box

This page enables you to extend or shorten the current timeslot.

To access During runtime, on the Performance Test Run page, click the Timeslot Duration

button .

Relevant
tasks

"How toManage a Performance Test Run" on page 242

User interface elements are described below:

UI Elements Description

Refreshes the Timeslot Remaining Time information.

Prolong Timeslot by X
minutes

Prolongs the timeslot duration by the selected number of
minutes.

Shorten Timeslot by X
minutes

Shortens the timeslot duration by the selected number of
minutes.
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Stop Run Dialog Box

This page enables you to stop a running performance test and to select a post-run collation option.

To access During a test run, on the Performance Center Dashboard's Performance Test Run

page, click theStop Run button .

Relevant
tasks

"How toManage a Performance Test Run" on page 242

User interface elements are described below:

UI
Elements
(A-Z)

Description

Moves all running Vusers to theGradual Exiting state.

Collate and
analyze
results

ALM Performance Center collates the run data from the load generators and
generates analysis data. After data is collated, Performance Center automatically
deletes the temporary results from the load generators and controllers. You can
display the results using analysis tools such as graphs and reports, or download the
results for analysis on a local machine. This option takes themost time.

Collate
results

ALM Performance Center collates the run data from the load generators. After data is
collated, Performance Center automatically deletes the temporary results from the
load generators. You can download the raw results from the Results tab, or manually
analyze results at a later point from the Results tab.

Note: This is the default setting.

Do not
collate
results

Frees themachines immediately after the test ends. You can collate and analyze
results at a later point from the Results tab.

Free
current
timeslot

Frees the current timeslot once the test has stopped.
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Performance Test Schedule Dialog Box

This dialog box enables you to edit scheduler settings during a performance test run.

To
access

On the Performance Test Run page, click theDesign Groups and Scheduler button

.Then select Edit Scheduler.

Relevant
tasks

"How toManage a Performance Test Run" on page 242

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Stops the scheduler and enables it for editing.

Pauses the scheduler.

Restarts the scheduler after editing.

<edit scheduler
section>

Enables you to edit a defined schedule. For more information, see "Global
Scheduler Actions" on page 184.

Global/Groups
Schedule

Displays whether the current schedule has been defined by test or by
group.

l Start Time. Enter a delay time for the scheduler to restart after editing.
To restart the scheduler immediately, leave this setting blank.

l Wait. (Groups schedule only) Select to initialize all Vuser groups
together.

l Group. (Groups schedule only) Select individual groups to display and
edit their schedules.

Schedule Graph Provides a graphical representation of the defined schedule actions.

State Displays the current scheduler status.

Monitor Profile Content Dialog Box

This dialog box displays a list of monitors which are currently running during a performance test, and
enables you to add, edit, and removemonitors during the run.
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Themonitors that are displayed are a combination of themonitors from all themonitor profiles that were
associated to the test, as well as a set of 'host' monitors which are added automatically to every test
for each host which is used in the test.

To access
On the Performance Test Run page, click theMonitors button , and
select Runtime Monitors.

Important
information

l Monitors which are defined as part of a monitor profile but fail to run do not
appear in the list of monitors.

l Default host monitors cannot bemodified during runtime.

Relevant tasks "How toManage a Performance Test Run" on page 242.

User interface elements are described below:

UI
Elements

Description

Add Monitor. Click to add amonitor to the performance test. For more information
about monitors, see "Add New Monitors Page" on page 69.

Edit Monitor. Click to edit the selectedmonitor. The relevant monitor type page opens,
enabling you to edit themonitor information.

Delete Selected Item. Deletes the selectedmonitor.

Refresh Monitors List. Refreshes themonitors list.

Load Generators Dialog Box

This dialog box enables you to view load generator status andmachine utilization, connect and
disconnect load generators, add load generators to the test, and to configure terminal sessions.

To access
On the Performance Test Run page, click the Load Generators button.

Relevant tasks "How toManage a Performance Test Run" on page 242

User interface elements are described below:

UI Elements Description

Select All. Selects all displayed load generators.

Deselect All. Deselects all displayed load generators.
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UI Elements Description

Invert Selection. Inverts the current selection of load generators. That is, the non-
selected load generators are selected, and the selected load generators are
cleared.

Disconnects the selected load generator for the performance test.

Connects the selected load generator for the performance test.

Add Load Generators. Opens the Add LoadGenerators dialog box, which
enables you to add load generators to the test. For user interface details, see "Add
LoadGenerators Dialog Box " below.

Terminal Session Settings. Opens the Terminal Services dialog box, which
enables you to configure terminal sessions for the load generator. For user
interface details, see "Terminal Services Dialog Box" on page 224.

Refresh. Refreshes the information displayed in the LoadGenerators dialog box.

Name The load generator name.

Details Load generator details.

Platform The platform on which the load generator is running.

Status The current status of the load generator. The possible statuses are:

l Active. The load generator is connected.

l Busy. The load generator is running Vusers.

l Disconnecting. The load generator is disconnecting.

l Down. The load generator is not connected.

l Failed. A connection with the load generator could not be established.

l Ready. The load generator is connected.

Add Load Generators Dialog Box

This dialog box enables you to add load generators to a running performance test.

To access
In the LoadGenerators dialog box, click theAdd Load Generators button .

Relevant tasks "How toManage a Performance Test Run" on page 242

See also "LoadGenerator Distribution " on page 160
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User interface elements are described below:

UI Elements Description

Add X
Automatch
Load
Generators

Enables you to add a specified number of automatch load generators.

Add Specific
Load
Generators

Enables you to add specific load generators. The load generator table lists the
specific load generators which are available, displaying the following information
for each load generator:

l Name. The load generator name.

l State. The current state of the load generator: Operational, Non-Operational,
orUnavailable.

l Purpose. The purpose of the load generator, that is, Controller, Load
Generator, Data Processor, or a combination of these.

l Location. The location of the load generator.

l Host Attributes. Select attributes for the load generator.

Monitor Over Firewall Dialog Box

This dialog box enables you to change the status of amonitor over firewall machine during a test run.

To access
On the Performance Test Run page, click theMonitors button , and select
Monitor Over Firewall.

Relevant
tasks

"How toManage a Performance Test Run" on page 242

User interface elements are described below:

UI Elements Description

Select All. Selects all displayedmonitor over firewall machines.

Deselect All. Deselects all displayedmonitor over firewall machines.

Invert Selection. Inverts the current selection of monitor over firewall machines.

That is, the non-selectedmachines are selected, and the selectedmachines are
cleared.
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UI Elements Description

Disconnects the selectedmonitor over firewall machine for the performance test.

Connects the selectedmonitor over firewall machine for the performance test.

Refresh. Refreshes the information displayed in themonitor over firewall agent
dialog box.

Vusers Dialog Box

This dialog box displays specific details for each Vuser in the performance test, and enables you to run
or stop individual Vusers irrespective of their defined schedules.

To
access

During Runtime, on the Performance Center Dashboard's Performance Test Run page,

click theVusers Details button .

Relevant
tasks

"How toManage a Performance Test Run" on page 242

User interface elements are described below:

UI
Elements

Description

Select All. Selects all displayed Vusers.

Deselect All. Deselects all selected Vusers.

Invert Selection. Inverts the current selection of Vusers. That is, the non-selected
Vusers are selected, and the selected Vusers are cleared.

Run Selected Vusers. Runs the selected Vusers.

Pause Selected Vusers. Pauses the selected Vusers.

Stop Selected Vusers Gradually. Stops the selected Vusers gradually. The Vusers
complete the current iteration before stopping.

Stop Selected Vusers Immediately. Stops the selected Vusers immediately.

Reset Selected Vusers. Resets the selected Vusers to the Down state.
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UI
Elements

Description

Show Selected Vusers Log. Opens the Vuser Activity Log, which displays runtime
information for the selected Vuser. The log displays the following information:

l Activity log for Vuser. The selected Vuser.

l Refresh. Refreshes the information displayed in the log.

l Download log. Enables you to download the log.

l Close. Closes the log.

l Log Message. Displays the logged Vuser messages.

l Show snapshot. Generates a snapshot of the point where an error occurred in a
test run. Before using this feature, youmust install the snapshot viewer on your
desktop, and enable theSnapshot on Error option in the Runtime Settings for the
Vuser script. For more information on configuring the runtime settings, see "Script
Runtime Settings" on page 466.

Refresh. Refreshes the information displayed in the dialog box.

Elapsed
Time

The amount of time the Vuser has been running.

Group Filters displayed Vusers by Vuser group.

ID The Vuser's ID.

Load
Generator

Filters displayed Vusers by load generators.

Status Filters displayed Vusers by their current status.

Run Vusers Dialog Box

This dialog box enables you to initialize, run, or stop any number of Vusers irrespective of their defined
schedules. In addition, you can add new Vusers or VUDs to the performance test.

To access
On the Performance Test Run page, click theVuser Details button .

Relevant tasks "How toManage a Performance Test Run" on page 242
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User interface elements are described below:

UI Elements Description

by Vusers. The Vusers being given an instruction are distributed
according to Vuser groups.

by Load Generator. The Vusers being given an instruction are
distributed according to load generators.

by Number. Enables you to give an instruction to a specific number of
Vusers per Vuser group/load generator.

by Percentage. Enables you to give an instruction to a specific number
of Vusers, which are then distributed among the Vuser groups/load
generators according to a percentage which you define.

Example: If you choose to run an additional 200Vusers, among three
Vuser groups, A, B, andC, and you define the percentage distribution as
A = 75%, B = 20%, andC = 5%, then the Vusers would be distributed
as follows:

A. 150 Vusers

B. 40 Vusers

C. 10 Vusers

Note:When selecting this method, you enter the number of Vusers
to run in the box adjacent to the by Percentage button.

Enter the number of Vusers per Vuser group/load generator.

Enter the percentage distribution per Vuser group/load generator.

Performs the selected instruction.

Group Lists the Vuser groups in the test.

Load Generator Lists the load generators in the test.
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UI Elements Description

Perform the following
Action

Give the desired instruction to the defined number of Vusers. The
possible actions are:

l Add new Vusers to Down state. Add the desired number of Vusers
to theDown state.

l Add new VUDs to Down state. Add the desired number of VUDs to
theDown state.

l Initialize Vusers from Down. Initializes the desired number of
Vusers currently in theDown state.

l Run Vusers from Down. Runs the desired number of Vusers
currently in theDown state.

l Run Vusers from Ready. Runs the desired number of Vusers
currently in theReady state.

l Stop Vusers.Moves the desired number of Vusers from theRun
state to theGradual Exiting state.

l Reset Vusers.Moves the desired number of Vusers from the
Stopped state to theDown state.

Note: You cannot perform an action onmore Vusers than are
currently in a particular state. For example, if you define 10Vusers
and select Initialize Vusers from Down, but there are only five
Vusers in the Down state, only those five Vusers are initialized.

Add Group Dialog Box

This dialog box enables you to add a Vuser group to a running performance test, or to edit Vuser group
settings during a test run.

To access l When adding a Vuser group. OnPerformance Test Run page, click the Design

Groups and Scheduler button . Then select Add Groups.

l When editing a Vuser group. On the Performance Test Run page, on the
Groups pane, place themouse cursor over the name of the group you want to edit.
Click the downward arrow that appears adjacent to the name, and select Edit
Group.

Important
information

To edit a Vuser group, all Vusers must be in the inactive state.
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Relevant
tasks

"How toManage a Performance Test Run" on page 242

User interface elements are described below:

UI Elements (A-Z) Description

Enables you to view and change the runtime settings for the Vuser script.
For more details, see "How to Configure Runtime Settings" on page 467.

Opens the script in VuGen.

Command Line Type the name and value of the parameter you want to send using the
format, <Parameter_Name> <value>.

For information about the command line parsing functions, or for details
about including arguments on a command line, see theHP LoadRunner
Online Function Reference, provided with HP Virtual User Generator.

Group Name The name of the Vuser group.

Load Generators The load generators on which the group is running.

Protocol The Vuser script's protocol.

Script The name of the Vuser script.

Vusers The number of Vusers assigned to the group.

View Script Dialog Box

This dialog box enables you view the code for each action in a running Vuser script.
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To
access

On the Performance Test Run page, on the Groups pane, place themouse cursor over
the name of a group. Click the downward arrow that appears adjacent to the name, and
select View Script.

Relevant
tasks

"How toManage a Performance Test Run" on page 242

User interface elements are described below:

UI Elements Description

Enables you to download the script.

Script Name The script's name.

Type The script type.

Last Update The last updated date and time.

Actions Lists the actions included in the script. Click on an action to view its code in
the right pane.

Included files Displays files included in the script.

SLA Report

This report displays the post-run SLA statuses of the SLA goals defined for the performance test.

To access Use one of the following:

l On theMy Performance Center navigation bar, select Test Management > Test
Plan. Click a performance test in the test plan tree. In the Test Run tab, click SLA
Report button.

l On theMy Performance Center navigation bar, select Test Management > Test
Lab or select Runs & Analysis > Runs. In the Test Runs view, click SLA
Report button.

Important
information

The SLA report is available only if SLAs were defined prior to running the performance
test.

Relevant
tasks

"Running Performance Tests Overview" on page 241

See also "Service Level Agreements Overview" on page 189

User and Administrator Guide
Chapter 18: Performance Test Execution Introduction

HP ALM Performance Center (12.20) Page 285 of 521



User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Export to Excel. Enables you to export the selected section of the SLA report
to an Excel file.

Export to PDF. Enables you to export the selected section of the SLA report to
a .pdf file.

Export to CSV. Enables you to export the selected section of the SLA report to
a .csv file.

Export to Word. Enables you to export the selected section of the SLA report
to aWord file.

<Test run
details>

The details of the performance test run to which the SLA report data relates are
displayed at the top of the report.

<SLA grids> The results for each SLA are displayed in separate grids.

Tip: Each set of results can be exported to Excel, Word, PDF, and CSV
format.

<SLA status
indicators> . Indicates a failed SLA status.

. Indicates a passed SLA status.

. Indicates that there is no data about the SLA status.

Calculate Service Level Agreement Dialog Box

This dialog box enables you to change the test time range included in the Service Level Agreement
(SLA).

To access Use one of the following:

l On theMy Performance Center navigation bar, select Test Management >Test
Plan. Click a performance test in the test plan tree. Click the Test Run tab. Click
theRecalculate SLA Report button.

l On theMy Performance Center navigation bar, select Test Management >Test
Lab or select Runs & Analysis > Runs. Click theRecalculate SLA Report
button.

Important
information

The Recalculate SLA button is available only if SLAs were defined for the
performance test.
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Relevant
tasks

"Running Performance Tests Overview" on page 241

See also "Service Level Agreements Overview" on page 189

User interface elements are described below:

UI Elements Description

Recalculates the SLA according to the defined information.

Calculate SLA for
whole run duration

Calculates the SLA over the whole test run.

Calculate SLA for part
of run duration

Calculates the SLA over part of the test run. Enter the desiredStart Time
andEnd Time over which to calculate the SLA.
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Network Virtualization Overview
HP ALM Performance Center integrates with HP Network Virtualization to help you test point-to-point
performance of network-deployed products under production conditions. By installing HP Network
Virtualization, you can introduce highly probable network effects such as latency, packet loss, and link
settings. As a result, your test scenario runs in an environment that more reliably and accurately
represents the real-world conditions experienced by end users.

HP Network Virtualization includes a global library of network conditions from cities around the world.
Because the network parameters are provided by HP Network Virtualization, you do not need to
manually enter this information.

The following table presents themost typical effects that you can configure:

Effect Description

Latency The time, in milliseconds, that it takes an IP packet to cross the network. This is
usually affected by geographical distance, the available bandwidth, the network load
on the route between the two ends, and whether this is a terrestrial link.

Packet
Loss

The chance of losing IP packets while data travels through a network. Packets can get
lost due to link faults or due to extreme network load.

Bandwidth The capacity of your network to transfer data.

You can createmoremeaningful results by configuring several load generators or groups of Vusers with
a unique set of network effects, and by giving each set a unique location path. For example, you could
define a location from New York to London and another one from Los Angeles toNew York.

After running a performance test, view the results in the Performance Test Run page or the LoadRunner
Analysis. For details on the Performance Test Run page, see "Performance Test Run Page" on
page 261. For details on viewing results in Analysis, see theHP LoadRunner Analysis User Guide.

For details on how to integrate Network Virtualization into your performance test, see "How to Integrate
Network Virtualization into a Performance Test" on page 292.

This section also includes:

l "Defining Virtual Locations" on the next page

l "ExcludingMachines from Network Virtualization" on the next page

l "Viewing Network Virtualization Graphs" on the next page

l "Workflow forWorking with Network Virtualization" on page 291
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Defining Virtual Locations
From within Performance Center, HP Network Virtualization enables you to define different network
locations and conditions for virtualizing in the test environment, so each end user geography and the
unique conditions associated with each can be accurately represented. For example, you can define
end point locations in London andNew York and emulate the network path between those two cities.
You add locations in the Network Virtualization Settings dialog box. You can define global virtualization
settings or configure the settings for each of the locations separately. For details, see "Network
Virtualization Settings Dialog Box" on page 300.

Excluding Machines from Network Virtualization
In some situations, youmay need to exclude certain machines from the network virtualization as they
could inappropriately affect the emulation. When amachine is excluded from network virtualization,
network traffic to that machine does not suffer any network effects and is not included in the network
virtualization results.

The followingmachines are excluded by default:

l The Controller machine or theMI Listener and proxy server

l The Diagnostics Commander server

l The Performance Center server

l The SiteScope server (configured tomonitor Performance Center servers and hosts)

In addition to themachines that are excluded by default, consider excluding the followingmachines:

l In aMulti-protocol performance test that includes aWeb server and a database server, where
information from the database server is not required as a part of the performance test, exclude the
database server

l All deployment and software upgrade servers

l Where you run and store scripts on a shared network drive

Viewing Network Virtualization Graphs
Network Virtualization starts and stops automatically as you start and stop the performance test.
Network Virtualizationmonitors are assigned automatically when the performance test run starts and
metrics are automatically collected during the performance test run. You can view the network
virtualizationmetrics during the performance test run in the Performance Test Run page. For details on
the Performance Test Run page, see "Performance Test Run Page" on page 261.

You can also view the results in LoadRunner Analysis. For more details on viewing results in Analysis,
see theHP LoadRunner Analysis User Guide.
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Workflow forWorking with Network Virtualization
The following workflow shows how to integrate Network Virtualization into a performance test
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How to Integrate Network Virtualization into a
Performance Test
This following describes how to integrate Network Virtualization into your performance test and how to
view themetrics in Analysis.

To learnmore about Network Virtualization, see "Network Virtualization Overview" on page 289.

This task includes the following steps:

l "Prerequisites" below

l "Open network virtualization " below

l "Enable network virtualization and choose a virtualizationmethod" on the next page

l "Set the global network virtualization settings" on the next page

l "Add virtual locations" on the next page

l "For network virtualization per Group - Define the settings for each group" on page 294

l "For network virtualization per LoadGenerator - Define the settings for each load generator" on
page 294

l "For network virtualization per LoadGenerator - Define the same settings for all load generators" on
page 294

l "Run the performance test" on page 295

l "View the graphs" on page 295

1. Prerequisites
n Make sure that you have HP Network Virtualization installed on the followingmachines:

o the Performance Center server

o the load generators

o the Controller

n Make sure that you have a properly designed performance test. For more information, see
"How to Define a Performance Test Workload" on page 128.

2. Open network virtualization
a. In the Performance Test Designer window, click Groups & Workload. For user interface
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details, see "Performance Test Designer > Groups & Workload" on page 134.

b. Open network virtualization. In theGroups & Workload view, select Advanced >
Network Virtualization Settings. The Network Virtualization Settings dialog box opens. For
user interface details, see "Network Virtualization Settings Dialog Box" on page 300.

3. Enable network virtualization and choose a virtualizationmethod
a. Enable Network Virtualization. In the Network Virtualization Settings dialog box, select

Enable Network Virtualization.

b. Select a method. Select Per Group orPer Load Generator.

Use the default Per Group to perform network virtualization per Vuser group. This option
enables you to emulatemultiple virtual locations on the same load generator. It makes it
easier to switch between load generators used in your performance test.

UsePer Load Generator to perform network virtualization per load generator, where each
machine can only emulate a single location.

4. Set the global network virtualization settings
a. Click Global Settings to define the global options for all network virtualizations. This opens

the interface to HP Network Virtualization.

b. Indicate if you want to allow packet capture and which recordingmethod to use, cyclic or
non-cyclic. It is recommended that you do not enable packet capture as this requires a larger
memory allocation andmay affect performance.

c. In the IP Filter section,specify any machines that youmay want to exclude from network
virtualization for all locations. For details on whichmachines to exclude, see "Network
Virtualization Overview" on page 289.

5. Add virtual locations
a. In theAdd new virtual location field, type a location name.

Note: For location names, only use English letters. You cannot use the following
characters: \ / : “ ? ‘ < > | * % ^ , ! { } ( ) ; = #

b. Click Add. This opens the interface to HP Network Virtualization.

c. In the Shunra NV Virtualization tab, select a definitionmode such as Import from library or
Custom. If you select Import from library, Shunra NV automatically uses its built-in
settings for the location you select. If you select Custom, you need tomanually specify the
network effects to apply to the location, such as latency, loss, and client bandwidth.
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Manage virtual locations. In the Network Virtualization Virtual Locations pane, you can add,
modify, duplicate, or delete a virtual location. You can also import locations from other tests.

d. In the Shunra NV Options tab's Bandwidth allocation section, select Share bandwidth
between all users unless you are testingmobile applications.

e. In theOptions tab's IP Filter box,specify any machines that youmay want to exclude from
network virtualization for this location. For details on whichmachines to exclude, see
"Network Virtualization Overview" on page 289.

f. Click OK to close the Shunra NV interface. The location is added to the Network Virtualization
Settings dialog box. To enable the location, select the check box.

g. Repeat the above steps for each location.

6. For network virtualization per Group - Define the settings for each group
a. Select virtual location. In the Performance Test Designer window click Groups &

Workload, under theVirtual Location column, click theSelect virtual location link. The
Virtual Location dialog box opens.

b. Select a virtual location.

7. For network virtualization per Load Generator - Define the settings for each load
generator
a. In Performance Test Designer window click Groups & Workload, in the LG Distribution

box, select Assign manually.

Note: Formore details on LG distributionmethods, see "Performance Test Designer >
Groups & Workload" on page 134.

b. Under the Load Generator column, click theSelect Load Generator link. The Select Load
Generators dialog box opens. For user interface details, see "Select LoadGenerators Dialog
Box " on page 168.

c. Assign one or more load generators. Select theAutomatch orSpecific tab. Select one or
more load generators.

d. Select virtual location. Under theVirtual Locations column, click theSelect Virtual
Location link for each selected load generator. The Select Virtual Location dialog box opens.
Select a virtual location.

8. For network virtualization per Load Generator - Define the same settings for all load
generators
a. In the Performance Test Designer window click Groups & Workload, in the LG Distribution
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box, select Assign all to each group.

b. In the LG box, specify the number of automatch load generators for the test.

c. Click theConfigure Load Generators Properties button . The Automatch Load
Generators Properties dialog box opens. For user interface details, see "Automatch Load
Generators Properties Dialog Box" on page 171.

9. Run the performance test
Run the test to check its performance. For more details on running a performance test, see "How
toManage a Performance Test Run" on page 242.

10. View the graphs
Network virtualizationmetrics are automatically collected during the performance test run.You can
view all the network virtualizationmetrics in the Performance Test Run Page or the LoadRunner
Analysis.

For more details on the Performance Test Run page, see "Performance Test Run Page" on
page 261. For more details on viewing results in Analysis, see theHP LoadRunner Analysis User
Guide.

Network Virtualization Graphs

Average Latency Graph

This graph shows the average recorded time required for a packet of data to travel from the indicated
source point to the required destination, measured inmilliseconds.

Purpose Helps you evaluate the time required for a packet of data to travel over the
network.

User and Administrator Guide
Chapter 19: Network Virtualization

HP ALM Performance Center (12.20) Page 295 of 521



X-axis Elapsed time since the start of the run.

Y-axis The average latency—the time inmilliseconds required for a packet of data
to reach its destination.

See also l "Network Virtualization Overview" on page 289

l "Performance Test Run Page" on page 261

Packet Loss Graph

This graph shows packets lost during the last second of the test run. Packet loss occurs when data
packets fail to reach their destination. It can result from gateway overload, signal degradation, channel
congestion, or faulty hardware.

Purpose Helps you understand how many data packets were lost over a specific time interval.

X-axis Elapsed time since the start of the run.

Y-axis Includes the followingmeasurements:

l The percentage of lost packets from all packets that were sent.

l The number of data packets that were lost over 60 seconds.

l The total number of packets that were lost.

See also l "Network Virtualization Overview" on page 289

l "Performance Test Run Page" on page 261

Average Bandwidth Utilization Graph

This graph shows the average bandwidth utilized by a virtual user or a virtualized location from the
maximum available bandwidth allocated for it during the last second, measured in percentages.
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Purpose Helps you evaluate the bandwidth used over your network.

X-axis Elapsed time since the start of the run.

Y-axis The percentage of bandwidth utilization.

See also l "Network Virtualization Overview" on page 289

l "Performance Test Run Page" on page 261

Average Throughput Graph

This graph shows the average data traffic passing to or from the virtualized location, measured in
kilobytes per second (kbps).

Purpose Helps you evaluate the amount of load Vusers generate, in terms of server and client
throughput. The graph shows metrics for input and output traffic for both the server and
client machines. Use the legend below the graph to determine the line color for each
metric.

X-axis Elapsed time since the start of the run.
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Y-axis The rate of data passing to and from the virtual location, in kbps for the followingmetrics
per group or load generator:

l Input to the client machine

l Output from the client machine

l Input to the server machine

l Output from the server machine

See
also

l "Total Throughput Graph" below

l "Network Virtualization Overview" on page 289

l "Performance Test Run Page" on page 261

Total Throughput Graph

Displays the total data traffic passing to or from the virtualized location, measured in kilobytes.

Purpose Helps you evaluate the total amount of load that Vusers generate while running a
scenario with network virtualization.

The graph shows metrics for input and output traffic for both the server and client
machines. The legend below the graph indicates the line color for each of thesemetrics.

X-axis Elapsed time since the start of the run.

Y-axis Throughput of the server, in kilobytes per second (Kbps).

See
also

l "Average Throughput Graph" on the previous page

l "Network Virtualization Overview" on page 289

l "Performance Test Run Page" on page 261
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Network Virtualization User Interface
This section includes:

Network Virtualization Settings Dialog Box 300

Import Virtual Locations Dialog Box 301
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Network Virtualization Settings Dialog Box

This dialog box enables you to configure your network virtualization settings.

To access 1. On theMy Performance Center navigation bar, select Test Management
> Test Plan.

2. Select a performance test in the test plan tree and click Edit Test.

3. In the Performance Test Designer window, click Groups& Workload.

4. Select Advanced > Network Virtualization Settings.

Important
information

To access this dialog box, youmust have HP Network Virtualization installed
on your machine.

Relevant tasks "How to Integrate Network Virtualization into a Performance Test" on page 292

User interface elements are described below:

UI Elements Description

Enable Network
Virtualization

Enables Network Virtualization per one of the following:

l Per Group. Assigns network virtualization locations per Vuser group.
(Default)

l Per Load Generator. Assigns network virtualization locations per
load generator. Eachmachine can only emulate a single location.

Global Settings Opens the HP Network Virtualization interface for defining the global
setting for the virtualization. For more details on global settings, see
"How to Integrate Network Virtualization into a Performance Test" on
page 292.

Enables you tomodify the virtual location name and description.

Opens the HP Network Virtualization interface for editing the location.
For details, see the relevant third party software documentation.

Duplicates the virtual location.

Deletes the selected virtual location from the Virtual Locations list and
any associated groups or load generators.

User and Administrator Guide
Chapter 19: Network Virtualization

HP ALM Performance Center (12.20) Page 300 of 521



UI Elements Description

Opens the Import Virtual Locations dialog box enabling you to import
virtual locations from another test. For details, see "Import Virtual
Locations Dialog Box" below.

Location Name Indicates the virtual location name.

Description The description of the virtual location.

Add new virtual
location

Enables you to add a new virtual location. Type the location name and
click Add. Opens the HP Network Virtualization interface for setting the
virtualization properties and location options. For more details on adding
virtual locations, see "How to Integrate Network Virtualization into a
Performance Test" on page 292.

Import Virtual Locations Dialog Box

This dialog box enables you to import virtual locations from another test.

To access 1. On theMy Performance Center navigation bar, select Test Management
> Test Plan.

2. Select a performance test in the test plan tree and click Edit Test.

3. In the Performance Test Designer window, click Groups & Workload.

4. Select Advanced > Network Virtualization Settings.

5. Click the Import button.

Important
information

To access this dialog box, youmust have HP Network Virtualization installed
on your machine.

Relevant tasks "How to Integrate Network Virtualization into a Performance Test" on page 292

User interface elements are described below:

UI Elements Description

Test Set A list of available test sets from which to select tests with virtual
locations.

ID The ID number of the test.

Name The name of the test.

Responsible The user responsible for the test.

Last Modified The date on which the test was last modified.
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UI Elements Description

Virtual Locations Preview
pane

Displays the location names included in a selected test.

Limitations for Network Virtualization
l Network virtualization integration does not comply with accepted Internationalization (I18N)
conventions.

l The network virtualization softwaremay consume large amounts of memory, since the technology
delays traffic and captures traffic for later analysis. To verify that the load generator machine has
sufficient memory, compare the load generator memory consumption with and without the
virtualization.

l Network virtualization software integration is not supported for the Linux platform.

l You cannot run a scenario on the same load generator from two different Controller machines if they
both have network virtualization enabled.
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Trend Reports Overview
The ALM Performance Center trend reports allow you to compare performance test run data over time,
thereby giving you better visibility and control of your application's performance.

By comparing the samemeasurement in more than one instance of a test run, you can identify whether
its performance trend is improving or regressing.

For example, if you were interested in the performance trend of the transaction response time
measurement, the trend report clearly displays whether over several instances of a test run, this value
has increased or decreased from one run to another - a performance regression or improvement
respectively.

This section also includes:

l "ComparisonMethods" below

l "Trend Thresholds" on the next page

l "CustomMeasurement Mapping" on page 307

ComparisonMethods
There are twomethods of comparingmeasurements contained in a performance test run for the
purposes of identifying performance trends: Compare to Baseline and Compare to Previous.

Comparison
Method Description

Compare to
Baseline

You select one performance test run in the trend report and define it as the baseline.
All measurements in the report are then compared to themeasurements contained in
the baseline.

Compare to
Previous

All measurements in a performance test are compared to themeasurements in the
performance test run that immediately precedes it in the report.

It is important to understand the difference between the two comparisonmethods. The following
example will illustrate how the same data can yield different results depending on themethod you
select.
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As shown in the image below, the average Transaction Response Timemeasurement is being trended
from four performance test runs: 3, 4, 5, and 6.

Performance test run (PT) 3 has been defined as the baseline (as indicated by the wordBase in
parentheses). The average transaction response times contained in the other performance test runs are
compared to PT 3 only.

In PT 3, the average transaction response time for TRX_01was 2.045. The average transaction
response time for the same transaction in PT 5 was 2.035, which represents a slightly faster response
time and therefore a slight improvement in the performance of this measurement. The percentage
difference between the two figures is displayed in brackets, in this case -0.49%.

However, if the Compare to Previous comparisonmethod was selected, then the average transaction
response time in PT 5 would be compared not to PT 3, but rather to PT 4 (since 4 precedes it in the
table). The value for PT 4 is 4.073while for PT 5 it's 2.035, a percentage difference of -50.04%.

Using exactly the same data, the two comparisonmethods have yielded very different results. Only a
slight improvement with the Compare to Baselinemethod (-0.49%), while amore significant
improvement with the Compare to Previous method (-50.04%).

Trend Thresholds
To identify significant improvements or regressions in performance, you can define unique thresholds
to track differentials betweenmeasurements being compared. If a differential exceeds a defined
threshold, that value appears in a predetermined color, identifying it as an improvement, minor
regression, or major regression.
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For example, if you define an improvement threshold for comparing transaction response times as
50%, then any transaction response time that is 50% lower than that of the baseline or previous run
(depending on the comparisonmethod) will appear in the color you defined for improvements.

In the example below, the following performance thresholds for the transaction response time (TRT)
measurement have been defined:

l Improvement. At least 90% decrease

l Major Regression. At least 50% increase

These threshold definitions mean that any performance improvements or regressions which exceeds
these percentages will be displayed in color, making themmore identifiable.

In the following table, the Compare to Previous comparisonmethod is used.

In the table above, we see that the value of the TRTmeasurement for theAction_Transaction in
performance test run 4 is 46900% higher than in performance test run 3 - a performance regression
which far exceeds the defined threshold for major regressions. Therefore, the value appears in red, the
default color for major regressions.

The corresponding value for performance test run 5 represents a 100% improvement on performance
test run 4. Since this percentage exceeds the defined threshold for improvements, the value appears in
green, the default color for improvements.

CustomMeasurement Mapping
The CustomMeasurement Mapping feature allows you to reconcile inconsistent transaction or monitor
names between performance test runs, thereby allowing you to properly trend thesemeasurements.

The following are two examples of when you would use the CustomMeasurement Mapping feature:

l Inconsistent transaction name

You run a performance test that contains the transactionBuyBook. A while later you run the
performance test again. However, in the time between the two performance test runs, the transaction
name has been changed to TRX_01_BuyBook.

As a result of this inconsistent naming, you cannot obtain any trending information for this
measurement, as Performance Center cannot recognize that the two transactions are actually the
same, and compare them for trending purposes.
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To overcome this problem, youmap the twomeasurements (BuyBook and TRX_01_BuyBook) to a
new third measurement which you create, for exampleBuy_Book_mapped. You add this new user-
definedmeasurement to the trend report. Performance Center can then compare two instances of the
Buy_Book_mapped transaction and give youmeaningful trending information.

You can give the new transaction the same name as one of the current transactions. Additionally, you
can configure themapping so that all future instances of the transaction are automatically mapped to
the new transaction name.

l Inconsistent monitor name

Youwant to compare your application's performance when it runs on different operating systems or
when it runs on different Web/application servers.

You run the performance test once on aWindows platform, and then again on a Linux platform. You
then want to compare the CPU utilization between the two runs. However, each platform provides a
different name for this measurement. For example,% Processor Time (Processor_Total) in
Windows, andCPU Utilization in Linux.

Performance Center cannot successfully obtain trending information for this measurement because
themeasurement names may be different.

To overcome this problem, youmap the twomeasurements (% Processor Time (Processor_Total)
and CPU Utilization) to a third measurement which you create, for exampleCPU_mapped. You
then add this new user-definedmeasurement to the trend report. Performance Center can then
compare the two instances of theCPU_mapped transaction and give youmeaningful trending
information.

You can give the new monitor the same name as one of the current monitors. Additionally, you can
configure themapping so that all future instances of themonitor are automatically mapped to the new
monitor name.

Trend by Quality Attributes Template - Trended
Measurements
The following table shows whichmeasurements are trended, and by which quality attribute the
information is displayed when the Trend by Quality Attributes template is selected:

Quality
Attribute Trended Measurement

Performance Transaction Response Time (compared to baseline). For more information on
comparisonmethods, see "Trend Reports Overview" on page 305.

System
Performance

CPU utilization

Disk utilization

Available memory
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Quality
Attribute Trended Measurement

Availability Transaction Summary (compared to baseline). For more information on comparison
methods, see "Trend Reports Overview" on page 305.

Repeatability Transaction Percentiles (compared to baseline). For more information on
comparisonmethods, see "Trend Reports Overview" on page 305.

Stability Error Statistics

Transaction Failures

Measurement Acronyms
The following table lists all themeasurement acronyms that might be used in the trend report:

Data Type Full Name Initials

Vusers Running Vusers VU

Errors Errors ERR

Transactions Transaction Response Time TRT

Transaction Per Second TPS

Transaction Summary TRS

WebResources Hits per Second

Throughput

Connections

WEB

User Defined Data Points User Defined Data Points UDP

System Resources Windows Resources WIN

UNIX Resources UNX

Server Resources SRVR

SNMP SNMP

SiteScope SiS

Web Server Resources Apache APA

MS IIS IIS

iPlanet PLA
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Data Type Full Name Initials

WebApplication Server Resources Ariba ARI

ATGDynamo ATG

BroadVision BDV

ColdFusion CFU

MS ASP ASP

Oracle Application Server OAS

SilverStream SST

WebLogic WL

WebSphere WS

Database Server Resources DB2 DB2

Oracle ORA

MS SQL SQL

Sybase SYB

ERP/CRM Server Resources SAP SAP

SAP Portal SAPP

SAP CCMS CCMS

SAP GUI SAPU

Siebel Web Server SIEB

Siebel Server Manager SIEB

J2EE Server Request J2EE

.NET Server Request NET

Additional Components COM+ COM

.NET NET

Application Deployment Solution Citrix MetaFrame XP CTRX

Middleware Performance IBMWebSphereMQ MQ

Application Traffic Measurement F5 BIG-IP F5
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Trend Reports User Interface
This section includes:

Performance TrendingModule 312

Create New Trend Report Page 313

<Report Name> Trend Report 314

TrendOverview Tab 315

Trend View Tabs 317

Trend Views 318

Export Trend Report Page 323

Select Columns Dialog Box 324

Select Test Runs to Trend Report Dialog Box 327

Threshold Settings Dialog Box 329

CustomMeasurement Mapping Dialog Box 330

Add Trend Views to Tab Dialog Box 332

Measurements Configuration Dialog Box 333
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Performance Trending Module

This module enables you tomanage trend reports. It displays a list of available reports, and enables
you to create new reports, and to delete or duplicate existing reports.

To
access

On theMy Performance Center navigation bar, select Runs & Analysis > Trending.

Tip On the ALM sidebar, underPerformance Center, select Performance Lifecycle to
view the fivemost recently created trending reports.

Relevant
tasks

"How toManage a Performance Test Run" on page 242

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<My Performance Center common
UI elements>

ForMy PC menus and buttons, see "My Performance
CenterWindow" on page 23.

Opens the Trend Report creation page, which enables you
to create trend reports.

Creates a duplicate of the selected report.

Enables you to edit the report name and description.

Deleted the selected report.

ID The trend report ID number.

Report Name The name of the report.

Description A description of the report.

Modified by The user who last modified the report.

Responsible The user who created the report.

Last Modified The date on which the report was last modified.

Runs The number of trended runs contained in the report.
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Create New Trend Report Page

This page enables you to create trend reports.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis >
Trending.

2. On the Performance Trending page, click New Trend Report.

Relevant
tasks

"How toManage a Performance Test Run" on page 242

General Details Pane
User interface elements are described below:

UI Elements Description

Name The name of the report.

Description A description of the report.

Contents and Layouts Pane
User interface elements are described below:

UI Elements Description

Description A description of the selected template.

Transaction
Trends
template

Provides trend views that display trending information for the following
measurements:

l Transaction Response Time

l Transaction Pass/Fail Summary

l Transactions per Second
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UI Elements Description

Transactions
and
Monitors
Trends
template

Provides trend views that display trending information for the following
measurements:

l Transaction Response Time

l Transaction Summary

l System Resources (specifically: CPU utilization, Disk utilization, and Available
memory)

Trend by
Quality
Attributes
template

Provides trend views that display trending information from the point of view of
quality attributes. For a table which displays whichmeasurements are trended and
by which quality attribute, see "Trend by Quality Attributes Template - Trended
Measurements" on page 308.

User
Defined
template

This template provides only the basic layout for the report with no further predefined
tab or trend view configuration.

<Report Name> Trend Report

This page enables you tomanage the test runs that are included in the report, as well as tomanage the
trend views which display the trending information.

To
access

1. On theMy Performance Center navigation bar, select Runs & Analysis > Trending.

2. On the Performance Trending page, in the Trend Reports grid, click the name of the
report to open. The report opens as an additional tab on theMy Performance Center
Dashboard.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Opens the Export Trend Report page, which enables you to
export the selected report to a .pdf file. For user interface
details, see "Export Trend Report Page" on page 323.

Opens the Threshold Settings dialog box, which enables you to
define the thresholds to be used for identifying performance
improvements and regressions. For user interface details, see
"Threshold Settings Dialog Box" on page 329.

Opens the CustomMeasurement Mapping dialog box, which
enables you to define and customizemappedmeasurements.
For user interface details, see "CustomMeasurement Mapping
Dialog Box" on page 330.
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UI Elements Description

Enables you to edit layout within a trend view tab.

Enables you to view tabs that are not currently displayed.

Note: A maximum of five tabs can be displayed at one time.

Refreshes the information contained in the report.

Add a New Tab. Adds a new tab to the report.

<Trend Views> Trend views are display items that present trending information,
and are contained within the <trend view tabs>. For more
information, see "Trend Views" on page 318.

<Trend View tabs> The <trend view tabs> contain the trend views and are defined
by the template on which the report is based. For more
information, see "Trend View Tabs" on page 317.

Trend Overview tab The TrendOverview tab displays the test runs trended in the
report, and provides options for managing the test runs. For
more information, see "TrendOverview Tab" below.

Trend Overview Tab

The TrendOverview tab is used for managing the information contained in the trend report.

To access The TrendOverview tab is displayed by default when you access a <report
name> Trend Report.

Important
information

The TrendOverview tab is common to all trend reports, irrespective of which
template is selected.

See also "<Report Name> Trend Report " on the previous page

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Add runs to trend report. Opens the Select Test Runs to Trend Report dialog
box. For user interface details, see "Select Test Runs to Trend Report Dialog
Box" on page 327.

Remove run from trend report. Remove test runs from the trend report.
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UI Elements Description

Set run as baseline. Sets the selected test run as the baseline run for comparing
test runs. For more information on comparisonmethods, see "Trend Reports
Overview" on page 305.

Note: The first run which is added to the report is automatically defined as the
baseline.

Move Run Up/Down.Moves the selected test run up or down in the run order.
Changing the position of the test runmay have an effect on the comparison value
when the Compare to previous method is selected. For more information on
comparisonmethods, see "Trend Reports Overview" on page 305.

Customize Table Columns. Customizes which columns appear in the Trended
Runs table. For user interface details, see "Select Columns Dialog Box" on
page 324.

<Trended runs
table>

Displays information for all trended test runs in the report. It is divided into three
sections, General Details,Workload Characteristics, andPerformance
Overview.

General
Details

Columns in this section display general information relating to the test run.

For a list of the available fields under this section seeCustomize Table
Columns above.

Performance
Overview

Columns in this section contain information relating to the overall performance of
your application.

The purpose of this section is to provide you with basic overview trending
information without having to open a trend view. The basic trend information is
shown by upward or downward arrows that indicate performance improvements or
regressions with regards the baseline only. For more information on comparison
methods, see "Trend Reports Overview" on page 305.

For a list of the available fields under this section seeCustomize Table
Columns above.
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UI Elements Description

Run
Information
pane

Displays details for the selected test run. The following information is displayed:

l Performance Test Set. The test set from which the test was run.

l Test. The name of the test.

l Comments. Comments about the test run.

l Run Date. The date of the test run.

l State. The publish state of the run. Either Trended orNot Trended. If Not
Trended, then the reason for this error appears in this field. A link appears to
republish the run after you have fixed the error.

Workload
Characteristics

Columns in this section are intended to display enough information in order for you
to identify whether the test runs are similar enough in terms of workload, and
therefore suitable for trending.

The values displayed in this section are relevant only for the selected time range.
Changing the selected time range will likely lead to different results. For more
information on the Define TimeRange filter, see "Select Test Runs to Trend
Report Dialog Box" on page 327.

For a list of the available fields under this section seeCustomize Table
Columns above.

Trend View Tabs

A report tab can contain any number of trend views. The tabs are defined by the template on which the
report is based, and which sets the name of the tab and automatically includes trend views that are
related to its name.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis >
Trending.

2. On the Performance Trending page, in the Trend Reports grid, click the name of
the report to open. The report opens as an additional tab on theMy Performance
Center Dashboard. The trend view tabs are displayed by default.

Important
information

The trend view tabs which appear by default depend on which template the report is
based on.

See also "<Report Name> Trend Report " on page 314
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<tab
management
menu>

Select a trend view tab and click the down arrow to open the tabmanagement
menu, which contains the following options (not available on the TrendOverview
tab):

l Add View to Tab. Opens the Add Trend Views to Tab dialog box. For user
interface details, see "Add Trend Views to Tab Dialog Box" on page 332.

l Edit Tab Title. Enables you to change the name of the tab.

l Move Tab Left. Moves the tab left in the tab order.

l Move Tab Right. Moves the tab right in the tab order.

l Delete This Tab. Deletes the tab and all of the trend views contained in it,
from the report.

<Trend
view>

A display item that presents trending information. For more information, see "Trend
Views" below.

Trend Views

A trend view is a display item that presents trending information for a particular performancemetric, for
example, transaction response time.

To
access

1. On theMy Performance Center navigation bar, select Runs & Analysis > Trending.

2. On the Performance Trending page, in the Trend Reports grid, click the name of the
report to open. The report opens as an additional tab on theMy Performance Center
Dashboard. The trend view tabs are displayed by default.

Trend Views are contained within the trend view tabs. The trend view tabs are
displayed by default.

See
also

"<Report Name> Trend Report " on page 314

Edit Trend ViewMenu
This menu contains options that enable you to edit the trend view's display and comparison settings.

To
access

On the trend view, click theOpen edit menu button (Not available in the Trend
Overview tab).
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User interface elements are described below:

UI Elements Description

3D Mode (stacked
bar chart view
only)

Enables you to view the chart in 3D.

Color Trends
(table view only)

Activates the trend report's threshold settings. For more information about
thresholds, see "Trend Reports Overview" on page 305.

Compare to
baseline/previous
(table view only)

Enables you to change the comparisonmethod displayed in the trend view. For
more information on comparisonmethods, see "Trend Reports Overview" on
page 305.

Delete this Trend
View

Deletes the trend view.

Do not show
difference (table
view only)

Enables you to hide value differentials between test runs. It is recommended to
use this setting when exporting the report to a CSV format.

Edit Display
Setting

Enables you to change the appearance of the trend view. The available
settings are:

l Table view. This view is best suited for displaying comparisons between
measurements. You can view threshold settings in this view only. For more
information, see "Display Setting: Table" on the next page.

l Line graph view. This view is best suited for displaying trending
information graphically over a timeline. For more information, see "Display
Setting: Line Graph" on the next page.

l Stacked bar chart view. This view displays trending information
graphically over a timeline. It is best suited for trending a small number of
multiple measurements. For more information, see "Display Setting:
Stacked" on page 322.

Edit Trend View
Title

Enables you to edit the trend view title.

Export to CSV
(table view only)

Enables you to export the report to a CSV format.

Select
Measurements

Opens theMeasurements Configuration dialog box, which enables you to add
measurements to the trend view. For user interface details, see
"Measurements Configuration Dialog Box" on page 333.
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UI Elements Description

Show difference
as
value/percentage
(table view only)

Enables you to define how to display value differentials between test runs in
the trend view - as values or as percentages.

Show Values
(stacked bar chart
view only)

Enables you to view themeasurement values on the actual bar columns.

Display Setting: Table
This section explains the Table trend view display setting.

To access

1. On the trend view, click theOpen edit menu button (Not available
in the TrendOverview tab).

2. Select Edit Display Setting.

3. In the Edit Display Setting dialog box, select Table.

Important
information

You can view threshold settings in table view only.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Measurement
value name>

The name of themeasurement value being trended, for example, minimum,
maximum, average, and so on.

<Measurement
value>

The actual value of themeasurement being trended, and its comparison value,
displayed per test run. For more information about comparisonmethods, see
"Trend Reports Overview" on page 305.

Name The name of themeasurement being compared.

Type The type of measurement being compared.

Display Setting: Line Graph
This section explains the Line Graph trend view display setting.
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To access

1. On the trend view, click theOpen edit menu button (Not available in the
TrendOverview tab).

2. Select Edit Display Setting.

3. In the Edit Display Setting dialog box, select Line.

Important
information

l When you hold the cursor over the line graph, a tooltip appears displaying the
exact amount of units for that measurement, correct to the nearest test run on the
timeline. In other words, if you hold the cursor near the left point of the line graph,
you see the value of the first test run.

l When you click a section in the line graph/measurement in the legend, it becomes
highlighted, as does the corresponding section in the legend/line graph.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

<graph
slope>

The upward or downward slope of the line represents an upward or downward change in
themeasurement's unit. For example, a higher transaction response time (which is a
performance regression), or a higher transactions per second value (which is a
performance improvement).

<x-axis> Lists the test runs according to their run date.

<y-axis> The relevant unit of measurement.

Example: For the Transaction Response Timemeasurement, the y-axis values
represent seconds, while for the transactions per secondmeasurement, the values
represent the number of transactions.

B Displays themeasurement in bold.

C Displays the color of themeasurement as it appears in the graph. Click the colored
square in the column to select a different color for themeasurement.

Function Displays the value of themeasurement being trended.

Name The name of themeasurement.

Scale Indicates the scale of themeasurement. When viewing information in the line graph
view, you can adjust the scale of any measurement to make comparingmeasurements
moremeaningful.

To change the scale of ameasurement, click the value in the column and select the
desired scale from the Set Scale box that opens. You can also apply the selected scale
to all themeasurements in the graph.
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UI
Elements

Description

Type Contains an acronym that identifies themeasurement type. For a full list of available
acronyms, see "Measurement Acronyms" on page 309.

V Determines whether themeasurement is visible. All measurements are displayed by
default. Clear the check box to hide ameasurement.

Display Setting: Stacked
This section explains the Stacked Bar Chart trend view display setting.

To access

1. On the trend view, click theOpen edit menu button (Not available in the
TrendOverview tab).

2. Select Edit Display Setting.

3. In the Edit Display Setting dialog box, select Stacked.

Important
information

l If different values are selected for the samemeasurement (for example,
Maximum andAverage transaction response times), then themeasurements
appear as stacked bars. That is, the values appear above each other for the bar
that represents the transaction response timemeasurement for a specific test run.

l When you hold the cursor over a bar, a tooltip appears which displays the exact
number of units for that measurement, correct for that test run.

l When you click a section in the bar chart/measurement in the legend, it becomes
highlighted, as does the corresponding section in the legend/bar chart.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

<bar
height>

The height of the bar represents the change in themeasurement's unit. For example, a
higher transaction response time, which represents a performance regression, or a
higher transactions per second value, which represents a performance improvement.

<x-axis> Lists the test runs according to their run date.
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UI
Elements

Description

<y-axis> The relevant unit of measurement.

Example: For the Transaction Response Timemeasurement, the y-axis values
represent seconds, while for the transactions per secondmeasurement, the values
represent the number of transactions.

C Displays the color of themeasurement as it appears in the graph. Click the colored
square in the column to select a different color for themeasurement.

Function Displays the value of themeasurement being trended.

Name The name of themeasurement.

Scale Indicates the scale of themeasurement. When viewing information in the line graph
view, you can adjust the scale of any measurement to make comparingmeasurements
moremeaningful.

To change the scale of ameasurement, click the value in the column and select the
desired scale from the Set Scale box that opens. You can also apply the selected scale
to all themeasurements in the graph.

Type Contains an acronym that identifies themeasurement type. For a full list of available
acronyms, see "Measurement Acronyms" on page 309.

V Determines whether themeasurement is visible. All measurements are displayed by
default. Clear the check box to hide ameasurement.

Export Trend Report Page

This page enables you to export the selected trend report to a .pdf file.

To
access

1. On theMy Performance Center navigation bar, select Runs & Analysis > Trending.

2. On the Performance Trending page, in the Trend Reports grid, click the name of the
report to open. The report opens as an additional tab on theMy Performance Center
Dashboard.

See
also

"<Report Name> Trend Report " on page 314

User interface elements are described below:

UI
Elements

Description

Details
area

Enables you to define report details, such as report title, author, and summary.
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UI
Elements

Description

Logo
area

Enables you to set the image that is placed on the cover page of the report and at the top
of each page of the report. The HP logo is available by default.

content
area

Enables you to specify data to include in your report, such as a title page, table of
contents, and trend views.

Select Columns Dialog Box

This dialog box enables you to select columns to be displayed in the <report name> Trend Report's
TrendOverview tab.

To access On the <report name> Trend Report, select the Trend Overview tab, and click the

Customize table columns button .

Important
information

Due to space limitations, the names of the columns in the TrendOverview tabmay
differ from how they appear in this dialog box. In these cases, column names as they
appear in the TrendOverview tab appear in parentheses.

See also "<Report Name> Trend Report " on page 314

Select Columns for 'General Details' Section

User interface elements are described below:

UI Elements
(A-Z)

Description

Project Name
(Project)

The name of the project in which the test was run.

Publish State
(State)

Indicates whether the test run was successfully added to the report or not, either
trended or not trended respectively. A test run that was not successfully added
appears in red and a tooltip displays the reason.

Note: Displayed by default.

Run By The name of the user who ran the test.

Note: Displayed by default.
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UI Elements
(A-Z)

Description

Run Date
(Date)

The date of the load test run.

Note: Displayed by default.

Run Duration
(Duration)

The duration of the test run, in minutes.

Note: Displayed by default.

Run ID The run ID.

Note: Displayed by default.

Test Name
(Test)

The name of the test.

Test Version The version of the test.

Total Vusers
in Run (Total
Vusers)

The number of Vusers in the test run, within the selected time range.

Trended Time
Range
(Trended
Range)

The time range within the test run that is selected for trending.

Select Columns for 'Workload Characteristics' Section

User interface elements are described below:

UI Elements (A-Z) Description

Hits per Second (HPS) The average number of hits per second within the trended time
range.

Passed Transactions per
Minute (TPM)

The number of transactions that passed per minute of the test run
within the selected time range.

Note: Displayed by default.
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UI Elements (A-Z) Description

Passed Transactions per
Second (TPS)

The number of transactions that passed per second of the test run
within the selected time range.

Note: Displayed by default.

Total Hits (Hits) The total number of hits per second within the trended time range.

Total Number of
Transactions (Transactions)

The total number of transactions in the test run that passed, failed
or stopped within the selected time range.

Note: Displayed by default.

Total Throughput
(Throughput)

The total throughput within the trended time range.

Total Vusers in Trended
Range (Trended Vusers)

Themaximum number of running Vusers within the trended time
range.

Note: Displayed by default.

Throughput per Second
(Throughput per Sec.)

The amount of throughput per second within the selected time
range.

Select Columns for 'PerformanceOverview' Section

User interface elements are described below:

UI Elements (A-Z) Description

Average Transaction Response
Time (Response Time)

The weighted average transaction response time for all the
transactions within the selected time range.

Note: Displayed by default.

Errors per Second (EPS) The average amount of errors per second within the selected
time range.

Note: Displayed by default.

Failed Transactions (Failed) The actual amount of transactions that failed within the
selected time range.
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UI Elements (A-Z) Description

Passed Transactions (Passed) The actual amount of transactions that passed within the
selected time range.

Total Errors (Errors) The total number of errors within the selected time range.

Transaction Success Rate
(Success)

The percentage of the total amount of transactions that passed
within the selected time range.

Note: Displayed by default.

Select Test Runs to Trend Report Dialog Box

This dialog box enables you to add performance test runs to the report.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis >
Trending.

2. On the Performance Trending page, in the Trend Reports grid, click the name of
the report to open. The report opens as an additional tab on theMy Performance
Center Dashboard.

3. On the <report name> Trend Report, select the Trend Overview tab, and click
theAdd runs to trend report button .

Important
information

l In order to add performance test runs to the trend report, theremust be a data
processor present in your project pool.

l The process whereby ALM Performance Center extracts the performance test
data from Analysis is very labor intensive on the data processor, andmay take
anywhere from several minutes to over an hour. It is recommended that you use a
machine dedicated for this purpose.

l ALM Performance Center extracts the performance test data from Analysis using
a granularity of 16 seconds. This valuemight be different from the defined
granularity in Analysis, andmay lead to slight variations when comparing values
between Analysis and ALM Performance Center.

User interface elements are described below:

UI Elements Description

Project A list of available projects from which to select test instances to trend.

Test Set A list of available test sets from which to select test instances to trend.
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UI Elements Description

Test The tests contained in the selected test set.

Refresh. Enables you to refresh the dialog box information.

Load Data Populates the test runs table with all analyzed instances of the selected test.

Run ID The Run ID.

Run Name The name of the test run.

Time Range The duration of the test run that is selected for trending.

Example: If a test run's overall duration is 30minutes, and the time range is
defined as 0-15min, then only the first 15minutes of the test run will be
considered for trending.

Default: The whole test run in selected.

Exec Date The date and time of the test run.

Duration The duration (in minutes) of the test run.

Max Vusers Themaximum number of running Vusers during the test run.

Total
Transactions
Passed

The total number of passed transactions during the test run.

Total Errors The total number of errors during the test run.

Time Range filter. Opens the Define TimeRange dialog box, which enables you to
change the defined time range within a test run for trending purposes.

In the Define TimeRange dialog box, select one of the following options:

l Trend Complete Run.Makes all data collected from the beginning to the end of
the test run available for trending.

l Trend Part of Run. Makes only part of the test run available for trending. Select
the desired part of the run to trend by entering the start and end times in theStart
Time andEnd Time boxes.

Adds the selected test runs to the trend report.
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Threshold Settings Dialog Box

This dialog box enables you to define which percentage differentials betweenmeasurement constitute
significant improvements or regressions in performance.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis >
Trending.

2. On the Performance Trending page, in the Trend Reports grid, click the name of
the report to open. The report opens as an additional tab on theMy Performance
Center Dashboard.

3. On the <report name> Trend Report, click theSet Thresholds button

.

Important
information

The threshold definition and color settings are applied on a global level and hold true
across all trend views in the report.
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User interface elements are described below:

UI Elements Description

Measurement
Type

Includes the followingmeasurement types:

l Transaction Response Time (TRT).Measures whether the average
transaction response time of the transactions over a specified time interval
exceeds the defined threshold.

l Transactions per Second (TPS).Measures the number of times a transaction
was executed in a second.

l Transaction Summary Pass (TRS).Measures the actual amount of
transactions that passed within the trended time range.

l Transaction Summary Fail (TRS).Measures the actual amount of
transactions that failed within the trended time range.

l Total Errors (ERR).Measures the total number of errors within the trended time
range.

l Errors per Second (EPS).Measures the average amount of errors per second
within the trended time range.

l Hits (WEB).Measures the total number of transaction hits to theWeb server
within the trended time range.

l Throughput (WEB).Measures the total throughput to theWeb server within the
trended time range.

Improvement Enter the percentage differential between instances of themeasurement that will be
considered an improvement in performance.

Minor
Regression

Enter the percentage differential between instances of themeasurement that will be
considered aminor regression in performance.

Major
Regression

Enter the percentage differential between instances of themeasurement that will be
considered amajor regression in performance.

CustomMeasurement Mapping Dialog Box

This dialog box enables you tomapmeasurements with different names to a new single measurement
which you create.
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To
access

1. On theMy Performance Center navigation bar, select Runs & Analysis > Trending.

2. On the Performance Trending page, in the Trend Reports grid, click the name of the
report to open. The report opens as an additional tab on theMy Performance Center
Dashboard.

3. On the <report name> Trend Report, click theCustom Measurement Mapping
button .

User interface elements are described below:

UI Elements Description

Opens the Add New Mapping dialog box, enabling you to create a new
mappedmeasurement.

In the Add New Mapping dialog box, enter the following information:

l Name. The name of the new mappedmeasurement.

l Description. A description of the new mappedmeasurement.

l Data Type. Select themeasurement type: Transaction,Monitor, or
Other.

Creates a duplicate of the selectedmappedmeasurement.

Refreshes themappedmeasurements table.

Date Type Themappedmeasurement's data type.

Description A description of themappedmeasurement.
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UI Elements Description

Details A table which lists all the test runs in the trend report. The runs appear in
the same order as they appear in the TrendOverview tab.

Click in the Type andName fields to select whichmeasurements to
map to themappedmeasurement.

The following fields appear in the table:

l Run ID. The test run ID.

l Type. Themeasurement type.

l Name. Themeasurement name.

Note:When you use theDefault option, all future instances of the
measurement are automatically mapped to the current settings.

ID Themappedmeasurement's ID.

Name Themappedmeasurement's name.

Add Trend Views to Tab Dialog Box

This dialog box enables you to add trend views to a trend report.

To
access

1. On theMy Performance Center navigation bar, select Runs & Analysis > Trending.

2. On the Performance Trending page, in the Trend Reports grid, click the name of the
report to open. The report opens as an additional tab on theMy Performance Center
Dashboard.

3. Select the desired trend view tab.

4. Click the down arrow next to the tab name to open the tabmanagement menu and

select Add View to Tab.

User interface elements are described below:

UI Elements Description

Monitors
Trend Views

Trendmeasurements related tomonitors.
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UI Elements Description

Other Trend
Views

Trendmeasurements other than transactions andmonitor measurements (Web
Resources and Error Statistics). Included in this section are three basic non-
configured trend views, each one based on one of the trend view display options.
You can select one of these trend views and customize it as desired.

Transactions
Trend Views

Trendmeasurements related to transactions.

Measurements Configuration Dialog Box

Each trend view has a default set of measurements that it trends. This dialog box enables you to add
additional measurements.

To
access

1. On theMy Performance Center navigation bar, select Runs & Analysis > Trending.

2. On the Performance Trending page, in the Trend Reports grid, click the name of the
report to open. The report opens as an additional tab on theMy Performance Center
Dashboard. The trend view tabs are displayed by default.

Trend Views are contained within the trend view tabs.

3. On a trend view, click theOpen edit menu button (Not available in the Trend
Overview tab), then select Select Measurements.

Trend Data Types Pane
The Trend Data Types pane contains a list of themeasurements that are available for trending. Only
measurements that contain data appear.

User interface elements are described below:

UI Elements Description

Monitors All monitor relatedmeasurements that contain data.

Others All non-transaction/monitor measurements.

Transactions All transactions that contain data.

User-
Defined

This node appears only if you havemapped any measurements. For more
information onmappedmeasurements, see "Trend Reports Overview" on page 305.

Measurement Selection Pane
User interface elements are described below:
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UI
Elements
(A-Z)

Description

Rule. This icon indicates that themeasurement has already been selected using an
automatic selection rule.

Define
automatic
selection
rule

Opens the Automatic Selection Rule dialog box, which enables you use regular
expressions to define a rule that automatically selects measurements to be included in
the trend view. The automatic selection rule applies tomeasurements that are currently
displayed in the trend report data, as well as any futuremeasurements.

Name The name of the available measurement.

Select
values to
trend

Displays the available values of the selectedmeasurement which can be included in
the trend view.
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PAL Overview
Performance Application Lifecycle (PAL) is a process which enables better communication between
the development and operation teams around the testing andmonitoring of applications.

PAL enables you to use user traffic and systemmonitoring data in production to design a performance
test that closely resembles production behavior. You can import production data from HP Business
ServiceManagement (BSM), Webtrends Analytics, Microsoft IIS W3C Extended Log Format, and
Google Analytics.

Using the production system information, you can generate PAL reports to analyze and compare
results between the production data and the performance test data. Based on the results of these
comparisons, performance tests can be tuned to resemble production system activity.

PAL’s importance stems from the basic need to correctly plan testing initiatives. Without a clear
understanding of what users are doing in production, and how the production system behaves, it is very
difficult to:

l focus testing on themost widely used business cases and scenarios

l test the system under appropriate loads

l define testing targets (for example, Service Level Agreements)

This section also includes:

l "PAL Flow" below

l "ComparisonMethods" on the next page

l "PAL Thresholds" on page 339

l "Tuning Performance Tests" on page 339

PAL Flow
The PAL flow includes the followingmain steps:

User and Administrator Guide
Chapter 21: Performance Application Lifecycle (PAL)

HP ALM Performance Center (12.20) Page 337 of 521



Step Description

Import
production
data

Import data from the production systems. Performance Center supports data from HP
Business ServiceManagement (BSM), Webtrends Analytics, Microsoft IIS W3C
Extended Log Format, andGoogle Analytics. Different productionmonitoring systems
provide different data whichmay influence which information is available to the user.

Create
production
report

Create a report based on the production data. The report displays information on the
different activities that were observed in production. For example, measurements
related to transactions, such as hits and response time.

Design
and run
test

Use the production report to create a performance test. The first performance test
design will probably exhibit very different behavior from production and is only a
starting point for tuning. Execute the performance test to gather traffic data and other
information.

Add test
data to
report

Add performance test data to the report and compare it to the production data. This
comparison is the basis of the performance test tuning process.

Tune test Update the performance test to try bring the behavior and patterns of usage to
resemble production as closely as possible. This is an iterative process in which the
performance test is updated, executed, and compared until it resembles the load in
production.

Export
data to
production

Export various items that can help speed up the deployment of a new version to
production. This informationmay include the scripts that can be used in Business
ServiceManagement (BSM)monitoring and the SiteScope templates that can be re-
used in production. The information should be exported once the defined performance
test has been run on the final version of the application and the application has been
certified for release.

ComparisonMethods
There are twomethods of comparingmeasurements contained in a performance test run for the
purposes of comparing testing environment data with real production environment data.

Comparison
Method Description

Compare to
Baseline

You select one performance test run in the PAL report and define it as the baseline.
All measurements in the report are then compared to themeasurements contained in
the baseline.
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Comparison
Method Description

Compare to
Previous

All measurements in a performance test are compared to themeasurements in the
performance test run that immediately precedes it in the report. Compare to previous
depends on the order of the data sets in the report.

PAL Thresholds
To identify significant differences in performance, you can define unique thresholds to track
differentials betweenmeasurements being compared. If a differential exceeds a defined threshold, that
value appears in a predetermined color, identifying it as aminor difference, or major difference.

Tuning Performance Tests
The first time you run your performance test it will probably exhibit very different behavior than your
production report. Remember that the output generated is only a starting point for tuning. Based on your
PAL comparison reports, update the performance test, run it again, and compare the updated
performance test to production. Continue this iterative process until the performance test closely
resembles production.

You can tune the test during runtime or after the run ends. When tuning during runtime, the framework
enables you to continuously adjust the data to view your changes almost immediately.

How to Work with PAL
This task describes how to work with PAL to create a testing environment similar to your real
production environment.

This task includes the following steps:

1. Open PAL

On theMy Performance Center navigation bar, select Runs & Analysis > PAL.

2. Define a PAL application
a. In the upper-right corner of the window, click Manage PAL Applications. TheManage PAL

Applications Dialog Box opens.

b. Add an application. For user interface details, see "Manage PAL Applications Dialog Box" on
page 345.
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3. Import production data

a. In theData Set tab, select a data set folder and click . The Upload Production
Data Set Dialog Box opens. For user interface details, see "Upload Production Data Set
Dialog Box" on page 346.

b. Upload the data set file. The data file is stored as a .zip file.

For information on how to create data sets using IIS W3C extended log format, Google
Analytics, orWebtrends, see "How to Create Data Sets from IIS, Google Analytics, or
Webtrends" on the next page.

4. Create production report

a. In theReports tab, select a report folder and click . The Create New
Performance Application Lifecycle Report Dialog Box opens. For user interface details, see
"Create New Performance Application Lifecycle Report Dialog Box" on page 346.

b. In the Create New Performance Application Lifecycle Report Dialog Box, click Create.The
report opens as an additional tab on theMy Performance Center Dashboard. The report
contains sub-tabs. The Data Sources sub-tab is displayed by default. For user interface
details, see "<Report Name> PALReport" on page 349.

c. Define data sets and performancemetrics to be used for the production report. For example,
you can set threshold settings, custommeasurement mappings, and scaling factors.

5. Design performance test based on production report
a. On theMy Performance Center navigation bar, select Test Management > Test Plan. In the

test tree, click . The Create New Performance Test dialog box opens. For user interface
details, see "Create New Performance Test Dialog Box" on page 124.

b. Define the performance test. For more details, see "Performance Test DesignerWindow" on
page 122.

6. Run performance test
In the Performance Test Set pane, select the performance test and click RunTest. The Run dialog
box opens. For user interface details, see "Run Test Dialog Box" on page 270.

7. Add performance test data to the report
a. On theMy Performance Center navigation bar, select Runs & Analysis > PAL. In the

Reports tab, select a PAL report. The Data Sources tab is displayed by default.
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b. Add the performance test data to the report. For user interface details, see "Data Sources
Tab" on page 352.

c. Click the report sub-tabs to view and compare production and performance test behavior. For
user interface details, see "PALReport View Tabs" on page 353.

8. Tune the performance test
a. Based on the comparison report, edit the performance test and rerun the test. For user

interface details, see "Test LabModule" on page 249.

b. View the updated report and compare the performance test and production data. For user
interface details, see "PALReport View Tabs" on page 353.

c. Continue tuning until the performance test closely resembles production. You can tune the
test during runtime or after the run ends.

9. Export the test run details
a. Open the Test Run Pane. For user interface details, see "Test LabModule" on page 249.

b. View the result information for the selected test run.

c. To export test run data once the performance test has run on the final version of the

application, click . For user interface details, see "Export PAL Data
Dialog Box" on page 348.

How to Create Data Sets from IIS, Google Analytics, or
Webtrends
This task describes how to create a data sets from IIS W3C Extended Log File Format, Google
Analytics, orWebtrends.

Note: This task is part of a higher-level task. For details, see "How toWork with PAL" on
page 339.

Creating Data Sets from IIS W3C Extended Log File Format

This task includes the following steps:

1. Create log files

a. Open the Internet Information Services (IIS) Manager window.
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b. UnderConnections, select aWebsite (not a virtual directory).

c. In the right pane, select Logging.

d. In the Log File section, under Format, verify thatW3C is selected.

e. Click theSelect Fields button and select the following fields: Date, Time, Client IP
Address, Server Name, Server Port,Method, URI Stem, URI Query, Protocol Status,
Time Taken, Host, User Agent, Cookie, and Referer.

f. UnderDirectory, set the directory location for storing the logs.

2. Create the IIS data set file.

Open the PALData Set Creator wizard to create the IIS data set file. For user interface details,
see "PALData Set CreatorWizard" on page 369.

Creating Data Sets from Google Analytics

This task includes the following steps:

1. Create a new custom report.

a. From Google Analytics, click theCustomization tab.

b. Click theNew Custom Report button.

c. Add a title name.

d. In the Type section, select Flat Table.

e. In theMetric Groups section, addUnique Visitors andPageviews.

f. In theDimensions section, addPage and Hour of Day.

g. In theViews section, select Web sites.

h. Click Save.

2. Export the report.

Open the report, and select Export > CSV.

3. Create the Google Analytics data set file.

Open the PALData Set Creator wizard to create the Google Analytics data set file. For user
interface details, see "PALData Set CreatorWizard" on page 369.

Creating Webtrends Data Sets

Open the PALData Set Creator wizard to create theWebtrends data set file. For user interface details,
see "PALData Set CreatorWizard" on page 369.
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PAL User Interface
This section includes:

PALModule 344

Manage PAL Applications Dialog Box 345

Upload Production Data Set Dialog Box 346

Create New Performance Application Lifecycle Report Dialog Box 346

Export PAL Data Dialog Box 348

<Report Name> PALReport 349

Export Report to PDF Dialog Box 351

Data Sources Tab 352

PALReport View Tabs 353

PALReport Views 354

Add Views To Tab Dialog Box 356

Select Measurements Dialog Box 358

Add Data Dialog Box 359

Select Columns Dialog Box 361

Threshold Settings Dialog Box 362

Monitors Mapping Dialog Box 363

Transactions Mapping andGrouping Dialog Box 365

Set Scaling Factors Dialog Box 367

Set Global Transactions Filter Dialog Box 368

PALData Set CreatorWizard 369
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PAL Module

This pane enables you to import data from the production system.

To access On theMy Performance Center navigation bar, select Runs & Analysis > PAL.

Relevant tasks "How toWork with PAL" on page 339

See also "PALOverview" on page 337

Reports Tab
This tab enables you to create PAL reports.

User interface elements are described below:

UI Elements Description

The Create New Performance Application Lifecycle Report Dialog Box
opens, enabling you to define a PAL report. For user interface details, see
"Create New Performance Application Lifecycle Report Dialog Box" on
page 346.

Enables you to define folder for storing PAL reports.

Enables you to duplicate select PAL report.

Enables you to rename selected item.

Enables you to delete selected item.

Data Sets Tab
This tab enables you to import andmanage data sets from the production system.

User interface elements are described below:

UI Elements Description

Opens the Upload Production Data Set. For more details, see "Upload Production
Data Set Dialog Box" on page 346.

Enables you to add a data set folder.

Enables you edit the data set folder details.
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UI Elements Description

Saves the data set locally in ZIP format.

Enables you to delete the data set folder.

Manage PAL Applications Dialog Box

This dialog box enables you to associate PAL entities, such as data sets with a specific AUT.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis >
PAL.

2. In the upper-right corner of the window, click Manage PAL Applications.

Relevant tasks "How toWork with PAL" on page 339

See also "PALOverview" on page 337

User interface elements are described below:

UI Elements Description

Defines a new application.

Refreshes the table.

Edits a selected application.

Deletes a selected application.

ID The ID number of the application.

Name The name of the application.

Description A description of the application.
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Upload Production Data Set Dialog Box

This dialog box enables you to upload production data set files.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis >
PAL.

2. In the Data Sets tab, click

Relevant tasks "How toWork with PAL" on page 339

See also "PALOverview" on page 337

User interface elements are described below:

UI Elements Description

Name The name of the data set file.

Description A description of the data set file.

Select production data set file Click theBrowse button to select the data set file.

Select Folder Indicates the folder for storing the data set file.

Take application name from data set Uses the application defined in the data set file.

Choose an Application Indicates the application for use with the data set file.

Messages Indicates the progress of the uploading process.

Upload Uploads the data set file to the specified location.

Create New Performance Application Lifecycle Report Dialog Box

This dialog box enables you to create PAL reports.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis >
PAL.

2. In the Reports tab, .

Relevant tasks "How toManage a Performance Test Run" on page 242
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General Details Area
User interface elements are described below:

UI Elements Description

Name The name of the report.

Description A description of the report.

Location The location of the report.

Application Area
User interface elements are described below:

UI Elements Description

Select an application to base the report upon List the available applications.

Template Area
User interface elements are described below:

UI Elements Description

Based on HP BSM
Production Info

A report based on HP Business ServiceManagement (BSM). This
template displays the following preconfigured PAL report views:

l Workload Data

l Performance Data

l Distribution Data

l Monitors Data
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UI Elements Description

Based on HP BSM
Production Info -
Advanced

A report based on HP Business ServiceManagement (BSM). This
template displays the following preconfigured PAL report views:

l Workload Data

l Performance Data

l Distribution Data

l Monitors Data

l Top 10 Hits, Top 10 Users andWorkload Data

l Top 10 Response Time and Performance Data

l Top 10 Hits Percentage and Distribution Data

Based on non-BSM info
(e.g., WebTrends)

A report based on onWebTrends and other non-HP data sources. This
template displays the following preconfigured PAL report views:

l Workload Data

l Performance Data

l Distribution Data

Empty Provides only the basic layout for the report without the preconfigured
PAL report views.

Description A description of the selected template.

Export PAL Data Dialog Box

This dialog box enables you to export test run data once the load test has run on the final version of the
application.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis >
PAL.

2. Click .

Relevant tasks "How toWork with PAL" on page 339

See also "PALOverview" on page 337
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User interface elements are described below:

UI Elements Description

Description The description of the exported test run data.

Run Info The list of exported information.

Application Indicates the associated application.

Export Saves the data set locally in ZIP format.

<Report Name> PAL Report

This tab enables you to view andmanage the PAL report. The PAL reports includes multiple tabs that
allow youmanage the data that is included in the report, as well as tomanage the views which display
the PAL information.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis > PAL.

2. In the Reports tab, click a report.

Important
information

The PAL sub-tabs which appear by default depend on which template the report is
based on. The Data Sources tab is common to all PAL reports irrespective of which
template is selected.

Relevant
tasks

"How toWork with PAL" on page 339

See also "PALOverview" on page 337
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Opens the Export Report to PDF dialog box, which
enables you to export the selected report to a .pdf file. For
user interface details, see "Export Report to PDF Dialog
Box" on the next page.

Opens the Threshold Settings dialog box, which enables
you to define the thresholds to be used for identifying
major andminor differences between production and
testing data. For user interface details, see "Threshold
Settings Dialog Box" on page 362.

Opens the Transactions Mapping andGrouping Dialog
Box, which enables you tomap and group similar
transactions in your production data or in your load test
results. For user interface details, see "Transactions
Mapping andGrouping Dialog Box" on page 365.

Opens theMonitors Mapping dialog box which enables
you tomap production and testingmonitored hosts to
monitor measurements, such as CPU, memory, and
virtual memory used. For user interface details, see
"Monitors Mapping Dialog Box" on page 363.

Opens the Set Scaling Factors dialog box, which enables
you to define the scaling factor. For user interface details,
see "Set Scaling Factors Dialog Box" on page 367.

Opens the Global Filter dialog box, which enables you to
filter the transactions displayed in the PAL report views.
For user interface details, see "Set Global Transactions
Filter Dialog Box" on page 368.

Enables you to arrange views within a PAL view tab.

Enables you to view tabs that are not currently displayed.

Refreshes the information contained in the report.

Data Sources Tab The Data Sources tab is used for managing the
information contained in the PAL report. For more details,
see "Data Sources Tab" on page 352.
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UI Elements Description

<PAL report view tabs> The PAL report view tabs contain the PAL report views
and are defined by the template on which the report is
based. For more details, see "PALReport View Tabs" on
page 353.

<PAL report views> PAL report views are display items that present PAL
information, and are contained within the PAL report view
tabs. For more information, see "PALReport Views" on
page 354.

Add a New Tab. Adds a new tab to the report.

Export Report to PDF Dialog Box

This page enables you to export the selected PAL report to a .pdf file.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis >
PAL.

2. In the Reports tab, click a report.

3. Click .

See also "<Report Name> PALReport" on page 349

User interface elements are described below:

UI
Elements

Description

Details
area

Enables you to define report details, such as report title, author, and summary.

Logo
area

Enables you to set the image that is placed on the cover page of the report and at the top
of each page of the report. The HP logo is available by default.

content
area

Enables you to specify data to include in your report, such as a title page, table of
contents, and report views.
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Data Sources Tab

The Data Sources tab is used for managing the information contained in the PAL report.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis
> PAL.

2. In the Reports tab, click a report.The Data Sources tab is displayed by
default.

Important
information

The Data Sources tab is common to all PAL reports, irrespective of which
template is selected.

See also "<Report Name> PALReport" on page 349

User interface elements are described below:

UI Elements Description

Opens the Add Data dialog box and displays the Production tab. Select
the production data to be used for comparison. For user interface
details, see "Add Data Dialog Box" on page 359.

Opens the Add Data dialog box and displays the Test Run Results tab.
Select the testing data to be used for comparison. For user interface
details, see "Add Data Dialog Box" on page 359.

Opens the Select Run Test dialog box and displays all the tests that are
currently running. To tune a test during runtime, select a running test,
select the refresh frequency rate from the Refresh Time Intervals
drop-down list. Click OK. The test is added to the Data Sources tab.

Note: A test added during runtime is displayed in blue in the Data
Sources grid. After the test run ends, you can publish it by clicking
Add Testing Data. The test will now be displayed in black.

Remove item from report. Removes production data sets or test runs
from the PAL report.

Set run as baseline. Sets the selected item (production data set or
test run) as the baseline run for the comparison.

Note: The first item which is added to the report is automatically
defined as the baseline.
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UI Elements Description

Move Up/Down.Moves the selected item up or down in the order.
Changing the position of the report itemmay have an effect on the
comparison value when the Compare to previous method is selected.
For more information on comparisonmethods, see "PALOverview" on
page 337.

Customize Table Columns. Customizes which columns appear in the
PALRuns table. For user interface details, see "Select Columns Dialog
Box" on page 361.

<Data Sources grid> Displays information for all the items in the report. For a list of the
available fields, seeCustomize Table Columns above.

Report Item Information Includes a description and current state of the selected report item.

PAL Report Completion Indicates the flow for completing the report.

PAL Report View Tabs

A report tab can contain any number of views. The tabs are defined by the template on which the report
is based. The tabs and views can be customized.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis > PAL.

2. In the Reports tab, click a report. The report opens as an additional tab on theMy
Performance Center Dashboard. The PAL report view tabs are displayed.
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Important
information

l The view tabs which appear by default depend on which template the report is
based on.

l For user interface details on the Data Sources tab, see "Data Sources Tab" on
page 352.

Relevant
tasks

"How toWork with PAL" on page 339

See also "PALOverview" on page 337

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Click the down arrow next to the tab name to open the tabmanagement menu, which
contains the following options:

l Add View to Tab. Opens the Add Views to Tab dialog box. For user interface
details, see "Add Views To Tab Dialog Box" on page 356.

l Edit Tab Title. Enables you to change the name of the tab.

l Move Tab Left. Moves the tab left in the tab order.

l Move Tab Right. Moves the tab right in the tab order.

l Delete This Tab. Deletes the tab and all of the trend views contained in it,
from the report.

Note: This option is not available for all views.

<PAL
report
view>

A display item that presents PAL information within a PAL report view tab. For more
information, see "PALReport Views" below.

PAL Report Views

A PAL report view is a display item that presents PAL information for a particular performancemetric.

To
access

1. On theMy Performance Center navigation bar, select Runs & Analysis > PAL.

2. In the Reports tab, click a report. The report opens as an additional tab on theMy
Performance Center Dashboard. The PAL report view tabs are displayed. The PAL
report views are contained within the tabs.
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Relevant
tasks

"How toWork with PAL" on page 339

See also "PAL Report View Tabs" on page 353

User interface elements are described below:

UI
Elements

Description

Edit PAL report view. Contains options that enable you to edit the PAL report view's
display and comparison settings.

Show in Maximized/Normal view.Maximizes or returns to the normal PAL report
view.

Minimizes/Maximizes data.Minimizes or maximizes the displayed data.

PAL Report ViewMenu

Important Some options are not available in all views.

User interface elements are described below:

UI Elements Description

Select
Measurements

Opens theMeasurements Configuration dialog box, which enables you to add
measurements to the view. For user interface details, see "Select
Measurements Dialog Box" on page 358.

Edit Display
Setting

Enables you to change the appearance of the view. The available settings are
table view, line graph view, and stacked bar chart view.

Edit View Title Enables you to edit the view title.

Compare to
baseline/previous

Enables you to change the comparisonmethod displayed in the view. For more
information on comparisonmethods, see "ComparisonMethods" on page 338.

Show difference
as
value/percentage

Enables you to define how to display value differences between items or data
sets in the view - as values or as percentages.

Do not show
difference

Enables you to hide value differences between items or data sets. It is
recommended to use this setting when exporting the view to a CSV format.

Color View Activates the PAL report's threshold settings.
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UI Elements Description

Export to CSV Enables you to export the view to a CSV format.

Delete this View Deletes the view.

Add Views To Tab Dialog Box

This dialog box enables you to add views to a PAL report view tab.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis > PAL.

2. In the PALReports tab, click a report. The report opens as an additional tab on
theMy Performance Center Dashboard. The PAL report view tabs are displayed.

3. Click the down arrow next to the tab name to open the tabmanagement menu

and select Add View to Tab.

Important
Information

Some views are not relevant for all report types.

See also "PAL Report View Tabs" on page 353
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User interface elements are described below:

UI Elements Description

Workload Displays data that will help you tune the amounts and pacing of the scripts.

Top 10 Hits Lists the top ten actions with the highest number of hits.

Top 10 Users Lists the top ten actions with the highest number of users.

Performance
Data

Shows the number of hits for each action, as well as response time, and total time
in system.

Top 10
Response
Time

Lists the top ten actions with the highest total response time in seconds.

Top 10 Time
in System

Lists the top ten actions with the highest time in the system in seconds.

Distribution Displays distributions of different business processes.

Top 10 Hits
Percentage

Lists the top ten actions with highest number of hits by percentage.

Top 10 Users
Percentage

List the top ten actions with highest number of users by percentage.

Monitoring Displays monitoring data that helps compare the behavior of the underlying
hardware and software in the production and testing systems.

Over Time
View

Displays hits over time in the production system.

Locations
Throughput

Displays location throughput.

Locations
Total Runs

Displays total runs per location.

Adds select views to a PAL report view tab.
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Select Measurements Dialog Box

Each PAL view has a default set of measurements that it uses. This dialog box enables you to
customize themeasurements displayed in a selected report view.

To access 1. On theMy Performance Center navigation bar, select Runs & Analysis > PAL.

2. In the Reports tab, click a report. The report opens as an additional tab on theMy
Performance Center Dashboard. The PAL report view tabs are displayed.

3. On a PAL report view, select themenu button , then select Select
Measurements.

Important
Information

The term transaction applies to any activity measured by testing and production
systems. This includes VuGen script transactions, HP RUM transactions and
actions, and URLs measured by other production systems.

User interface elements are described below:

UI Elements Description

Data Types pane Displays transactions with data. The transactions are enabled based on
existing data.
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UI Elements Description

Transactions Pane This pane displays the following:

l <Top check box>. Selects/clears all transactions in the grid. To
select/clear a specific transaction, select/clear the check box to the left of
the transaction name.

l Mapping Type. Indicates themapping type: All,Mapped, Not Mapped.

l Name. Enables you to locate a specific transaction. Type the name and
press Enter.

l Page Size. Sets the number of transactions displayed per page.

Applies the changes.

Includes the transactions from the Set Global Transactions Filter dialog box.
For more details, see "Set Global Transactions Filter Dialog Box" on
page 368.

Add Data Dialog Box

This dialog box enables you to add production data sets and performance test runs to the report. The
added data is used for comparison and it is the basis for the load test tuning process.

To
access

1. On theMy Performance Center navigation bar, select Runs & Analysis > PAL.

2. In the Reports tab, click a report. The report opens as an additional tab on theMy
Performance Center Dashboard. The PAL report view tabs are displayed.

3. In the Data Sources tab, click Add Production Data or Add Testing Data

User interface elements are described below:

UI Elements Description

Production Tab Enables you to select a production data set for the PAL report.

Test Run Results
Tab

Enables you to select a test run for the PAL report.

Adds the selected production data set and test run results to the PAL
report.
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Production Tab
User interface elements are described below:

UI
Elements

Description

Enables you to filter the data sets displayed in the production grid.

Select one of the following options:

l Only data sets linked to the report application. Displays data sets associated
with PAL application defined in the selected report.

l All. Displays all data sets regardless of a selected PAL application.

Name The name of the data set.

ID The data set ID.

Type The data set type.

Date
Uploaded

The date the data set was uploaded.

Description The description of the data set.

Application The application associated with the data set.

Test Run Results Tab
User interface elements are described below :

UI Elements Description

Enables you to filter the results displayed in the run results grid. Includes the
following options: Project, Test Set, and Test.

ID The Run ID.

Run Name The name of the test run.

Time Range The duration of the test run that is selected.

Example: If a test run's overall duration is 30minutes, and the time range is defined
as 0-15 min, then only the first 15minutes of the test run will be considered for
trending.

Default: The whole test run in selected.
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UI Elements Description

Time Range filter. Opens the Define TimeRange dialog box, which enables you to
change the defined time range within a test run for reporting purposes.

Select one of the following options:

l Publish Complete Run.Makes all data collected from the beginning to the end
of the test run available for the report.

l Publish Part of Run. Makes only part of the test run available for the report.
Select the desired part of the run by entering the start and end times in theStart
Time andEnd Time boxes.

Exec Date The date and time of the test run.

Duration The duration (in minutes) of the test run.

Max Vusers Themaximum number of running Vusers during the test run.

Total
Transactions
Passed

The total number of passed transactions during the test run.

Total Errors The total number of errors during the test run.

Select Columns Dialog Box

This dialog box enables you to select columns to be displayed in the <report name> PALReport's Data
Sources tab.

To
access

On the <report name> PALReport, select theData Sources tab, and click theCustomize

table columns button .

See
also

"<Report Name> PALReport" on page 349

User interface elements are described below:

UI
Elements

Description

Duration The duration of the test run, in minutes.

Global
Filter

The applied global filter.

ID The run ID.
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UI
Elements

Description

Name The package or run name.

Publish
Progress

Indicates whether the report item was successfully added to the report.

Test Name The test name.

Scaling Indicated the scaling factor. For more details on setting the scaling factor, see "Set
Scaling Factors Dialog Box" on page 367.

Start Time The date and time of the report item.

Type Indicates the type of report item.

Threshold Settings Dialog Box

This dialog box enables you to define threshold values for the PALmeasurement types.

To access
On the <report name> PALReport, click .

Important
information

l The term transaction applies to any activity measured by testing and production
systems. This includes VuGen script transactions, HP RUM transactions and
actions, and URLs measured by other production systems.

l The threshold definition and color settings are applied on a global level and hold
true across all views in the report.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Measurement
Type

The type of measurement.

Minor Difference Enter a threshold value for indicating aminor difference between the
production and test data.

Major Difference Enter a threshold value for indicating amajor difference between the
production and test data.

<color settings> Enables you to select in which color themeasurement appears in the report.
Click the colored square in the column to select a different color for the
measurement.

Response Time Measures the average response time transactions take to complete (in
seconds).
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UI Elements Description

Hits Measures the total number of transaction hits over the entire test run.

Hits Distribution The percentage of transaction hits occurrence from the total amount of all
transaction hits.

Users Counts the number of users that performed a specific transaction.

Users
Distribution

The percentage of transaction users from the total amount of users in all
transactions.

Time In System
(Hits X Response
time)

Total time a specific transaction was running in the system. Calculated by
multiplying the average transaction response time by the number of hits.

Transactions per
Second (TPS)

The number of times a transaction was executed in a second. Calculated by
dividing the number of hits by the duration of the data set.

HP SiteScope
Monitors (SiS)

Themetrics monitored by HP SiteScope.

Monitors Mapping Dialog Box

This dialog box enables you tomapmonitored hosts andmonitors.

To access
On the <report name> PALReport, click .

Relevant tasks "How toWork with PAL" on page 339

See also "<Report Name> PALReport" on page 349

"PALOverview" on page 337

Monitored Hosts Tab
Enables you to createmapping for themonitored hosts.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Adds a new mapping.

Creates a duplicate of the selectedmapping.
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UI Elements Description

Deletes a selectedmapping.

Refreshes the list of mappings.

<top grid> Includes the following columns:

ID. Themapping ID.

Name. Themapping name.

Description. A description of themapping.

Mapping Information: Name Themapping name.

Mapping Information: Description A description of themapping.

Mapping Information: Details Lists details of a selectedmeasurement.

The following fields are displayed in the table:

l Data Set ID. The data set ID.

l Data Set Type. Themeasurement type.

l Name. Themonitored host name.

Messages Indicates the status of themapping.

Monitors Tab
Enables you to createmapping for monitor measurements.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Adds a new mapping.

Creates a duplicate of the selectedmapping.

Deletes a selectedmapping.
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UI Elements Description

Refreshes the list of mappings.

<top grid> Includes the following columns:

ID. Themapping ID.

Name. Themapping name.

Description. A description of themapping.

Mapping Information: Name Themapping name.

Mapping Information: Description A description of themapping.

Mapping Information: Monitored
Hosts Mapping

The host whosemeasurements are beingmonitored.

Click in the field to select whichmonitored host to map to the
mappedmeasurement.

Mapping Information: Details Lists details of a selectedmeasurement.

The following fields are displayed in the table:

l Data Set ID. The data set ID.

l Data Set Type. Themeasurement type.

l Name. Themonitor measurement name.

Messages Indicates the status of themapping.

Transactions Mapping and Grouping Dialog Box

This dialog box enables you tomap and group similar transactions in your production data or in your
load test results. Grouping andmapping aggregates the data of the grouped transactions.

To access
On the <report name> PALReport, click .

Important
Information

The term transaction applies to any activity measured by testing and production
systems. This includes VuGen script transactions, HP RUM transactions and
actions, and URLs measured by other production systems.

Relevant
tasks

"How toWork with PAL" on page 339

See also "<Report Name> PALReport" on page 349

"PALOverview" on page 337
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Mapping Production to Testing > Transactions Section
The pane enables you tomap between production and load test transactions in order to have
comparable data in your report. This is relevant in cases where transactions that measure the same
business process have different names.

For example the transaction for measuring the search page is called Search in the VuGen script
whereas the production system calls it Find. Mapping between the transactions makes them
comparable.

User interface elements are described below:

UI Elements Description

Enables you to import mappings from other reports.

Enables you to delete a selectedmapping.

Production Lists the available production transactions.

Performance
Test

Lists the available testing transactions or groups and enables you tomap a testing
transaction or a group to a production transaction.

Mapping
Name

Themapping name of a production transaction. This is the transaction name that
will be used in the reports.

Status Indicates whether the production transaction is mapped or not.

Applies themapping changes.

Internal Transactions Grouping > Load Test or Production Transactions Section
This pane enables you to group similar transactions in your production data or in your load test results.
This is important when similar transactions are given different names. For example the Login
transaction has a suffix added to denote the script it's in, so that several Login transactions are
measured (for example. login_1, login_2, login_3, etc.) although they all measure the same business
process. Grouping will aggregate the data of the grouped transactions.

User interface elements are described below:

UI Elements Description

Clears details in the Group Details pane.
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UI Elements Description

Deletes a selected group name from theGrouping Name pane.

Grouping
Name

Lists the available groups.

This icon indicates that the group is created using regular expressions. The
group contains measurements that are currently displayed underAvailable
Measurements, as well as any futuremeasurements.

Group's Name
& Selected
Measurements

Enter a group name. Use the arrows tomovemeasurements betweenSelected
Measurements andAvailable Measurements. To save the group, click the
Group button.

Available
Measurements

Lists the available transactionmeasurements.

l Use the arrows tomovemeasurements betweenAvailable Measurements
andSelected Measurements.

l . Enables you to locate a specific measurement, type the

measurement name and click this button. The results are displayed below.

l Create group using this regular expression. Enables you use regular
expressions to define a rule that automatically selects measurements to be
included in a group. The automatic selection rule applies tomeasurements that
are currently displayed underAvailable Measurements, as well as any future
measurements.
To define a rule, type the regular expression and select theCreate group
using this regular expression check box. The applicable measurements are
added underSelected Measurements.

Enables you to group the selected transactionmeasurements. The group name is
added to the Grouping Name pane.

Set Scaling Factors Dialog Box

This dialog box enables you to readjust data set durations and differences, to enable you to
compensate for the dissimilarity between the data sets due to different durations or difference in
system configuration (for example, number and power of servers). It also enables you to plan for larger
loads.

To access
On the <report name> PALReport, click .

Duration Adjustments Pane

Affects the followingmeasurement types: Hits and Time in System.
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User interface elements are described below:

UI Elements Description

Adjust data set
duration

Adjusts duration differences of data sets to match the data set duration used
for the baseline.

Scaling Factors Pane

Affects the followingmeasurement types: Hits, Users, Time in System, and transaction per second
(TPS).

User interface elements are described below:

UI Elements Description

Data Set ID The data set ID.

Data Set Type The data set type (Production or Testing).

Data Set
Duration

The duration of the data set.

Scaling
Factor

Indicates the scale of themeasurement.

To change the scale of ameasurement, click the upward/downward arrow to adjust
to the desired scale.

Scaling Factors Preview Pane

The pane previews the scaling factor changes set to the affectedmeasurements. For example, x2
indicates themeasurement is beingmultiplied by 2.

Set Global Transactions Filter Dialog Box

This dialog box enables you to filter transactions from the PAL report views.

To access
On the <report name> PALReport, click .

Important Information This filter does not affect mapped transactions.

Relevant tasks "How toWork with PAL" on page 339

Percentage Filter Tab
This tab enables you to set the filter percentage.

User interface elements are described below:
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UI
Elements

Description

Data Set ID The data set ID.

Data Set
Type

The data set type (Production or Testing).

Global
Filter

Indicates the filter percentage.

To change the percentage of a filter, click the upward/downward arrow to adjust to the
desired value.

Transaction Selection Tab
This tab enables you to select the transactions to be displayed in the report views.

User interface elements are described below:

UI
Elements

Description

<Top
check
box>

Selects/clears all transactions in the grid. To select/clear a specific transaction,
select/clear the check box to the left of the transaction name.

Mapping
Type

Indicates themapping type: All,Mapped, Not Mapped.

Name Enables you to locate a specific transaction. Type the name and press Enter.

Page Size Sets the number of transactions displayed per page.

PAL Data Set Creator Wizard

This wizard enables you to create production data sets using IIS W3C Extended Log File Format,
Google Analytics, orWebtrends. After creating the data sets, you can upload them from PAL and use
them in your reports.

To
access In the upper-right corner of theMy Performance Center window, click . Click PAL

Data Set Creator.

Relevant
tasks

l "How to Create Data Sets from IIS, Google Analytics, orWebtrends" on page 341

l "How toWork with PAL" on page 339
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Wizard
map

This wizard contains:

"Select Data Source Page" below > "Select Log to Import Page" on the next page >
"Webtrends Credentials Page" on page 372 > "Webtrends Data Extractor Page" on
page 373

See also l "PALOverview" on page 337

l "Upload Production Data Set Dialog Box" on page 346

Select Data Source Page

This wizard page enables you to select a data source type.

Important
information

General information about this wizard is available here: "PAL Data Set Creator
Wizard" on the previous page.

Wizard
map

The "PALData Set CreatorWizard" on the previous page contains:

"Select Data Source Page" above > "Select Log to Import Page" on the next page >
"Webtrends Credentials Page" on page 372 > "Webtrends Data Extractor Page" on
page 373

See also l "PALOverview" on page 337

l "Upload Production Data Set Dialog Box" on page 346

User interface elements are described below:

UI Element Description

Microsoft IIS W3C Extended Log
Format

Creates a production data set file using IIS W3C Extended
Log File Format.
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UI Element Description

Google Analytics Creates a production data set file using Google Analytics.

Webtrends Creates a production data set file usingWebtrends.

Select Log to Import Page

This wizard page enables you to select Google Analytics and IIS W3c logs.

Important
information

l General information about this wizard is available here: "PAL Data Set Creator
Wizard" on page 369.

l Available only if you selectedMicrosoft IIS W3C Extended Log Format or
Google Analytics in the "Select Data Source Page" on the previous page.

Wizard
map

The "PALData Set CreatorWizard" on page 369 contains:

"Select Data Source Page" on the previous page > "Select Log to Import Page"
above > "Webtrends Credentials Page" on the next page>"Webtrends Data Extractor
Page" on page 373

See also l "PALOverview" on page 337

l "Upload Production Data Set Dialog Box" on page 346

User interface elements are described below:

UI Element Description

Application Name The PAL application name.

Log Location Enables you to browse for, and select, a log.
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UI Element Description

Date The date of the log file.

Hour Defines the time range for sampling the log.

Session Name Defines the session name.

Available for: IIS W3C Extended Log File Format

Create Creates the data set file.

Webtrends Credentials Page

This wizard page enables you to connect to aWebtrends host.

Important
information

l General information about this wizard is available here: "PAL Data Set Creator
Wizard" on page 369.

l Available only if you selectedWebtrends in the "Select Data Source Page" on
page 370.

Wizard
map

The "PALData Set CreatorWizard" on page 369 contains:

"Select Data Source Page" on page 370 > "Select Log to Import Page" on the
previous page > "Webtrends Credentials Page" above>"Webtrends Data Extractor
Page" on the next page

See also l "PALOverview" on page 337

l "Upload Production Data Set Dialog Box" on page 346
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User interface elements are described below:

UI Element Description

Webtrends host Indicates theWebtrends host name.

Username Indicates the user name.

Note:Youmust have permissions to access the Data Extraction API.

Password Indicates the password.

Webtrends Data Extractor Page

This wizard page enables you to create aWebtrends dataset.

Important
information

l General information about this wizard is available here: "PAL Data Set Creator
Wizard" on page 369.

l Available only if you selectedWebtrends in the "Select Data Source Page" on
page 370.

Wizard
map

The "PALData Set CreatorWizard" on page 369 contains:

"Select Data Source Page" on page 370 > "Select Log to Import Page" on page 371 >
"Webtrends Credentials Page" on the previous page>"Webtrends Data Extractor
Page" above

See also l "PALOverview" on page 337

l "Upload Production Data Set Dialog Box" on page 346
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User interface elements are described below:

UI Element Description

Profiles Indicates theWebtrends profile.

Date Defines the date for sampling theWebtrends data.

Hour Defines the time range for sampling theWebtrends data.

Create Dataset Creates aWebtrends dataset.
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Chapter 22: Working with ALM Performance Center
Online Monitors
This chapter includes:

Monitoring Process Overview 379

How to Set Up theMonitoring Environment –Workflow 379

Monitor Types 380
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Monitoring Process Overview
Beforemonitoring a performance test, you need to set up and configure the ALM Performance Center
monitoring components. Eachmonitor has different configuration requirements that are explained in the
specific monitoring chapters. The following diagram illustrates the ALM Performance Center monitoring
process.

Beforemonitoring a server, perform the following steps:

l Configure themonitoring environment on the server machine (if necessary).

l Configure themonitor on the Controller machine.

For details, see "How to Set Up theMonitoring Environment –Workflow" below.

How to Set Up the Monitoring Environment – Workflow
This task describes how to set up the ALM Performance Center onlinemonitoring environment. You
specify themachines andmeasurements that the Controller will monitor during performance test
execution in the ALM Test Resources module. During performance test execution, the collected
measurement data appears in the online graphs.

1. Configure the monitoring environment on the servermachine
To use the followingmonitors, youmust first install or configuremonitoring components on the
server machine. For details about configuring themonitoring components, see the specific
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monitoring sections.

n "How to Set up the Citrix Monitoring Environment" on page 445

n "How to Set Up the IBMWebSphereMQMonitor" on page 453

n "How to Enable and Configure J2EE/.NET Diagnostics" on page 205

n "How to Set Up the Network Monitoring Environment" on page 408

n "How to Set Up theOracle Monitoring Environment" on page 421

n "How to Set up the UNIX Monitoring Environment" on page 400

2. Configure the monitors on the Controller
To obtain performance data for amonitor, you need to configure themonitor (from the Controller),
and indicate which statistics andmeasurements you want to monitor.

n For information about selecting the servers tomonitor and selecting themeasurements to
monitor, see "How to Create and ConfigureMonitor Profiles" on page 65.

n For details about eachmonitor's default measurements, refer to the relevant reference section
for themonitor.

Monitor Types
All of themonitors allow you to view a summary of the collected data at the conclusion of the
performance test. Using LoadRunner Analysis, you can generate a graph for any of themonitors. For
more information, see theHP LoadRunner Analysis User Guide.

The onlinemonitors are divided into the following categories:

Monitor Type Description

Run-Time
Monitors

Display the number and status of Vusers participating in the scenario, as well as
the number and types of errors that the Vusers generate. For more information, see
"Run-Time and TransactionMonitoring" on page 384.

Transaction
Monitors

Display the transaction rate and response times. For more information, see "Run-
Time and TransactionMonitoring" on page 384.

Web
Resource
Monitors

Provide information about the number of Web connections, throughput volume,
HTTP responses, server retries, and downloaded pages at theWeb servers during
performance test run. For more information, see "WebResourceMonitors" on
page 390.
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Monitor Type Description

System
Resource
Monitors

Measure theWindows, Linux, Server, and SNMP resources used during a
performance test run. For more information, see "System ResourceMonitoring " on
page 398.

Network
Monitors

Displays information about the network delays on your system. For more
information, see "Network Delay Monitoring" on page 406.

Firewall
Monitor

Measures statistics related to the firewall servers during the scenario run.

Web Server
Resource
Monitors

Measure statistics related to theMicrosoft IIS and ApacheWeb servers during the
performance test run. For more information, see "Web Server ResourceMonitoring"
on page 414.

Web
Application
Server
Resource
Monitors

Measure statistics related to theMicrosoft ASP application servers during the
performance test run. For more information, see "Web Application Server Resource
Monitoring" on page 418.

Database
Server
Resource
Monitors

Measure statistics related to the SQL server, andOracle databases during the
performance test run. For more information, see "Database ResourceMonitoring"
on page 420.

Network
Virtualization
Monitors

Measure statistics related to network virtualization, such as Packet Loss and
Latency. For information, see "Network Virtualization Graphs" on page 295.

Service
Virtualization
Monitors

Measure statistics related to HP Service Virtualization, per operation and service.
For information, see "Service VirtualizationMonitoring" on page 151.

SiteScope
Monitor

Use the SiteScopemonitor and its counters to measure resources. For information,
see the documentation provided with SiteScope.

Flex Monitors Measure statistics related to Flex RTMP connections and throughput, as well as
buffering time. For details, see "Flex Monitoring" on page 428.

Streaming
Media
Monitors

Measure statistics related to the RealPlayer Client andMedia Player Client servers
during the scenario run. For more information, see "StreamingMediaMonitoring" on
page 432.

ERP/CRM
Server
Resource
Monitors

Measure statistics related to Siebel Server Manager during the performance test
run. For more information, see "ERP/CRM Server ResourceMonitoring" on
page 436.
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Monitor Type Description

J2EE & .NET
Diagnostics
Monitors

Provide information to trace, time, and troubleshoot individual transactions through
J2EEWeb, application, and database servers. For more information, see theHP
Diagnostics User Guide.

Application
Deployment
Solutions
Monitors

Measures statistics related to the Citrix MetaFrame XP server during a
performance run. For more information, see "Application Deployment Solution
Monitoring " on page 444.

Middleware
Performance
Monitors

Measure statistics related to the IBMWebSphereMQ servers during a scenario
run. For more information, see "Middleware PerformanceMonitoring " on page 452.

Infrastructure
Resources
Monitor

Displays information about network client data points during a scenario run using
the Network Client graph. For more information, see "Infrastructure Resources
Monitoring" on page 462.
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Chapter 23: Run-Time and Transaction Monitoring
This chapter includes:

Run-TimeGraphOverview 385

TransactionMonitor Graphs Overview 387
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Run-Time Graph Overview
TheRun-Time monitor provides information about the status of the Vusers participating in the
performance test, as well as the number and types of errors that the Vusers generate. In addition, the
Run-Timemonitor provides the User-Defined Data Points graph, which displays the real time values for
user-defined points in a Vuser script.

The Run-Timemonitor is enabled by default—it automatically begins monitoring Vusers at the start of a
performance test.

You can view the following Run-Timemonitor graphs during a test run:

Running Vusers Graph
Themonitor's Running Vusers graph provides information about the status of the Vusers running in
the current performance test on all load generator machines. The graph shows the number of running
Vusers, while the information in the legend indicates the number of Vusers in each state.

The Name field of each Vuser displays the current status of the Vuser. The following table describes
each Vuser status:

Status Description

Running The total number of Vusers currently running on all load generators.

Ready The number of Vusers that completed the initialization section of the script and are ready
to run.

Finished The number of Vusers that have finished running. This includes both Vusers that passed
and failed.

Error The number of Vusers whose execution generated an error.

User-Defined Data Points Graph
TheUser-Defined Data Points graph displays the real-time values of user-defined data points. You
define a data point in your Vuser script by inserting an lr_user_data_point function at the appropriate
place (user_data_point for GUI Vusers and lr.user_data_point for Java Vusers).

Action1()
{
    lr_think_time(1);
    lr_user_data_point ("data_point_1",1);
    lr_user_data_point ("data_point_2",2);
    return 0;
}
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For Vuser protocols that support the graphical script representations such as Web andOracle NCA,
you insert a data point as a user-defined step. Data point information is gathered each time the script
executes the function or step.

By default, ALM Performance Center displays all of the data points in a single graph. The legend
provides information about each data point. If desired, you can hide specific data points using the
legend below the graphs.

You can also view data points offline, after the completion of the performance test. For more
information, see theHP LoadRunner Analysis User Guide.

Error Statistics Graph
Themonitor's Error Statistics graph provides details about the number of errors that accrue during
each second of the test run. The errors are grouped by error source—for example, the location in the
script or the load generator name.

Operations Graph
TheOperations graph shows virtual service operations performance counters on all the SV servers that
are used in the scenario. It only shows services that are used in the scenario.

Example

TheOperations on <server> graph shows themeasurement (y-axis) as a function of the elapsed time
in the performance test (x-axis).

Measurement Description

Average Response
Time

Average response time of virtual service in milliseconds.

Hit Rate The number of requests per second of the virtual service operation.

Throughput Data sent and received by virtual service operationmeasured in
megabytes.
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Services Graph
The Services monitor displays information about the virtual services used during a test run.

TheServices on <server> graph shows themeasurement (y-axis) as a function of the elapsed time in
the performance test (x-axis).

Example

Measurement Description

Average
Response
Time

Average Response Time on virtual service in milliseconds.

Data
Simulation
Accuracy

Accuracy of DataModel emulation on virtual service displayed as a percentage.
Accuracy is compared to the recorded behavior on the corresponding actual
service, if available.

Hit Rate The number of requests per second of the virtual service.

Performance
Simulation
Accuracy

Accuracy of performancemodel emulation on virtual service displayed as a
percentage. Accuracy is compared to the recorded behavior on the corresponding
actual service, if available.

Throughput Data sent and received on virtual servicemeasured inmegabytes per second.

Vusers with Errors Graph
TheVusers with Errors graph provides details about the number of Vusers that generate errors during
test execution. The errors are grouped by error source.

Transaction Monitor Graphs Overview
The Transactionmonitor displays the transaction rate and response time during a test run. The
Transactionmonitor is enabled by default—it automatically begins monitoring Vuser transactions at the
start of a test run. To conserve resources, you can disable the Transactionmonitor from the Controller.

You can view the following Transactionmonitor graphs during a test run:

l The Transaction Response Time graph shows the average response time of transactions in
seconds (y-axis) as a function of the elapsed time in the performance test (x-axis).
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l The Transactions per Second (Passed) graph shows the number of successful transactions
performed per second (y-axis) as a function of the elapsed time in the performance test (x-axis).

l The Transactions per Second (Failed, Stopped) graph shows the number of failed and stopped
transactions per second (y-axis) as a function of the elapsed time in the performance test (x-axis).

l The Total Transactions per Second (Passed) graph shows the total number of completed,
successful transactions per second (y-axis) as a function of the elapsed time in the performance
test (x-axis).

Note:

n If there are no transactions defined in your Vuser script or if no transactions are being
executed, no data will be displayed in the onlinemonitor graphs.

n To generateWeb Page diagnostics for each transaction, configure the Diagnostics options
from the Controller.
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Web Resource Monitoring Overview
TheWebResourcemonitor enables you to analyze the following resources on theWeb server during a
performance test run: throughput, HTTP requests, downloaded pages, server retries, TCP/IP
connections, and SSL connections.

You can view the following resourcemonitor graphs during a test run:

Hits per Second Graph
TheHits Per Second graph shows the number of hits (HTTP requests) to theWeb server (y-axis) as a
function of the elapsed time in the performance test (x-axis). This graph can display the whole step, or
the last 60, 180, 600, or 3600 seconds. You can compare this graph to the Transaction Response Time
graph to see how the number of hits affects transaction performance.

Throughput Graph
The Throughput graph shows the amount of throughput (y-axis) on theWeb server during each second
of the test run (x-axis). Throughput is measured in bytes and represents the amount of data that the
Vusers received from the server at any given second. You can compare this graph to the Transaction
Response Time graph to see how the throughput affects transaction performance.

In the following example, the Transaction Response time graph is compared with the Throughput
graph. It is apparent from the graph that as the throughput decreases, the transaction response time
also decreases. The peak throughput occurred at approximately 1minute into the step. The highest
response time also occurred at this time.
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Example

HTTP Responses per Second Graph
TheHTTP Responses per Second graph shows the number of HTTP status codes (y-axis)—which
indicate the status of HTTP requests, for example, "the request was successful" or "the page was not
found"—returned from theWeb server during each second of the performance test run (x-axis).

The HTTP responses are grouped by status code. You can also group the results shown in this graph
by script (using the "Group By" function) to locate scripts which generated error codes.

For a list of status codes and their explanations, see "HTTP Status Codes" on page 395.

Pages Downloaded per Second Graph
ThePages Downloaded per Second graph shows the number of Web pages (y-axis) downloaded
from the server during each second of the test run (x-axis). This graph helps you evaluate the amount of
load Vusers generate, in terms of the number of pages downloaded.

Note: To view the Pages Downloaded per Second graph, youmust select Pages per second
(HTML Mode only) from the script's Run-time settings Preferences tab before running your
performance test.

Like throughput, downloaded pages per second is a representation of the amount of data that the
Vusers received from the server at any given second.
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l The Throughput graph takes into account each resource and its size (for example, the size of each
.gif file, the size of eachWeb page).

l The Pages Downloaded per Second graph takes into account simply the number of pages.

In the following example, the Throughput graph is compared with the Pages Downloaded per Second
graph. It is apparent from the graph that throughput is not proportional to the number of pages
downloaded per second. For example, between 15 and 16 seconds into the performance test, the
throughput decreased while the number of pages downloaded per second increased.

Example

Retries per Second Graph
TheRetries Per Second graph shows the number of attemptedWeb server connections (y-axis) as a
function of the elapsed time in the performance test (x-axis).

A server connection is retried when:

l The initial connection was unauthorized

l Proxy authentication is required

l The initial connection was closed by the server
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l The initial connection to the server could not bemade

l The server was initially unable to resolve the load generator's IP address

Connections Graph
TheConnections graph shows the number of open TCP/IP connections (y-axis) at each point in time
of the performance test (x-axis). One HTML pagemay cause the browser to open several connections,
when links on the page go to different Web addresses. Two connections are opened for eachWeb
server.

This graph is useful in indicating when additional connections are needed. For example, if the number of
connections reaches a plateau, and the transaction response time increases sharply, adding
connections would probably cause a dramatic improvement in performance (reduction in the
transaction response time).

Connections per Second Graph
TheConnections Per Second graph shows the number of new TCP/IP connections (y-axis) opened
and the number of connections that are shut down each second of the performance test (x-axis).

This number should be a small fraction of the number of hits per second, because new TCP/IP
connections are very expensive in terms of server, router and network resource consumption. Ideally,
many HTTP requests should use the same connection, instead of opening a new connection for each
request.

SSLs per Second Graph
The SSLs per Second graph shows the number of new and reused SSL connections (y-axis) opened in
each second of the performance test (x-axis). An SSL connection is opened by the browser after a
TCP/IP connection has been opened to a secure server.

Because creating a new SSL connection entails heavy resource consumption, you should try to open
as few new SSL connections as possible; once you have established an SSL connection, you should
reuse it. There should be nomore than one new SSL connection per Vuser.

If you set your run-time settings to simulate a new Vuser at each iteration (using the run-time settings
Browser Emulation node), you should have nomore than one new SSL connection per Vuser per
iteration. Ideally, you should have very few new TCP/IP and SSL connections each second.

WebSocket Statistics Monitor
ThisWeb Resource graph shows WebSocket statistics during the run.

Purpose Provides you with statistics forWebSocket connections, byte rate, and
failed connections.
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X-axis Elapsed time since the start of the run.

Y-axis WebSocket per second throughout the whole scenario.

Note You cannot change the granularity of the x-axis to a value that is less than
theWeb granularity you defined in the General tab of the Options dialog box.

HTTP Status Codes
The following table displays a list of HTTP status codes. These codes appear in the "WebResource
Monitoring Overview" on page 391.

Code Description Code Description

200 OK 405 Method Not Allowed

201 Created 406 Not Acceptable

202 Accepted 407 Proxy Authentication Required

203 Non-Authoritative Information 408 Request Timeout

204 No content 409 Conflict

205 Reset content 410 Gone

206 Partial content 411 Length Required

300 Multiple Choices 412 Precondition Failed

301 Moved Permanently 413 Request Entity Too Large

302 Found 414 Request - URI Too Large

303 SeeOther 415 UnsupportedMedia Type

304 Not Modified 416 Requested range not satisfiable

305 Use Proxy 417 Expectation Failed

307 Temporary Redirect 500 Internal Server Error

400 Bad Request 501 Not Implemented

401 Unauthorized 502 BadGateway

402 Payment Required 503 Service Unavailable

403 Forbidden 504 Gateway Timeout

404 Not Found 505 HTTP Version not supported
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Formore information on the above status codes and their descriptions, see
http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html#sec10.
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System Resource Monitors Overview
You use ALM Performance Center's System Resourcemonitors to monitor amachine's system
resource usage during a performance test run and isolate server performance bottlenecks.

A primary factor in a transaction's response time is its system resource usage. Using the ALM
Performance Center resourcemonitors, you canmonitor theWindows, UNIX, SiteScope, and SNMP
server on amachine during a test run, and determine why a bottleneck occurred on a particular
machine.

The resourcemonitors are automatically enabled when you execute a test run. However, youmust
specify themachine you want to monitor and which resources tomonitor for eachmachine. You can
also add or removemachines and resources during the test run.

Windows Resource Monitoring
TheWindows Resources monitor shows theWindows resources measured during the test run.
Windows measurements correspond to the built-in counters available from theWindows Performance
Monitor.

If you want to monitor a remoteWindows server that does not useWindows domain security, youmust
authenticate the Controller on the remoteWindows server. To authenticate the Controller, create an
account, or change the password of the account used to log on to the Controller so that it matches the
password and user name used to log on to the remotemonitoredWindows machine. When the remote
Windows machine requests another machine's resources, it sends the logged-in user name and
password of themachine requesting the resources.

UNIX Resource Monitoring
The UNIX Resources monitor shows the UNIX resources measured during the test run. This graph
helps you determine the impact of Vuser load on the various system resources.

The UNIX kernel statistics measurements include those available by the rstatd daemon. For a
description of themeasurements, see "UNIX Resources Performance Counters" on page 401.

Note: Youmust configure an rstatd daemon on all UNIX machines beingmonitored. For
information see "How to Set up the UNIX Monitoring Environment" on the next page.

SNMP Resource Monitoring
The SNMP Resourcemonitor shows statistics for aWindows or UNIX machine using the Simple
Network Management Protocol (SNMP). The SNMP Resources monitor is available for monitoring any
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machine that runs an SNMP agent, using the Simple Network Management Protocol (SNMP).

SiteScope Resource Monitoring
The SiteScope Resources monitor graph shows the SiteScope resources measured during the test run.
The SiteScopemonitor canmeasure server, network, and processor performance counters. For
detailed information on the performance counters that SiteScope canmonitor, refer to the relevant
SiteScope documentation.

Before setting up the SiteScopemonitor, ensure that SiteScope has been installed on a server. You
can install SiteScope on the samemachine as the Controller, or on a dedicated server. If SiteScope is
installed on amachine other than the Controller, verify that the SiteScopemachine is accessible from
the Controller machine.

How to Set up the UNIX Monitoring Environment
This task describes how to configure the UNIX environment before setting up the UNIX monitor.

This task includes the following steps:

l "Verify whether the rstatd daemon is already configured" below

l "Configure the rstatd daemon" below

l "Configure themonitor for a UNIX machine over a firewall (optional)" on the next page

l "Configure themonitor measurements on the Controller" on the next page

1. Verify whether the rstatd daemon is already configured
The rstatd daemonmight already be configured, because when amachine receives an rstatd
request, the inetd on that machine automatically activates the rstatd.

n The rup command reports various machine statistics, including rstatd configuration. Run the
following command on the UNIX machine to view themachine statistics:

>rup host

n You can also use lr_host_monitor and see if it returns any relevant statistics.

If the command returns meaningful statistics, the rstatd daemon is already configured and
activated. If not, or if you receive an error message, the rstatd daemon is not configured.

2. Configure the rstatd daemon
If the rstatd daemon is not yet configured, follow these steps to configure it:
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a. On the UNIX machine, run the command: su root

b. Go to /etc/inetd.conf and look for the rstatd row (it begins with the word rstatd). If it is
commented out (with a #), remove the comment directive, and save the file.

c. From the command line, run:

kill -1 inet_pid

where inet_pid is the pid of the inetd process. This instructs the inetd to rescan the
/etc/inetd.conf file and register all daemons which are uncommented, including the rstatd
daemon.

d. Run rup again.

If the command still does not indicate that the rstatd daemon is configured, contact your
system administrator.

3. Configure the monitor for a UNIX machine over a firewall (optional)
Tomonitor a UNIX machine over a firewall, youmust run a UNIX utility called rpcinfo and identify
the rstatd's port number.

Run rpcinfo -p <hostname>. You will receive a list of all RPC servers registered in the host's
portmapper, along with the port number. This list will not change until rstatd is stopped and rerun.

Some firewalls allow you to open an RPC program number instead of a port. In such cases, open
program 100001. If are prompted to include a version number, specify versions 3 and 4.

4. Configure the monitormeasurements on the Controller
For task details, see "How to Create and ConfigureMonitor Profiles" on page 65.

For a description of the available UNIX monitor measurements, see "UNIX Resources
Performance Counters" below.

UNIX Resources Performance Counters
The following default measurements are available for the UNIX machine:

Measurement Description

Average load Average number of processes simultaneously in Ready state during the
last minute.

Collision rate Collisions per second detected on the Ethernet.

Context switches rate Number of switches between processes or threads, per second.
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Measurement Description

CPU utilization Percent of time that the CPU is utilized.

Disk rate Rate of disk transfers.

Incoming packets error
rate

Errors per second while receiving Ethernet packets.

Incoming packets rate Incoming Ethernet packets per second.

Interrupt rate Number of device interrupts per second.

Outgoing packets errors
rate

Errors per second while sending Ethernet packets.

Outgoing packets rate Outgoing Ethernet packets per second.

Page-in rate Number of pages read to physical memory, per second.

Page-out rate Number of pages written to pagefile(s) and removed from physical
memory, per second.

Paging rate Number of pages read to physical memory or written to pagefile(s), per
second.

Swap-in rate Number of processes being swapped in.

Swap-out rate Number of processes being swapped out.

System mode CPU
utilization

Percent of time that the CPU is utilized in systemmode.

User mode CPU
utilization

Percent of time CPU is utilized in user mode.
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Windows Resource Performance Counters
The following default measurements are available forWindows machines:

Object Measurement Description

System % Total
Processor Time

The average percentage of time that all the processors on
the system are busy executing non-idle threads. On a
multi-processor system, if all processors are always
busy, this is 100%, if all processors are 50% busy this is
50% and if 1/4 of the processors are 100% busy this is
25%. It can be viewed as the fraction of the time spent
doing useful work. Each processor is assigned an Idle
thread in the Idle process which consumes those
unproductive processor cycles not used by any other
threads.

System File Data
Operations/sec

The rate at which the computer issues read and write
operations to file system devices. This does not include
File Control Operations.

Processor % Processor
Time (Windows
2000)

The percentage of time that the processor is executing a
non-idle thread. This counter was designed as a primary
indicator of processor activity. It is calculated by
measuring the time that the processor spends executing
the thread of the idle process in each sample interval, and
subtracting that value from 100%. (Each processor has
an idle thread which consumes cycles when no other
threads are ready to run). It can be viewed as the
percentage of the sample interval spent doing useful
work. This counter displays the average percentage of
busy time observed during the sample interval. It is
calculated by monitoring the time the service was
inactive, and then subtracting that value from 100%.

System Processor
Queue Length

The instantaneous length of the processor queue in units
of threads. This counter is always 0 unless you are also
monitoring a thread counter. All processors use a single
queue in which threads wait for processor cycles. This
length does not include the threads that are currently
executing. A sustained processor queue length greater
than two generally indicates processor congestion. This
is an instantaneous count, not an average over the time
interval.
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Object Measurement Description

Memory Page Faults/sec This is a count of the page faults in the processor. A page
fault occurs when a process refers to a virtual memory
page that is not in its Working Set in themainmemory. A
page fault will not cause the page to be fetched from disk
if that page is on the standby list (and hence already in
mainmemory), or if it is in use by another process with
which the page is shared.

Physical Disk % Disk Time The percentage of elapsed time that the selected disk
drive is busy servicing read or write requests.

Memory Pool Nonpaged
Bytes

The number of bytes in the nonpaged pool, a system
memory area where space is acquired by operating
system components as they accomplish their appointed
tasks. Nonpaged pool pages cannot be paged out to the
paging file. They remain in mainmemory as long as they
are allocated.

Memory Pages/sec The number of pages read from the disk or written to the
disk to resolvememory references to pages that were not
in memory at the time of the reference. This is the sum of
Pages Input/sec and Pages Output/sec. This counter
includes paging traffic on behalf of the system cache to
access file data for applications. This value also includes
the pages to/from non-cachedmappedmemory files. This
is the primary counter to observe if you are concerned
about excessivememory pressure (that is, thrashing),
and the excessive paging that may result.

System Total
Interrupts/sec

The rate at which the computer is receiving and servicing
hardware interrupts. The devices that can generate
interrupts are the system timer, themouse, data
communication lines, network interface cards, and other
peripheral devices. This counter provides an indication of
how busy these devices are on a computer-wide basis.

Objects Threads The number of threads in the computer at the time of data
collection. Notice that this is an instantaneous count, not
an average over the time interval. A thread is the basic
executable entity that can execute instructions in a
processor.

Process Private Bytes The current number of bytes that the process has
allocated that cannot be shared with other processes.
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Network Monitoring Overview
Network configuration is a primary factor in the performance of applications. A poorly designed network
can slow client activity to unacceptable levels.

You use Network monitoring to determine whether your network is causing a delay in the performance
test. You can also determine the problematic network segment.

In a trueWeb or client/server system, there aremany network segments. A single network segment
with poor performance can affect the entire system.

The following diagram shows a typical network. To go from the server machine to the Vuser machine,
datamust travel over several segments.

The Network Delay Timemonitor shows the delays for the complete path between the source and
destinationmachines (for example the database server and Vuser host). The graphmaps the delay as a
function of the elapsed performance test time. Each defined path is represented by a separate line with
a different color in the graph.

Tomeasure network performance, the Network monitor sends packets of data across the network.
When a packet returns, themonitor calculates the time it takes for the packet to go to the requested
node and return. This time is the delay which appears in the Network Delay Time graph.

Note: The delays from the sourcemachine to each of the nodes aremeasured concurrently, yet
independently. It is therefore possible that the delay from the sourcemachine to one of the nodes
could be greater than the delay for the complete path between the source and destination
machines.

l For information about how to set up the network monitoring environment, see "How to Set Up the
Network Monitoring Environment" on the next page.

l For information about how to configure the Linux sourcemachine for network monitoring, see "How
to Configure the Linux SourceMachine for Network Monitoring" on page 409.
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How to Set Up the Network Monitoring Environment
This task describes how to prepare your environment for network monitoring.

To leanmore about network monitoring, see "Network Monitoring Overview" on the previous page.

This task includes the following steps:

l "Prerequisites" below

l "Configure the Linux sourcemachine - optional" below

l "Configure the firewall between the source and destinationmachines - Optional " below

l "Configure the Network monitor on the Controller" on the next page

1. Prerequisites
To enable network monitoring, youmust install the Performance Center agent on the source
machine. You do not have to install the Performance Center agent on the destinationmachine.

To run the Network monitor, youmust have administrator privileges on theWindows source
machine (unless you are using the ICMP protocol).

2. Configure the Linux source machine - optional
You can run the Network monitor on Linux sourcemachines, using UDP or ICMP. Before running
the Network monitor from a Linux sourcemachine, configure the sourcemachine. For task details,
see "How to Configure the Linux SourceMachine for Network Monitoring" on the next page.

3. Configure the firewall between the source and destinationmachines - Optional
If you aremonitoring a network in which there are firewalls between the source and the destination
machines, youmust configure the firewalls to allow the network data packets to reach their
destinations.

n If you are using the TCP protocol, the firewall that protects the destinationmachine should not
block outgoing ICMP_TIMEEXCEEDED packets (packets that are sent outside the firewall
from themachine). In addition, the firewall protecting the sourcemachine should allow ICMP_
TIMEEXCEEDED packets to enter, as well as TCP packets to exit.

n If you are using the ICMP protocol, the destinationmachine's firewall should not block
incoming ICMP_ECHO_REQUEST packets, or outgoing ICMP_ECHO_REPLY and ICMP_
ECHO_TIMEEXCEEDED packets. In addition, the firewall protecting the sourcemachine
should allow ICMP_ECHO_REPLY and ICMP_ECHO_TIMEEXCEEDED packets to enter,
and ICMP_ECHO_REQUEST packets to exit.

n If you are using the UDP protocol, ensure that the UDP protocol can access the destination
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machine from the sourcemachine. The destinationmachine's firewall should not block
outgoing ICMP_DEST_UNREACHABLE and ICMP_ECHO_TIMEEXCEEDED packets. In
addition, the firewall protecting the sourcemachine should allow ICMP_DEST_
UNREACHABLE and ICMP_ECHO_TIMEEXCEEDED packets to enter.

Note: To run the Network Delay monitor when there are firewalls between the Controller
and the sourcemachine, youmust configure the Performance Center agent, MI Listener,
and Network Delay monitor for monitoring over a firewall.

4. Configure the Networkmonitor on the Controller
For task details, see "How to Create and ConfigureMonitor Profiles" on page 65.

How to Configure the Linux Source Machine for Network
Monitoring
This task describes how to configure a UNIX sourcemachine before running the network monitor.

To leanmore about network monitoring, see "Network Monitoring Overview" on page 407.

This task includes the following steps:

l "Assign permissions where Performance Center is installed locally" below

l "Assign permissions where Performance Center is installed on the network" on the next page

l "Connect to the Linux SourceMachine Through RSH " on the next page

l "Connect to the Linux SourceMachine Through the Agent" on page 411

1. Assign permissions where Performance Center is installed locally
Follow these steps to assign root permissions to themerc_webtrace process:

a. Log in to the sourcemachine as root.

b. Type: cd <performance center_installation>/bin to change to the bin directory.

c. Type: chown root merc_webtrace to make the root user the owner of themerc_webtrace
file.

d. Type: chmod +s merc_webtrace to add the s-bit to the file permissions.

e. To verify, type ls -l merc_webtrace. The permissions should look like this: -rwsrwsr-x.
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2. Assign permissions where Performance Center is installed on the network
In a Performance Center network installation, themerc_webtrace process is on the network, not
on the sourcemachine disk. The following procedure copies themerc_webtrace file to the local
disk, configuresmdrv.dat to recognize the process, and assigns root permissions tomerc_
webtrace:

a. Copymerc_webtrace from <performance center_installation>/bin to anywhere on the
local disk of the sourcemachine. For example, to copy the file to the /local/<performance
center> directory, type: cp /net/tools/performance center_installation/bin/merc_
webtrace /local/<performance center>

Note: All of the sourcemachines that use the same network installationmust copy
merc_webtrace to the identical directory path on their local disk (for example,
/local/<performance center>), since all of them use the samemdrv.dat.

b. Add the following line to the <performance center_installation>/dat/mdrv.dat file, in the
[monitors_server] section:

ExtCmdLine=-merc_webtrace_path /local/xxx

c. Log in to the sourcemachine as root.

d. Type: cd performance center_installation/bin to change to the bin directory.

e. Type: chown root merc_webtrace to make the root user the owner of themerc_webtrace
file.

f. Type: chmod +s merc_webtrace to add the s-bit to the file permissions.

g. To verify, type ls -l merc_webtrace. The permissions should look like:
-rwsrwsr-x.

3. Connect to the Linux Source Machine Through RSH
Follow these instructions if the Controller is connected to the sourcemachine through RSH
(default connectionmode). In this case you do not need to activate the agent daemon.

Before running the Network monitor the first time, you enter an encrypted user name and
password in the Network monitor configuration file.

a. On the Performance Center host machine, type cd <Performance Center installation>/bin to
change the bin directory.

b. RunCryptonApp.exe.

c. In thePassword box, type your RSH user name and password, separated by a vertical bar
symbol. For example, myname|mypw.
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d. Click Generate. An encoded string is displayed in the Encoded string field.

e. Click Copy to copy the encoded string to the clipboard.

f. Add the following line to the <performance center_installation>/dat/monitors/ndm.cfg file,
in the [hosts] section:

Host = <encrypted string copied from clipboard>

g. Close and open the current performance test. ALM Performance Center will read the updated
configuration file and recognize the sourcemachine for monitoring.

4. Connect to the Linux Source Machine Through the Agent
Follow these instructions for activating agent daemon on the sourcemachine if the Controller is
not connected to the sourcemachine through RSH.

a. Type m_daemon_setup -install from the <performance center_installation>/bin
directory.

b. Make sure that the agent daemon is running whenever you activate the Network monitor.

c. To stop the Network Delay Monitor agent daemon, type m_daemon_setup -remove.

Network Delay Monitoring User Interface
This section includes:

l "Network Delay TimeGraph" below

Network Delay Time Graph

The Network Delay Time graph shows the delay for the complete path between the source and
destinationmachines (y-axis) as a function of the elapsed performance test time (x-axis).

Each path defined in the Add DestinationMachines for Network Delay Monitoring dialog box is
represented by a separate line with a different color in the graph.
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Troubleshooting and Limitations
This section describes troubleshooting for the Network Delay monitor.

If monitoring is unsuccessful and ALM Performance Center cannot locate the source or destination
machines, make sure that the specifiedmachines are available to your machine. Perform a "ping"
operation. At the command line prompt, type Ping server_name.

To check the entire network path, use the trace route utility to verify that the path is valid.

ForWindows, type tracert <server_name>.

For UNIX, type traceroute <server_name>.

If themonitoring problem persists once you verify that themachines are accessible and that the
network path is valid, perform the following procedures:

1. If you are using the TCP protocol, run <performance center root folder>\bin\webtrace.exe from
the sourcemachine to determine whether the problem is related to the Controller, or theWebTrace
technology on which the Network Delay monitor is based. If you are using the UDP or ICMP
protocols, the problemmust be related to the Controller and not WebTrace, since these protocols
are not WebTrace technology-based.

2. If you receive results by runningwebtrace.exe, the problem is related to the Controller. Verify that
the sourcemachine is not a UNIX machine, and contact the Customer Support Web site with the
following information:

n the Controller log file, drv_log.txt, located in the temp directory of the Controller machine.

n the traceroute_server log file, located on the sourcemachine.

n the debug information located in the TRS_debug.txt andWT_debug.txt files in the path
directory. These files are generated by adding the following line to the [monitors_server] section
of the <performance center root folder>\dat\mdrv.dat file, and rerunning the Network
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monitor:

ExtCmdLine=-traceroute_debug path

3. If you do not receive results by runningwebtrace.exe, the problem is related to theWebTrace
technology, on which the Network Delay monitor is based. Perform the following procedures on
the sourcemachine:

n Verify that the packet.sys file (theWebtrace driver) exists in theWINNT\system32\drivers
directory.

n Check whether a driver (such as "Cloud" or "Sniffer") is installed on top of the network card
driver. If so, remove it and runWebTrace again.

n Verify that there are administrator permissions on themachine.

n Using ipconfig /all, check that only one IP address is assigned to the network card.
WebTrace does not know how to handlemultiple IP addresses assigned to the same card (IP
spoofing).

n Check the number of network cards installed. Run webtrace –devlist to receive a list of the
available network cards.

n If there is more than one card on the list, run webtrace -dev <dev_name> <destination>,
where <dev_name> is one of the network card names shown in the list. If you discover that
WebTrace is binding to the wrong card, you can use webtrace set_device <dev_name> to set
a registry key that instructs WebTrace to use a specified card instead of the default one.

n Verify that the network card is of the Ethernet type.

n Contact the Customer Support Web site with the output of webtrace.exe –debug (for example,
webtrace.exe –debug www.merc-int.com) and ipconfig /all on themachine.
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Web Server Resource Monitoring Overview
WebServer Resourcemonitors provide you with information about the resource usage of theMicrosoft
IIS and ApacheWeb servers during performance test execution. To obtain this data, you need to
activate the onlinemonitor for the server and specify which resources you want to measure before
executing the test.

For information about how to configure themonitors on the Controller, see "How to Set Up the
Monitoring Environment –Workflow" on page 379.

How to Change the Apache Default Server Properties
This task describes how tomodify the Apache default server properties that are defined in themonitor
configuration file.

1. Open the apache.cfg file in the <performance center server root folder>\dat\monitors
directory.

2. Edit the following parameters after the Delimiter=: statement:

InfoURL. Server statistics information URL

ServerPort. Server port number

SamplingRate. Rate (milliseconds) at which themonitor will poll the server for the statistics
information. If this value is greater than 1000, ALM Performance Center will use it as its sampling
rate. Otherwise, it will use the sampling rate defined in theMonitors tab of the Options dialog box.

3. Save and close the file.

Apache Performance Counters
The following table describes themeasurements and server properties that can bemonitored on the
ApacheWeb server during the test run:

Measurement Description

# Busy Servers The number of servers in the Busy state.

# Idle Servers The number of servers in the Idle state.

Apache CPU Usage The percentage of time the CPU is utilized by the Apache server.

Hits/sec The HTTP request rate.

KBytes Sent/sec The rate at which data bytes are sent from theWeb server.
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Microsoft IIS Performance Counters
The following table describes themeasurements and server properties that can bemonitored on the
Microsoft IIS Web server during the test run:

Object Measurement Description

Web
Service

Bytes Sent/sec The rate at which the data bytes are sent by theWeb service.

Web
Service

Bytes
Received/sec

The rate at which the data bytes are received by theWeb service.

Web
Service

Get
Requests/sec

The rate at which HTTP requests using the GETmethod aremade.
Get requests are generally used for basic file retrievals or image
maps, though they can be used with forms.

Web
Service

Post
Requests/sec

The rate at which HTTP requests using the POSTmethod aremade.
Post requests are generally used for forms or gateway requests.

Web
Service

Maximum
Connections

Themaximum number of simultaneous connections established with
theWeb service.

Web
Service

Current
Connections

The current number of connections established with theWeb service.

Web
Service

Current
NonAnonymous
Users

The number of users that currently have a non-anonymous
connection using theWeb service.

Web
Service

Not Found
Errors/sec

The rate of errors due to requests that could not be satisfied by the
server because the requested document could not be found. These
are generally reported to the client as an HTTP 404 error code.

Process Private Bytes The current number of bytes that the process has allocated that
cannot be shared with other processes.
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Web Application Server Resource Monitoring Overview
You use ALM Performance Center's Web Application Server Resourcemonitors to monitor Microsoft
Active Server Pages servers during a test run and isolate application server performance bottlenecks.

TheMicrosoft Active Server Pages (ASP)monitor displays statistics about the resource usage on the
ASP server during the test run.

MS Active Server Pages Performance Counters
The following table describes the default counters that can bemonitored:

Measurement Description

Errors per
Second

The number of errors per second.

Requests Wait
Time

The number of milliseconds themost recent request was waiting in the queue.

Requests
Executing

The number of requests currently executing.

Requests
Queued

The number of requests waiting in the queue for service.

Requests
Rejected

The total number of requests not executed because there were insufficient
resources to process them.

Requests Not
Found

The number of requests for files that were not found.

Requests/sec The number of requests executed per second.

Memory
Allocated

The total amount of memory, in bytes, currently allocated by Active Server
Pages.

Errors During
Script
Run-Time

The number of failed requests due to run-time errors.

Sessions
Current

The current number of sessions being serviced.

Transactions/sec The number of transactions started per second.
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Database Resource Monitoring Overview
ALM Performance Center's Database Server Resourcemonitors measure database resource usage
statistics for Oracle, or SQL Servers during a performance test run. You use thesemonitors to isolate
database server performance bottlenecks.

TheOracle monitor displays information from Oracle V$ tables: Session statistics, V$SESSTAT,
system statistics, V$SYSSTAT, and other table counters defined by the user in the custom query.

Before defining themonitoringmeasurements for the Oracle monitors in the Controller, youmust set up
themonitoring environment on the database server.

For details about the Oracle monitor configuration, see "How to Set Up theOracle Monitoring
Environment" below.

How to Set Up the Oracle Monitoring Environment
This task describes how to set up themonitor environment beforemonitoring anOracle database
server.

Note: If a problem occurs in setting up the Oracle environment, check the Oracle server to view
the error messages.

This task includes the following steps:

l "Prerequisites" below

l "Configure the Oracle client/server connection" on the next page

l "Connect to themonitored server machine and verify the connection" on page 423

l "Modify themonitoring sample rate (optional)" on page 423

l "Configure the Oracle monitor on the Controller" on page 423

1. Prerequisites
n Ensure that the Oracle client libraries are installed on the Controller machine.

n Verify that%OracleHome%\bin is included in the path environment variable. If it is not, add it.

n Ensure that the registries are updated for the version of Oracle that you are using and that they
have the following key: HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

n Ensure that the Performance Center Server is installed in a directory whose path does not
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include any of the following characters: ( ) : ; * \ / " ~ & ? { } $ % | < > + = ^ [ ].

n Verify that the Oracle server you want to monitor is up and running. Note that it is possible to
monitor several Oracle database servers concurrently.

Note: Only the 32-bit Oracle client should be installed on the Controller machine running the
Oracle monitor. If you have a 16-bit and a 32-bit Oracle client installation on the Controller
machine, the 16-bit installation should be uninstalled.

2. Configure the Oracle client/server connection
Set the connection parameters so the Oracle client (Controller machine) can communicate with
the Oracle server(s) you plan tomonitor.

On the Controller machine, set the following configuration parameters either by editing the
tnsnames.ora file in a text editor, or using the Oracle service configuration tool.

Example:

Start > Programs > Oracle for Windows NT > Oracle Net8 Easy Config

n A new service name (TNS name) for the Oracle instance

n TCP protocol

n The host name (name of monitored server machine)

n The port number (usually 1521)

n The database SID (the default SID is ORCL)

Example:
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3. Connect to the monitored servermachine and verify the connection
a. Obtain a username and password for the service from your database administrator, and

ensure that the Controller has database administrator privileges for the OracleV$ tables
(V$SESSTAT, V$SYSSTAT, V$STATNAME, V$INSTANCE, V$SESSION).

b. Verify connection with the Oracle server by performing tns ping from the Controller machine.

Note: Theremay be a problem connecting if the Oracle server is behind a DMZ/firewall
that limits its communication to application servers accessing it.

c. Run SQL*Plus from the Controller and attempt to log in to the Oracle server(s) with the desired
username/password/server combination.

d. TypeSELECT * FROM V$SYSSTAT to verify that you can view the V$SYSSTAT table on
the Oracle server. Use similar queries to verify that you can view the V$SESSTAT,
V$SESSION, V$INSTANCE, V$STATNAME, and V$PROCESS tables on the server.

4. Modify the monitoring sample rate (optional)
To change the length of eachmonitoring sample (in seconds), edit the dat\monitors\vmon.cfg file
in the Performance Center root folder. The default rate is 10 seconds.

Theminimum sampling rate for the Oracle Monitor is 10 seconds. If you set the sampling rate at
less than 10 seconds, the Oracle Monitor will continue tomonitor at 10 second intervals.

5. Configure the Oracle monitor on the Controller
For task details, see "How to Create and ConfigureMonitor Profiles" on page 65.

Oracle Performance Counters
The followingmeasurements aremost commonly used whenmonitoring the Oracle server (from the
V$SYSSTAT table):

Measurement Description

CPU used by
this session

The amount of CPU time (in 10s of milliseconds) used by a session between the
time a user call started and ended. Some user calls can be completed within 10
milliseconds and, as a result, the start and end-user call time can be the same. In
this case, 0milliseconds are added to the statistic. A similar problem can exist in
the operating system reporting, especially on systems that suffer frommany
context switches.
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Measurement Description

Bytes
received via
SQL*Net
from client

The total number of bytes received from the client over Net8.

Logons
current

The total number of current logons.

Opens of
replaced files

The total number of files that needed to be reopened because they were no longer in
the process file cache.

User calls Oracle allocates resources (Call State Objects) to keep track of relevant user call
data structures every time you log in, parse, or execute. When determining activity,
the ratio of user calls to RPI calls gives you an indication of how much internal work
is generated as a result of the type of requests the user is sending to Oracle.

SQL*Net
roundtrips
to/from client

The total number of Net8messages sent to, and received from, the client.

Bytes sent
via SQL*Net
to client

The total number of bytes sent to the client from the foreground processes.

Opened
cursors
current

The total number of current open cursors.

DB block
changes

Closely related to consistent changes, this statistic counts the total number of
changes that weremade to all blocks in the SGA that were part of an update or
delete operation. These are changes that generate redo log entries and hence will
cause permanent changes to the database if the transaction is committed. This
statistic is a rough indication of total database work and indicates (possibly on a
per-transaction level) the rate at which buffers are being dirtied.

Total file
opens

The total number of file opens being performed by the instance. Each process
needs a number of files (control file, log file, database file) to work against the
database.
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SQL Server Performance Counters
The following table describes the default counters that can bemonitored on version 6.5 of the SQL
Server:

Measurement Description

% Total
Processor Time

The average percentage of time that all the processors on the system are busy
executing non-idle threads. On amulti-processor system, if all processors are
always busy, this is 100%, if all processors are 50% busy this is 50% and if 1/4
of the processors are 100% busy this is 25%. It can be viewed as the fraction of
the time spent doing useful work. Each processor is assigned an Idle thread in
the Idle process which consumes those unproductive processor cycles not
used by any other threads.

% Processor
Time

The percentage of time that the processor is executing a non-idle thread. This
counter was designed as a primary indicator of processor activity. It is
calculated by measuring the time that the processor spends executing the
thread of the idle process in each sample interval, and subtracting that value
from 100%. (Each processor has an idle thread which consumes cycles when
no other threads are ready to run). It can be viewed as the percentage of the
sample interval spent doing useful work. This counter displays the average
percentage of busy time observed during the sample interval. It is calculated by
monitoring the time the service was inactive, and then subtracting that value
from 100%.

Cache Hit Ratio The percentage of time that a requested data page was found in the data cache
(instead of being read from disk).

I/O - Batch
Writes/sec

The number of 2K pages written to disk per second, using Batch I/O. The
checkpoint thread is the primary user of Batch I/O.

I/O - Lazy
Writes/sec

The number of 2K pages flushed to disk per second by the Lazy Writer.

I/O -
Outstanding
Reads

The number of physical reads pending.

I/O -
Outstanding
Writes

The number of physical writes pending.

I/O - Page
Reads/sec

The number of physical page reads per second.

I/O -
Transactions/sec

The number of Transact-SQL command batches executed per second.
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Measurement Description

User
Connections

The number of open user connections.
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Flex RTMP Connections Graph
This graph shows the number of open RTMP connections at any time during the load test scenario run.
The throughput represents the amount of data that the Vusers received from the server or sent to the
server at any given second.

Purpose This graph is useful in indicating when additional connections are needed. For example, if
the number of connections reaches a plateau, and the transaction response time
increases sharply, adding connections would probably cause a dramatic improvement in
performance (reduction in the transaction response time).

X-axis Elapsed time since the start of the scenario run.

Y-axis Number of connections.

Flex RTMP Throughput Graph
This graph shows the amount of throughput (in bytes) on the RTMP/T server during each second of the
load test scenario run. The throughput represents the amount of data that the Vusers received from the
server or sent to the server at any given second.

Purpose Helps you evaluate the amount of load that Vusers generate, in terms of server
throughput.

X-axis Elapsed time since the start of the scenario run.

Y-axis Throughput of the server in bytes

Note You cannot change the granularity of the x-axis to a value that is less than theWeb
granularity you defined in the General tab of the Options dialog box.

Flex RTMP Other Statistics Graph
This graph shows various statistics about Flex RTMP Vusers.

Purpose The graph shows the duration taken to perform various RTMP tasks.

X-axis Elapsed time since the start of the scenario run.

Y-axis Task duration (in milliseconds).
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Flex Streaming Delivery Graph
This graph displays the total number of streams that were successfully delivered by the server. A
successful delivery is indicated when the server initiates a "NetStream.Stop" message at the end of
the requested stream.

Purpose Helps you evaluate the amount of load that Vusers generate, in terms of server
throughput.

X-axis Elapsed time since the start of the scenario run.

Y-axis Number of streams delivered

Flex Average Buffering Time Graph
This graph displays the average buffering time for RTMP streams.

Purpose Helps you evaluate the amount of load that Vusers generate, in terms of time spent for
streams in the buffer.

X-axis Elapsed time since the start of the scenario run.

Y-axis Buffering time inmilliseconds
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Streaming Media Monitoring Overview
To isolate server and client performance bottlenecks during a scenario run, youmonitor theWindows
Media Server and RealPlayer audio/video servers, as well as the RealPlayer andMedia Player clients.

Note: For instructions on recording a script containing streamingmedia functions, see the HP
Virtual User Generator.

The streamingmediamonitors provide you with performance information for theWindows Media Server
and RealPlayer audio/video servers, as well as the RealPlayer andMedia Player clients. To obtain data
for theWindows Media Server and RealPlayer Server, you need to activate the streamingmedia
monitor before executing the scenario, and indicate which statistics andmeasurements you want to
monitor. The RealPlayer Client andMedia Player Client do not require pre-session or scenario
activation or configuration.

l The Real Client monitor graph shows statistics on the RealPlayer client machine as a function of
the elapsed scenario time. The x-axis represents the time that has elapsed since the start of the
scenario run. The y-axis represents the resource usage.

l TheMedia Player Client monitor graph shows statistics on theWindows Media Player client
machine as a function of the elapsed scenario time. The x-axis represents the time that has elapsed
since the start of the scenario run. The y-axis represents the resource usage.

RealPlayer Client Performance Counters
The following table describes the RealPlayer Client measurements that aremonitored:

Measurement Description

Current Bandwidth
(Kbits/sec)

The number of kilobytes in the last second

Buffering Event Time (sec) The average time spent on buffering

Network Performance The ratio (percentage) between the current bandwidth and the
actual bandwidth of the clip

Percentage of Recovered
Packets

The percentage of error packets that were recovered

Percentage of Lost Packets The percentage of packets that were lost

Percentage of Late Packets The percentage of late packets

User and Administrator Guide
Chapter 31: StreamingMediaMonitoring

HP ALM Performance Center (12.20) Page 433 of 521



Time to First Frame
Appearance (sec)

The time for first frame appearance (measured from the start of
the replay)

Number of Buffering Events The average number of all buffering events

Number of Buffering Seek
Events

The average number of buffering events resulting from a seek
operation

Buffering Seek Time The average time spent on buffering events resulting from a seek
operation

Number of Buffering
Congestion Events

The average number of buffering events resulting from network
congestion

Buffering Congestion Time The average time spent on buffering events resulting from
network congestion

Number of Buffering Live
Pause Events

The average number of buffering events resulting from live pause

Buffering Live Pause Time The average time spent on buffering events resulting from live
pause

Media Player Client Performance Counters
The following table describes theMedia Player Client measurements that aremonitored:

Measurement Description

Average
Buffering
Events

The number of times Media Player Client had to buffer incomingmedia data due to
insufficient media content.

Average
Buffering
Time (sec)

The time spent by Media Player Client waiting for sufficient amount of media data in
order to continue playingmedia clip.

Current
bandwidth
(Kbits/sec)

The number of kbits per second received.

Number of
Packets

The number of packets sent by server for a particular media clip.

Stream
Interruptions

The number of interruptions encountered by media player client while playing a
media clip. This measurement includes the number of times Media Player Client
had to buffer incomingmedia data, and any errors that occurred during playback.
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Stream
Quality
(Packet-level)

The percentage ratio of packets received to total packets.

Stream
Quality
(Sampling-
level)

The percentage of stream samples received on time (no delays in reception).

Total number
of recovered
packets

The number of lost packets that were recovered. This value is only relevant during
network playback.

Total number
of lost
packets

The number of lost packets that were not recovered. This value is only relevant
during network playback.
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ERP/CRM Server Resource Monitoring Overview
You use ALM Performance Center's ERP/CRM server resourcemonitors to monitor ERP/CRM
servers during a performance test run and isolate server performance bottlenecks.

The Siebel Server Manager monitor displays statistics about the resource usage of a Siebel Server
Manager during the scenario run.

Siebel Server Manager Performance Counters
The following table shows the default counters that can bemeasured:

Measurement Description

Average Connect Time The average connection time.

Average Reply Size The average size of a user reply.

Average Request Size The average size of a user request.

Average Requests Per
Session

The average number of user requests per session.

Average Response Time The average amount of time that it takes the server to respond to a
request.

Average Think Time The average amount of think time taken to respond to a request.

Avg SQL Execute Time The average SQL execute time.

Avg SQL Fetch Time The average SQL fetch time.

Avg SQL Parse Time The average SQL parse time.

CPU Time The CPU time used in the work process.

Elapsed Time The total amount of elapsed time.

Num of DBConn Retries The number of database connection retries.

Num of DLRbk Retries The number of DLRbk retries.

Num of Exhausted Retries The total number of retries that expired.

Number of SQL Executes The total number of SQL executes.

Number of SQL Fetches The total number of SQL fetches.

User and Administrator Guide
Chapter 32: ERP/CRM Server ResourceMonitoring

HP ALM Performance Center (12.20) Page 437 of 521



Number of SQL Parses The total number of SQL parses.

Number of Sleeps The number of sleeps.

Object Manager Errors The total number of object manager errors.

Reply Messages The total number of reply messages.

Request Messages The total number of request messages.

SQL Execute Time The total SQL execute time.

SQL Fetch Time The total SQL fetch time.

SQL Parse Time The total SQL parse time.

Sleep Time The total sleep time.

Tests Attempted The number of tests attempted.

Tests Failed The number of tests that failed.

Tests Successful The number of tests that were successful.

Total Reply Size The total reply size, measured in bytes.

Total Request Size The total request size, measured in bytes.

Total Response Time The total response time.

Total Tasks The total number of tasks.

Total Think Time The total think time.

Siebel Server Manager Monitor - Troubleshooting and
Limitations
This section describes troubleshooting for the Siebel Server Manager Monitor

The Siebel Server Manager monitor uses a Siebel command line utility (srvrmgr) to gather it's statistics.
If you are having trouble getting the Siebel Server Manager monitor to work, run this command from the
Siebel Server Manager client:

srvrmgr /s <server> /g <gateway> /e <enterprise> /u <user> /p <pw>

If this commandworks from the command line, but SiteScope has trouble executing the command,
open /sitescope/templates.applications/commandline.siebel, and verify that you can run the
following command from the command line:

CONNECT_COMMAND:$PATH$/srvrmgr /g $GATEWAY$ /e $ENTERPRISE$ /s $SERVERS$ /u
$USERNAME$ /p $PASSWORD$
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Note: On aWindows 2000 Advanced Server platform this commandmust be changed to:

CONNECT_COMMAND:$PATH$\srvrmgr.exe /g $GATEWAY$ /e $ENTERPRISE$ /s $SERVERS$ /u
$USERNAME$ /p $PASSWORD$

How to Set Up the PeopleSoft (Tuxedo) Resource Monitor
This task describes the working order for setting up themonitoring environment. If Tuxedo 7.1 or later is
installed, you canmonitor more than one PeopleSoft (Tuxedo) application server at a time. If Tuxedo
6.5 or earlier is installed, you canmonitor only one PeopleSoft (Tuxedo) application server at a time.

This task includes the following steps:

l "Prerequisites" below

l "Define the environment variables on the Controller machine" below

l "Check theWorkstation Listener (WSL) Process" on the next page

l "Configure the PeopleSoft (Tuxedo) monitor on the Controller" on the next page

1. Prerequisites
Ensure that a Tuxedo workstation client (not a native client), version 6.3 or later, is installed on the
Controller machine.

Use a Tuxedo 6.x client if a Tuxedo 6.x server is used, and Tuxedo 7.1 or later client if a Tuxedo
7.1 or later server is used.

If you use a Tuxedo 6.5 or earlier server, you can still use a Tuxedo 7.1 or later client in order to
monitor it, provided that you set theWSINTOPPRE71 environment variable to yes.

Note: A Tuxedo workstation client communicates with the application server over the
network, and is not required to run the Tuxedo application server on the samemachine. A
native client can only communicate with the Tuxedo application server if it is part of the
relevant Tuxedo domain.

2. Define the environment variables on the Controllermachine
a. Set the TUXDIR variable to the Tuxedo installation directory (for example,

V:\environ\32\Tuxedo 8.0).

b. Add the Tuxedo bin directory to thePATH variable.
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3. Check the Workstation Listener (WSL) Process
Ensure that the workstation listener (WSL) process is running. This enables the application server
to accept requests from workstation clients.

The address and port number used to connect to the application server must match those
dedicated to theWSL process.

Note: For information on configuring theWSL, refer to the BEA TuxedoWeb site.

4. Configure the PeopleSoft (Tuxedo)monitor on the Controller
For task details, see "How to Create and ConfigureMonitor Profiles" on page 65.

How to Set Up the SAPGUI Server Resource Monitor
This task describes the working order for setting up themonitoring environment.

Note: The SAPGUI monitor supports SAP server versions 3.1 to 4.6, regardless of the SAP R/3
server's operating system and the platform on which it is installed.

This task includes the following steps:

l "Prerequisites" below

l "Enable the last minute load from the client" below

l "Configure the SAPGUI Server Resourcemonitor on the Controller" on the next page

1. Prerequisites

Note: Once the SAPGUI monitor is activated on the Controller machine, you cannot record a
SAPGUI protocol script on that machine.

n Install the SAPGUI forWindows 6.20 client on the Controller machine.

n Install the latest patch for the SAPGUI forWindows 6.20 client. The lowest supported level is
patch 36. (SAPGUI patches can be downloaded from https://websmp104.sap-ag.de/patches.
You will need a valid ServiceMarketplace username and password to access this site.)

2. Enable the lastminute load from the client
From the SAPGUI client application, click F6 to determine whether you can access the st03
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transaction and query for last minute load information.

If this functionality is not already enabled, enable it from the SAP R/3 client on the Controller
machine, using the username and password defined in the Controller.

3. Configure the SAPGUI Server Resource monitor on the Controller
For task details, see "How to Create and ConfigureMonitor Profiles" on page 65.

PeopleSoft (Tuxedo) Performance Counters
The following table describes the default counters that can bemeasured. It is recommended to pay
particular attention to the followingmeasurements: % Busy Clients, Active Clients, Busy Clients, Idle
Clients, and all the queue counters for the APPQ/PSAPPSRV queue.

Monitor Measurements

Machine % Busy Clients - The percent of active clients currently logged in to the Tuxedo
application server that are waiting for a response from the application server.

Active Clients - The total number of active clients currently logged in to the Tuxedo
application server.

Busy Clients - The total number of active clients currently logged in to the Tuxedo
application server that are waiting for a response from the application server.

Current Accessers - The number of clients and servers currently accessing the
application either directly on this machine or through a workstation handler on this
machine.

Current Transactions - The number of in use transaction table entries on this
machine.

Idle Clients - The total number of active clients currently logged in to the Tuxedo
application server that are not waiting for a response from the application server.

Workload Completed/second - The total workload on all the servers for the
machine that was completed, per unit time.

Workload Initiated/second - The total workload on all the servers for themachine
that was initiated, per unit time.

Queue % Busy Servers - The percent of active servers currently handling Tuxedo requests.

Active Servers - The total number of active servers either handling or waiting to
handle Tuxedo requests.

Busy Servers - The total number of active servers currently busy handling Tuxedo
requests.
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Monitor Measurements

Idle Servers - The total number of active servers currently waiting to handle Tuxedo
requests.

Number Queued - The total number of messages which have been placed on the
queue.

Server Requests/second - The number of server requests handled per second.

Workload/second - The workload is a weightedmeasure of the server requests.
Some requests could have a different weight than others. By default, the workload is
always 50 times the number of requests.

Workstation
Handler
(WSH)

Bytes Received/sec - The total number of bytes received by the workstation
handler, per second.

Bytes Sent/sec - The total number of bytes sent back to the clients by the
workstation handler, per second.

Messages Received/sec - The number of messages received by the workstation
handler, per second.

Messages Sent/sec - The number of messages sent back to the clients by the
workstation handler, per second.

Number of Queue Blocks/sec - The number of times the queue for the workstation
handler blocked, per second. This gives an idea of how often the workstation handler
was overloaded.

SAPGUI Performance Counters
The following table lists themost commonly monitored counters:

Measurement Description

Average
CPU time

The average CPU time used in the work process.

Average
response
time

The average response time, measured from the time a dialog sends a request to the
dispatcher work process, through the processing of the dialog, until the dialog is
completed and the data is passed to the presentation layer. The response time
between the SAPGUI and the dispatcher is not included in this value.
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Measurement Description

Average wait
time

The average amount of time that an unprocessed dialog step waits in the dispatcher
queue for a free work process. Under normal conditions, the dispatcher work
process should pass a dialog step to the application process immediately after
receiving the request from the dialog step. Under these conditions, the average wait
time would be a few milliseconds. A heavy load on the application server or on the
entire system causes queues at the dispatcher queue.

Average load
time

The time needed to load and generate objects, such as ABAP source code and
screen information, from the database.

Database
calls

The number of parsed requests sent to the database.

Database
requests

The number of logical ABAP requests for data in the database. These requests are
passed through the R/3 database interface and parsed into individual database
calls. The proportion of database calls to database requests is important. If access
to information in a table is buffered in the SAP buffers, database calls to the
database server are not required. Therefore, the ratio of calls/requests gives an
overall indication of the efficiency of table buffering. A good ratio would be 1:10.

Roll ins The number of rolled-in user contexts.

Roll outs The number of rolled-out user contexts.

Roll in time The processing time for roll ins.

Roll out time The processing time for roll outs.

Roll wait
time

The queue time in the roll area. When synchronous RFCs are called, the work
process executes a roll out andmay have to wait for the end of the RFC in the roll
area, even if the dialog step is not yet completed. In the roll area, RFC server
programs can also wait for other RFCs sent to them.

Average time
per logical
DB call

The average response time for all commands sent to the database system (in
milliseconds). The time depends on the CPU capacity of the database server, the
network, the buffering, and on the input/output capabilities of the database server.
Access times for buffered tables aremany magnitudes faster and are not
considered in themeasurement.
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Application Deployment Solution Monitoring Overview
Using ALM Performance Center's Application Deployment Solutionmonitor, you can isolate server
performance bottlenecks by monitoring the Citrix server during a performance test run.

ALM Performance Center's Citrix monitor provides you with information about the application
deployment usage of the Citrix server during performance test execution. The Citrix monitor allows you
tomonitor the server performance statistics from Citrix servers. You canmonitor multiple parameters
(counters) with a single monitor instance. This allows you to watch server loading for performance,
availability, and capacity planning.

To obtain performance data, you need to activate the onlinemonitor for the server and specify which
resources you want to measure before executing the performance test.

For information about how to set up the Citrix monitoring environment, see "How to Set up the Citrix
Monitoring Environment" below.

How to Set up the Citrix Monitoring Environment
This task describes the working order for setting up themonitoring environment.

To learnmore about application deployment solutionmonitoring, see "Application Deployment Solution
Monitoring Overview" above.

1. Prerequisites
n Make sure that Citrix Server has been installed and is running.

n If Citrix Server machine is runningWindows 2000, make sure that the server machine is also
running the Remote Registry service.

n Measurements that monitor instances are valid for the currently running Citrix session only. If
you run this test again, you will need to reconfigure themeasurements that are instance-
oriented.

Tomonitor the different instances, ensure that the server login and logout procedures are
recorded in theVuser_init andVuser_end sections respectively, and not in the Action section
of the script. For more information, see theHP Virtual User Generator User Guide.

2. Map the Network Drive
From the Controller machine, map a network drive to the Citrix server machine. This ensures that
the required authentication is provided to the Controller to access the resource counters.

3. Launch PerfMon
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Launch PerfMon from the Controller machine to enable the counters on the Citrix server. This
allows you tomonitor the same counters for the ICA Session object on the Citrix monitor.

4. Open the Connection with the Citrix Server
You can configure the Citrix monitor to view ICA Session object counters only if at least one
session is being run on the Citrix server. If no "real" user has opened a connection with the Citrix
server, you need to first initialize or run a Citrix Vuser against the server, and only then configure
the Citrix Monitor and add the ICA Session counters. If you configure the Citrix monitor without
first initializing or running a Citrix Vuser (or connecting to the Citrix server as a "real" user), you will
not be able to view the ICA Session object.

5. Configure the Citrix Monitor on the Controller
For task details, see "How to Create and ConfigureMonitor Profiles" on page 65.

Citrix MetaFrame Performance Counters
The following sections describe some of the counters that can bemeasured.

l "Non-Virtual Counters" below

l "Virtual Channel Counters" on page 448

Non-Virtual Counters
The following table describes non-virtual counters:

Measurement Description

% Disk Time The percentage of elapsed time that the selected disk drive services read or write
requests.

% Processor
Time

The percentage of time that the processor executes a non-Idle thread. This
counter is a primary indicator of processor activity. It is calculated by measuring
the time that the processor spends executing the thread of the Idle process in
each sample interval, and subtracting that value from 100%. (Each processor has
an Idle thread which consumes cycles when no other threads are ready to run.) It
can be viewed as the percentage of the sample interval spent doing useful work.
This counter displays the average percentage of busy time observed during the
sample interval. It is calculated by monitoring the time the service was inactive,
and then subtracting that value from 100%.

File data
Operations/sec

The rate that the computer issues Read andWrite operations to file system
devices. This does not include File Control Operations.
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Measurement Description

Interrupts/sec The average number of hardware interrupts the processor receives and services
per second. It does not include DPCs, which are counted separately. This value is
an indirect indicator of the activity of devices that generate interrupts, such as the
system clock, themouse, disk drivers, data communication lines, network
interface cards and other peripheral devices. These devices normally interrupt the
processor when they have completed a task or require attention. Normal thread
execution is suspended during interrupts. Most system clocks interrupt the
processor every 10milliseconds, creating a background of interrupt activity. This
counter displays the difference between the values observed in the last two
samples, divided by the duration of the sample interval.

Output
Session Line
Speed

This value represents the line speed from server to client for a session in bps.

Input Session
Line Speed

This value represents the line speed from client to server for a session in bps.

Page
Faults/sec

A count of the Page Faults in the processor. A page fault occurs when a process
refers to a virtual memory page that is not in its Working Set in mainmemory. A
Page Fault will not cause the page to be fetched from disk if that page is on the
standby list, and hence already inmainmemory, or if it is in use by another
process with whom the page is shared.

Pages/sec The number of pages read from the disk or written to the disk to resolvememory
references to pages that were not in memory at the time of the reference. This is
the sum of Pages Input/sec and Pages Output/sec. This counter includes paging
traffic on behalf of the system Cache to access file data for applications. This
value also includes the pages to/from non-cachedmappedmemory files. This is
the primary counter to observe if you are concerned about excessivememory
pressure (that is, thrashing), and the excessive paging that may result.

Pool
Nonpaged
Bytes

The number of bytes in the Nonpaged Pool, a systemmemory area where space
is acquired by operating system components as they accomplish their appointed
tasks. Nonpaged Pool pages cannot be paged out to the paging file, but instead
remain in mainmemory as long as they are allocated.

Private Bytes The current number of bytes this process has allocated that cannot be shared with
other processes.

Processor
Queue Length

The instantaneous length of the processor queue in units of threads. This counter
is always 0 unless you are alsomonitoring a thread counter. All processors use a
single queue in which threads wait for processor cycles. This length does not
include the threads that are currently executing. A sustained processor queue
length greater than two generally indicates processor congestion. This is an
instantaneous count, not an average over the time interval.
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Measurement Description

Threads The number of threads in the computer at the time of data collection. Notice that
this is an instantaneous count, not an average over the time interval. A thread is
the basic executable entity that can execute instructions in a processor.

Latency –
Session
Average

This value represents the average client latency over the life of a session.

Latency – Last
Recorded

This value represents the last recorded latency measurement for this session.

Latency –
Session
Deviation

This value represents the difference between theminimum andmaximum
measured values for a session.

Input Session
Bandwidth

This value represents the bandwidth from client to server traffic for a session in
bps.

Input Session
Compression

This value represents the compression ratio for client to server traffic for a
session.

Output
Session
Bandwidth

This value represents the bandwidth from server to client traffic for a session in
bps.

Output
Session
Compression

This value represents the compression ratio for server to client traffic for a
session.

Output
Session
Linespeed

This value represents the line speed from server to client for a session in bps.

Virtual Channel Counters
The following table describes virtual channel counters:

Measurement Description

Input Audio
Bandwidth

This value represents the bandwidth from client to server traffic on the audio
mapping channel. This is measured in bps.

Input Clipboard
Bandwidth

This value represents the bandwidth from client to server traffic on the
clipboardmapping channel. This is measured in bps.

Input COM1
Bandwidth

This value represents the bandwidth from client to server traffic on the COM1
channel. This is measured in bps.
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Measurement Description

Input COM2
Bandwidth

This value represents the bandwidth from client to server traffic on the COM2
channel. This is measured in bps.

Input COM
Bandwidth

This value represents the bandwidth from client to server traffic on the COM
channel. This is measured in bps.

Input Control
Channel
Bandwidth

This value represents the bandwidth from client to server traffic on the ICA
control channel. This is measured in bps.

Input Drive
Bandwidth

This value represents the bandwidth from client to server traffic on the client
drivemapping channel. This is measured in bps.

Input Font Data
Bandwidth

This value represents the bandwidth from client to server traffic on the local
text echo font and keyboard layout channel. This is measured in bps.

Input Licensing
Bandwidth

This value represents the bandwidth from server to client traffic on the
licensing channel. This is measured in bps.

Input LPT1
Bandwidth

This value represents the bandwidth from client to server traffic on the LPT1
channel. This is measured in bps.

Input LPT2
Bandwidth

This value represents the bandwidth from client to server traffic on the LPT2
channel. This is measured in bps.

Input Management
Bandwidth

This value represents the bandwidth from client to server traffic on the client
management channel. This is measured in bps.

Input PN
Bandwidth

This value represents the bandwidth from client to server traffic on the
Program Neighborhood channel. This is measured in bps.

Input Printer
Bandwidth

This value represents the bandwidth from client to server traffic on the printer
spooler channel. This is measured in bps.

Input Seamless
Bandwidth

This value represents the bandwidth from client to server traffic on the
Seamless channel. This is measured in bps.

Input Text Echo
Bandwidth

This value represents the bandwidth from client to server traffic on the local
text echo data channel. This is measured in bps.

Input Thinwire
Bandwidth

This value represents the bandwidth from client to server traffic on the
Thinwire (graphics) channel. This is measured in bps.

Input VideoFrame
Bandwidth

This value represents the bandwidth from client to server traffic on the
VideoFrame channel. This is measured in bps.

Output Audio
Bandwidth

This value represents the bandwidth from server to client traffic on the audio
mapping channel. This is measured in bps.
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Measurement Description

Output Clipboard
Bandwidth

This value represents the bandwidth from server to client traffic on the
clipboardmapping channel. This is measured in bps.

Output COM1
Bandwidth

This value represents the bandwidth from server to client traffic on the COM1
channel. This is measured in bps.

Output COM2
Bandwidth

This value represents the bandwidth from server to client traffic on the COM2
channel. This is measured in bps.

Output COM
Bandwidth

This value represents the bandwidth from server to client traffic on the COM
channel. This is measured in bps.

Output Control
Channel
Bandwidth

This value represents the bandwidth from server to client traffic on the ICA
control channel. This is measured in bps.

Output Drive
Bandwidth

This value represents the bandwidth from server to client traffic on the client
drive channel. This is measured in bps.

Output Font Data
Bandwidth

This value represents the bandwidth from server to client traffic on the local
text echo font and keyboard layout channel. This is measured in bps.

Output Licensing
Bandwidth

This value represents the bandwidth from server to client traffic on the
licensing channel. This is measured in bps.

Output LPT1
Bandwidth

This value represents the bandwidth from server to client traffic on the LPT1
channel. This is measured in bps.

Output LPT2
Bandwidth

This value represents the bandwidth from server to client traffic on the LPT2
channel. This is measured in bps.

Output
Management
Bandwidth

This value represents the bandwidth from server to client traffic on the client
management channel. This is measured in bps.

Output PN
Bandwidth

This value represents the bandwidth from server to client traffic on the
Program Neighborhood channel. This is measured in bps.

Output Printer
Bandwidth

This value represents the bandwidth from server to client traffic on the printer
spooler channel. This is measured in bps.

Output Seamless
Bandwidth

This value represents the bandwidth from server to client traffic on the
Seamless channel. This is measured in bps.

Output Text Echo
Bandwidth

This value represents the bandwidth from server to client traffic on the local
text echo data channel. This is measured in bps.

Output Thinwire
Bandwidth

This value represents the bandwidth from server to client traffic on the
Thinwire (graphics) channel. This is measured in bps.
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Measurement Description

Output
VideoFrame
Bandwidth

This value represents the bandwidth from server to client traffic on the
VideoFrame channel. This is measured in bps.
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Middleware Performance Monitoring Overview
A primary factor in a transaction's response time is theMiddleware performance usage. ALM
Performance Center's Middleware Performancemonitors provide you with information about the
Middleware performance usage of the IBMWebSphereMQ server during performance test execution.
To obtain performance data, you need to activate the onlinemonitor for the server and specify which
resources you want to measure before executing the the performance test.

The IBMWebSphereMQmonitor is used tomonitor channel and queue performance counters on an
IBMWebSphereMQ (version 5.x) Server.

How to Set Up the IBM WebSphere MQ Monitor
This task describes how to configure the Controller and IBMWebSphereMQmachines:

1. Prerequisites
Ensure that an IBMWebSphereMQClient Connection (version 5.21 only) is installed on the
Controller machine.

2. Configure the server environment tomonitor events
The LoadRunner MQMonitor retrieves event messages from two standardMQSeries queues
only:

n SYSTEM.ADMIN.PERFM.EVENT – performance events, such as "queue depth high"

n SYSTEM.ADMIN.CHANNEL.EVENT – channel events, such as "channel stopped"

Events must be enabled for the queuemanager (and inmany cases, on the applicable object, as
well). Performance events are enabled by setting attributes for the queue on theMQServer.
Channel events are enabled by default, and cannot be disabled.

Note: The IBMWebSphereMQmonitor does not retrieve data from a queuemanager after
the queuemanager has been restarted.

a. Run the followingMQSC command:
ALTER QMGR PERFMEV(ENABLED).

b. Set the queue attributes. For a list of queue attributes, "IBMWebSphereMQQueue
Attributes" on page 456.
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3. Add the monitored server to the Controller
a. In the Controller Run view, click the IBMWebSphereMQ graph in the graph tree, and drag it

into the right pane.

b. Right-click the graph and select Add Measurements, or click anywhere on the graph and
selectMonitors > Add Measurements. The IBMWebSphereMQ dialog box opens.

In theMonitored Server Machines section, click Add. The AddMachine dialog box opens.

c. The first time that you addmeasurements, enter the server name or IP address of themachine
you want to monitor. The format of the server name is <machine name>:<port number>.
Select the platform on which themachine runs, and click OK.

d. In theResource Measurements section of the IBMWebSphereMQ dialog box, click Add.

4. Configure the IBMWebSphere MQmonitor
The IBMWebSphereMQmonitor connects to the IBMWebSphereMQ server (via theMQClient
Connection installed on the Controller machine). In MQClient environments, the client machine
connects to anMQServer instance, and uses the Server's resources as if they were local to the
client machine.

n Specify the connection information andmeasurements in theMQMonitor AddMeasurements
dialog.

IBM WebSphere MQ Performance Counters
The following tables list the available IBMWebSphereMQmonitor measurements:

Queue Performance Counters
The following table describes the Queue Performance counters:

Measurement Description

Event - Queue Depth High
(events per second)

An event triggered when the queue depth reaches the configured
maximum depth.

Event - Queue Depth Low
(events per second)

An event triggered when the queue depth reaches the configured
minimum depth.

Event - Queue Full (events
per second)

An event triggered when an attempt is made to put amessage on a
queue that is full.
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Event - Queue Service
Interval High (events per
second)

An event triggered when nomessages are put to or retrieved from
a queue within the timeout threshold.

Event - Queue Service
Interval OK (events per
second)

An event triggered when amessage has been put to or retrieved
from a queue within the timeout threshold.

Status - Current Depth Current count of messages on a local queue. This measurement
applies only to local queues of themonitored queuemanager.

Status - Open Input Count Current count of open input handles. Input handles are opened so
that an applicationmay "put" messages to a queue.

Status - Open Output Count Current count of open output handles. Output handles are opened
so that an applicationmay "get" messages from a queue.

Channel Performance Counters
The following table describes the Channel Performance counters:

Measurement Description

Event - Channel
Activated
(events per
second)

Event generated when a channel, waiting to become active but inhibited from
doing so due to a shortage of queuemanager channel slots, becomes active due
to the sudden availability of a channel slot.

Event - Channel
Not Activated
(events per
second)

Event generated when a channel, attempts to become active but inhibited from
doing so due to a shortage of queuemanager channel slots.

Event - Channel
Started (events
per second)

Event generated when a channel is started.

Event - Channel
Stopped (events
per second)

Event generated when a channel is stopped, regardless of source of stoppage.

Event - Channel
Stopped by
User (events per
second)

Event generated when a channel is stopped by a user.

Status -
Channel State

The current state of a channel. Channels pass through several states from
stopped (inactive state) to running (fully active state). Channel states range from
0 (stopped) to 6 (running).
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Status -
Messages
Transferred

The count of messages that have been sent over the channel. If no traffic is
occurring over the channel, this measurement will be zero. If the channel has not
been started since the queuemanager was started, nomeasurement will be
available.

Status - Buffer
Received

The count of buffers that have been received over the channel. If no traffic is
occurring over the channel, this measurement will be zero. If the channel has not
been started since the queuemanager was started, nomeasurement will be
available.

Status - Buffer
Sent

The count of buffers that have been sent over the channel. If no traffic is
occurring over the channel, this measurement will be zero. If the channel has not
been started since the queuemanager was started, nomeasurement will be
available.

Status - Bytes
Received

The count of bytes that have been received over the channel. If no traffic is
occurring over the channel, this measurement will appear as zero. If the channel
has not been started since the queuemanager was started, nomeasurement will
be available.

Status - Bytes
Sent

The count of bytes that have been sent over the channel. If no traffic is occurring
over the channel, this measurement will appear as zero. If the channel has not
been started since the queuemanager was started, nomeasurement will be
available.

IBM WebSphere MQ Queue Attributes
You set the following queue attributes using theMQSC command ALTER QMGR PERFMEV(ENABLED):

Measurement Set Event Attributes

Event - Queue
Depth High

l QDEPTHHI(integer) - where integer is a value expressed as a percentage of
maximummessages allowed, and is in the range of 0 to 100 inclusive.

l QDPHIEV(action) - where action is the word "ENABLED" or "DISABLED",
enabling or disabling the generation of the event, respectively.

Event - Queue
Depth Low

To enable the event for a queue, the following attributes of the queuemust be set:

l QDEPTHLO(integer) - where integer is a value expressed as a percentage of
maximummessages allowed, and is in the range of 0 to 100 inclusive.

l QDPLOEV(action) - where action is the word "ENABLED" or "DISABLED",
enabling or disabling the generation of the event, respectively.
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Event - Queue
Full

l QDEPTHHI(integer) – where integer is a value expressed as a percentage of
maximummessages allowed, and is in the range of 0 to 100 inclusive.

l QDPMAXEV(action) – where action is the word "ENABLED" or "DISABLED",
enabling or disabling the generation of the event, respectively.

Event - Queue
Service
Interval High

l QSVCINT(integer) – where integer is a value expressed as milliseconds, in the
range of 0 and 999,,999, inclusive. Note: this value is shared with Queue
Service Interval OK.

l QSVCIEV(type) – where type is the word "HIGH", "OK", or "NONE", enabling
service interval high events, enabling service interval ok events, or disabling
the generation of the event, respectively.

Event - Queue
Service
Interval OK

l QSVCINT(integer) – where integer is a value expressed as milliseconds, in the
range of 0 and 999,999,999, inclusive. Note: this value is shared with Queue
Service Interval High.

l QSVCIEV(type) – where type is the word "HIGH", "OK", or "NONE", enabling
service interval high events, enabling service interval ok events, or disabling
the generation of the event, respectively.

How to Set Up the Tuxedo Monitoring Environment
This task describes the working order for setting up themonitoring environment.

Note: If Tuxedo 7.1 or higher is installed on the Controller machine, more than one Tuxedo
application server can bemonitored at a time. However, if Tuxedo 6.5 or below is installed on the
Controller machine, only one Tuxedo application server can bemonitored at a time.

1. Prerequisites
Ensure that a Tuxedo workstation client (not a native client) is installed on the Controller machine.
Use a Tuxedo 6.x client if a Tuxedo 6.x server is used, and Tuxedo 7.1 or above client if a Tuxedo
7.1 or above server is used.

If you use a Tuxedo 6.5 or earlier server, you can still use a Tuxedo 7.1 or later client to monitor it,
provided that you set theWSINTOPPRE71 environment variable to "yes".

Note: A Tuxedo workstation client communicates with the application server over the
network, and is not required to run the Tuxedo application server on the samemachine. A
native client can only communicate with the Tuxedo application server if it is part of the
relevant Tuxedo domain.

User and Administrator Guide
Chapter 34: Middleware PerformanceMonitoring 

HP ALM Performance Center (12.20) Page 457 of 521



2. Define the Tuxedo Environment Variables
Define the Tuxedo environment variables on the Controller machine—set the TUXDIR variable to
the Tuxedo installation directory (for example, V:\environ\32\Tuxedo8.0), and add the Tuxedo
bin directory to the PATH variable.

3. Check the Workstation Listener (WSL) Process
Ensure that the workstation listener (WSL) process is running. This enables the application server
to accept requests from workstation clients.

The address and port number used to connect to the application server must match those
dedicated to theWSL process.

Note: For information on configuring theWSL, refer to the BEA TuxedoWeb site.

4. Configure the Tuxedomonitor on the Controller
For task details, see "How to Create and ConfigureMonitor Profiles" on page 65.

Tuxedo Performance Counters
The following table lists the available Tuxedomonitor measurements. It is recommended to pay
particular attention to the followingmeasurements: % Busy Clients, Active Clients, Busy Clients, Idle
Clients, and all the queue counters for relevant queues.

Monitor Measurements

Machine % Busy Clients - The percent of active clients currently logged in to the Tuxedo
application server that are waiting for a response from the application server.

Machine Active Clients - The total number of active clients currently logged in to the Tuxedo
application server.

Machine Busy Clients - The total number of active clients currently logged in to the Tuxedo
application server that are waiting for a response from the application server.

Machine Current Accessers - The number of clients and servers currently accessing the
application either directly on this machine or through a workstation handler on this
machine.

Machine Current Transactions - The number of in-use transaction table entries on this
machine.

Machine Idle Clients - The total number of active clients currently logged in to the Tuxedo
application server that are not waiting for a response from the application server.
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Monitor Measurements

Machine Workload Completed/second - The total workload on all the servers for the
machine that was completed, per unit time.

Machine Workload Initiated/second - The total workload on all the servers for themachine
that was initiated, per unit time.

Queue % Busy Servers - The percent of active servers currently handling Tuxedo requests.

Queue Active Servers - The total number of active servers either handling or waiting to
handle Tuxedo requests.

Queue Busy Servers - The total number of active servers currently busy handling Tuxedo
requests.

Queue Idle Servers - The total number of active servers currently waiting to handle Tuxedo
requests.

Queue Number Queued - The total number of messages which have been placed on the
queue.

Server Requests/second - The number of server requests handled per second

Server Workload/second - Workload is a weightedmeasure of the server requests. Some
requests could have a different weight than others. By default, the workload is
always 50 times the number of requests.

Workstation
Handler
(WSH)

Bytes Received/sec - The total number of bytes received by the workstation
handler, per second.

Workstation
Handler
(WSH)

Bytes Sent/sec - The total number of bytes sent back to the clients by the
workstation handler, per second.

Workstation
Handler
(WSH)

Messages Received/sec - The number of messages received by the workstation
handler, per second.

Workstation
Handler
(WSH)

Messages Sent/sec - The number of messages sent back to the clients by the
workstation handler, per second.

Workstation
Handler
(WSH)

Number of Queue Blocks/sec - The number of times the queue for the workstation
handler blocked, per second. This gives an idea of how often the workstation handler
was overloaded.
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Tuxedo tpinit.ini File
The tpinit.ini file is saved in the recorded script's directory. It contains information for connecting the
Tuxedomonitor to the server. The client logon information is located in the Logon section of the
tpinit.ini file.

In the following example of a tpinit.ini file, the Tuxedomonitor was configured for a server named psft1
using port 7000, and a client named bankapp. The logon user namewas PS and the password was PS.

[Logon]
LogonServername=//psft1:7000
LogonUsrName=PS
LogonCltName=bankapp
LogonGrpName=
LogonPasswd=PS
LogonData=
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Infrastructure Resources Monitoring Overview
You canmonitor network client resources for FTP, POP3, SMTP, IMAP, and DNS Vusers during a
performance test run and isolate client performance bottlenecks.

Activating the Network Client Monitor

The Network Client onlinemonitor graph is only available during performance tests that run relevant
scripts, such as FTP, POP3, and so forth.

You can view this graph by dragging it from the Infrastructure Resources Graph section in the graph
tree into the right pane of the Run view. The graph appears in the graph view area.

Network Client Performance Counters
The following table describes the Network Client measurements that aremonitored:

Measurement Description

Pings per sec Number of pings per second

Data transfer bytes per sec Number of data bytes transferred per second

Data receive bytes per sec Number of data bytes received per second

Connections per sec Number of connections per second

Accept connections per sec Number of connections accepted per seconds

SSL Connections per sec Number of SSL connections per second

SSL Data transfer bytes per sec Number of SSL data bytes transferred per second

SSL Data receive bytes per sec Number of SSL data bytes received per second

SSL Accept connections per sec Number of SSL connections accepted per seconds
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Script Runtime Settings Overview
Before you run a performance test, you can configure the behavior of the Vuser scripts in the test using
runtime settings. You can configure general settings and protocol-specific settings.

General Settings

After you record a Vuser script, you can configure its runtime settings. The runtime settings define the
way the script runs, such as delay between actions, the number of times to repeat an action, and the
level of logging.

Configuring runtime settings allows you to emulate different kinds of user activity. For example, you
can emulate a user who responds immediately to the server, or a user who stops and thinks before
each response. You can also configure the runtime settings to specify how many times the Vuser
should repeat a set of actions.

Protocol-Specific Settings

Before replaying a Vuser script, you can configure its runtime settings. The runtime settings define the
way the script runs, using settings that are specific for your particular environment.

Different combinations of runtime settings are available for each protocol. When you open the runtime
settings, only the relevant nodes will be displayed.

For protocol-specific tips, see "Protocol Specific Runtime Settings" on the next page.

For task details, see "How to Configure Runtime Settings" below.

How to Configure Runtime Settings
This task describes how to open and configure runtime settings to define the way a script runs.

To configure the runtime settings in a Vuser script:

1. On theMy Performance Center navigation bar, select Test Management > Test Plan. Select a
performance test in the test plan tree and click Edit Test.

2. In theGroups & Workload view, select a Vuser group and click Edit Runtime Settings .
The Edit Runtime Settings dialog box opens.

3. Select the runtime settings type to edit and define the required information.
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n Different combinations of runtime settings are available for each protocol. When you open the
runtime settings, only the relevant nodes will be displayed.

n If you do not edit the runtime settings, the script runs using the default runtime settings, or the
last saved runtime settings if the script was recorded in VuGen.

n For information about each of the runtime settings, see themouseover hints by each field in the
Description pane of the Runtime Settings window.

See Also:

n For an overview on the runtime settings, see "Script Runtime Settings Overview" on the
previous page.

n For protocol-specific tips, see "Protocol Specific Runtime Settings" below.

n For Internet protocol preferences, see "Runtime Settings > Internet Protocol > Preferences" on
page 470.

n For Internet protocol content check, see "Runtime Settings > Internet Protocol > Content
Check " on page 482.

n For theMultithreading runtime option, see "Runtime Settings > General > Miscellaneous >
Multithreading" on page 482

Protocol Specific Runtime Settings
The following sections provide tips for configuring the Runtime Settings for specific protocols.

For information about each of the Runtime settings, see themouseover hints by each field.
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All Protocols

In theGeneral > Miscellaneous node, follow these guidelines:

l It is not recommended to enable both theContinue on Error andGenerate Snapshot on Error
options in a load test environment. This configurationmay adversely affect the Vusers'
performance.

l If you require the Vusers to generate breakdown data for diagnostics (J2EE) during the test run, do
not use automatic transactions. Instead, manually define the beginning and end of each transaction.

l Automatic transactions are not relevant for HP Business ServiceManagement.

MMS (MultimediaMessaging Service)

For theMMS (MultimediaMessaging Service) protocol, it is recommended that you run Vusers as a
process.

To configure this options, open the Runtime settings and select theGeneral > Miscellaneous node.

RDP (Remote Desktop Protocol)

l In theAdvanced node, disable the options that are not essential for your test, in order to conserve
system resources on the remote desktop server.

l In theRDP Agent node, for theRDP agent log folder option—if no folder is specified and the
agent log destination was set to File, the log is saved in the temp folder of the user on the server.

RTE (Remote Terminal Emulation)

In theRTE node, in theDelay before typing option, the delay settings determine how Vusers execute
TE_type functions.

l First key. Specifies the time inmilliseconds, that a Vuser waits before entering the first character of
a string.

l Subsequent keys. Specifies the time inmilliseconds, that a Vuser waits between submitting
successive characters.

Note:You can use the TE_typing_style function to override the Delay settings for a portion of a
Vuser script.

SAP GUI

In the SAPGUI General node, theShow SAP Client during replay option shows an animation of the
actions in the SAP client during replay. The benefit of this, is that you can closely follow the actions of
the Vuser and see how the forms are filled out. This option, however, requires additional resources and
may affect the performance of your load test.

Take ActiveScreen snapshots during replay. This feature captures replay snapshots with Control
ID information for all active objects. ActiveScreen snapshots differ from regular ones, in that they allow
you to see which objects were recognized by VuGen in the SAP GUI client. As youmove your mouse
across the snapshot, VuGen highlights the detected objects. You can then add new steps to the script
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directly from within the snapshot. It also allows you to add steps interactively from within the snapshot
for a specific object. For more information, see theHP Virtual User Generator User Guide.

TruClient - IE / TruClient - Firefox

Settings that youmodify In the Load > Browser node, only affect TruClient Vusers in loadmode.

These settings correspond to those in theBrowser Settings tab in the TruClient General Settings
Dialog Box. However, the settings that youmodify in the TruClient General Settings Dialog Box only
affect interactivemode.

When you save your script in interactivemode, the settings that youmodified in theBrowser Settings
tab are applied to these LoadRuntime settings.

Runtime Settings > Internet Protocol > Preferences
You use the Internet Protocol Preferences runtime settings to control the Vusers in the following
areas:

l Image and Text Checks

l GeneratingWeb PerformanceGraphs

l AdvancedWebRuntimeOptions

l Additional Options for Internet Preferences

This node is only available for specific protocols. When you open the Runtime Settings, only the
relevant nodes will be displayed.

The user interface elements are described below:

UI Element Description

Checks l Enable image and text checks. Allows the Vuser to perform verification
checks during replay by executing the verification functions web_find orweb_
image_check. This option only applies to statements recorded in HTML-based
mode. Vusers running with verification checks usemorememory than Vusers
who do not perform checks.

Default value: disabled.
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UI Element Description

Web
Performance
Graph
Generation

Instructs a Vuser to collect data forWeb Performance graphs. You view theHits
per Second, Pages per Second, andResponse Bytes per Second (Throughput)
graphs during test execution using the onlinemonitors and after test execution using
the Analysis. You view the Component Breakdown graph after test execution using
the Analysis. Select the types of graph data for the Vuser to collect.

Note: If you do not use theWeb performance graphs, disable these options to
conservememory.

Advanced l Use WinInet replay instead of Sockets (Windows only). Instructs VuGen to
use theWinInet replay engine instead of the standard Sockets replay. VuGen
has two HTTP replay engines: Sockets-based (default) orWinInet based. The
WinInet is the engine used by Internet Explorer and it supports all of the features
incorporated into the IE browser. The limitations of theWinInet replay engine are
that it is not scalable and does not support Linux. In addition, when working with
threads, theWinInet engine does not accurately emulate themodem speed and
number of connections. VuGen's proprietary sockets-based replay is a lighter
engine that is scalable for load testing. It is also accurate when working with
threads. The limitation of the sockets-based engine is that it does not support
SOCKS proxy. If you are recording in that type of environment, use theWinInet
replay engine.

Default value: disabled (socket-based replay engine).

l Include File name and line in automatic transaction names. Creates unique
transaction names for automatic transactions by adding file name and line
number to the transaction name.

l List non-critical resource errors as warnings. Returns a warning status for a
function which failed on an item that is not critical for load testing, such as an
image or Java applet that failed to download. This option is enabled by default. If
you want a certain warning to be considered an error and fail your test, you can
disable this option. You can set a content-type to be critical by adding it to the list
of Non-Resources. For more information, see theHP Virtual User Generator
User Guide.

l Save snapshot resources locally. Saves the snapshot resources to files on
the local machine.
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HTTP

UI Element Description

HTTP
version

Specifies which version HTTP to use: version 1.0 or 1.1. This information is
included in the HTTP request header whenever a Vuser sends a request to aWeb
server.

HTTP 1.1 supports the following features:

l Persistent Connections—see "Keep-Alive HTTP connections" below.

l HTML compression—see Accept Server-Side Compression below.

l Virtual Hosting—multiple domain names sharing the same IP address.

Keep-Alive
HTTP
connections

Keep-alive is a term used for an HTTP extension that allows persistent or
continuous connections. These long-lived HTTP sessions allow multiple requests to
be sent over the same TCP connection. This improves the performance of theWeb
server and clients.
The keep-alive option works only withWeb servers that support keep-alive
connections. This setting specifies that all Vusers that run the Vuser script have
keep-alive HTTP connections enabled.
Default value: enabled.

Include
Accept-
Language
request
header

Provides a comma-separated list of accepted languages. For example, en-us, fr,
and so forth. For more information, see theHP Virtual User Generator User Guide.

Mark HTTP
errors as
warnings

Issues a warning instead of an error upon failing to download resources due to an
HTTP error.

HTTP-
request
connect
timeout (sec)

The time, in seconds, that a Vuser will wait for the connection of a specific HTTP
request within a step before aborting. Timeouts provide an opportunity for the server
to stabilize and respond to the user.
Maximum value: 32000 seconds.

HTTP-
request
receive
timeout (sec)

The time, in seconds, that a Vuser will wait to receive the response of a specific
HTTP request within a step before aborting. Timeouts provide an opportunity for the
server to stabilize and respond to the user.
Maximum value: 32000 seconds.

HTTP Keep-
Alive
timeout (sec)

A time limit within which some activity must be performed on an HTTP connection.
If this timeout is reached, the connections is closed during replay.
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UI Element Description

Request zlib
headers

Sends request data to the server with the zlib compression library headers. By
default, requests sent to the server include the zlib headers. This option lets you
emulate non-browser applications that do not include zlib headers in their requests.
Default value:Enabled.

Accept
server-side
compression

Indicate to the server that the replay can accept compressed data. The available
options are: None (no compression), gzip (accept gzip compression), gzip, deflate
(accept gzip or deflate compression), and deflate (accept deflate compression).
Note that by accepting compressed data, youmay significantly increase the CPU
consumption.
Default value: Accept gzip and deflate compression.
Tomanually add compression, enter the following function at the beginning of the
script:
web_add_auto_header("Accept-Encoding", "gzip");
To verify that the server sent compressed data, search for the string Content -
Encoding: gzip in the section of the server's responses of the replay log. The log
also shows the data size before and after decompression.

Delete
unreferenced
cache
entries

Delete cache entries that have not been referenced within the specified number of
iterations. Set to zero (0) to never delete cache entries.

General

UI Element Description

Enable
snapshots
during replay

Create snapshots during replay.

Note:Disabling replay snapshots will improve the replay speed. However,
snapshot-dependent features such as DFE and correlations, will not be able to use
data captured during the replay. This may cause unstable behavior.

DNS caching Instructs the Vuser to save a host's IP addresses to a cache after resolving its
value from the Domain Name Server. This saves time in subsequent calls to the
same server. In situations where the IP address changes, as with certain load
balancing techniques, be sure to disable this option to prevent Vuser from using the
value in the cache.
Default value: enabled.

Convert
to/from UTF-8

Converts received HTML pages and submitted data from and to UTF-8. You
enable UTF-8 support in the recording options. For more information, see theHP
Virtual User Generator User Guide.
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UI Element Description

Charset to
use for
converting
HTML

The character set to use to convert received HTMLs and submitted data from/to
the set charset. This option is ignored if you enabled the previous option, \'Convert
to/from UTF-8\'.

Mark step
timeouts
caused by
resources as
a warning

Issues a warning instead of an error when a timeout occurs due to a resource that
did not load within the timeout interval. For non-resources, VuGen issues an error.
Default value: disabled.

Parse HTML
content-type

When expecting HTML, parse the response only when it is the specified content-
type: HTML, text\html, TEXT any text, orANY, any content-type. Note that
text/xml is not parsed as HTML.
Default value: TEXT.

Step
download
timeout (sec)

The time that the Vuser will wait before aborting a step in the script. This option can
be used to emulate a user behavior of not waiting for more than x seconds for a
page.
Maximum value: 32000 seconds.
The timeout settings are primarily for advanced users who have determined that
acceptable timeout values should be different for their environment. The default
settings should be sufficient in most cases. If the server does not respond in a
reasonable amount of time, check for other connection-related issues, rather than
setting a very long timeout which could cause the scripts to wait unnecessarily.

Network
buffer size

Sets themaximum size of the buffer used to receive the HTTP response. If the
size of the data is larger than the specified size, the server will send the data in
chunks, increasing the overhead of the system. When runningmultiple Vusers
from the Controller, every Vuser uses its own network buffer. This setting is
primarily for advanced users who have determined that the network buffer size
may affect their script's performance. The default is 12K bytes. Themaximum size
is 0x7FFF FFFF.

Print NTLM
information

Print information about the NTLM handshake to the standard log.

Print SSL
information

Print information about the SSL handshake to the standard log.

Maximum
number of
failure-
matches to
list as errors

Limit the number of content-check failures that are issued as errors, where a failure
is indicated by the appearance of a string (Fail=Found). This applies tomatch
criteria using a left and right boundary. All subsequent matches are listed as
informational messages. The default is 10.

Default value: 10matches.
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UI Element Description

Maximum
redirection
depth

Themaximum number of allowed redirections.
Default value: 10.

Maximum
number of
'META
Refresh' on a
single page

Themaximum number of times that aMETA refresh can be performed per page.
Default value: 2.

Convert
ContentCheck
values to
UTF-8

Store the values in the ContentCheck XML file in UTF-8.
Default value: disabled.

Limit the Tree
view request
body to

Limit the number of request body bytes displayed in Tree-View. Set to zero (0) for
no limit.

Limit the
stored
snapshot to

Limit the size of each snapshot file to a specific number of kilobytes. Enter 0 to
indicate no limit.

IP version The IP version to be used: IPv4, IPv6 or automatic selection. The default value is
IPv4.

web_sync
retry interval

The time to wait (in milliseconds) between testing the condition that yields false
and the next retry. The default value is 1000.

web_sync
retry timeout

Themaximum time (in milliseconds) during which retries are allowed. If the
computed timeout exceeds the step timeout (as determined by the 'Step download
timeout' setting), the latter is used.

WebSocket
callback
interval

The time interval in milliseconds, before repeating a call to aWebSocket callback
handler. This must be a non-zero value.

Prefetch and
prerender
callback timer
interval

The time interval in milliseconds, before repeating a call to Prefetch and Prerender
callback handlers. This must be a non-zero value.
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Authentication

UI Element Description

Add a fixed
delay upon
authentication

Automatically adds think time to the Vuser script for emulating a user entering
authentication information (username and password). This think time will be
included in the transaction time.
Default value: 0.

Disable NTLM2
session
security

Use full NTLM 2 handshake security instead of themore basic NTLM 2 session
security response.
Default value:No.

Use the native
Windows
NTLM
implementation

Use theMicrosoft Security API for NTLM authentication instead of the
indigenous one.
Default value:No.

Override
credentials in a
Windows
native NTML
implementation

Use the credentials provided by the user at logon.

Enable
integrated
authentication

Enable Kerberos-based authentication. When the server proposes authentication
schemes, useNegotiate in preference to other schemes.
Default value:No.

Induce heavy
KDC load

Do not reuse credentials obtained in previous iterations. Enabling this setting will
increase the load on the KDC (Key Distribution Server). To lower the load on the
server, set this option toYes in order to reuse the credentials obtained in previous
iterations. This option is only relevant when Kerberos authentication is used.
Default value:No.

Use canonical
name in SPN

Use the canonical name instead of the original hostname retrieved from the URL,
to generate SPN (Service Principal Name).
Default value:Yes.

Append non-
default port to
SPN

Append the port number to the SPN, if the specified port is a non-standard one
(neither 80 nor 443).
Default value:No.

Enable
retrieving keys
from nCipher
HSM

Enables LoadRunner to retrieve private keys from the nCipher HSM (Hardware
Security Module). This option loads and initializes the CHIL engine necessary to
retrieve these keys.
Default value:Yes.
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Logging

UI Element Description

Print buffer line length Line length for printing request/response header/body and/or
JavaScript source, disabling wrapping.

Print buffer escape for binary
zeros only

l Yes. Escape only binary zeros when printing
request/response headers/body and/or JavaScript source.

l No. Escape any unprintable/control characters.

Limit the maximum response
size written to the log

Limits the size of the log containing the response data.

JavaScript

UI Element Description

Enable running
JavaScript code

Enable runningWeb JavaScript steps, such as web_js_run() and web_js_reset
(). This option creates a JavaScript runtime engine even in the there are no
JavaScript steps in the script.

JavaScript
Engine runtime
size

Thememory size in kilobytes, to allocate for the JavaScript engine runtime. One
runtime engine will be created for all Vusers in a process.

JavaScript
Engine stack
size per thread

Thememory size in kilobytes, to allocate for each Vuser thread in the JavaScript
engine.
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Click & Script Preferences

UI Element Description

General l Home Page URL. The URL of the home page that opens with your browser
(default is about:blank).

l DOM-based snapshots. Instructs VuGen to generate snapshots from the DOM
instead of from the server responses.

Default value:Yes.

l Charset conversions by HTTP. Perform charset conversions by the `Content-
Type:....; charset=...' HTTP response header. Overrides `Convert from /to UTF-
8.'

l Reparse when META changes charset. Reparse HTMLwhen aMETA tag
changes the charset. Effective only whenCharset conversions by HTTP is
enabled. Automeans reparsing is enabled only if it used in the first iteration.

l Fail on JavaScript error. Fails the Vuser when a JavaScript evaluation error
occurs.

Default value:No (issue a warningmessage only after a JavaScript error, but
continue to run the script).

l Initialize standard classes for each new window project.When enabled, the
script—the src compiled script, will not be cached.

l Ignore acted on element being disabled. Ignore the element acted on by a
Vuser script function being disabled.
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UI Element Description

Timers l Optimize timers at end of step.When possible, executes a
setTimeout/setInterval/<META refresh> that expires at the end of the step
before the expiration time

Default value:Yes.

l Single setTimeout/setInterval threshold (seconds). Specifies an upper
timeout for the window.setTimeout and window.setInterval methods. If the delay
exceeds this timeout, thesemethods will not invoke the functions that are
passed to them. This emulates a user waiting a specified time before clicking on
the next element.

Default value: 5 seconds.

l Accumulative setTimeout/setInterval threshold (seconds). Specifies a
timeout for the window.setTimeout and window.setInterval methods. If the delay
exceeds this timeout, additional calls to window.setTimeout and
window.setInterval will be ignored. The timeout is accumulative per step.

Default value: 30 seconds.

l Reestablish setInterval at end of step.0 = No; 1 = Once; 2 = Yes.

l Limit no-network timers at end of step: Limit the number of
setTimeout/setInterval specified script evaluations at the end of a step when no
network requests are issued. Set to zero (0) for no limit. The default value is 100.
This limit is only used when 'Optimize timers at end of step' is enabled.

History l History support. Enables support for the window.history object for the test run.
The options areEnabled, Disabled, andAuto. TheAuto option instructs
Vusers to support the window.history object only if it was used in the first
iteration. Note that by disabling this option, you improve performance.

Default value: auto.

l Maximum history size. Themaximum number of steps to keep in the history
list.

Default value: 100 steps.
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UI Element Description

Navigator
Properties

l navigator.browserLanguage. The browser language set in the navigator DOM
object's browserLanguage property.

Default value: The recorded value. Scripts created with older recording engines
use en-us by default.

l navigator.systemLanguage. The system language set in the navigator DOM
object's systemLanguage property.

Default value: The recorded value. Scripts created with older recording engines
use en-us by default.

l navigator.userLanguage. The user language set in the navigator DOM object's
userLanguage property.

Default value: The recorded value. Scripts created with older recording engines
use en-us by default.

Screen
Properties

l screen.width Sets the width property of the screen DOM object in pixels.

Default value: 1024 pixels.

l screen.heightSets the height property of the screen DOM object in pixels.

Default value: 768 pixels.

l screen.availWidth Sets the availWidth property of the screen DOM object in
pixels.

Default value: 1024 pixels.

l screen.availHeight. Sets the availHeight property of the screen DOM object in
pixels.

Default value: 768 pixels.
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UI Element Description

Memory
Management

l Default block size for DOM memory allocations. Sets the default block size
for DOMmemory allocations. If the value is too small, it may result in extra calls
to malloc, slowing the execution times. Too large a block size, may result in an
unnecessarily big footprint.

Default value: 16384 bytes.

l Memory Manager for dynamically-created DOM objects.Yes—Use the
Memory Manager for dynamically-created DOM objects. No—Do not use the
Memory Manager, for example whenmultiple DOM objects are dynamically
created in the same document as under SAP. Auto—Use the protocol
recommended (default Yes for all protocols except for SAP).

l JavaScript Runtime memory size (KB). Specifies the size of the JavaScript
runtimememory in kilobytes.

Default value: 256 KB.

l JavaScript Stack memory size (KB). Specifies the size of the JavaScript
stack memory in kilobytes.

Default value: 32 KB.

Web
Javascript

l Enable running Javascript code. Yes—Enables running web Javascript
steps, such as web_js_run() andweb_js_reset(). No—Web
Javascript steps can not be run. Note that enabling this option causes the
creation of a Javascript Engine Runtime, even if there are no Javascript steps in
the script.

Default value:No

l Javascript Engine runtime size (KB). Specifies the size of the Javascript
Engine Runtimememory in kilobytes. One Runtime will be created for all Vusers
in a process.

Default value: 10240 KB

l Javascript Engine stack size per-thread (KB). Specifies the size of each
Vuser thread in the Javascript Enginememory, in kilobytes.

Default value: 32 KB
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Runtime Settings > Internet Protocol > Content Check
You use the Internet Protocol Content Check runtime option to check the contents of a page for a
specific string. This is useful for detecting non-standard errors. In normal operations, when your
application server fails, the browser displays a generic HTTP error page indicating the nature of the
error. The standard error pages are recognized by VuGen and treated as errors, causing the script to
fail. Some application servers, however, issue their own error pages that are not detected by VuGen as
error pages. The page is sent by the server and it contains a formatted text string, stating that an error
occurred.

For example, suppose that your application issues a custom page when an error occurs, containing the
text ASP Error. You instruct VuGen to look for this text on all returned pages. When VuGen detects
this string, it fails the replay.

Note: VuGen searches the body of the pages—not the headers.

Runtime Settings > General > Miscellaneous >
Multithreading
TheMultithreading runtime option enables you to run each Vuser in a separate process or in a
separate thread.

The Controller uses a driver program (such as mdrv.exe or r3vuser.exe) to run your Vusers. If you run
each Vuser as a process, then the same driver program is launched (and loaded) into thememory again
and again for every instance of the Vuser. Loading the same driver program intomemory uses up large
amounts of RAM (random access memory) and other system resources. This limits the numbers of
Vusers that can be run on any load generator.

Alternatively, if you run each Vuser as a thread, the Controller launches only one instance of the driver
program (such as mdrv.exe), for every 50 Vusers (by default). This driver process/program launches
several Vusers, each Vuser running as a thread. These threaded Vusers share segments of the
memory of the parent driver process. This eliminates the need for multiple re-loading of the driver
program/process saves muchmemory space, thereby enablingmore Vusers to be run on a single load
generator.

Note: ForMMS (MultimediaMessaging Service) protocol, it is recommended that you run Vusers
as a process.
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Performance Center Administration Overview
Performance Center administration is performed in LabManagement. Youmust be a LabManagement
administrator to perform these tasks.

LabManagement administrators are defined in the ALM Site Administration site. For details on how to
create a LabManagement administrator user, see theHP ALM LabManagement Guide.

Performance Center administration responsibilities includemanaging lab resources, such as hosts and
host pools, creating andmaintaining testing assets, and other administration tasks.

For related task details, see "How toWork with Performance Center Administration" below.

How to Work with Performance Center Administration
This section lists the tasks that a LabManagement administrator can perform. Some tasks are
available only for projects with Performance Center licenses.

Prerequisites
To perform any of these tasks, youmust be a LabManagement administrator. For details on how to
create a LabManagement administrator, see theHP ALM LabManagement Guide.

Perform initial Performance Center configuration
Immediately after installing the Performance Center components, the relevant component's
configuration tool opens, prompting you for initial configuration settings. If this configuration was
skipped, youmust configure the settings manually before you can start working with Performance
Center.

For details, see "How to Initially Configure Performance Center" on page 491.

Create Performance Center projects and define project settings
You create projects in Site Administration, and define the limits and other settings for the project in Lab
Management, in the Project Settings module. For details, see theHP ALM LabManagement Guide.

Manage andmaintain Performance Center lab resources
Youmanage hosts, host pools, host locations, and relevant MI Listeners from the Lab Resources
modules. For details, see theHP ALM LabManagement Guide.

When you plan to perform maintenance tasks on the hosts—such as installing patches, rebooting
hosts, and so on—it is recommended to reserve these hosts in timeslots. This way, you can be sure
that they will be available for maintenance. For details, refer to theHP ALM LabManagement Guide.
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View andmanage performance test runs
The test runs from Performance Center can be viewed andmanaged in the Test Runs module. For
details, see theHP ALM LabManagement Guide.

View Performance Center usage reports
Performance Center usage reports provide you with an overall analysis of Performance Center. The
analysis includes site users, resource usage, concurrent resource usage vs. license limitations,
timeslot usage, resource usage by duration and runs, VUDS usage, protocol usage, and cloud
utilization and operations. For details, see theHP ALM LabManagement Guide.

You can also export these reports to PDF and Excel format. For details, see theHP ALM Lab
Management Guide.

Upload application patches
Before you can install application patches on Performance Center Servers and hosts, youmust upload
the patches to the system. For details, see theHP ALM LabManagement Guide.

Manage Performance Center Servers
Youmanage Performance Center Servers in LabManagement from the PC Servers module. For
details, see theHP ALM LabManagement Guide.

Manage Performance Center and Performance Center host licenses
Youmanage the Performance Center license and Performance Center host license in LabManagement
from the Licenses module. For details, see theHP ALM LabManagement Guide.

Manage Diagnostic Servers andMediators
Integrating diagnostics modules with ALM enables monitoring and analysis of the performance of
complex applications under test. For details on setting up the diagnostics modules, see theHP ALM
LabManagement Guide.

Maintain system health
You track andmaintain the health of the system LabManagement from the System Health module. For
details, see theHP ALM LabManagement Guide.

Change the Performance Center system user
You use the System Identity Utility, installed on the Performance Center Server, to change the
Performance Center system user on the Performance Center Server and hosts. For details, see "How
to Change the System User" on page 497.
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Update the Communication Security passphrase
You use the System Identity Utility, installed on the Performance Center Server, to update the
Communication Security passphrase on the Performance Center Server and hosts. For details, see
"How to Update the Communication Security Passphrase" on page 496.

Update the secure host communication settings
Initially, you define secure communication settings on each Performance Center host or standalone
load generator using the Host Security Setup utility, installed locally on each host or load generator. For
details, see "How to Configure Security Settings Locally on Hosts" on page 510.

To update these settings on all the hosts and load generators simultaneously, you can use the Host
Security Manager, installed on the Performance Center Server. For details, see "How to Update Host
Security Settings Remotely" on page 511.

Configure general Performance Center settings

Youmanage general Performance Center settings in LabManagement. On themasthead, click
and select Performance Center General Settings. For user interface details, see theHP ALM Lab
Management Guide.
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Initial Performance Center Configuration Overview
Immediately after installing the Performance Center Server and hosts, the relevant component's
configuration tool opens, prompting you for initial configuration settings. If any parts of the configuration
were skipped, youmust configure the settings manually before you can start working with Performance
Center.

You can perform the configuration by running the configuration tool on the relevant machine, or
alternatively by defining the settings manually in LabManagement.

For details on running the relevant configuration tools, see theHP ALM Performance Center Installation
Guide.

For details on configuring the initial settings in LabManagement, see "How to Initially Configure
Performance Center" below.

How to Initially Configure Performance Center
This task describes how tomanually perform the initial configuration of the Performance Center Server
and hosts in LabManagement.

This task includes the following steps:

l "Prerequisites" below

l "Log into LabManagement" below

l "Add the Performance Center Server(s) to ALM" on the next page

l "Add the Performance Center license and the host license" on the next page

l "Add Performance Center hosts to the system" on the next page

1. Prerequisites
n The Performance Center Server and Performance Center hosts must be installed according to

instructions provided in theHP ALM Performance Center Installation Guide.

n To perform any of these tasks, youmust be a LabManagement administrator. For details on
how to create a LabManagement administrator, refer to theHP ALM LabManagement Guide.

2. Log into Lab Management
a. Open yourWeb browser and type the ALM URL in the following format:

http://<ALM>[<:port number>]/qcbin
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b. In the HP Application Lifecycle Management window that opens, click Lab Management.

c. Enter your LabManagement Administrator user name and password and click Login.

3. Add the Performance Center Server(s) to ALM
On the LabManagement sidebar, underServers, select PC Servers, and add your Performance
Center Server. For details on how to add a Performance Center Server, refer to theHP ALM Lab
Management Guide.

4. Add the Performance Center license and the host license
On the LabManagement sidebar, underPerformance Center, select PC Licenses.

Add the Performance Center license, and then the host license. For interface details, refer to the
HP ALM LabManagement Guide.

5. Add Performance Center hosts to the system
On the LabManagement sidebar, under Lab Resources, select Hosts. For user interface details,
refer to theHP ALM LabManagement Guide.
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ALM Performance Center Communication Security
During installation of ALM and the Performance Center Server and hosts, a passphrase, known as the
Communication Security passphrase, is defined. This passphrase enables secure communication
between the Performance Center components and ALM. This passphrasemust be identical on all of
the components of the system.

The Communication Security passphrase can be updated from time to time. For information about
updating the Communication Security passphrase, see "How to Update the Communication Security
Passphrase" on the next page.

Performance Center System User
During installation of the Performance Center Server and hosts, a default Performance Center system
user, IUSR_METRO (default passwordP3rfoRm@1nce), is created in the Administrators user group
of the server/host machines.

Note: To prevent security breaches, you can replace Performance Center's default system user
by creating a different local system user, or by using a domain user.

For stronger security, you can create a non-administrator Performance Center system user in a local
group under the Users group. This system user has the permissions granted to any user in the Users
group with extended rights toWeb services and the HP file system and registry.

With these limited permissions, such a system user cannot perform all administrative system tasks.
You need to specify a configuration user (a user with administrative privileges that is defined on the
Performance Center Server and hosts) that Performance Center uses when administrative tasks are
required on the system. After the tasks are complete, the system user reverts back to itself, with its
limited Performance Center user permissions.

Note: The configuration user is saved in the database so that whenever an administrative-level
system user is required to perform a task, the system automatically uses the configuration user,
without asking for its credentials.

The Performance Center Server is installed with the System Identity Utility that enables you tomanage
the Performance Center system user on the Performance Center Server and hosts from one
centralized location.

Using this utility, you can periodically update the Performance Center system user name and
password. For more information, see "How to Change the System User" on page 497.

User and Administrator Guide
Chapter 39: Performance Center System Administration

HP ALM Performance Center (12.20) Page 495 of 521



Remote Performance Center Server and Host Administration

To perform administrative tasks on the Performance Center Server or hosts (such as adding,
configuring, or resetting a Performance Center Server/host), Performance Center must use a user with
administrative privileges. This must be the Performance Center system user with administrative
privileges or, if the Performance Center system user is non-administrative, a configuration user.

When the Performance Center system user has administrative privileges and is defined on the remote
machine, tasks are performed upon request. After validating the Performance Center system user or
configuration user, Performance Center can perform required tasks.

How to Update the Communication Security Passphrase
This task describes how to update the Communication Security passphrase on the ALM-Performance
Center system components.

To learnmore about ALM-Performance Center communication security, see "ALM Performance Center
Communication Security" on the previous page.

This task includes the following steps:

l "Update the Communication Security passphrase on ALM" below

l "Update the Communication Security passphrase on the Performance Center components" below

1. Update the Communication Security passphrase on ALM
a. In Site Administration, update theCOMMUNICATION_SECURITY_PASSPHRASE default

parameter. For details, see theHP Application Lifecycle Management Administrator Guide.

b. Restart the HP Application Lifecycle Management service on the ALM server.

2. Update the Communication Security passphrase on the Performance Center
components
The System Identity Utility is installed on the Performance Center Server. You use this utility to
update the Communication Security passphrase on the Performance Center Server and hosts
from one centralized location.

a. From the Performance Center Server installation's bin directory, open the System Identity
Utility (<Performance Center Server Installation
directory>/bin/IdentityChangerUtil.exe).

Note: You can run this utility from any one of the Performance Center Servers in the
system.

b. Enter the ALM details to connect to ALM.
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c. The System Identity Utility opens. For user interface details, see "System Identity Utility
Window" on page 500.

In theCommunication Security Passphrase section, select Change, and enter the new
Communication Security passphrase.

d. Click Apply.

How to Change the System User
You use the System Identity Utility, installed on the Performance Center Server, to change the system
user on the Performance Center Server and hosts.

When you change the system user, or a user's password, the System Identity Utility updates the
Performance Center Server and hosts.

To learnmore about the Performance Center system user, see "Performance Center System User" on
page 495.

This task includes the following steps:

l "Prerequisites" below

l "Launch the System Identity Utility on the Performance Center Server" below

l "Change the details of the Performance Center user" on the next page

l "Verify that the system user was changed on the Performance Center Server" on the next page

1. Prerequisites
n When changing the system user, Performance Center must be down. That is, all users must be

logged off the system and no tests may be running.

n When changing the user password:

o Ensure that each host is listed in theMachines table under one alias only.

o In the case of a domain user, when the domain IT team notifies you that the password is to
be changed, you need to temporarily change the Performance Center system user on the
Performance Center Server and hosts to a different user. After the domain IT team has
changed the password of the domain user and has notified you of this change, you need to
change the Performance Center system user back to the domain user on the Performance
Center Server and hosts.

2. Launch the System Identity Utility on the Performance Center Server
a. In the Performance Center Server installation's bin directory, open the System Identity Utility
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(<Performance Center Server Installation directory>/bin/IdentityChangerUtil.exe).

b. Enter the ALM details to connect to ALM.

The System Identity Utility opens. For user interface details, see "System Identity Utility
Window" on page 500.

3. Change the details of the Performance Center user
Enter the relevant details to update and click Apply. The utility updates the Performance Center
Server and hosts, starting with the Performance Center Server.

In the lower part of the utility window, theMachines table displays the status of eachmachine
during the configuration process.

If the utility is unable to change the user on the Performance Center Server, it stops the
configuration, rolls back the change, and issues amessage explaining why the change cannot be
made. Correct the error and click Apply again.

When configuration completes successfully on the Performance Center Server, the utility
proceeds with the configuration of the hosts. The utility attempts to configure all the hosts, even if
the configuration on one or more hosts is unsuccessful. In this case, after the utility has attempted
to configure all the hosts, correct the errors on the failed hosts, and click Reconfigure. The utility
runs again on the whole system.

4. Verify that the system user was changed on the Performance Center Server
a. Open IIS Manager. UnderSites > Default Web Site, choose a virtual directory.

b. Under Authentication select Anonymous Authentication. Verify that the anonymous user
defined was changed for the following virtual directories: PCS, LoadTest and Files (a virtual
directory in LoadTest).

c. Check in thePCQCWSAppPool and LoadTestAppPool application pools that the identity is
the Performance Center user.

Required Policies for the Performance Center System User
This section describes the policies required for the Performance Center system user.
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Note: This section applies to:

l An administrative or non-administrative Performance Center user

l All Performance Center servers and hosts

The Performance Center user must be granted all of the following policies:

Policy Reason

Create global object For Autolab running Vusers on the Controller.

Batch logon rights Theminimum policies required to runWeb applications.

Service logon rights Theminimum policies required to runWeb applications.

Access this computer
from the network

Theminimum policies required to runWeb applications.

Log on locally Required by infra services. For example, after reboot, the system logs in
with the Performance Center system user.
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System Identity Utility Window
This utility enables you update the ALM-Performance Center Communication Security passphrase, as
well as the Performance Center system user and/or password on the Performance Center Server and
hosts from one centralized location.

To access From the Performance Center Server installation's bin directory, open the System
Identity Utility (<Performance Center Server Installation
directory>/bin/IdentityChangerUtil.exe).

Important
information

l This utility does not apply changes to UNIX machines, Standalone Load
Generators, or machines that are located over the firewall.

l When updating the Communication Security passphrase, it is essential that it is
updated in ALM as well.

l This utility applies changes to the Performance Center servers and hosts listed in
theMachines grid.

l When changing the system user, Performance Center must be down. That is, all
users must be logged off the system and no tests may be running.
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Relevant
tasks

l "How to Change the System User" on page 497

l "How to Update the Communication Security Passphrase" on page 496

See also l "Performance Center System User" on page 495

l "ALM Performance Center Communication Security" on page 495

User interface elements are described below:

UI Elements Description

Applies the selected changes on the Performance Center Server and hosts,
starting with the Performance Center Server.

Hides/shows the legend.

If, when applying a change, there are errors on any of the Performance Center
hosts, troubleshoot the problematic host machines, then click Reconfigure.
The utility runs again on the Performance Center Server and hosts.
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UI Elements Description

Performance
Center User

The Performance Center system user details.

l Change. Enables you to select which detail to change.

n None. Do not change the user's name or password.

n Password Only. Enables you to change only the Performance Center
system user's password.
Note:When changing the password:
- Ensure that each host is listed in theMachines table under one alias
only.
- In the case of a domain user, when the domain IT team notifies you that
the password is to be changed, you need to temporarily change the
Performance Center system user on the Performance Center Server and
hosts to a different user. After the domain IT team has changed the
password of the domain user and has notified you of this change, you
need to change the Performance Center system user back to the domain
user on the Performance Center Server and hosts.

n User. Enables you to change the Performance Center system user
name and password.

l Domain\Username. The domain and user name of the Performance Center
system user.

l Password/Confirm Password. The password of the Performance Center
system user.

l Delete Old User. If you are changing the user, this option enables you to
delete the previous user from themachine.

Note:You cannot delete a domain user.

User Group The details of the user group to which the Performance Center system user
belongs.

l Group type. The type of user group.

n Administrator Group. Creates a user in the Administrators group with
full administrator policies and permissions.

n Other. Creates a local group under the Users group, granting policies
and permissions as well as other Performance Center permissions.
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UI Elements Description

Configuration
User

If you are creating a non-administrative Performance Center system user, that
is, if you selectedOther underUser Group, you need to configure a
configuration user (a system user with administrative privileges) that the non-
administrative Performance Center system user can impersonate when it
needs to perform administrative tasks. For more details, refer to "Performance
Center System User" on page 495.

If you selectedDelete Old User in thePerformance Center User area,
ensure that the configuration user you are configuring is not the same as the
system user you are deleting. Alternatively, do not delete the old user.

l Domain\Username. The domain and user name of a system user that has
administrator privileges on the Performance Center Server and hosts.

l Password/Confirm Password. The password of a system user that has
administrator privileges on the Performance Center Server and hosts.

Communication
Security
Passphrase

The Communication Security passphrase that enables the Performance Center
Server and hosts to communicate securely with ALM.

l Change. Enables you to change the passphrase.

l New passphrase. The new Communication Security passphrase.

Note: This passphrasemust be identical to the Communication Security
passphrase defined in ALM. For details, refer to the "How to Update the
Communication Security Passphrase" on page 496.

User and Administrator Guide
Chapter 39: Performance Center System Administration

HP ALM Performance Center (12.20) Page 503 of 521



UI Elements Description

Machines grid l Type. Indicates whether themachine type is a Performance Center server
or a host.

l Name. Themachine name.

l Configuration Status. Displays the configuration status on each of the
Performance Center components.

n Configuration complete. The system user configuration was
completed.

n Needs to be configured. The Performance Center server/host is
pending configuration. Displayed only after the Performance Center
Server configuration is complete.

n Configuring..... The Performance Center Server/host in being
configured.

n Configuration failed. The Performance Center Server/host
configuration failed. The utility displays the reason for failure together
with this status.

Note:

n If the utility is unable to apply the change on the Performance Center
Server, the utility stops the configuration, rolls back the change, and
issues amessage explaining why the change cannot be applied.
Correct the error and click Apply again.

n When configuration completes successfully on the Performance
Center Server, the utility proceeds with the configuration of the
hosts. The utility attempts to configure all the hosts, even if the
configuration on one or more hosts is unsuccessful. In this case,
after the utility has attempted to configure all the hosts, correct the
errors on the failed hosts, and click Reconfigure. The utility runs
again on the whole system.
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Secure Host Communication Overview
The need to secure communication channels from hackers attacking the corporate networks is critical.
Securing communication channels ensures confidentiality, integrity, and the user's authenticity within
the scope of the load testing application.

Because load generators and Controllers serve somany projects, it is essential that the channels
between Controllers and load generators remain opaque to all machines except for the Controllers and
load generators participating in running performance tests or collating test data after a run.

Secure communication is established between the Controller and load generator hosts using a security
key. Each host in the systemmust be set up with the identical security key. If security keys on the
hosts do not match, secure communication cannot be established.

A host is in secure mode when it has a security key and security is enforced.

A host is in non-secure mode:

l if it has no security key

l if it has a security key but security is not enforced

When a host in securemode tries to communicate with a host in non-securemode, security is
automatically enforced on the non-secure host—assuming their security keys match—allowing secure
communication to be established.
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Note:

l When you run a performance test, if secure communication cannot be established between a
secure host (Controller or load generator) and another host participating in the test, the test
cannot run.

l By definition, non-secure hosts can communicate with each other and participate in test runs
over non-secure channels.

This can be summarized in the following table:

Both Hosts in
Secure Mode

Security Mode on
Hosts Differ

Both Hosts in Non-
Secure Mode

Security keys
match

Test runs over secure
channel

Test runs over secure
channel

Test runs over non-secure
channel

Security keys
do not match

Test does not run Test does not run Test runs over non-secure
channel

Host Security Configuration
When you install the hosts (Controllers and load generators), by default no security settings are defined
on them, and communication channels between the hosts are not secure. To enforce secure
communication between the hosts, youmust configure security settings on each host machine
immediately after installing the hosts.

When configuring these settings for the first time, to avoid configuration over non-secure channels,
youmust set the security on each host locally using theHost Security Setup utility. For details, see
"How to Configure Security Settings Locally on Hosts" on page 510.

After initial security configuration, you can update security settings locally or simultaneously across all
the Performance Center hosts from a remote location using theHP Host Security Manager utility.
This utility is installed on the same Performance Center Server. For details, see "How to Update Host
Security Settings Remotely" on page 511.

Remote Security Configuration
You can align security settings across all the Performance Center hosts simultaneously from a remote
location using theHP Host Security Manager utility.

The utility lists all the Performance Center hosts, as well as theMI Listeners required to connect to the
hosts that are over a firewall, where applicable.

Using Host Security Manager, you can update the security key on all the hosts, or update the security
mode on selected hosts. For details, see "How to Update Host Security Settings Remotely" on
page 511.
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Master Security Key
To update security settings on the hosts, Host Security Manager uses amaster key that matches the
security keys on all the hosts. This enables secure communication between Host Security Manager
and the hosts for the purpose of remotely updating the security settings.

If themaster key and security key on a particular host do not match, Host Security Manager cannot
update security settings on that host.

When you open Host Security Manager for the first time, you are prompted for a key.
Host Security Manager stores this key as amaster key for secure communication with the hosts. If you
do not enter the key at this point, you are prompted for it again when you try to update the security
settings.

Considerations for Updating Linux Load Generators

l Linux load generators that use rsh (remote shell) to connect to the Controller host cannot be updated
using Host Security Manager. To update security settings on such load generators, use the local
Host Security Setup utility. See "How to Configure Security Settings Locally on Hosts" on the next
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page.

l To update security settings on a Linux load generator using Host Security Manager, youmust
launch the load generator daemon for a user andmanually grant write permissions to the user on
<installation folder>/config.

Host Security Best Practices
l To avoid sending security settings over a non-secure channel, perform initial configuration of the
security settings on each host locally (see "How to Configure Security Settings Locally on Hosts"
below).

l Security settings should be changed once amonth.

l Security settings can be updated:

n manually on each host

n remotely on all hosts simultaneously using the Host Security Manager utility

If the host's settings fail when using the Host Security Manager utility, youmust update the settings
manually.

How to Configure Security Settings Locally on Hosts
This task describes how to configure security settings locally on Controllers and load generators.

Note: This task is part of a higher-level task. For details, see "How toWork with Performance
Center Administration" on page 487.

Windows Hosts

1. On each host, launch the Host Security Setup utility (Start > All Programs > HP Performance
Center Host > Tools > Host Security Setup).

For user interface details, see "Host Security Setup Dialog Box" on page 515.

2. Select a security mode for the host.

3. If you selected to enforce secure communication, enter a security key (6 - 16 characters). Enter
the key a second time for confirmation.
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Linux Hosts

1. Log in as root user and change to tcsh.

2. Go to the /opt/HP/HP_LoadGenerator directory and type:

>source ./env.csh

3. RunSecurityKeyConsole.exe, located in the <Installation_folder>/bin/ directory.

4. In the Console window, enter an option as follows:

n To change the security mode, enter 1.

n To change the security key, enter 2.

5. If you are changing the security mode:

n To turn the security on, enter 1.

n To turn the security off, enter 0.

6. If you are changing the security key, enter the new key. A valid key is 6 - 16 characters long.

How to Update Host Security Settings Remotely
This task describes how to use Host Security Manager to update security settings on the Performance
Center hosts remotely, from the Performance Center Server.
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Note: This task is part of a higher-level task. For details, see "How toWork with Performance
Center Administration" on page 487.

This task includes the following steps:

l "Prerequisites" below

l "Register Performance Center hosts in Host Security Manager" below

l "Update the security settings" below

l "Results" on the next page

1. Prerequisites
n Each host must have a security key defined on it, and all of the hosts' security keys must be

identical.

n Host Security Manager must have amaster security key that is identical to the security key on
all of the hosts. For details, see "Remote Security Configuration" on page 508.

2. Register Performance Center hosts in Host Security Manager
For Host Security Manager to communicate with the Performance Center hosts, youmust first
register the hosts in Host Security Manager.

Note: Every time you use Host Security Manager to update security settings, make sure that
the list of hosts in Host Security Manager is updated.

a. Open Host Security Manager: On the Performance Center Server, select Start > All
Programs > HP Performance Center Server > Tools > Host Security Manager. For user
interface details, see" Host Security ManagerWindow" on page 514.

b. Before opening, the tool prompts you for the ALM login credentials. Enter the credentials.

c. In the Host Security Manager, click Get Performance Center Hosts. The list of hosts is
updated as follows:

o The hosts—and, where relevant, their associatedMI Listeners—are imported from ALM
into the utility.

o If you are updating the list, hosts that are no longer in ALM are removed from the list.

3. Update the security settings
a. Update the desired security setting:
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o Security key. Click Update Security Key, enter the new key, and enter it again for
confirmation.

o Security Mode. Select the hosts in the list that you want to update. To select multiple
hosts, hold down the CTRL key on your keyboard while selecting the relevant hosts. Click
Update Security Mode, and select a security mode.

b. Click Update.

Host Security Manager attempts to update the security setting on the hosts listed under
Update progress. As it attempts to update each host, it displays the update status, Updated
or Failed, before attempting to update the next host.

If a host is not updated successfully, check for possible reasons. You can stop the update
process by clickingStop.

If there is amismatch between Host Security Manager's master security key and the host's
security key, the Update Error dialog box opens, prompting you for an appropriate action:

o Skip host. Skip updating this host.

o Establish a secure channel using this key. Use a different security key to
communicate securely with the host.

o Communicate over non-secure channel. Update the security setting over a non-secure
channel. This action is not recommended, especially when updating the host security to
securemode. You should rather update the security setting locally on the host (see "How
to Configure Security Settings Locally on Hosts" on page 510).

To apply the selected error-handling action to all similar mismatches, select Use this
solution with all similar mismatches.

Note: The security key update also updates Host Security Manager's master security
key. If the update fails on all of the hosts, Host Security Manager's master key is not
updated.

4. Results
If the update was successful, Host Security Manager displays the time and status of the security
key/mode update for each host.

Secure Host Communication User Interface
This section includes:

Host Security ManagerWindow 514

Host Security Setup Dialog Box 515
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Update Security Key Dialog Box 516

Update Security Mode Dialog Box 517

Host Security Manager Window

This window enables you to update security settings remotely on all of the hosts in the performance
testing system.

To access On the Performance Center server select Start > All Programs > HP Performance
Center Server > Tools > Host Security Manager.

Important
information

l Youmust provide Host Security Manager with amaster security key before you
can update the security settings.

l Every time you use Host Security Manager to update security settings, click Get
Performance Center Hosts to make sure that the list of hosts is up to date.

Relevant
tasks

"How to Update Host Security Settings Remotely" on page 511

See also " Secure Host Communication Overview " on page 507

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Imports all the hosts defined in ALM into Host Security Manager.

Opens the Update Security Key dialog box, enabling you to update the
security key on all the hosts. For details, see " Update Security Key
Dialog Box" on page 516.

Opens the Update Security Mode dialog box, enabling you to update
the security mode on selected hosts. For details, see " Update
Security Mode Dialog Box" on page 517.

Opens the Set Master Key dialog box where you update Host Security
Manager's master security key.

Opens the History dialog box, enabling you to view the history of
updates made to the hosts. The information displayed includes the
date of the update, the operation (key/mode update), and the update
status (Passed/Failed).
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UI Elements Description

<Hosts table> Displays the following information:

l Host Name/IP. The name or IP address of the host.

l Host Type. The type of host: Controller/Load Generator.

l MI Listener. When the host is over a firewall, the name of theMI
Listener through which the host communicates with the other
hosts.

l Last Key Update. The last time the security key was updated.

l Key Update Status. The status of the last security key update.

l Last Security Mode Update. The last time the security mode was
updated.

l Security Mode Update Status. The status of the last security
mode update.

Tip: You can sort the details on this page in ascending or
descending order by clicking the heading of the column by which
you want to sort. Click the column heading again to reverse the
sort order.

Host Security Setup Dialog Box

This dialog box enables you to update a host's security settings manually.

To access On the host machine, select Start > All Programs > Performance Center Host >
Tools > Host Security Setup

Important
information

When configuring security settings on hosts for the first time, to avoid configuration
over non-secure channels, it is recommended to configure security settings on each
host locally using the Host Security Setup utility.

After initial security configuration, you can update security settings locally, or
simultaneously across all the hosts in the system using the HP Host Security
Manager utility installed on the Performance Center Server. For details, see "Remote
Security Configuration" on page 508.

Relevant
tasks

"How to Configure Security Settings Locally on Hosts" on page 510

See also "Host Security Configuration " on page 508

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Elements

Description

Select a
security
mode

Select one of the following security modes:

l Allow non-secure communication. Allows the host to communicate with other
machines over a non-secure channel. (Default)

l Enforce secure communication. Enforces the host to communicate with other
machines over a secure channel. If you select this option, youmust provide the key
(6 - 16 characters long) matching the security key on the other hosts with which it
needs to communicate.

Update Security Key Dialog Box

This dialog box enables you to update the security key simultaneously on all the hosts.

To access In Host Security Manager, click Update Security Key.

Important
information

When you update the security key, the Host Security Manager's master
security key is also updated.

If the update fails on all the hosts, the Host Security Manager's master key is
not updated.

Relevant tasks "How to Update Host Security Settings Remotely" on page 511

User interface elements are described below:

UI Elements Description

Updates the security key on all of the hosts.

Stops updating the hosts.

Security Key/Confirm
Security Key

Enter the new security key to be updated on all the hosts, and a
second time for confirmation.

Note: The key must be 6 - 16 characters long.

Update progress Displays the hosts and their status during and after the update.
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Update Security Mode Dialog Box

This dialog box enables you to update the security mode simultaneously on selected hosts.

To access In Host Security Manager, click Update Security Mode.

Relevant tasks "How to Update Host Security Settings Remotely" on page 511

User interface elements are described below:

UI Elements Description

Updates the security mode on the selected hosts.

Stops updating the hosts.

Security
mode

Select a security mode:

l Non-secure. Allows non-secure communication.

l Secure. Enforces secure communication.

Update
progress

Displays the hosts, their previous status (if known), and their status during and
after the update.

Troubleshooting and Limitations
This section describes troubleshooting and limitations for secure host communication.

Cannot Run Test Over Secure Channels
Problem description:When you try to run a test over secure channels, the test cannot initialize
because it cannot connect to a Controller or load generator.

Troubleshooting:

Verify that the reason the test cannot run is because of a security key mismatch: try to run the same
test with the same hosts from a local Controller.

If a Security Key Mismatch error is displayed in the error log, the keys do not match. Align the security
keys on all the host machines.

Test Run Fails. Load Generator Status is Changed to Resource Failure
Problem description:When trying to run a test over secure channels, the test fails to run and the load
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generator status changes toResource Failure.

Troubleshooting: To re-enable the load generators, manually reset the status on each affected load
generator toOperational.

When Opening Host Security Manager Get Unhandled Exception
Problem description:When you open Host Security Manager for the first time, amessage displays
the following exception: Unhandled exception has occurred....

Troubleshooting: Click Continue to close themessage window.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on User and Administrator Guide (ALM Performance Center 12.20)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to SW-Doc@hp.com.

We appreciate your feedback!
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